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Introduction to MPI Stylus – How to Use This Manual 
 
Welcome to MPI Stylus Pro!  We thank you for your patronage and hope that this manual helps you learn 
about the application in a quick, clear and efficient manner. 

 
This manual has been designed with all levels of users in mind.  For the beginner, it may serve as an 
excellent introduction to the program, and may be worked through from start to finish to quickly become 
familiar with the most powerful and commonly used features of the application.  For more advanced 
users, it may serve as an ongoing desk reference for specific features within the application.   
 
We encourage all users to familiarize themselves with the additional learning materials and resources 
covered in Chapter 11 (MPI Learning Programs Resources), in order to ensure that you are getting the 
most out of MPI Stylus Pro.  And, as an MPI Stylus Pro user, you are entitled to full access to our forums, 
newsletters, white papers and support materials, conveniently located on our web site at: 
 

http://www.markovprocesses.com 
 
Do you have suggestions or corrections for information in this manual?  If so, please contact us at 
manual@markovprocesses.com.  Your questions, comments and suggestions will be read and responded 
to by an MPI Client Services specialist. 
 
Thanks again for using MPI Stylus Pro! 

Getting Help from MPI Support 
 
Questions or comments about MPI Stylus Pro?  MPI has an entire range of resources and tools available to 
help you quickly and efficiently learn and use our application.  A brief summary may be found in Chapter 
11 of this manual; however, for more information you may also log on to our web site at: 
 

http://www.markovprocesses.com 
 

 
Of particular note are our excellent user forums, which provide users a chance to share their general or 
specific questions about the product, and to get fast answers from MPI.   
 

http://www.markovprocesses.com/phorum/ 
 

You will need your MPI Stylus user name and password to log in.   

You may also contact us during business hours at the following numbers: 

US/Canada: 908.608.1558  
8:30 AM to 6 PM Monday-Friday EST 
Closed market holidays. 

Europe: +44 (0) 203 514 5571  
9 AM to 6 PM GMT Monday-Friday GMT 
Closed market holidays. 

http://www.markovprocesses.com/
mailto:manual@markovprocesses.com
http://www.markovprocesses.com/
http://www.markovprocesses.com/phorum/
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ABOUT MPI  
 
Markov Processes International (MPI) is a provider of technology, solutions and services to the global 
wealth and investment management industry. MPI’s flagship Stylus products give investment 
practitioners highly-customizable reporting capabilities, time-saving automation features, comprehensive 
data integration and powerful predictive analytics.  
 
Rooted in the principles of transparency, objectivity and efficiency, MPI’s solutions solve problems for 
over 350 clients worldwide in the areas of performance attribution and reporting, asset allocation, 
quantitative fund due diligence and risk analysis to ensure clients have the tools to succeed in ever-
crowded markets.  
 
Our mission is to bring innovative and precise solutions to the market that exceed the goals and exacting 
standards of our clients.  
 
MPI’s deep experience working with hundreds of clients for over a decade has led to the development of 
tools that deliver the highest quality results while minimizing time, resources and operational risk – 
allowing our clients to bring more value to their customers.  
 
MPI is an independent, privately owned company headquartered in Summit, NJ with regional offices 
throughout North America, Europe and Asia. 
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Installing and Updating MPI Stylus Pro 

Chapter 1 

Overview 
 

This chapter will briefly provide 
the background information on 
installing and updating the MPI 
Stylus Pro application. 
 
Always make sure to check with 
your existing users (if any) to 
determine what installation 
approach is right for you. 
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Chapter 1 
 

Installing & Updating MPI Stylus Pro - Quick Start Guide 

 
Welcome to MPI Stylus Pro!  This chapter will guide you through the installation and update processes for 
the application. Key topics include your Stylus user name and password, instructions for downloading and 
updating data, information on subscribing to 3rd party database feeds, and more.  Please note that this is 
not a full installation guide, but is instead meant to cover a typical user installation of the application.  For 
more advanced installation procedures, please consult our MPI Stylus Installation Reference Guide. 
 
 
 
 
 
 
 
 
 
 
 
 

 

Your Stylus User Name & Password 

 
As an MPI Stylus subscriber, you have an assigned user name and password that are linked to your MPI 
Stylus license.  This login information gives you complete access to the client-only features of our web 
site, including our user forums, documentation & training materials, and more.  Our web site may be 
found at: 
 

http://www.markovprocesses.com 
 

Your user name and password are supplied to you when you first subscribe to MPI Stylus Pro.  If you have 
not installed MPI Stylus Pro and/or cannot find your user name/password, please contact MPI at 
support@markovprocesses.com. 
 

Important Note – User Permissions 
 

Many MPI Stylus Pro users work behind corporate firewalls or in high-security environments that 
prohibit traditional software installation and update options.  Successfully installing and updating MPI 
Stylus Pro will require user Internet access and read/write permission to the installation location (i.e., 
C: drive) to download and run .MSI and/or .EXE files.  If you are unable to install or update MPI Stylus 
Pro and/or its associated data feeds, please discuss your computer/network access privileges with 
your firm’s technical support/information technology department. MPI Support will be unable to 
adjust your Internet issues or read/write capabilities. 

http://www.markovprocesses.com/
mailto:support@markovprocesses.com
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Installing MPI Stylus Pro 

 
Installation 

 
1. Go to the following link in your Internet web browser: http://www.markovprocesses.com 

You will need your Stylus user name and password. 
 

2. Locate the latest version of MPI Stylus Pro.  Save the .MSI file onto your computer.  Once this 
download is complete, locate the file in its respective directory using My Computer or 
Windows Explorer. 
 

3. Double-click on the downloaded .MSI file to bring up the Installation Wizard.  Follow the 
prompts using the “Next” button to install MPI Stylus Pro.  Please select your C:/ drive (or 
other hard drive) as the destination for your installation.  (Note: If you do not have Microsoft 
Installer (MSI), please download this free tool, available in the Support-> Updates section of 
our corporate web site) 

 
4. Once the Installation Wizard is finished, proceed to “License Activation.” 

  
License Activation 
 

5. In order to activate the application, please save your license file (provided by MPI), named 
STYLUS.LIC, into your Stylus root folder following the installation (e.g. c:\Stylus\STYLUS.LIC). 

 
Note on Licenses 
You may view your License Expiration Date at any time by going to Help->About in the main MPI Stylus 
Pro menu.  MPI understands that many of our users are not responsible for invoicing/payment, and 
therefore provides a 30-day grace period past expiration in order to allow you to continue using our 
product while arrangements are made for payment.  During this time period, you will receive a pop-up 
notification every time you open the application, reminding you of the final cut-off date. This grace period 
is not provided to trial users. 
 
Database update 
 

6. To update the databases associated with your Subscription, please use the MPI Updater 
Tool (Tools>MPI Updater) from within your Stylus Pro application.  After the list of 
databases available for download is retrieved, simply check the boxes next to those marked 
as NEW, and follow the prompts.  If a database is listed as “N/A”, then you are not currently 
listed as a subscriber to that database.  If a database says “UTD,” then you have the most up-
to-date version available. If a database is listed as “Add”, then the database was not 
previously available for download, but is now available and may be downloaded. 

 
Network Installations & Advanced Technical Guide 
 
These instructions are intended for the typical MPI Stylus Pro user, and are not for network installations 
or more advanced technical installations.  Please refer to the MPI Stylus Pro Installation Reference for 
more information. It may be downloaded in the Support Materials section of our web site. 
 

http://www.markovprocesses.com/
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Updating MPI Stylus Pro Software Online 

 
Periodic updates to MPI Stylus Pro may become available as new tools & features are added, or as 
industry changes warrant.  We recommend that users periodically check for updates to make sure they 
are using the most recent version of MPI Stylus Pro. 

 
To see your current version of MPI Stylus Pro: 

 
1. In your main MPI Stylus menu, go to Help -> About. 
2. Your current version number should be displayed, along with the date the current version 

was released. 
 

To check for the latest version of MPI Stylus Pro: 
 
1. Log on to the Support -> Updates section of our web site at 

http://www.markovprocesses.com. 
2. Check under the “MPI Stylus Program” heading for the latest update to MPI Stylus. 

 
To install an updated version of MPI Stylus Pro: 

 
1. Make sure your current version of MPI Stylus is closed. 
2. Click on the update link for the latest update and save the file to your hard drive. 
3. Open the file on your computer to begin the installation process. 
4. Run MPI Stylus. 

Installing Data Sources for MPI Stylus Pro 

 
MPI has always worked tirelessly to accommodate the diverse data needs of our users, offering a wide 
variety of databases and the flexibility to work with almost any 3rd party provider of manager data. 
Additionally, MPI Stylus users may import their own proprietary data or link multiple proprietary and/or 
third party databases through our optional Open Database Link (ODL). 
 
All users are encouraged to download the MPI Database Updates User Guide, available on our web site. 
 
Updating Standard & Subscription-Based Feeds 
 
There are two methods of updating your data feeds for MPI Stylus.  The first, called “MPI Updater” is the 
quicker and more-efficient of the two, as it may be done right through your MPI Stylus program.  Due to 
technical problems that may be experienced by MPI Stylus users behind a corporate firewall, MPI also 
provides the update files in MSI form in the “Updates” section of our corporate website, at 
http://www.markovprocesses.com.  If you are unable to use/access either update procedure, please refer 
your connectivity problems to your tech support/information technology department. 
 
Updating via MPI Updater 
 
The MPI Updater allows you to quickly check for updates in your data feeds from within Stylus, and then 
to efficiently run your updates without having to download files from our website.  For instructions on 
using the MPI Updater, please see Chapter 10 (Helpful Stylus Tools.) 
 
In addition, please see the Home module section in this manual for more information about checking for 
database updates prior to launching the MPI Updater tool. 
 

http://www.markovprocesses.com/
http://www.markovprocesses.com/
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Updating via the MPI Website 
 

1. Make sure to close MPI Stylus before beginning this process. 
2. Log on to our website at http://www.markovprocesses.com and go to the Support -> 

Updates section.   
3. Select the appropriate index you wish to download and click on its associated link. 
4. Save the MSI file to your computer’s hard drive. 
5. Using My Computer or Windows Explorer, find the downloaded file and double-click it to run 

it. 
6. Click “Next” through the Installation wizard. 
7. When finished, open MPI Stylus. 

 

Adding Existing MPI Stylus Files to Your Installation 
 
To add existing MPI Stylus files (for example, files already being used by your company) to your copy of 
MPI Stylus, please use the following steps: 

 
Determine the file extension(s) of the files you wish to save into your MPI Stylus directory.  The file 
extensions associated with MPI Stylus are: 
 

File Extension Stylus Module/Function Stylus folder to save to 

.sty Stylus study Stylus\study\sample 

.unv Prospector study Stylus\pstudy 

.itg Integrator study Stylus\integrat\sample 

.ast Allocator study Stylus\allocat\sample 

.stt Stylus Template Stylus\template\sample 

.unt Prospector Template Stylus\ptemplat 

.aat Allocator Template Stylus\atemplat\sample 

.mng Manager file Stylus\managers\sample 

.ind Index file (Indices) Variable 

.fnd Portfolio file (formerly 
Fund file) 

Stylus\funds\sample 

.set Set file Stylus\sets\sample 

.smp Style map file Stylus\maps\sample 

.stylusjob User Level Interface (ULI) 
jobs 

Documents and Settings\(User)\My 
Documents\Stylus Jobs 

.stylusqueue User Level Interface (ULI) 
queue 

Documents and Settings\(User)\My 
Documents\Stylus Queues 

 
Note that some files (such as Prospector studies) may generate automatic accessory files with extensions 
such as .cdx, .dbf, and .dbn.  Though these files are necessary for a fully operational study, they do not 
need to be included when sharing .unv files with other users, as these additional files are recreated by 
Stylus when the study is run.  The only exception is for users that have proprietary databases and wish to 
send the embedded data in their studies to another user.  In this case, all associated files for a Prospector 
study must be kept together. 
 
Save the appropriate files to the corresponding directories in your Stylus folder.  You should then be able 
to access them through your MPI Stylus software.   
 
 

http://www.markovprocesses.com/


Chapter 1 
Installing & Updating MPI Stylus Pro 

www.markovprocesses.com  Page 13 

 

 
 
Receiving MPI Stylus Pro files via e-mail 
 
Some users who have received MPI Stylus Pro files from MPI or from other users have found that certain 
e-mail programs or Windows programs try to save the files with incorrect extensions, such as .html or .txt.  
This may be avoided by always making sure to preserve the correct file extension when downloading a 
study.   
 
To do this when downloading using a Windows-based program, use “Save as” for the attachment and 
make sure that the “Save as type” dropdown menu is set to “All Files.” 
 
Remember that a very easy way to share your active study is to simply use: 
 
Tools-> Send Current Study to MPI Support 
 
And then to change the e-mail address in the e-mail before you send it. 
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Troubleshooting Installing & Updating 

 
For more Frequently Asked Questions (FAQ), please visit our web site at 
http://www.markovprocesses.com.  
 
Q: I can’t download or run the necessary files, I am unable to access the Internet, or my company does not 
allow me to install, update and/or overwrite files.  What should I do? 
A: Contact your tech support/IT department to discuss your computer’s network or Internet connectivity, 
as well as user permissions and access to files on your computer or network.  MPI will not be able to 
change permissions on your computer or corporate network. 
 
Q: I am unsure whether to save MPI Stylus Pro to my computer hard drive or network.  Does this matter? 
A: Yes. MPI Stylus Pro may be installed to either a hard drive or a network, but many companies have 
preferences or regulations regarding the location of programs in their systems.  Please check with your 
key user or your firm’s tech support team for more information. 
 
Q: Studies I received from another user look different on my computer.  What is going wrong? 
A: There are several reasons why this may be occurring.   Common explanations include, but are not 
limited to: 
 

▪ The other user may have an older or newer version of MPI Stylus Pro 
▪ The other user may be using data you do not have access to, or you or the other user may not 

have up-to-date data 
▪ You may be using a different color palette than the other user 

 
Q: A database I want access to is marked “N/A” in MPI Updater, or I can’t see the database in my 
selections in the program. 
A: All supported 3rd party databases come automatically configured in MPI Stylus; an inability to view or 
access a database, such as N/A in the MPI Updater, means that you are not listed as a subscriber to this 
database.  To subscribe to a 3rd party database, please see the Appendices to this manual for contact 
information. 
 
Q: How do I subscribe to a third-party database? 
A: The Updates page of our website contains information on subscribing to various 3rd-party databases. 
Please consult this page, or contact MPI support for more information.
  

http://www.markovprocesses.com/
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Chapter 2 

Overview 
 

Want to get up and running 
quickly in MPI Stylus Pro? Trying 
to get more familiar with new 
parts of the application? Getting 
to know the Home Module is a 
quick, easy way to help guide 
your use of the application. Not 
only are their helpful pointers on 
features and documents, but 
shortcuts for daily Stylus Pro use 
as well. 
 

Quick Start: Using the Home Module 
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Chapter 2 

Quick Start: Using the Home Module 
 
The Home Module provides users with a clean, friendly and efficient way to learn more about the 
application and even guide their day-to-day use. In this chapter, we’ll explore how users can make the 
most of this resource in improving their experience with MPI Stylus Pro. Please note that only users with 
MPI Stylus Pro 10.0 or higher will be able to use the Home module. 

Home Module at a Glance 

In this chapter, we will examine the following components of the Home Module. Let’s take a quick look at 
each section to get a quick idea of what it does: 
 

• Welcome – The perfect screen for new users. Review each module’s functions, along with 
featured templates you can use out-of-the-box or customize to your own needs. 

• New – Ready to create your own studies? You can create templates from, or review (and 
organize) templates across modules. 

• Open – Looking for an existing study? You can search across modules and see detailed 
information across your full set of studies. 

• Recent – Want to jump right to one or more studies you created or used recently? This is the 
place. 

• Favorites – This is the perfect place to keep track of studies you use time and time again.  

• Update Monitor – A quick and easy way to check for available updates for your databases. 

• Help Center – Looking for support or training help from MPI? This quick list of references gives 
you easy access to some of our most popular documents, as well as quick links to all of our 
Support options. 

• Online Resources – This tool allows you to access features of MPI’s online web help documents 
directly through Stylus. 

Toggling Home Module On/Off 

 
Users who wish to turn the Home Module off (or on) can do so any time via the Configurator module; 
however, MPI recommends that all users avail themselves of the time-saving features included in the 
Home module. 
 
Show Home module on Startup 
The Home Module is turned on by default in MPI Stylus Pro (10.0 or higher). That said, it may be turned 
on or off at any time through the following steps: 
 

1. In the main menu, go to File-> Configure. This will open the Configurator module. 
2. Click on the ‘Default’ node in the Design Tree. 
3. On the right-hand side, click the ‘Home’ tab. 
4. You should now see a checkbox control that says ‘Show Home module on startup; If this is 

checked, the Home module will appear on all future startups. If it is unchecked, the Home 
module will no longer appear at startup. 

5. Save Configurator before closing. 
 
Opening the Home Module on Request 
Regardless of whether or not you use the Home Module on startup, you will always be able to access it at 
any time via the main menu. To do this: 
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1. In the main menu, go to File-> Home. 
2. The Home module should open. 

Welcome Screen 

 
The Welcome screen is the perfect starting point for new users in MPI Stylus Pro. Each of the Stylus Pro 
modules are clearly explained in terms of client workflows, giving you the direction you need to pursue 
your goals in the software. 
 

 
 
Figure 1 
 
Module Overview 
The first section you will notice is the Module Overview. This is where you can learn about the specific 
general uses and workflow applications of the modules that comprise MPI Stylus Pro. Please note that 
these introductions are usually quite general; there simply isn’t room to list all the powerful applications 
of each module. Please feel free to contact us at training@markovprocesses.com if you are seeking more 
extensive module-based training. 
 
 Create Study 

This convenient button will send you directly to the ‘New’ screen for the module in question, 
allowing you to get started with a blank study or work from existing templates. 
 
Learn More 
Want to dig deeper into the module and how to use it? Click ‘Learn More’ to jump to our 
embedded Help file, where you can scroll through the full text of our manual. 
 
Back/Next 
These buttons may be used to scroll between the different modules.  

 

mailto:training@markovprocesses.com
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Featured Templates 
In this section, you will find thumbnails and descriptions of some featured MPI templates related to the 
module in question. Simply double-click the template to open it and begin working. 
 

 

New Screen 

 
 

 
Figure 2 

 
In this screen, you can create new studies in any module, using templates provided by MPI or developed 
by your firm. Helpful thumbnail previews allow you to assess your options at a glance; however, users are 
encouraged to take a few moments to open and run each template in order to better understand its 
offerings. 
 

All 
This tab allows you to view templates across all modules; this can be a helpful survey of your 
complete template library, especially if you do not remember in which module a specific 
template was constructed. 
 
Stylus/Prospector/Allocator/Integrator tabs 
These tabs will showcase templates by module, allowing for a more full appreciation of the types 
of workflow and output each module is intended to generate. 

 
Template Menu buttons 

 
 
 
In each tab, you will notice Template Menu buttons. These buttons only become highlighted when you 
click on a template, because their actions all relate to templates as individual files. The buttons are: 
 
 Open 
 This button will open the selected template for immediate use. 
 
 Rename 
 This button allows you to change the file name for the template in question.  
 
 Delete 

This button allows you to delete a template. Always check with your Key User to ensure you 
really wish to delete a template permanently; template files take up very little space, and it is 
possible that other users in your group will have need of them now or in future. 
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Move 
MPI’s file management system allows users to organize their studies in whatever manner they 
please (for more information, see the Configurator chapter). This button allows users a quick and 
convenient method for moving a template from one template database to another. Don’t worry 
– you will still be able to find the template easily in the module-specific tab! 
 
 
 
Favorite 
This option allows you to mark a given template as a ‘favorite’. The template will still be visible 
here, but will also appear in your custom-created shortlist in the Favorites screen, discussed later 
in this chapter. This is a great tool for studies or templates you intend to use quite often. To 
remove a template from your ‘Favorites’, click the template once to make it active, and then click 
the ‘Favorites’ button again.  

 
Group by: 
 

 
 
In addition to the module-based groupings discussed above, MPI Stylus Pro allows users the flexibility to 
see templates based upon other categories that can be quite helpful in template searches. They are: 
 
 None 

This option is the default, and places no additional 
categorization on templates. 

 
 Asset Class 

This setting allows you to sort templates by their 
relevant asset classes, where available. 

 
 Region 

This setting allows you to sort templates by their 
relevant geographic region, where available. 

 
 Report Database 

This applies to report templates designed for use 
with funds from a specific database. 

 
 Product Type 

This allows you to sort templates that have product-
specific entries (i.e., ETF, Hedge, etc.)  

 
 Report Type 

This sorts templates based on asset classes (i.e., equity, fixed income, etc.) 
 

Templates vs. Existing Studies 

What’s the Difference? 

 
New users sometimes have a little trouble 
keeping track of the difference between a 
template and an existing study. While there 
really isn’t much difference in terms of the 
file structure itself, the easiest thing to 
remember concerns saving the study. 
 
A template, whether it comes from MPI or 
your own firm, will have no study name 
when it is opened – you will have to give 
the study a name in order to save it. Thus, 
you can never ‘save over’ a template. 
 
Existing studies are templates that have 
been saved, or studies that have been built 
from scratch. When you open them, they 
already have study names and can be 
saved as-is, meaning it is possible to save 
over them. 
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 Database Name (Folder)  
 This option sorts templates by database name (i.e., Stylus database, etc.) 
 
Usability Options for Group by: 
 
Several buttons may be found surrounding the Group by: option. These are added to help you customize 
and enhance your experience with this feature. They are described below, but please note that certain 
buttons will only appear when relevant ‘Group by:’ options have been selected in the dropdown menu. 
 
   
 Expand all groups 

  
Clicking this button will cause all groups for a relevant grouping categorization to automatically 
expand. For example, if you have selected ‘Asset Class’, this button would expand all Asset Class 
options to show the relevant underlying templates for each class. 
 
Collapse all groups 

 
Clicking this button will cause all groups to collapse back to their closed state. The user may then 
choose to expand a single or all groups as they like. 
 
Thumbnail View 

 
 
This button allows you to view all shown templates as thumbnails, giving you a quick look not 
only at their file names and extensions, but also a sample of their output. 
 
List View 

 
 
This option allows you to see a list of templates, containing their file names, descriptions of their 
content (where relevant), and the date of each file’s creation or last update. These columns may 
be sorted by clicking on the column heading, and the standard MPI Stylus Pro search options also 
apply. 
 
Show Preview 

 
 
This button toggles on/off a ‘Preview’ screen that allows the user to view the content of a 
specific template’s ‘Memo’ tab. This can be a very helpful way to review template information, 
instructions, etc. 
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Open Screen  

 
Figure 3 
 
In this screen, you can open one or more existing studies from any module. As was the case with the New 
Screen, you may choose to work within a module-related tab, or you can work in the All tab to see your 
existing studies across modules. 
 
The same controls used in the New Screen are used in Open, so please refer to the section directly above 
for information on how to use the assorted buttons and tools in this section. 
 

Recent Screen  

 
Figure 4 
 
This screen allows you a quick and easy way to open studies that you have worked with in the recent past. 
Again, you may review these studies on a per-module basis, or across all modules.  
 

Open 
The Open option in this section works as in the ‘New Section’ above; you may also double-click a 
study to open it. 
 
Favorites 
As in the above sections, you may click the ‘Favorites’ button to add or remove ‘Favorites’ status 
for a template or study in this section. 

 

Favorites Screen 

 
Figure 5 
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‘Favorites’ allows you to have a customized, user-created list of templates and studies that are available 
to you for quick reference. This is the perfect way to keep track of the templates and studies you will be 
using more often, and you can view them separately by module or as a group. 
 

View 

 
 
This dropdown allows you to toggle between viewing your Favorite templates and studies. In 
both cases, you may view these by module or as a group. Please note that these options are 
grayed out until a specific study is selected. 
 
Open 
The Open option in this section works as in the ‘New Section’ above; you may also double-click a 
study to open it. 
 
Favorites 
As in the above sections, you may click the ‘Favorites’ button to add or remove ‘Favorites’ status 
for a template or study in this section. 

 

Update Monitor Screen 

 

 
Figure 6 
 
The ‘Update Monitor’ screen is a convenient way for you to check for available updates for your 
subscribed databases without having to open and run the MPI Updater utility. 
 
Available Updates 
 
There are four options for viewing available database updates: 
 

• All. This option monitors all databases available for download. 

• New. This option will only monitor updates to databases you have already configured and 
installed in MPI Stylus Pro.  

• Selected. This option will only monitor databases that you have specifically marked in the MPI 
Updater utility. For more information, please see the instruction set for MPI Updater. 

• Up-to-date. This option monitors all databases to indicate which ones are currently up-to-date. 
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Open Updater 
This button allows you to launch MPI Updater directly from this screen. This is a convenient way to 
engage in any needed database updates, or to add or remove databases from your ‘Selected’ list. 
 
Refresh 
The Database Update Monitor conventionally checks for updates when you click on the ‘Update Monitor’ 
node. If you have left this open or feel new updates might be available, you may click the ‘Refresh’ option 
to do a further live check for updates. 
 
All requested databases are up-to-date 
This note in the update pane means that all of your current databases available from the MPI Updater 
utility are up-to-date. Please note that database updates schedules are available in the Updates section of 
our website at markovprocesses.com. 
 
Please note that internal databases for your firm are not available for review via the Database Update 
Monitor; please consult your Key User and/or IT team for more information on updating internal 
databases. 
 
View: Simple/Detailed 
This option allows you to see different column sets that may help you evaluate your data options more 
efficiently.  
 

Help Center 

 

Figure 7 

 

The Help Center is the perfect first stop for users who would like to know more about contacting MPI 
Support, or finding core documents that match their specific interests.  

 
 
MPI Support 
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Along the top of the Help Center are four buttons that are meant to provide you with quick access to 
information about MPI Support services and documents. 

 

Forums 

This button will take you to our web-based forums, which are the perfect resources for general (non-
proprietary) questions and discussions. In addition to Q&A forums, you will also find opportunities to 
directly submit 'Wish List' items for our software, and to subscribe to updates related to various data 
releases. And because our forums are fully searchable, this can be the quickest way to get an answer to 
general questions - there's a good chance someone has asked your question before! 

 

E-mail 

This button opens an e-mail to our Support e-mail address, support@markovprocesses.com. This can be a 
great way to communicate with us when you have a complex or proprietary problem to describe, or you 
want to send us files for review. Remember that you can always send us your current study easily by going 
to Help-> Send current study to MPI Support. 

 

Phone 

Prefer to speak to a live MPI Support representative? Mouse over this button to see our Support phone 
numbers by region. Please keep in mind that each region keeps specific hours and may be closed for 
certain national holidays. For this reason, we always recommend e-mailing MPI Support - this will ensure 
that your question is seen by any Support team members, regardless of region. 

 

Web 

This button will take you to the MPI website, where you can find documents, templates, case studies, 
forums, company news and research, and more!  

 

Online Resources 

 
The Online Resources pane allows users to access various helpful elements of the MPI website without 
having to operate via a web browser.  
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MPI Portal 

 
The MPI Portal brings the latest MPI news, events, content, training options and data feed 
announcements directly in to your application.  
 
Users can check in with the click of a button to see the latest information – and follow links 
directly to related content on our webpage. While content and categories may change over 
time, you may customize the experience by collapsing or expanding sections of interest to you 
by using the + and – symbols next to each category heading. 
 
Please note that users without a live Internet connection may get an error message in this 
space informing them that ‘Authorization’ is required (or a similar message). This can be fixed 
by establishing a live Internet connection with permissions to access and download HTML 
(web) pages. For more information, please speak with your IT team. 
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Troubleshooting the Home Module 

 
For more Frequently Asked Questions (FAQ), please visit our web site at 
http://www.markovprocesses.com.  
 
Q: I don’t see the Home Module when I start up. Where do I find it? 
A: You can access the Home Module at any point by going to File-> Home in the main menu or clicking 
Ctrl+H. You can also arrange in Configurator to have the Home Module always show on startup. For more 
information, please see the Configurator chapter later in this manual. 
 
Q: I am receiving an ‘Authorization Required’ error, or another error in place of content. 
A: Several screens related to the Home module require an active Internet connection and the ability to 
access HTML pages (web site pages). MPI does not have access to your permissions issues for the 
Internet; for assistance with this issue, please speak with your IT department. 
  

http://www.markovprocesses.com/
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Chapter 3 

Overview 
 

This chapter covers global Stylus 
features and is designed to help 
the user quickly become 
comfortable working in any Stylus 
environment.  Many of the tools 
and features in this section will be 
useful to all users regardless of 
their specific goals in using the 
application. 

 
 

Getting to Know the Basic Interface 
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Chapter 3 

Getting to Know the Basic Interface 

Introduction to MPI Stylus Pro 

 
The MPI Stylus Pro application is module-based, meaning that different research and reporting needs may 
be separated into different areas of the tool.  The four major modules are MPI Stylus, MPI Prospector, 
MPI Integrator and MPI Allocator; a fifth module, MPI Configurator, is used only for global application 
settings and database configuration. 
 
Our goal is to allow new users to familiarize themselves with the Stylus Pro interface quickly and 
conveniently.  This helps the user feel more at ease when tackling a new module or unfamiliar program 
features.  Therefore, MPI Stylus Pro is designed to share features and functionality between modules 
wherever possible and to be consistent with many recognized standards from other Windows-based 
programs. 
 
This chapter has been designed to introduce global MPI Stylus Pro features; after reading this chapter, the 
user should be able to recognize the basic layout of any MPI Stylus Pro module, its relevant screens and 
tools, and its endpoint functionality. 
 
Stylus File Locations 
 
Everything you do in MPI Stylus Pro is done through “templates” or “studies”, which are files related to a 
given module. All the files needed to run MPI Stylus Pro are normally meant to be located within the 
Stylus directory itself. The normal installation path for Stylus users who have installed the application on 
their computer would be: 
 

C:\Stylus\ 
 

This would probably not be the correct path for a network installation of MPI Stylus Pro; therefore, we 
always encourage our users to know the drive on their computer or network where Stylus is installed. This 
will be important when you wish to create new folders, databases, or share studies with coworkers or 
MPI, as well as when you arrange backups of your files – something we encourage highly for all users. 
 
Stylus File Types 
 
Each type of file in MPI Stylus Pro has a particular extension associated with it; being able to recognize 
these files by their extension will allow you to share files with colleagues and MPI tech support more 
comfortably.  Please make note of the following file types and associated extensions, as well as their 
related default folders.  Some or all of these file types may occur in more than one folder; these 
recommendations are presented as an organizational guidelines for MPI Stylus Pro’s default 
configurations. 
 

File Extension Stylus Module/Function Stylus folder to save to 

.sty Stylus study Stylus\study\sample 

.unv Prospector study Stylus\pstudy 

.itg Integrator study Stylus\integrat\sample 

.ast Allocator study Stylus\allocat\sample 

.stt Stylus Template Stylus\template\sample 

.unt Prospector Template Stylus\ptemplat 
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.aat Allocator Template Stylus\atemplat\sample 

.mng Manager file Stylus\managers\sample 

.ind Index file (Indices) Variable 

.fnd Portfolio file (formerly fund file) Stylus\funds\sample 

.set Set file Stylus\sets\sample 

.smp Style map file Stylus\maps\sample 

.sbt Stylus batch file Variable 

 
Stylus Pro Databases 
 
MPI Stylus Pro stores files of similar types within various databases for organizational purposes.  These 
databases fall into two common types: true databases and Stylus databases. All databases must be 
brought into MPI Stylus Pro through the Configurator module, and will be assigned a name (i.e., 
Morningstar) and a three-character unique ID (i.e., Mfi).   
 
True databases include dBase, Microsoft Access, SQL Server, etc., and are normally used to organize and 
store large quantities of data, such as return series. MPI Stylus Pro has the flexibility to link to all of these 
databases; however, users may require the Advanced Database package to make full use of this 
functionality. 
 
Stylus Pro databases can be Microsoft Excel sheets, folders on your hard drive or network, or other user 
files that can serve as databases. The folders listed in the table above all represent examples of these. 
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Getting Started in MPI Stylus Pro 

 
When you first open MPI Stylus Pro, you may see one of two screens. If you are opening it for the first 
time, or have not turned off the Home Module, then you will see one of the Home Module screens (you 
can configure the software to decide which one shows on start-up). If you have turned off the Home 
Module, you will see the blank screen shown at right. 
 
 
Getting Started in the Home Module 
 
If the Home Module is open, please see the next chapter to get a sense of how to use the various screens 
to get the most out of MPI Stylus pro. 
 
Getting Started with the Blank Screen 
 
To get started, you will need to create a new study or open an existing study in any module.  Opening, 
saving, closing and deleting studies will always be done the same way for any module; therefore, the 
instructions in this section should be useful for all users, regardless of which module(s) you wish to use.   
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Global Menus and Toolbars 

 
MPI Stylus Pro Main Menu 
 
The MPI Stylus Pro main menu is common to all modules in the application and controls many basic 
features, including opening, closing and saving studies. It also serves as the pathway to important 
application tools, such as MPI Updater, and to MPI Stylus Pro help features. Some of these features are 
also available through the MPI Stylus Pro toolbar, described below. 
 
There are five sections to the MPI Stylus Pro main menu: 
 

 
1. Operating System Menu 
2. File Menu 
3. Window Menu 
4. Tools Menu 
5. Help Menu 

 
Operating System Menu 
 

 
Figure 8 

 
The Operating System menu brings into MPI Stylus Pro several basic program-level functions related to 
your Microsoft Windows operating system and MPI Stylus Pro on your desktop. Clicking the Operating 
System menu icon (which appears on the main menu as a book) opens the menu and allows you to make 
your selection. Please note that the Operating System menu will only appear when at least one study is 
open in MPI Stylus Pro. 
 
Restore 
 
This option is used when you have any study open and maximized (visible as the whole screen, not as a 
floating window) in MPI Stylus. Using the restore feature returns any open study (or studies) to being 
floating windows in the application. You may also use the restore function when MPI Stylus is open but 
minimized on your computer desktop. Simply right-click on the appropriate block on your desktop taskbar 
and click “Restore” to show MPI Stylus again. 
 
Move 
 
The Move option is only enabled when an actual study within MPI Stylus is not maximized, and therefore 
is smaller than the total available screen area for a study. When the Move tool is enabled, you may click it 
to turn your mouse’s arrow icon into a pointer that will allow you to click anywhere on the study window 
and move the study to a different area of the window. 
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Size 
 
The Size feature allows you to use your mouse to easily resize a study window that is not maximized. This 
may also be done by clicking on any edge of the study window and dragging in the desired direction. 
 
Minimize 
 
The Minimize option works only when a study is either maximized, or is not maximized but is the active 
window on your screen. When you click minimize, a study will be minimized to a small window at the 
bottom of your screen. Simply double-click on the study to maximize it again. 
 
Maximize 
 
The Maximize feature will display a study in a full-screen view within the program. 
 
Close 
 
The Close option will close a study in Stylus. When you click “Close,” Stylus will first ask you if you wish to 
save the study. 
 
Next 
 
The Next feature is used when multiple studies are open, and you would like Stylus to show you in full-
screen mode the next study in your Navigator.  
 
File Menu 
 

 
Figure 9 

 
The File Menu in MPI Stylus Pro is similar to that in numerous other computer applications in that it 
controls major functions such as opening, closing, and saving studies.  It is also the pathway to the 
Configurator module.  Each segment of the File Menu is explained below.  To get to any of the options 
below, click on the word “File” in the Main Menu. 
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New 
 
This option controls the creation of new studies in MPI Stylus.  These may either be completely blank 
studies or templates provided by MPI or specially created by your company. 
 
Open 
 
The Open option controls access to existing MPI Stylus studies, and will be the feature you are most likely 
to use for reaching your studies.  Note that if the study is set to run any scripts on start-up, they will run 
when you open the study using File-> Open. 
 
Load Batch 
 
The Load Batch option is used in batch processing work, and is associated with Stylus batch files (.sbt).  
Please note that this option is associated with our Automation package. 
 
Close 
 
This option allows you to close the MPI Stylus study you currently have open.  If more than one study is 
open, the close feature will apply to the active study only.  To determine which study is active, please 
refer to your Multiple Study Navigator.  If you are using cascaded or tiled windows, the active study is the 
one with the highlighted title bar. 
 
Save 
 
The Save option is used to save MPI Stylus studies.  You will always be asked if you would like to save any 
study before you close it, but it is suggested that you save often throughout your work to avoid excessive 
loss of data/time/work in the event of a power, hardware or software failure.  The Save feature on the 
File menu and the Save button on the toolbar are linked, and therefore either feature may be used. 
 
Please note that if you are working in a new study that has not been saved yet, you will need to use the 
“Save As” function below to save the study.  The general Save feature will be unable to save new studies 
because of the special names they are assigned (i.e., NONAME.sty).  This feature requires a user to give 
their own name to a study, thus making it easier for them to find the study the next time they need it. 
 
Save As 
 
The Save As option is necessary when you save a new study for the first time, or when you wish to save a 
copy of an existing study under a new name, or otherwise create a backup copy of a study.   
 
To Save As: 
 

1. Go to File-> Save As. 
2. The Save Study As… box will open.  In the Study Name field, write in the new name you would 

like to give your study.  Note that you do not need to type in the file extension – MPI Stylus will 
automatically append it for you. 

3. If you would like to save your study in a different database than the one selected, use the browse 
function to scroll to the appropriate database. 

4. You may also enter a new description for the study in the field below Database and Study Name. 
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5. You also have the option of making any adjustments to the Study-level tabs at this time. 
6. When you have finished making your modifications in the Save Study As…box, click “Save.”  The 

old study will close and only the new version will be open. 
7. You may click the “Cancel” button at any time to avoid saving the study in its new name.  The old 

study will not close, as no new version has been saved. 
 
Save as Template 
 
The Save as Template option is used when you are trying to create a new template in MPI Stylus for future 
use as a starting point for studies.  The template you create will be automatically saved to the correct 
folder and reachable in future through File->New for the appropriate module. 
 
Recover 

The File-> Recover tool opens the 'Recover Study' tool, which may be used to retrieve the Recovery copy 
of a Stylus, Prospector, Integrator or Allocator study. The controls for determining how Study Recovery 
works are located in Configurator, but the interface to recover them will be used through this control.  

To recover a study: 

1. Use File-> Recover to open the 'Recover Study' tool. You will be asked for which module you wish 
to recover a given study.  

2. The 'Recover (Module) Study' box will open. You may then make your selection from the 
interface, which is quite similar to the interface for opening templates or studies. This includes 
the ability to move between databases/folders to find your relevant Recovery file version of a 
study. If you do not see a study listed, it may mean that no Recovery version of the study exists 
yet.  

3. Once you have located and clicked on the file, click the green checkmark button to open it in the 
respective module. 

The fields in the box are: 

• ID - This shows you the actual file name for which you wish to request the Recovery version. 

• Type - This shows you what the type of the file is. A 'Recovery' file is the official Recovery version; 
'Temporary' files are older versions of Recovery studies that are preserved until a given threshold 
is met (in number of versions, or age of files, or both, based on Configurator settings). There are 
also ‘Revision’ copies that are periodically stored. Please consult dates and times for the version 
you wish to recover. 

• Date - The date and time for the specific version's creation. 

• Path - The file location of the Recovery or Temporary file. Please note that this is NOT the 
location for the main file for which this is a Recovery version, but rather the Recovery file itself. 

 
Apply Template 
 
The Apply Template option is a special feature in MPI Stylus meant to quickly allow you to apply the 
content of an existing template to any study.  This normally affects the study by keeping any specified 
information in nodes but adding in any additional elements from the template, including managers, style 
outlines/maps, peer groups, views and reports.   
To apply a template to a study: 
 

1. Open the study to which you wish the template be applied. 
2. Go to File-> Apply Template. 
3. The “Select Template” box will open.  Select the template you wish to apply to your active study 

by double-clicking the template name or clicking it once and then pressing the green checkmark.  
The template will now be applied to your study. 
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4. Make sure to check each node of your Design Tree to ensure that you have the correct 
information selected.  Once you have verified the information, you may wish to save the current 
study. 

 
Export All 
 
This option can export all View/Report content in a given study to the study home folder. For example, if a 
study called ‘sample1.sty’ were stored in your Stylus\Study\Sample folder, an export of this study would 
lead to a file being placed at this location. Note that checked items only are exported; unchecked items 
are disregarded. 
 
The options for this are: 

• Views. The file name will be studyname.exp. Charts will be saved in .wmf format, and tables in 
.xls format. 

• Reports. The file name will be studyname.exr. Reports will be in .wmf format. 

• Slide Show. The file will be a slideshow .exe file. 
 
It should be noted that if the study has not been saved, Views and Reports will be saved in the default 
folder, which is the top-most study folder for the module in question (as listed in Configurator). 
  
The File->Export All->View/Report option will export all the Views and Reports in the study to the home 
folder of that particular study. For instance, if the File->Export All->View option is used for a Stylus study 
called 'sample1.sty', which is stored in your '\Stylus\Study\Sample' folder, the Views from the study will 
be exported to a folder called 'sample1.exp' . Each chart from the Views will be saved in '.wmf' format 
whereas each table will be saved in '.xls' format. The same operation for the reports will generate a folder 
called 'sample1.exr' and the reports will be saved in '.wmf' format. 
 
However, if the study has not been saved, then the Views and Reports will be saved in the default folder, 
which is the top-most study folder for that module, as listed in Configurator. 
 
Execute Binder 
This allows you to execute Binder settings from the main menu. 
 
Configure 
The Configure option is the pathway to the MPI Configurator module, which governs many of the global 
settings in MPI Stylus.  For more information on MPI Configurator, please see Chapter 12. 
 
Home 
The Home option opens the Home Module, which contains the Welcome Screen and a host of other 
useful features. All MPI Stylus Pro users are highly encouraged to review Chapter 2 of this manual for a 
complete breakdown of the Home Module and how it can be integrated into your day-to-day workflow. 
 
Exit 
The Exit option is used for closing MPI Stylus.  This feature is especially useful when you have multiple 
studies open, as you would otherwise have to close each one individually.  When you use the Exit option, 
the program will ask you automatically if you want to save each of your open studies.  Simply click “Yes” 
or “No” for each relevant study, and when all studies have been addressed the program will close. 
 
Recently Used Studies List 
The last option in the File menu is to open one of your most recently used studies.  This list shows the MPI 
Stylus Pro studies you most recently had open, and studies for any module may appear on the list.  It 
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should be noted that templates do not appear on the list – only actual studies do.  You may change the 
number of studies that appear on this list in the Configurator module. 
 
To open a study from the list: 
 

1. Go to File-> and select with your mouse the name of the study you wish to open. 
2. The study should open on your computer.  Note that if the study is set to run any scripts on start-

up, these will run at this time.  This will also be the case when you use File-> Open. 
 
Window Menu 
 

 
Figure 10 
 
The Window Menu controls how you view multiple reports in MPI Stylus.  The default setting in the 
program is to have the active study open full-screen in the program, with the Multiple Studies Navigator 
open on the left-hand side of the screen; however, this may be adjusted through the use of different 
window setups. 
 
Cascade vs. Tile 
The two options for viewing multiple studies in a format other than one-at-a-time full screen are Cascade 
and Tile.  Each option provides for a different appearance that is indicative of how your screen will look 
when more than one study is open at the same time.  MPI Stylus users may use whichever option they 
find the most comfortable; however, the full-screen option is generally recommended for optimal viewing 
of charts & tables in views and reports.  In addition, export commands will always create files that mimic 
the size charts and tables would be were Stylus at its full-screen setting. 

 
Arrange Icons 
The Arrange Icons function is useful when you are using one of the two above views and you have 
minimized one or more studies.  The Arrange Icons tool simply organizes them neatly on your screen. 
 
Minimize All 
This option minimizes all open studies in the program into icon bars at the bottom of your data pane.  
These may be maximized, cascaded or closed at any time by using the standard Microsoft Windows 
controls on the icons. 
 
Open Studies List 
The last feature in the Windows menu is a list of studies currently open in MPI Stylus.  You may use your 
mouse to click on any study in this list and it will appear on your screen in either its full screen, tiled or 
cascaded appearance. 

 



Chapter 3 
Getting to Know the Basic Interface 

www.markovprocesses.com  Page 37 

 

Tool Menu 
 
The Tools menu is used to access certain special programs and utilities that work with the MPI Stylus 
application suite. The two that will always be listed are the MPI Updater and MPI Publisher; however, 
please note that MPI Publisher is an advanced package feature and may not be available to non-
subscribers. 
 
User-level Interface 
This function allows you to open the User-level Interface, a standalone interface that provides an 
alternative method for populating and automating existing reports on the fly. For more information, 
please see the User-level Interface User Guide, available from MPI.  
 
MPI Updater 
Tools-> MPI Updater allows you to use the MPI Updater program to update your data streams in MPI 
Stylus Pro.  For instructions on using the MPI Updater, please see Chapter 10. 
 
Factor Search 
This option is only available for subscribers to our Factor Search advanced package. For more information, 
please see the Factor Search User Guide, available from MPI. 
 
Show Printers 
This feature will open your operating system’s Control Panel (to the ‘Devices and Printers’ area in order to 
help you to establish a default printer. This is necessary in order to use certain features of the program. 
 
Force “as of date”… 
This feature has been enabled as an option for all MPI-supplied databases (it will not work for 3rd-party 
vendor databases). Through this feature, the user may force Stylus to use a specified date as the ‘as of 
date’ for reporting purposes. Once enabled, this feature must additionally be ‘turned on’ in Configurator 
for each database you wish to use it for. 
 

• Use the most recent date (default) – This setting is the default for the program, and makes no 
changes from normal work. 

• Force “as of date” to – Enables the custom option. 
 
Help Menu 
 
The MPI Stylus Help Menu contains a variety of useful features meant to assist our users.  Each feature is 
described below; however, we recommend you see Chapter 11 of this manual for a list of more solutions 
available for MPI Stylus users. 
 
Topics 
The Topics menu opens the MPI Stylus Help Guide, which is a specially adapted version of this manual 
meant for quick use within the application. 
 
Manual 
This opens the most recent version of the MPI Stylus Pro User Manual included in your install folder. 
 
Formula Reference 
MPI formulas are now contained in a standalone PDF reference document accessible through this link. 
 
What’s New 
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This opens the ‘What’s New’ (readme) file included with the latest MPI Stylus Pro major release. This is a 
quick and convenient way of scanning the major additions and enhancements to the product by module 
and/or advanced package.  
Macro Reference 
This opens the Macro Reference, which contains a complete list of all global/module-based macro 
statements and their relevant parameters.  
 
Automation Reference 
Automation advanced package subscribers will be able to use this function to open up the 
Automation/Scripting Reference, which contains a complete list of supported script statements and their 
relevant parameters. 
 
Tip of the Day 
The Tip of the Day box is a great feature for new MPI Stylus users and those seeking to develop a better 
overall understanding of the application.  The default setting in MPI Stylus is for the Tip to appear 
whenever you open the program; however, once the box is closed it may also be opened at any time by 
going to Help-> Tip of the Day. 
 
If you do not want the Tip of the Day to show at startup, simply uncheck the box that says “Show Tips on 
Startup.”  The box will not appear the next time you open the program.  You may re-click this box again at 
any time by opening the Tip of the Day box and checking “Show Tips on Startup.” 
 
When the Tip of the Day box is open, you may click “Next Tip” to see another tip, or “Close” to close the 
box.  Note that this box is specially formatted to allow you to work in MPI Stylus with the box still open, 
allowing you to move it out of the way and try the tip without having to memorize it and close the box. 
 
MPI Home Page 
This option will launch your default web browser and open the MPI corporate home page, which may be 
found at: 
 

http://www.markovprocesses.com 
 

The MPI home page is an extensive client resource, and every MPI Stylus user should familiarize him or 
herself with its features in order to ensure that they are getting maximized support & information from 
MPI.   
 
MPI Support Forum 
The MPI Support Forum should be almost every client’s first stopping point (after this manual) when they 
have a question about MPI Stylus.  The forum is fully archived and searchable, meaning that you may 
often find that another client has already asked the same question, and an MPI Client Services 
Representative has provided a detailed text explanation.  In addition, forum questions are sent to several 
members of the MPI organization, ensuring that the person best suited to answer your question is among 
the first to know you need assistance.  And because forum postings benefit our entire client base, forum 
responses are always extremely fast. 
You may also access our forum at the following address: 
 

http://www.markovprocesses.com/phorum/ 
 
To log in you will need your MPI Stylus user name and password.  These are provided to users when they 
first purchase MPI Stylus Pro. 
 
Send Current Study to MPI Support 

http://www.markovprocesses.com/
http://www.markovprocesses.com/phorum/
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This feature communicates with your default e-mail program (note: this will not work with web-based e-
mail)) and begins a new e-mail, with support@markovprocesses.com as the address and certain files 
automatically entered in as an attachment. All you need to do is fill in the subject line and the body, and 
the e-mail is ready to send!  Please make sure to include your full name, company and telephone number 
in the body of your e-mail. 
 
Please note that NONAME studies (new studies that have not been saved) are not included in this 
process. Thus, to send a study to MPI, you must first save it with a filename. 
 
The following file types attach to your e-mail; you may remove any or all of them as you see fit: 

• The study file for the active study 

• Stylus.ini and Stylus.log files 

• .FND and .MNG files used in the study, if the study has such files loaded 
 
About 
The About section provides you with basic information about your MPI Stylus installation.  To retrieve the 
About box, simply click Help-> About. 
 
The About box tells you several important things about the MPI Stylus program you are running. 
 

1. Version – This tells you the current version of MPI Stylus Pro that you are running, as well as the 
release date for this version.  In certain cases, no release date will be listed. 

2. Modules – This tells you the modules to which you have access on your user license. 
3. Licensed to: - This field will contain the name of the user or organization to which this application 

has been licensed. 
4. Serial Number: Your MPI Stylus user serial number will appear in this section. 
5. Expiration – The expiration date for your current MPI Stylus license file.  Once this date has 

passed, you are permitted  a 30-day grace period to renew the application prior to termination of 
access. 

6. Packages – This section will tell you the various subscription features enabled in the license.  
Possibilities may include Automation, Advanced Reporting, Advanced Database, Advanced 
Analytics, etc. 

 
Acknowledgments 
This button provides acknowledgments and disclaimers for various major data partners. 
 
Version Detail 
This button will display for you the date and time of creation/update for a variety of important files 
included in the MPI Stylus Pro application.  Most users will not have any reason to use this feature; it is 
intended for the use of MPI client services specialists attempting to determine whether or not you 
currently have the most up-to-date version of key files, and is also useful for technical support people in 
client firms who wish to determine the current installations on a user machine. 

 
Icon Menu (Ribbon) 
 
The Icon Menu is visible throughout different parts of the application. Depending upon what screens are 
active (i.e., Parameters in the Design Tree, or a Report page), the options will change to reflect a helpful 
set of quick tools available to the user. More information about icons may be found in the relevant 
chapters. 

mailto:support@markovprocesses.com
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MPI Stylus Pro Toolbars 

 
Toolbars in MPI Stylus Pro contain icons that represent key application functions and features that are 
either linked to main menu options, accessible through right-click menus, or in some cases unavailable 
elsewhere in the application.  Not all buttons will appear in all modules, and some may only appear in 
certain circumstances.  In many cases, additional information on a button’s function may be found in 
other relevant sections of this manual. 
 

Button Function Name Description 

 
New 
 

This button is the same as File-> New and should be used when you 
are trying to create a new study. 

 
Open This button is the same as File-> Open and should be used when you 

are trying to open an existing study. 

 
Save This button is the same as File-> Save.  Please note that, just as with 

the menu version of Save, this button is not the same as “Save As” 
and should not be used for new studies. 

 

 

 
 

Run This button is used to run studies in MPI Stylus and may be one of 
three colors.  Red indicates that the study may not currently be run 
because something vital is missing – usually a manager.  Yellow means 
that the button must be pressed to run the study again, because data 
has been changed and MPI Stylus must recalculate something.  Green 
means that the study has been properly run and output may now be 
viewed. For more information on Run processes, see ‘Running a 
Study’ in this section. 

 
Navigator Pressing this button turns on or off the Multiple Studies Navigator, 

which appears to the left of the Design Tree when multiple studies are 
open.  Turning the Navigator off does not close the other studies; it 
only hides them from view. 

 
Export This button is for exporting the active chart or report (either by 

section or in its entirety.)  Depending on the item selected, this will 
allow you to either send the data to your clipboard, export it as an 
image file, or export it as a functional file, such as an Excel or text file. 

 
Print This button opens the print utility, with which you may print anything 

in MPI Stylus.  The print utility for Views is surprisingly powerful in 
MPI Stylus, and is examined in the next section below.  In reports, the 
print utility is similar to basic Windows printing for pages of 
documents. 

 
Attributes Editor The Attributes Editor allows for customization of 

charts/tables/memos and will become a familiar tool to any user with 
reporting needs in the program.   

 
Stationary Objects This button opens the Stationary Object creation/editing tool and is 

found only in Reports. 

 
Object Editor This button opens the Object Editor, allowing for the creation, editing 

or deletion of objects in charts in Views or Reports. 

 
Page Designer The Page Designer is used in Reports to allow the user to quickly 

redesign the basic structural look of the page without having to return 
to the Design Tree.  It may also be used to redesign Views. 

 
Chart/ Table/ 
Memo Designer 

This button launches the Chart/Table/Memo designer, which is used 
in both Views and Reports settings. Note that the exact designer 
name will correspond to the View being created (i.e., Chart Designer 
for Charts.) 
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Zoom to Whole 
Page View 

This button adjusts your report to the whole page view, in which the 
full page of any report is visible on screen. 

 
Zoom to Page 
Width View 

This button adjusts your screen to the page width view, in which the 
viewable size of the report is adjusted such that the report is as wide 
as your screen. 

 
Slide Show View This button switches to Slide Show view, which makes your report 

truly full screen.  You may then move your mouse to the right side of 
the screen and click to move forward, or to the left side of the screen 
to click and move backwards. 

 
Zoom In This button allows you to zoom in on sections of your report. 

 
Zoom Out This button allows you to zoom out from your report to extreme 

distances, giving you maximum control on zoom size. 

 
First Page This button returns you to the first page of your report. 

 
Last Page This button takes you to the last page of your report. 

 
Back One Page This button takes you back one page in the report. 

 
Forward One Page This button advances you one page in the report. 

 
Allow multiple 
selection 

This button allows you to select multiple studies to be opened 
simultaneously from the Select Study tool. 

 
Delete from the 
database 

This button allows you to select a study to be deleted from its 
database or folder and may be accessed through the Select Study tool.  
You may first use the “Allow multiple selection” button above if you 
wish to select multiple studies for deletion. 

 
Move to another 
database 

This button allows you to move a study from one database/folder to 
another without having to manually move the file outside of Stylus 
Pro. 

 
Automatically run 
studies after open 

This button allows you to have Stylus run any and all studies you are 
trying to open from the Select Study tool. 

 
Stop analysis This button, located in the lower right-hand corner of the application 

when a study is actively run, allows you to stop the run command 
midstream. This feature is now also possible via the Escape (Esc) key, 
which can also stop other processes. 

 Restore button This button restores settings in a pane or view to their original 
settings when first opened.  Please see Chapter 3 for more 
information. 

 
 

Show design 
names as titles 

This button allows you to show the names of charts, tables and 
memos as titles above them in Views, so that you may easily 
determine which name corresponds to which piece of output. 

 
Script Recorder This toggles script recording on/off. (Automation package only) 

 
ULI This toggles the User Level Interface screen on/off. 

 
Add View/Report Adds a View or Report to your study. 

 
Delete 
View/Report 

Deletes a View or Report from your study. 

 
Change Report 
Layout 

Changes Report layout, margins, headers, etc. 

 
Insert New Report 
Page 

Inserts a new page 

 
Delete Current 
Report Page 

Deletes the currently active page of the report. 

 
Add blank chart Adds a new, blank chart. 



MPI Stylus Pro  
 

Copyright 2005-2020, Markov Processes International, Inc.Page 42 

 

 
Add blank table Adds a new, blank table. 

 
Add blank memo Adds a new, blank memo. 

Figure 11 

 
 
Running a Study 
 
When a study is run, quite a number of actions take place that the MPI Stylus Pro user may want to keep 
in mind. These actions may affect different modules and features in unique ways, or be global across the 
application. It should be noted that, for Advanced Packages, additional actions may take place on Run that 
are not listed here. 
 
How Information is Stored 
With Stylus and Allocator, only inputs are saved (i.e., selections in the Design Tree). Output is created on-
the-fly when it is summoned for view by the user. By contrast, Prospector stores Output when it is not 
visible upon the screen. As a component of this, running a Prospector file will cause several other files to 
be created or updated, in order to store this information. Integrator stores the previous run/saved Report 
output, but must be Run again each time it is necessary to update a report. 
 
Please note that such storage is the default; additional options are available via such elements as the 
History tab, Dictionaries, etc. 
 
Additional functions worth knowing include the following: 
 
Stylus/Prospector 
In both modules, the following actions take place: 

• All values related to Asset Loadings and Style intercepts are calculated 

• Additional analysis is computed for Predicted R2 

• As of version 8.1, the ‘Perform Style Analysis on Peer Groups’ option, when active, will initiate 
this analysis on study run 

• Depending upon user parameter selections, additional analysis related to Index Selection and 
confidence intervals may be computed as well 

 
Allocator 
In Allocator, the following actions take place: 

• Running the study computes the portfolios along the efficient frontier and for simulating 
projection paths 

 
Integrator 
In Integrator, the following actions take place: 

• Running the study runs the underlying studies. Based on user selections, additional actions (such 
as scripts) may also be initiated at this point, but this is by Integrator or study-level commands, 
as opposed to the Run button itself. 

• ‘Linked’ charts/tables/memos from underlying studies are extracted, and Reports are updated if 
this option has been enabled in the Options node. 

 
Right-click Menus in MPI Stylus Pro 
 
For your convenience, MPI Stylus has several menus accessible through clicking your right mouse button.  
These menus contain the most common or useful features for a given area of the program, and often are 
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the fastest or only way to accomplish certain functions.  In other cases, choices on these menus 
correspond to buttons or menus on the main toolbar.   
 
Design Tree Menu 
 
There are several options available in right-click menus in Design Trees.  The “selected item” will be the 
item on the Design Tree on which you right-clicked to bring up the menu: 
 
 

Menu 
Selection 

Function 

Up Will move the selected item (i.e., manager, map, chart, report) up one position within a 
given node on the Design Tree. 

Down Will move the selected item (i.e., manager, map, chart, report) down one position within 
a given node on the Design Tree. 

Copy Copies the selected item. 

Paste Pastes a copied item into the appropriate area of the Design Tree. 

Delete Deletes a selected item. 

Enable All This checks/activates the relevant item on the Design Tree, as well as any children. For 
example, for a Manager Group, this would enable all funds in the group. 

Disable All This unchecks/deactivates the relevant item on the Design Tree, as well as any children. 
For example, for a Manager Group, this would disable all funds in the group. 

Clear All This deletes all items from the relevant area of the Design Tree. For example, it may be 
used to delete everything from a node, all Managers from a Manager Group, etc. 

Lock This locks a particular Manager or Manager Group to the Design Tree, meaning that the 
item may only be deleted by first being explicitly ‘unlocked’ and then deleted. Locked 

items retain their checked/unchecked status. 

Unlock This unlocks a given item, allowing for its status to be changed in some way (checked, 
unchecked, deleted, etc.) 

Figure 12 

 
Views Menu 
 
The right-click menu for Views will change depending on whether it is a chart or a table you are working 
with.  These menus have some features in common, as may be seen below.  Common features are 
covered in the “Charts” menu. 
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Charts Menu 

Menu Selection Function 

Maximize This feature will make a particular chart or table in a View full-screen.  This 
may also be achieved by simply double-clicking on this chart or table. 

Restore The Restore option is only activated when you have maximized a chart or 
table; restore will simply return it to its original size, making other 
charts/tables in the View visible again. 

Create Label Create Label will insert an object directly onto the point where you right-
clicked, populating it with data from the chart.  Labels created in this fashion 
should be edited with the Object Editor. 

Export The Export option will allow you to copy a bitmap or metafile version of the 
chart to your computer’s clipboard, or to save the chart as an image file. 

Print This option will print the selected View. 

Attributes Editor Opens the Attributes Editor. 

Object Editor Opens the Object Editor. 

Page Designer Opens the Page Designer. 

Chart/Table/Memo 
Designer 

Opens the Chart/Table/Memo Designer. 

Propagate Chart Style 
To… 

Opens the Propagate Chart Style To… Menu. 

Copy Copies the current object or page. 

Paste Pastes the current item from the clipboard. 

Delete Deletes the active object or item. 

Figure 13 
 
Tables Menu 

Menu Selection Function 

Maximize See “Chart” table above. 

Export The Export option allows you to export table text to the clipboard; to export it 
to a file (such as Excel); to export the information as a new series; or, where 
applicable, to export loadings as a new portfolio. 

Page Designer See “Chart” table above. 

Chart/Table/Memo 
Designer 

See “Chart” table above. 

Copy Copies the table to the clipboard. 

Paste Pastes from the clipboard. 

Delete Deletes the current table. 

Figure 14 
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Reports Menu 
 
The right-click menu for Reports will change slightly depending on which page of the report you are on, as 
page relationship features (such as First Page, Previous Page) are only available for certain pages. 
 

 

Menu Selection Function 

Zoom to Page Automatically zooms to normal full-page view for report page. 

Zoom to Page Width Automatically zooms to make page width full-screen. 

Slide Show Allows you to view your report in a slideshow format. 

Zoom In Zooms in one step.  Same as the “Zoom In” button. 

Zoom Out Zooms out one step.  Same as the “Zoom Out” button. 

First Page Takes you to the first page of your report. 

Previous Page Takes you to the previous page of your report. 

Next Page Takes you to the next page of your report. 

Last Page Takes you to the final page of your report. 

Print Used for printing your report. 

Export Allows you export your entire report to PDF, PowerPoint, or RTF files.  Also 
allows you to export specific pages or areas to their appropriate file types 
(see Chart and Table guides above.) 

Attributes Editor Opens the Attributes Editor. 

Object Editor Opens the Object Editor. 

Stationary Objects Opens the Stationary Objects Editor. 

Page Designer Opens the Page Designer. 

Chart/Table/Memo 
Designer 

Opens the Chart/Table/Memo Designer. 

Propagate Chart Style 
To… 

Opens the Propagate Chart Style To… Wizard. 

Design Linked This allows you to jump directly to the Chart Designer/Table Designer for the 
chart (or table) without having to leave the Report tab. 

Figure 15 
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Keyboard Shortcuts 

 
A variety of keyboard shortcuts may be used to interact with MPI Stylus Pro. In some cases, these 
shortcuts are similar to shortcuts used in other applications; however, in many cases they are not. For this 
reason, users should always take a moment to ensure that they are comfortable with the exact effect 
each shortcut will have upon their studies or the application as a whole. 
 
Global Shortcuts 

Function Key Shortcut Notes 

New   

Stylus study Shift+Ctrl+O  

Prospector study Shift+Ctrl+P  

Integrator study Shift+Ctrl+I  

Allocator study Shift+Ctrl+L  

Open   

Stylus study Ctrl+O  

Prospector study Ctrl+P  

Integrator study Ctrl+I  

Allocator study Ctrl+L  

Configurator study Ctrl+U  

Latest study from recently used 
list 

Ctrl+0  

Study #x from recently used list Ctrl+1..9  

Close   

All Studies/Configurator Shift+Ctrl+W  

MPI Stylus Pro Ctrl+Q  

Switch to Design Tree Ctrl+F Sets focus on Design Tree, 
allowing for keyboard 
interaction 

Stop Esc (Escape key) Interrupts running processes, 
including Scripts (and infinite 
loops), run button activation 
and Binder processing.  

Figure 16 

 
In Studies 

Function Key Shortcut Notes 

Save   

Study or Configurator Ctrl+S  

Save As Ctrl+Shift+S  

Close   

Study or Configurator Ctrl+W You will be prompted to save 
the study or Configurator before 
closing 

Switch   

To last Tab/Page Ctrl+END When in the Design Tree or 
Views, takes you to the last tab 
in your study. When in a Report, 
takes you to the last page 

To next Tab/Page Ctrl+PAGEDN Takes you to the next tab/page 
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To previous Tab/Page Ctrl+PAGEUP Takes you to previous tab/page 

Run   

Run study Ctrl+R  

Run script Shift+Ctrl+R  

Copy   

Design Tree node Ctrl+C Copies the active 
(clicked/selected) node 

Paste   

Design Tree node Ctrl+V Pastes the previously copied 
node contents into the active 
node (even if this is not the 
same node as was copied). 

Figure 17 

 
Views/Reports 

Function Key Shortcut Notes 

Views and Reports   

Chart/Table/Memo Designer Ctrl+D  

Page Designer Ctrl+G  

Object Designer Ctrl+B  

Attributes Editor Ctrl+T For Attributes Editor, Ctrl+T works as 
a toggle, and may be used to open or 
close it. 

Stationary Object Editor Ctrl+K This is for Reports only, but is 
included here for ease of finding. 

Switch between active page elements Tab In a View or Report, will cycle through 
charts/tables/memos based on order 
on the Design Tree, 

Switch between active page elements 
(reverse) 

Shift+Tab Reverse shifting through page 
elements. 

Views only   

Toggle chart zoom Shift+Enter Toggles a chart’s zoom 
maximized/restore state 

Reports only   

Go to first page Ctrl+Home  

Go to last page Ctrl+End  

Go to previous page Ctrl+Left arrow (<-)  

Go to next page Ctrl+Right arrow(->)  

Zoom In Ctrl+Plus 
Ctrl+Up arrow 
 

This may also be done by scrolling the 
moust wheel up. 

Zoom Out Ctrl+Minus 
Ctrl+Down arrow 

This may also be done by scrolling the 
mouse wheel down. 

Zoom to page Ctrl+Shift+Minus  

Zoom to page width Ctrl+Shift+Plus  

Pan right Right arrow  

Pan left Left arrow  

Pan up Up arrow  

Pan down Down arrow  

Position/Size form Ctrl+E  

For this form only   
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Change position of C/T/M Arrow keys  

Change dimension of active C/T/M Shift+Arrow keys  

Pop-ups (where appropriate)   

Cancel Esc  

Ok/Enter Enter  

Apply Ctrl+A  

Figure 18 
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Working with Studies 

 
MPI Stylus has been designed so that study and template management issues are nearly identical for all 
modules, allowing the user to feel very comfortable managing studies even in a new or unfamiliar 
module.   
 
Creating a New Study 

 
Creating a new study in MPI Stylus is simple!  There are only two things you need to decide: 
 

1. Which module would you like to use? 
2. Would you like to use a standard template or simply start from scratch with a blank study? 

 
MPI Modules 
 
Users are encouraged to refer to the module-specific chapters for more information on their basic 
functions, but in general, the list below can help you quickly determine which module is best suited for 
your purposes: 
 

▪ Stylus Module – Use for analyzing one or more managers, comparing managers, and creating 
reports. 

▪ Prospector Module – Use for creating or editing peer groups or for conducting manager 
searches. 

▪ Integrator Module – Use when you would like to combine views from multiple studies and/or 
modules into a single report. 

▪ Allocator Module – Use when you are examining asset allocation options or want to examine 
allocation statistics for portfolios. 

 
Blank Studies vs. Standard Templates 
 
MPI Stylus allows you to start each session by either using a blank study or a template (a third option, 
using an existing study, does not apply when you are creating a new study.)  Whether or not you want to 
start with a blank study or a standard Stylus module template will depend on what your goals are for your 
analysis. 
 
A blank study in MPI Stylus is one in which no information exists – the design tree is completely 
unpopulated.  (We will cover the design tree concept later in this chapter.)  The only exception is that 
modules with Style Outlines will have “Cash” automatically populated on their design tree with the 
study’s default cash proxy.  (The default is usually the 3-month T-bill Total Return Index; however, please 
always check to be sure of what cash proxy is actually set, as proxy may be changed by other users.)  In 
cases where “Cash” is present on the Design Tree, it will always be populated and may not be deleted.   
You may temporarily remove it from your considerations by unchecking the box to the left of it under 
Style Outline, but this simply sets the risk-free rate to zero, as opposed to actually removing it altogether 
from your study.  For more information on changing the cash proxy/risk-free designation in MPI Stylus, 
please see Chapter 12 (MPI Configurator) for the program-wide proxy setting, or refer to the parameters 
sections of this manual. 
 
You will probably want to use a blank study if: 
 

▪ You have very specific ideas about what kind of analysis you would like to run, what to include in 
your Design Tree, and what (if any) Views and Reports you will create. 
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▪ You wish to replicate fully an existing analysis or report, and want to ensure that unnecessary 
information is not included. 

 
A standard template comes with MPI Stylus and may include a fully populated design tree; in some cases, 
it may even include selected managers or other indices.. 
 
You will probably want to use a standard template if: 
 

▪ You would like to quickly conduct analysis based on generally accepted criteria present in the 
template. 

▪ You would rather edit existing Views and Reports than build new ones from scratch (for 
applicable modules.) 

▪ Your company maintains templates for certain managers, portfolios, peer groups or asset classes.  
For information on whether or not your company maintains standard templates of its own 
design, please see your key MPI Stylus user(s). 

 
Once you have decided whether to use a blank study or a standard template: 
 

1. On the MPI Stylus main menu and go to File-> New->.  Select the option that corresponds to the 
module you would like to work in (Stylus, Prospector, Integrator, or Allocator.)  The “Select 
Template” menu will open. 

2. If you wish to create a blank study, click on the green checkmark in the upper-right hand corner 
of the menu without selecting from any of the choices available.  This will open a basic, 
unpopulated study (“Cash” will be populated in appropriate modules).   

3. If you would prefer to use a standard MPI template, please select the most appropriate template 
from the choices in the “Select Template” box.  Note that not all modules may have the same 
number of templates.  Once you have selected the appropriate template, you may click the green 
checkmark in the upper-right hand corner of the menu to open it.  Don’t worry if a template does 
not exactly fit your needs; all templates are fully editable, and are presented as a quick-start 
convenience for our users. 

4. Your study should now be open and ready for adjustment.   
 
Opening an Existing Stylus Pro Study 
 
Depending on the nature of your company’s use of MPI Stylus, you may not wish to start a new study, but 
instead run or make adjustments to existing company studies.  This will include cases where you 
previously started a new study from either a blank or a standard template, and then saved your work for 
later use.  Please note that if you are trying to open an existing MPI standard template, this is considered 
a new study – please refer to the previous section in this chapter. 
 
To open an existing study in MPI Stylus: 
 

1. In the MPI Stylus main menu, go to File-> Open->.  Select the option that corresponds to the 
module you would like to work in (Stylus, Prospector, Integrator, Allocator.)  The “Select Study” 
menu will open. 

2. All Stylus Pro studies are stored in folders/databases on your computer or network; please make 
sure to always note where a study is stored when you save it.  If you have saved a study in a 
database/folder other than the default one in the “Select Study” menu, you will have to browse 
to the correct database to locate the study.  If you are already in the correct database, skip to 
step 4. 
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To change databases, you will need to click the ellipsis button (…) in your Select Study box. This will bring 
up a listing of your relevant databases (databases containing the types of studies you are seeking, such as 
.sty files. 
 

 
Figure 19 

 
You will be able to see how many records are available for each database, and then either double-click on 
the database you like or click its name and press the green checkmark.  This will then open the new 
database, allowing you to select the appropriate study from within. 
 

3. Once you have found the correct file, double-click it with your mouse to select it.  You may also 
click the study name once and then click the green checkmark to open it. 

4. If you would prefer to open multiple studies in MPI, please use the “Allow multiple selections” 
button in your “Select Study” menu.   

5. Your study/studies should now be open.  Please note that you must run each study to launch it, 
unless one or more studies are populated with scripts commanded to run upon the opening of 
the study. 

 
Opening Studies Options Buttons 
 
Allow Multiple Selections Button 
 

 
 
This button allows you to select multiple studies for simultaneous opening.  This saves you having to 
continuously use the File-> Open feature when you wish to work in several studies at once.  This is a 
module-specific feature, meaning for example that you cannot open a Stylus study and a Prospector study 
at the same time.  You may however open them individually or open multiple studies of the same type at 
once, and have multiple MPI Stylus modules open simultaneously. 
 
 
Automatically Run Studies After Open Button 
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This button commands MPI Stylus to automatically run the study/studies you are opening automatically, 
saving you having to move through each study pressing the “Run” button.  Note that this option only 
works for the Run command, and does not apply to the running of scripts.  To automate the running of a 
script upon opening a study, use the “Run on startup” check box in the Script tab of a study.  For more 
information, please see the “Study-level Tabs” section later in this chapter. Note that the button color 
tells you the state of the study run, as it would for normal studies as well. 
Saving your Stylus Study 
 
You will probably want to save a study after you have created or edited it.  There are three ways to save a 
study in MPI Stylus: 
 

1. You may save a previously saved study under the same name, overwriting the most recently 
saved version. 

2. You may save a new study, or save an existing study under a different name, by using the “Save 
As” feature.  For an existing study, this would allow you to save your changes without overwriting 
the previously saved version of the file. 

3. You may save a new or existing study as a template. 
 
Saving a new Study 

 
Please note that MPI Stylus will not allow you to save new studies under their automatically assigned 
default names (i.e., NONAME.sty, NONAME.unv).  This is a precautionary measure; by forcing you to give 
your study an appropriate name, you will be much more likely to be able to locate it again easily when 
next you need it. 
 
To save an existing study under the same name, overwriting the most recently saved version: 
 

1. Make sure that you wish to overwrite the most recent copy of this file with any changes you have 
made. 

2. On the MPI Stylus main menu or toolbar, you may either use File-> Save or press the Save 
button.  In both cases, Stylus will ask you if you are sure you would like to overwrite the existing 
file.  Click “Yes.” 

3. Your study is now saved. 
 
There are two ways to save a new study, or save an existing study under a new name.  The first is to use 
the “Save As” option: 
 

1. On the MPI Stylus main menu, go to File-> Save As.  The “Save Study As” menu will appear.  
When you first create a new study and click “Save” you will be directed here automatically. 

2. Make note of the specified database.  If you would like to change the database in which a study is 
saved, you may do so by using the ellipse button. 

3. Give the study a name that you feel will allow you to correctly identify it later.  A good name is 
short and descriptive; for example, the name of the client whose portfolio this study examines, 
the asset class around which the study is built, etc.  The default name of the study (i.e., 
NONAME.sty) will already be selected.  Delete this text and enter your new study name.  You do 
not have to type in the file extension (i.e., .sty, .unv) – Stylus will enter this information for you 
automatically. 

4. In the field below the “Database” and “Study Name” entry fields, you may enter a description of 
your study.  This is entirely for internal use, and is an excellent place to note in more detail the 
specific notes of interest for your study.  Good examples might include “Client A Portfolio vs. 
Model Portfolio B”, or “Fixed Income Manager Comparison.” 

5. You do not need to enter any information into the tabs at the present time – these may all be 
editable through the study itself; however, you may if you wish to.  
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6. Press “Save.”  Your study will now be saved, and in future may be located by using File-> Open->. 
 
The second option for saving studies is to simply rename and save the study from the Study node: 
 

1. Click on the Study node of the study you wish to save. 
2. In the data pane, you will see the “Study Name” field, which will display the name of the current 

study (for new studies, this may be something like NONAME.sty). 
3. Delete the name in the Study Name field and type in the new name for the study.  You do not 

need to enter the file extension – MPI Stylus Pro will automatically supply it when you press 
Enter. 

4. Click the Save button on your main toolbar.  The study will now be saved in its new name.  Please 
note that this new study will now become the active study – if you wish to use the old study 
again, you will need to reopen it. 

 
Saving a study as a template 
 
Some users like to design their own templates for the program, for their own use or for deployment to all 
company MPI Stylus users. Once it has been saved, any template created through this process will be 
found by going to File-> New-> and then selecting the template name. 
 
The basic steps for saving a study as a template are very similar throughout all modules in MPI Stylus; 
however, it should be noted that each module will have its own special interface screen and template 
options.  The general instructions below will work for all modules, but users are encouraged to reference 
the module-specific data tables below for more information on what information in the template “Save 
Template” box means. 
 
To save a study as a template: 
 

1. On the MPI Stylus main menu, go to File-> Save As Template.  The “Save Template” menu will 
appear. 

2. Specify the database where you would like your template to be stored.  The default is the 
“Sample Templates” database. 

3. Give your template a short, descriptive name for easy identification. 
4. In the “Narrative Description” field, enter a concise description that you feel will allow your users 

to quickly decide whether or not this template is appropriate for their needs. 
5. You may now decide which components of the current study you are using to create your 

template will be included in the actual template.  These options come in two basic categories.  
Please see the module-specific tables below for information on what is meant for each inclusion.  
The default setting will be to copy the template exactly by selecting all options with the 
exception of “Properties.WEB.”  This setting is only relevant to users creating templates for MPI 
StylusWeb – most MPI Stylus users will wish to keep this box unselected. 

6. Once you have decided which elements to include, press “OK” to save your template. 
 
Deleting a study 
 
Deleting a template or study is easy, and may be accomplished several ways – either through the MPI 
Stylus program, or by deleting the necessary files yourself by going into the folders in Windows.  This 
manual only supports the program-associated solution.  Please always check with your company’s other 
MPI Stylus users before deleting any study or template – even ones you do not personally use.  Files 
deleted through the program do not go to your system’s Recycle Bin – they are instead fully deleted.  
Once a study or template is deleted in MPI Stylus, it may not be recovered, unless your company 
maintains appropriate/timely system backups.  MPI does not maintain backups of client studies or 
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templates – please contact your company’s tech support team for information about backup procedures 
and availability. 
 
To delete a template or study: 
 

1. Go to the appropriate process for opening the module template or study you would like to 
delete.  For example, to delete a template you would go to File-> New->, whereas to delete an 
existing study, you would use File-> Open ->. 

2. Once the appropriate New/Open menu has appeared, locate the template or study you wish to 
delete and select it with your mouse.  Do not actually open the template or study. 

 

 
Figure 20 
 

3. In the upper left-hand corner of your “Select Template” or “Select Study” menu, you will see the 
“Delete from the database” button, which looks like a trash can.  Click this button. 

4. You will be asked if you are sure you wish to delete the file.  Click “Yes.” 
5. This file has now been deleted from MPI Stylus.   
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Sharing studies 
 
Sometimes users may be asked to share studies with colleagues, or send a study to MPI Tech Support to 
assist with a question or problem.  Knowing how to share these studies will significantly decrease your 
work time on Stylus issues, and help resolve issues more smoothly. 
 
Files in Stylus 
 
As we mentioned earlier, all studies in MPI Stylus are files, and have certain extensions associated with 
them.  The key to sharing studies in MPI Stylus is to: 
 

1. Know where to find the file you want to share. 
2. Know how to get that file to the person with whom you wish to share it. 
3. Know where to save files you receive from other users/MPI. 

 
Locating Files in your Stylus Folder 
 
The simplest way of finding out where the actual file for a study is located is to make note of the database 
in which the study is saved.  This database will correspond to a certain folder within your Stylus folder.  
For a listing of database names and their associated folders, please see Chapter 5. 
 
Alternately, if you know the name of the actual file (i.e., somename.sty), you may search for this file using 
Windows file management features. 
 
Stylus Files as Attachments 
 
MPI Stylus files may be sent as attachments to e-mails like any other file, and do not need to be zipped 
beforehand.  All information necessary for running the file, including design tree population, views and 
reports, will be included in the file itself. 
 
Saving Stylus Files from MPI/Other Users 
 
To use a study from another user in MPI Stylus, all you need to do is save the study in the correct folder.  
For a complete list of recommended folders, please see “Stylus File Types” at the beginning of this 
chapter. 
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Design Trees in MPI Stylus Pro 

 
Design Trees are a common element in all Stylus modules, and with good reason.  A Design Tree is a 
module’s backbone – it provides the user with a simple, consistent way of putting together any analysis, 
always asking for information in a logical order.  The differences between modules call for Design Trees 
that are unique to each module in the series of choices they offer the user, but navigability of Design 
Trees will always be the same. 
 
This section will introduce you to the basic Design Tree concept, and allow you to quickly learn how to 
navigate all of the features of a Design Tree.  The chapters in this manual that cover each specific module 
will contain additional Design Tree information, some of which will be repeated from what is discussed 
here. 
 
Why a Design Tree? 
 
The Design Tree simplifies the basic elements of analysis into clear, well-defined parts.  By using a Design 
Tree, a client not only can create or run analysis in a quick fashion, but also can become more alert to the 
various elements that comprise a solid, correct financial analysis.  Design Trees in Stylus govern both the 
creation of input and output, meaning that very little time is necessary to actually get at the data results 
you require.  
 
Basic Appearances 
 
The Design Tree always appears vertically on the left-hand side of your screen in MPI Stylus.  The only 
feature that ever appears to the left of the Design Tree is the Multiple Studies Navigator tool.  The Design 
Tree always consists of the following elements: 
 

▪ A special “Study” super-node that contains tabs controlling numerous study features. 
▪ “Nodes”.  Each represents a major element of your study design. 
▪ The Design Tree may always be found on the “Designer” tab of the study.  Output tabs will be 

discussed in more detail later in this chapter. 
 
In addition, control of elements on the Design Tree may be regulated through the use of a right-click 
menu.  This menu allows you to move specific elements within nodes, such as managers, indices, views 
and reports, up and down, as well as to copy, paste or delete them.  It should be noted that while you 
may change the position of elements within nodes, the order or number of nodes cannot be changed. 
 
Although each node has its own features and purpose, it is often the case that different nodes have 
similar screens and interaction capabilities.  One of the most common screens in the data pane will be 
discussed in part 3 of this section. 
 
Navigation 
 
Design Trees may be navigated using the mouse, or you may use your computer up/down arrows to move 
throughout the features. 
 
Module Design Trees 
 
Each module has its own Design Tree, available for study in that module’s chapter in this manual.  For the 
purposes of simplicity, we will work with the Stylus module Design Tree in this section as we discuss the 
navigation features common to all Design Trees in the application. 
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Here is the basic Stylus module Design Tree: 
 

 
Figure 21 

 
Notice that Cash always appears on a MPI Stylus design tree, even when the study is new and 
unpopulated.  You may uncheck Cash to remove it from consideration in a study, but it may not be 
removed from the design tree.  You may change the Cash setting in Configurator or in the Parameters 
node. 
 
Alignment Arrows 
 
Alignment arrows allow you to quickly move your Min/Max settings to the left or right on your design tree 
to adjust for visibility, screen size, etc.   
 
To use the alignment arrows: 
 

1. Left-click your mouse on the alignment arrows and hold down the mouse button.   
2. With the button held down, drag your mouse to the right or left.  The Min/Max settings should 

adjust with your mouse cursor. 
3. When you are satisfied with the alignment of Min/Max, release your mouse button. 

 
Right-click Menu 
 
The Design Tree right-click menu discussed earlier in this chapter is an important element of Design Tree 
navigation, allowing you to move items within nodes, as well as copy, paste or delete them.  For more 
information, please see the right-click menu sections earlier in this chapter. 
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Study Node 
 
The Study node of your design tree contains special study-wide controls that regulate features such as 
automation scripts & macros, certain color and symbol controls, text substitute features and more.  This is 
also the place to find out what the full name of your file is, and in what database in MPI Stylus it may be 
found.   
 
Blue Lettering in Study node tabs 
 
Please note that a tab on the Study node will switch to blue lettering when populated, allowing you to 
determine quickly which tabs are being used in the study and which are empty. 
 
Database 
 
The Database category simply tells you in which database the current study is located. 
 
Study Name 
 
This area shows you the name of the current Stylus study.  You may change this at any time, but please 
note that changes will not be reflected until you save the study.   
 
Description Field 
 
The Description Field is the unlabeled field located directly beneath the “Database” and “Study Name” 
fields.  The text you enter here will be visible in the “Description” column when you use the File->New or 
File->Open options to open a new study. 
 
Memo Tab 
 
The memo pane is an area for entering various textual notes for internal use.  Examples include: 
 

▪ Entering notes for colleagues on how/when to use a template. 
▪ Maintaining a list of clients for which a template is to be used. 
▪ Keeping a log for when a study has been run for client-use. 
▪ Compliance-related purposes. 
▪ And more… 

 
It should be noted that templates created in older versions of MPI Stylus Pro may show information in the 
Memo pane that concerns macro automation.  In older versions of MPI Stylus Pro, the memo pane was a 
catchall area for both general internal memos and macro automation information.  It should be noted 
that macros will still work in the memo pane in new versions of MPI Stylus Pro, but we recommend 
moving macros to the Macro Tab Pane in order to reduce confusion and avoid accidental erasure. 
 
Script Tab 
 
The Script Tab Pane is the area of MPI Stylus where all scripts should be entered for processing.  The pane 
will adjust to fit extra text, so there is no special limit on the length of scripts.  Scripts are a part of the MPI 
Stylus Pro Automation package; for more information, please consult your MPI Stylus Pro sales associate. 
 
In addition to the text entry pane, there are three features included in the Script Tab Pane. 
Run on Startup 
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Checking the “Run on startup” feature will tell MPI Stylus that you would like to have your script run 
automatically every time you open the study.  “Run on startup” is normally used once you have finalized 
your entire study and it is ready to be used in production; however, while designing the study you may 
wish to keep control of when a script is run, in order to check a study and make any last-minute 
adjustments before processing it.  For this reason, we also include the “Script Run” button. 
 
Script Run button 
 

 
 
The Script Run button in your Script Tab Pane allows you to choose to run a script at any time, and is 
recommended for most program users who are working with automation. 
 
Force Run to execute script 
 
Checking this option will cause your script to run every time the study is run. 
 
Macro Tab 
 
The Macro Tab Pane is the pane in which any study macros should be defined/entered.  Like the Script 
Tab Pane, this pane will expand to accommodate a large amount of text, so there is virtually no limit to 
the amount of macros you include. 
 
Studies created in older versions of MPI Stylus Pro may have macro information in the Memo Tab Pane; it 
should be noted that macros will work in either pane, but for organizational purposes should be located in 
the Macro Tab Pane only. 
 
Extensive detail on macros may be found in Chapter 9 of this manual. 
 
Binder Tab 
 
The Binder Tab Pane (available in Stylus, Allocator and Integrator) enables the creation of a report book 
(combination of different reports, or the same reports for different managers) from a single study without 
having to resort to scripting. This makes it an attractive feature both to those who do not subscribe to our 
Automation package, as well as to those who do not have the time or inclination to avail themselves of 
automation’s extremely powerful features. 
 
The Binder concept is based on selecting one or more Reports in your study and indicating whether Stylus 
should run the study for all managers at once, or each manager sequentially. The output file will then be 
saved in the “File Name” path. This process may also be extended in Integrator in order to combine 
reports from different studies (i.e., for different asset classes.)  
 
PDF/PPT 
 
This allows you to select the type of output you desire. If you are using PPT as your output, it is important 
to use the Screen layout control when creating the Reports involved. For more information, please see 
the Report chapter. 
File Name 
This tool allows you to type in (or browse to, using the … button) the location where you wish to have 
your output saved.  
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Preview File if Exists 
This option allows you to open the current version of the .PDF or .PPT file if one already exists; if no file 
exists, a “File not Found” error will be returned. 
 
Embed Fonts 
This feature is used to embed fonts in a file – this is useful when you are sending your file to other parties 
who may not have the fonts you are using. It is highly recommended that you only use this in the case of 
extremely rare or unique fonts, as it can have a dramatic effect on file size. 
 
Append to Existing File 
This feature allows you to attach the output you are creating to the end of an existing piece of output; for 
example, if the file you have selected in “File Name” already exists as a PDF, you can choose to have the 
file you are generating now added at the end of the other file, as opposed to overwriting it. 
 
Bind 
This button should be pressed when you are ready to create your output.  
 
Color & Symbol Tab 
 
The Color & Symbol Tab Pane is one of the most useful tools in MPI Stylus for creating clean, consistent 
reports. Using this tab pane, you can dictate on a study-wide level in what colors and shapes any 
manager, index, benchmark, universe statistic, or even chart components appear.  This allows for the 
enforcement of company logo colors, for report-wide consistency, and allows users to avoid the tedious 
task of implementing this consistency through the “Attributes Editor” of “Propagate Chart Style to…” 
features. The default setting is “Auto,” which is tied to the current individual settings for each chart, 
defined within the Attributes Editor. 
 
Use identity-based color/symbol assignments 
This feature allows you to assign a variety of properties that will help to control the colors and symbols 
that appear in output. For more information, please contact MPI Support. 
 
Maintain design-tree based benchmark colors 
Allows you to maintain colors based on specific design tree elements. 
 
Use study color palette 
This Feature allows users to define a study-specific color palette, which may be generated from scratch or 
copy/pasted in before adjustments are made. When enabled, this palette is used in study reports instead 
of the global Stylus color palette specified in Configurator. This setting also takes precedence over the 
‘Force standard color template palette to be used with template’ property which may have been set by a 
template designer in the Study/Template properties (access to study/template properties is available only 
to ULI/WEB Template Designer mode users, and thus this section may not be relevant to most users). 
 
Edit Palette 
This feature allows you to edit the color palette used in the active study. 
 
Compatibility with Attributes Editor. 
 
Because the Color & Symbol tab and the Attributes Editor may both be used to control series colors, it is 
important to understand the logic between the two. This becomes especially important because chart 
components (such as a manager or index name in a given chart) may have the option to be set to different 
colors than the managers and benchmarks themselves.  
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Stylus will first check for a color specification in the specific component section of the Color & Symbol tab. 
If no specification is present, the default will be to any specification in the Managers/Index sections of the 
Color & Symbol tab. If this is also unavailable, the scheme set in the Chart Attributes editor is used. 
 
Rules can be copied / pasted from and to Advanced Table Formatting. This allows users to utilize 
previously configured entries as a starting point.  
 
Text Substitute Tab 
 
The Text Substitute Tab is meant to give MPI Stylus users a quick, easy-to-check option for instituting text 
substitutions on a study-wide level.  This feature works similarly to some macros, in that it allows for 
automated substitution, but it does not require the complex setup of a macro to enact.  Note that this 
feature is not intended for memos in MPI Stylus, but rather for features that automatically bring in certain 
text, like the titles of managers, indices, etc. 
 
For example, if you were to create a memo in a View or Report with the word “Test” in it, and then to use 
the Text Substitute Tab to ask MPI Stylus to replace the word “Test” with “Fail,” you would find the 
program would make no change.  However, if you were to have a manager on the Design Tree named 
“Manager 1”, and asked the Text Substitute Tab to replace this with “Portfolio Manager 1”, it would 
automatically be called “Portfolio Manager 1” in all Views and Reports, except in Memos.  Therefore, 
memos should continue to use macros for this type of replacement. 
 
To substitute text: 
 

1. In the “From” column, enter the text you would like to be replaced.  This need not be an exact 
match; please look below for text match options. 

2. In the “To” column, enter the text with which you wish to replace the old text. 
 
Exact Match 
The exact match option will only make replacements where the exact text you have entered in the “From” 
column is found.   
 
Head Match 
The head match option allows you to specify the beginning characters in a text string to be replaced.  
Please note that only the characters in your text string will be replaced – the entire text string (if it has 
additional characters) will not be replaced. 
 
Tail Match 
The tail match option allows you to specify the ending characters in a text string to be replaced.  Please 
note that only the characters in your text string will be replaced – the entire text string (if it has additional 
characters) will not be replaced 
Substring Match 
The Substring match can locate and replace text entirely embedded in a longer text string.  Please note 
that only the characters in your text string will be replaced – the entire text string (if it has additional 
characters) will not be replaced. 
 
Special Symbols 
The Text Substitute tab now also includes options to display subscripts, superscripts and Currency symbols 
in a report.  
For example, 

1. Trademark: ™  
2. Service mark: ℠ or use @htmltext {<sup>SM</sup>} in a memo or a chart. 

Please note that this feature will also be supported in chart axis texts 
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Field Map Tab 
 
The Field Map tab allows you to rename header fields from one or more databases. This can be useful for 
a variety of applications, including when you want to have a standard name and column associated with a 
type of data that exists in multiple databases under different names. 
 
For example, suppose that Databases A and B have columns that contain the Expense Ratio for a 
Manager. Database A calls this “Expense R” and Database B calls this “Exp Ratio”. When you are using 
both databases in MPI Stylus Pro, these will appear as two separate columns, with information populated 
only for funds in the appropriate database. Using the Field Map tab, the user can rename both columns 
“Expense Ratio”, causing them to appear as one column in a table, with the appropriate number from the 
respective database displayed. 
 
Properties Tab 
 
This tab is primarily used for adding, editing or removing Manager Properties. This has a number of uses 
and is often tied to our Dictionaries functionality, which is part of an advanced package. Beginning with 
MPI Stylus Pro 11.0, properties were added to this tab allowing you to define benchmarks specific to each 
manager in your study.  
 
Read-only 
This option allows you to make a study ‘read only’. When you check this box and then save the study, it 
will no longer be possible to save over the current version of the study. Any attempt to save will become a 
‘Save As’ instead, and thus the original study will always be preserved. This may be undone by unchecking 
the box, and then saving the study. It will now be possible to write over the study. 
 
History Tab 
 
The History tab gives you the flexibility to store any data in either a Disctionary or SQL/Access file or 
database, to be called into the respective study at a later point. Likewise, the feature allows you to take 
data from the assigned table within the study and export it to the above-mentioned file/database so that, 
at a later time, the field history values may be shown.  
 
The History Tab is available as part of our Advanced Database package, and MPI maintains a sample study 
demonstrating the use of this feature, available on our website or from support@markovprocesses.com.  
 
 
Summary Tab 
 
The summary tab gives the user a quick glance at the overall design and content of their analysis and 
includes information on series, standard and advanced parameters, and the benchmark contained in a 
given study.  This has several very useful applications and should be a helpful resource for all users. 
 

mailto:support@markovprocesses.com
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Figure 22 

 
Series controls 
The Series section of the summary tab contains very useful information about each return series in the 
fund, including: 
 

▪ Label – The name of the return series as it appears on your design tree 
▪ Begins – The inception date/earliest return in each series 
▪ Ends – The most recent return available for each series 
▪ Freq – The data frequency (monthly, quarterly, etc.) 
▪ Missing – The number of missing returns identified by Stylus.  If this number is greater than zero, 

you may view the missing return dates by clicking on the manager’s name in the design tree and 
pressing the Warnings button. 

▪ DB – The database where the return series is located. 
▪ ID – The unique ID for the return series file. 
▪ Currency – The currency in which the series is calculated. 
▪ Series type – This unlabeled column tells the user if a series is a manager (M), map (m), style 

outline (O) or benchmark (B.) 
 
Parameters 
This section tells the user the basic parameters for the analysis: 
 

▪ Currency – What unit of currency is being used in the analysis (i.e., USD)? 
▪ Interval – This is the time period specified in your date range, and will specify a range of dates 

regardless of whether the Interval, First or Last options are selected in the Parameters node. 
▪ Window – This displays your window size, the number of calculations and the period at which the 

window moves (i.e., monthly).  If “Use Single Computation” is checked, this area will only say 
“Single Computation.” 

▪ Frequency – This displays your selected frequency information – either the common frequency or 
the forced frequency setting from the Parameters node. 

▪ Holdings – This tells the holdings assumption used in the study (i.e., Long only, shorting, etc.) 
 

Advanced 
This section displays settings from the Advanced Parameters pane. 
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• Model – The model type (CAPM, APT, etc.) 

• Win Position – The window position being used (Centered, Trailing, Custom) 

• Calculations – Whether or not Style in first point/last point are being employed 

• Weights – The weights setting for the window 
 
Benchmark 
 
This displays the benchmark type (i.e., Assigned) and the benchmark itself. 
 

Searching Options in MPI Stylus Pro 
 
Using the Search box (‘S’ box) 
 
Each column will also have a small box with an ‘s’ in it, in the lower right-hand section of the column 
heading. Clicking this will open the “Search” box. You may also use F2 to open this once you have clicked 
in the pane itself, and F3 to repeat a previous search. You may also hit the ESC key at any time during a 
search to stop the search process. 
 
Please note that the binocular icon may also be used to open a search box. 
 
Text 
This is where you will enter the text you are searching for. Be careful of entering too much information – 
each database may have its own abbreviations, and Stylus will only return a record that precisely matches 
what you enter. For example, typing in ‘Dodge and Cox’ will not return a result because it is listed as 
‘Dodge & Cox.’ 
 
Find in: 
This allows you to select the column you wish to search. You may choose to search more than one column 
if you wish. 
 
Select All/Select None 
This allows you to quickly select all or no columns for your search. 
 
Substring 
This allows you to search within a larger text string. For example, to search for ‘idel’ in the larger string 
‘Fidelity.’ 
 
Forward/Backward 
This determines whether or not the search begins at the start or end of the database, and in which 
direction it occurs. This may be used to save time in extremely large databases. 
 
 
QuickFilters 

 
QuickFilters are special, easy-to-use searching tools that allow you to quickly locate Managers, Style 
Indices, Assets, etc. without having to use the traditional search features in MPI Stylus Pro. 
 
 
 
QuickFilters are controlled through white boxes found just below column headings in the following 
sections of the application: 
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Module Node 

Stylus Managers 
Style Outline 
Peer Groups 

Allocator Assets 
Benchmark 
Portfolios 
Efficient Portfolios 

Figure 23 

 
You may type into these boxes strings of letters or numbers to help MPI Stylus Pro identify the possible 
matching record(s) of interest to you.  Once these records are identified, the filter field will be highlighted 
in order to ensure you know there is a QuickFilter being applied.  QuickFilters do not persist in the same 
way that Prospector filters do; they are instead temporary search tools, not permanent filters.  Once you 
close a study, any QuickFilters in that study are lost. 
 
Searching for text strings 
 
In addition to simply typing in a word, phrase or number to find all records beginning with that sequence 
of characters, you may also use the ~ sign to search for strings.  For example, if you were searching for a 
record such as: 
 

Fidelity Contrafund 
 
You could use the following entry: ~fund to find this.  Just entering “fund” by itself would not work 
because it would look for strings beginning with the word “fund” as opposed to containing it anywhere. 
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Navigator Panel 
 

 
Figure 24 
 
The Navigator Panel in MPI Stylus will automatically appear whenever you have more than one study 
open in the application at the same time – even if the studies are from different modules.  This provides 
you with a convenient tool for easily moving between studies (and modules) in the application.  You may 
click on any study name on the Navigator Panel to choose which study to make active on your screen. 
 
Positioning the Navigator Panel 
The Navigator Panel can be positioned on either the left side of the application frame, the top of the 
application frame, or hidden altogether. You can choose from these options in the Navigate section of the 
Main Stylus toolbar. 
 
Moving Between Studies/Modules Without the Navigator Panel 
If you do not wish to see the Navigator Panel but would like to move between studies and modules, you 
may use the Window option in your main program menu to switch between open studies in any module.   
 



Chapter 3 
Getting to Know the Basic Interface 

www.markovprocesses.com  Page 67 

 

Data Panes in MPI Stylus Pro 

 
The Design Tree may be the backbone of the application, but Data Panes represent the heart of a user’s 
interaction with MPI Stylus.  Almost all of the work you do in designing your analysis will involve some 
interaction with data panes. 
 
This section will introduce you to the basic Data Pane concept, and allow you to quickly learn how to 
navigate all of the features of a basic Data Pane.  The chapters in this manual that cover each specific 
module will contain additional Data Pane information, some of which will be repeated from what is 
discussed here. 
 
Basic Appearances 
 
The Data Pane always appears on the right-hand side of your screen in MPI Stylus.  Depending on the 
module and node you are in, Data Panes can vary dramatically from one another.  Views in Stylus are even 
done through Data Panes! 
 
While most Data Pane interaction is customized to a particular module, there are some basic features 
common to numerous nodes and/or modules in MPI Stylus; therefore, they will be introduced here as a 
good standard for navigating Data Panes in the application.  Users are encouraged to use both this 
section, and specific modular chapters, as references. 
 
Data Selection Data Pane 
 
One of the most common screens with which a user is asked to interact with a node in Stylus consists of 
the list of items to choose from, and the toolbar with the following buttons: Clear All, View, Edit, New, 
Refresh, Delete, and Move.  This screen can be found in multiple applications on varying nodes.  For more 
complete information, see the appropriate node in Design Tree descriptions. 
 
The data selection data pane screen is very important in MPI Stylus, because it serves two vital functions: 
 

1. It allows for series selection of funds, portfolios, indices, sets, peer groups, managers, sources, 
etc. 

2. It is the only place in Stylus where users may create new return series, portfolios and style maps. 
Peer groups may also be created here, but Prospector is the preferred method for doing this. 

 
The data selection data pane screen consists of three distinct parts; though the picture below gives a 
sample for managers, the same elements are true for the other nodes, such as peer groups, in which this 
screen type appears.  The three common elements are: 
 

1. The toolbar buttons 
2. Database field 
3. Source fields populated with relevant data information 

 

 
 
Each button is summarized in the table below, and then discussed in greater detail on the following pages.  
For more node- or module-specific information, please see the chapter or section dealing with the 
appropriate node or module. 
 
 

Button Function 
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Clear All Deselects all checked options and removes them from the Design Tree. 

View Allows you to view relevant details about a series. 

Edit Allows you to edit series information. 

New Allows you to create a new return series, fund, style map or peer group. 

Refresh Refreshes the data in the data pane. 

Delete Allows you to delete a series. 

Move Allows you to move a series to another database. 

 

Clear All 
 
This button will deselect/uncheck all selections currently selected in your database, and remove them 
from the Design Tree as well.  Please note that this function removes both checked and unchecked 
elements from the Design Tree, as opposed to unchecking them, and therefore the appropriate node in 
the Design Tree will need to be repopulated entirely if the Clear All button is pushed. 
 

View 
 
The View button is only enabled when a specific element is highlighted in the selection list – for example, 
a specific Manager has been selected.  When the View button is pressed, the “Series View” box opens, 
and the following information about a manager may be viewed: 
 

Field Function 

Label This is the basic name of the fund, and the name that appears on Views, Reports and 
the Design Tree.  This label remains correctly populated in the Series View even when a 
fund is renamed on the Design Tree. 

Database This field shows the source database from which a fund’s return series are being pulled. 

ID This field shows the unique ID name/number assigned to a given fund by its source 
provider. 

Close button This button may be used for closing the Series View tool when you have finished 
examining the data. 

Description This field may be identical to the Label field, or may contain a longer or alternative 
name, a brief description of fund makeup, etc.  This content is determined by the data 
provider in most cases. 

Memo This field displays the memo content, if any, entered for a given fund at the time it was 
configured in MPI Stylus.  This is an optional field that will seldom be populated. 

Date 
Controls 

There are four elements to the date controls in MPI Stylus, all pictured above: 
a. YYYYMM – This control is for reconfiguring the numerical date display 

for a fund, and will not be editable in the Series View box through this 
function.  The default display is four digits for the year, and then two 
for the month. 

b. 1% - This element displays whether returns are presented as 
percentages or fractions. 

c. Date/Return – This field displays the corresponding return for each 
period (i.e., a given month and its return.)  The earliest date/date of 
inception is always first, with the most recent date always last.  You 
may have to scroll to see the most recent returns. 

d. Warnings – This button is only activated when MPI Stylus encounters 
a problem with the return series, such as duplicate returns, incorrect 
period end dates, etc.  Clicking this button opens a window revealing 
the nature of the problem.  In general, this is an issue only with data 
brought in from client sources. 
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Fund Detail 
Controls 

These four controls relate to specific qualities of the fund data: 
a. Frequency – The period upon which returns are based (i.e. monthly, 

quarterly). 
b. Type – This is the actual type of database being brought into MPI 

Stylus.   
c. Currency – The currency in which fund data is presented. 
d. Series Type -The type of series: Return, Level or Change 

Since 
Inception 

Controls related to the Since Inception status of the fund. The options are: 
a. Start date 
b. End date 
c. Fractional return 
d. Total return 

Figure 25 
More specific information on relevant View Screens for each node may be found in the actual node 
descriptions. 
 

Edit 
 
 
The Edit button is made active when you click on any specific manager, style map, peer universe, etc. in 
the Data Pane.  For a peer universe, the Edit function will immediately launch the relevant Prospector 
study for editing.  In the case of a manager, the Edit function opens a window very similar to that of the 
“View” button above, with the following differences: 
 

1. Every field with the exception of “Frequency” is opened for editing, though in many cases it will 
make no sense or have no effect to change them (for example, database, data type, etc.)  This is 
a more useful field for editing label, description, memo, dates and returns. 

2. Three new buttons are added below the “Warnings” button.  They are:  
a. Add – This allows you to add specific dates and accompanying returns.  When you click 

on it, a calendar browse tool will open on your computer.  You may scroll through it to 
find the exact date for which you wish to enter a return.  The << and >> arrows scroll by 
the month, and the < and > arrows scroll by the day. 

b. Delete – This allows you to delete any date and return line in the return series.  Simply 
click on the appropriate line and press the “delete” button.  Note that MPI Stylus will 
not confirm the deletion with you – please only press the Delete button if you are 
confident you wish to delete a date/return line. 

c. Paste – This feature allows you to paste in a date/return series from your computer’s 
clipboard, instead of typing returns in manually.  MPI Stylus should be able to correctly 
interpret most recognized date formats used in programs like Microsoft Excel; however, 
please always check your dates and return stream after pasting them in. 

 

New 
 
The New Button is useful for creating a new Series, Portfolio, Style Map or Peer Group.  Each will be 
examined below in turn; for extensive information in efficiently creating peer groups, please see the MPI 
Prospector section of this manual. 
 
In the case of new series, portfolios and peer groups, MPI Stylus offers additional ways of bringing this 
information into the application.  To minimize time spent creating or importing data in the application, it 
is a good idea to familiarize yourself with all the options available to you.   
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Series 
 
Series are defined as one of three types; Return, Level or Change.  This refers to their treatment for 
analysis and aggregation.  Return is the % change in value from one period to the next, and is the type of 
the vast majority of series in Stylus.  Level is a time series of values before any transformation, such as 
index levels or interest rates.  Change refers to the first difference of a series of values, or the absolute 
change from one period to the next, expressed as (tn-tn-1).   
 
 
The New Series option is useful for manually creating a single portfolio/return stream in MPI Stylus.  
When you select the New->Series function, the “New Series” box will open and you will be asked to input 
three preliminary types of data: 
 

1. Format – There are three basic formats for importing data as a new series: 
a. MPI ASCII – This is default option and is recommended in most cases.  ASCII stands for 

“American Standard Code for Information Interchange,” and is a widely accepted 
method of codes used to present text. 

b. MPI Link – This allows you to link to an Excel spreadsheet.  Although this tool is still 
usable, this format has been rendered obsolete by the Excel Database capability in MPI 
Configurator.  MPI Link remains in the application for the purposes of backward 
compatibility.   

c. MPI SMART Link – This format provides much quicker access to data than MPI Link 
because, in addition to containing information from the MPI Link file, it also contains the 
return data.  The data is extracted from the spreadsheet and updated only when the 
spreadsheet changes.  Although this tool is still usable, this format has been rendered 
obsolete by the Excel Database capability in MPI Configurator.  MPI Link remains in the 
application for the purposes of backward compatibility.   

2. Frequency – This field allows you to specify the frequency with which returns will be available.  
The choices are daily, weekly, monthly, quarterly and annually. 

3. From…To – This timeline allows you to use sliders to designate the start and end dates for your 
return stream.  Each viable date for the period you select will be made available – in other words, 
if you select a monthly frequency, the last day of each month will be available for selection, 
whereas for a quarterly frequency it would be the last day of each quarter-ending month.  The 
sliders will allow you to enter a date through the end of the current month. 

 
When you have finished with the above options, you may press “OK” to begin your return series, or press 
the “Cancel” button to discard it. 
 
Series Edit Functions 
 
Now we will take a moment to look at the Series Edit box.  Edit boxes in Stylus can be very similar, but 
each is designed to offer the appropriate options for the particular task you wish to achieve. 
 

Field Function 

Label The label should be the fund, portfolio or index’s short, commonly accepted name, 
such as “S&P 500,” “Fidelity Contrafund,” etc.  This field determines what the series 
will be called by default in your studies. 

Database The default database for new portfolios is your SampleMng database; however, you 
may save a new portfolio in any editable database linked to MPI Stylus.  Make sure to 
note in which database a new series is stored so that you may find it later. 
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ID 3rd party databases assign their funds unique ID numbers.  For a new return series, 
you may assign any ID # you like, as long as it is unique.  Please note that MPI Stylus 
imposes a 14-character functional limit on ID’s. 

Description This field is commonly used for longer fund names, information on a portfolio, etc. 

Memo Optional field is used for any internal notes. 
 

YYYYMMDD This field allows for you to specify in which format your date ranges appear.  Each unit 
(i.e., Y, M) stands for both the presence of a digit, and its value – in other words, YYYY 
shows the four digits for a year, and DD shows two digits for a day (06, 15, etc.) 

Secondary 
date field 

The options in this field are either 1% or FRAC.  This field regulates whether returns 
will be shown in percentages or fractions.  The default setting is 1% for percentages. 

Frequency The frequency field cannot be edited in this Series Edit box.  Frequency should be 
specified whenever a return series is created in MPI Stylus Pro; frequencies for 3rd 
party vendor databases may not be adjusted. 

Type This feature informs you of the type of database being used for your returns data and 
should never be changed. 

Currency This allows you to select the currency in which the fund’s returns are expressed. 

Country This option allows you to select the relevant country for the fund. 

Series Type This allows you to define the type of series: Return, Level or Change 

Warnings Click on this button to examine any problems MPI Stylus has with your data. 

Add Use this feature to add new dates. 

Delete Use this feature to delete a date/return line. 

Paste This allows you to paste in a larger number of dates and returns, such as a complete 
return series from a text file or spreadsheet. 

Copy This allows you to copy one or more returns from the Series Edit tool for Managers, 
Benchmarks and the Style Outline. To copy all returns, do not click in the Date/Return 
section when you open the Series Edit tool; simply select the Copy button instead. 

Figure 26 

 
Portfolio 
Note: This feature was known as the “Fund Editor” in previous versions of MPI Stylus. 
 
The ability to create a new portfolio in MPI Stylus has several possible applications.  Unlike the New Series 
tool, where dates and returns are entered, creating a new portfolio is a matter of understanding the 
assets you would like in your portfolio, expressed in terms of percentage allocations or dollar amounts.   
 
 
This process also makes it easy to create several fund-like investment tools, including: 
 

▪ Client portfolios for analysis 
▪ Hypothetical or suggested portfolios for comparison to client models 
▪ Blended benchmarks 
▪ Specialty “funds” that combine different share classes of the same fund 

 
Portfolio Editor 
 
The Portfolio Editor gives you a significant level of control in setting up portfolios, fund of funds, blended 
benchmarks, etc.  You may set these up as a “Simple” or “Advanced” portfolio, with each option explained 
below. 
 

IMPORTANT NOTE ON PORTFOLIO DATABASE LINKING 
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For users who wish to maintain a large number of portfolios in MPI Stylus Pro, we highly recommend 
Portfolio Database Linking as a component of your work process. This allows you to make allocation 
updates/changes and add or remove portfolios in a database environment, as opposed to manually in MPI 
Stylus Pro. This may be done in two ways: 
 

• Excel – All users may link Portfolios via Excel spreadsheet through Configurator. For more 
information, please see the Configurator chapter. 

• Other Databases – Using the Advanced Database package, users may link a database of portfolios 
into MPI Stylus Pro from typical database applications such as Access or SQL. For more 
information, please contact MPI Support. 

 
Simple Portfolio 
 
A Simple Portfolio implies the default buy and hold strategy, but also has an option to select automatic 
rebalancing for the data frequency.  This type of portfolio does not have multiple dates assigned to it and 
defaults to the common period for all selected time series. 
 
Advanced Portfolio 
 
The Advanced Portfolio allows for a rebalancing scheme selection and multiple date entries. 
 
Fields in both the Simple and Advanced Portfolios 
 

Field Function 

Label The label should be the portfolio, fund or blended index’s short, commonly accepted 
name, such as “S&P 500,” “Fidelity Contrafund,” etc.  This field determines what the 
series will be called by default in your studies. 

Database The default database for new portfolios is usually your SampleMng database; however, 
you may save a new portfolio in any editable database linked to MPI Stylus.  Make sure 
to note in which database a new series is stored so that you may find it later. 
 

ID 3rd party databases assign their funds unique ID numbers.  For a new return series, you 
may assign any ID # you like, as long as it is unique.  Please note that MPI Stylus imposes 
a 14-character functional limit on ID’s. 

Description This field is commonly used for longer fund names, information on a fund, etc. 

Memo Optional field is used for any internal notes. 
 

Figure 27 
Editor Tab 
 
The Editor Tab is used to select, apply weights to and (where applicable) rebalance assets.  It will have 
additional features when the Advanced Portfolio option is selected; these are indicated below.  
Otherwise, all features are found in both options. 
 

Control Function 

Select 
Assets 

Allows you to browse through your databases locating return series to be used as assets 
in your portfolio.  This was formerly called “Edit Assets.” 

Equal 
Weight 

Imposes an equally balanced weighting scheme on your portfolio’s assets.  For example, 
four assets in a portfolio would result in a weight of 25% being given to each. 

Sort The Sort option allows you to sort all of the assets currently included in your portfolio in 
ascending or descending order by database, ID, label, ticker, begin date, end date or 
weight size. 
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Groups Allows you to manage settings related to Manager Groups. 

Copy The Copy function allows you to easily select assets within a portfolio and then paste 
them into your design tree or another location. 

Paste The Paste function allows you to paste into your portfolio as assets any series currently 
stored on your computer clipboard. 

Rebalance 
checkbox 

The Rebalance checkbox only appears in the Simple Portfolio option and allows you to 
toggle between having no rebalancing scheme and using whatever the default would be 
based on data frequency.  For example, all monthly assets would lead to monthly 
rebalancing.  When this is the case, you will also see the period being used in this 
rebalancing listed below the checkbox. 

Label The label field allows you to manually enter the label for underlying series in a portfolio. 

Figure 28 
 
Advanced Portfolio Controls in the Editor Tab 

Control Function 

Rebalancing 
dropdown menu 

Allows you to choose a rebalancing scheme of daily, weekly, monthly, quarterly, 
annually or no rebalancing. 

Extend begin date Limits the portfolio date range at the beginning to common dates 

Extend end date Limits the portfolio date range at the end to common dates 

Add Date Allows you to add dates to your portfolio in order to insert specific cases of 
rebalancing or asset allocation. 

Duplicate Date This control adds the same date as the currently selected date, only one period 
later.  For example, if you selected 4/30/2006 and used this feature, it would add 
5/30/2006. 

Delete Date Allows you to delete the currently selected date. 

Figure 29 

 
Adding Extra Columns 
Users who wish to add cosmetic ‘extra columns’ in the Portfolio  Editor for their own convenience may do 
so. Note that these extra columns will not appear in, or be available as, columns in output. They are 
purely for the user’s internal purposes. 
 
There are two ways to add these columns: 
 

• Locally – Specific to a single portfolio and defined by using the ‘Extra Columns’ button to the right 
of the Asset list table. 

• Globally – Will be available in all Portfolios, and are defined via Configurator-> User Interface. 
 
In both cases, there are two features to note: 
 

• Label – Used to denote the extra column name 
Values – Retrieved from the asset database header. If the header has no field, then the value will be 
blank. 
 
Right-click Menu for Advanced Portfolio Dates 
 
For Advanced Portfolios only, a right-click menu has been added to allow you to work with date columns 
in several ways.   
 

Control Options Function 

Set date to Common 
period start 

The first date common to all assets will be used. 



MPI Stylus Pro  
 

Copyright 2005-2020, Markov Processes International, Inc.Page 74 

 

Common 
period end 

The last date common to all assets will be used. 

Total period 
start 

The first date available for any asset will be used. 

Total period 
end 

The last date available for any asset will be used. 

Add new 
date 

- Allows you to add dates to your portfolio in order to insert specific cases 
of rebalancing or asset allocation. 

Duplicate 
date 

- This control adds the same date as the currently selected date, only one 
period later.  For example, if you selected 4/30/2006 and used this 
feature, it would add 5/30/2006. 

Delete 
date 

- Allows you to delete the currently selected date. 

Equal 
Weights 

- Inserts equal weights for the date in question. 

Figure 30 

 
Returns Tab 
 
The Returns tab allows you to examine the returns for all assets currently selected in your portfolio and 
may be used for Simple and Advanced Portfolios. 
 
To Create a New Portfolio 

1. Click on the Managers node of your Design Tree, and then click on the “New” button in the data 
pane.  Choose “Portfolio.”  The Portfolio Edit box (see picture) will open. 

2. Choose a label for your new portfolio.  This will be the portfolio name as you would like it to 
appear in charts & tables. 

3. Choose the database for the portfolio to be stored in.  The default database is Funds (My Funds), 
and is recommended for all portfolios you create through this method. 

4. Assign an ID number to your portfolio.  This should be a unique name or number code, and has a 
14-character limit.  This name will have a .fnd extension attached by the program, and thus will 
be the actual file name of the portfolio. 

5. Enter a description of the portfolio.  Examples might include, “Test portfolio for Client A,” 
“Blended benchmark – 40% S&P500, 60% Wilshire,” etc. 

6. You have the option of entering a memo here for internal purposes.  This is a good place to 
include any extra notes you find relevant. 

7. Set your rebalancing here.  You may rebalance on any of the following periods: Daily, Weekly, 
Monthly, Quarterly, Annually, or no rebalancing.  

8.  
9. You are now ready to add dates and assets to your portfolio.  These can be added in any order. 
10. To add assets, click on the “Edit Assets” button.  A browse tool will open that will allow you to 

move between databases, selecting series as you see fit.  Note that field heading sort and search 
features may be used here.  When you have selected all the assets for your new fund or 
portfolio, click the green checkmark.  The assets will now appear listed in your Portfolio Edit box.  
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11. Now that you have selected your assets, you will want to add each date where a change occurred 
in the portfolio.  To add a date, click the “Add Date” button.  A calendar browse tool will appear.  
You may use the single arrows to browse by month, and the double arrows to browse by year.  
Once you have found the appropriate date, simply click on it to bring it into the Dates field of the 
Portfolio Edit box. 

12. The date you selected will now appear as a field.  For each series, there will be a 0.00000 
designation for the date in question.  Simply enter the percentage for each series’ allocation in 
your overall portfolio at that date.  The percentage must add up to 100.  In certain cases, it is 
possible that rounding issues will cause percentages to add up to 99.9999, 100.00002, etc.  MPI 
Stylus should operate normally in spite of this slight rounding digression.  Enter a date for each 
change you must make in portfolio allocation. 

13. You may delete a date at any time by clicking in the column/row that pertains to the date and 
using the “Delete Date” button. 

14. If you want to assign each element of the portfolio the exact same weight for a period, you may 
use the “Equal Weights” button instead of manually typing in the weights.  Please note that 
rounding situations may occur (for example, three funds equally weighted will result in a Total of 
99.999996. 

15. Save the portfolio by pressing the “Save” button.  You are now ready to work with the new 
portfolio in MPI Stylus. 

16. You may press the “Cancel” button at any time in this process to cancel your portfolio build. 
 
Adjust Series 
 
In addition to bringing in return series manually or through databases, users have the ability to make 
specific adjustment types to series. These are accessed through the ‘Adjust Series’ check box, found on 
the series preview Data Pane when you click a series in the Design Tree.To create the adjustments, the 
‘Add’ button must also be selected. 
 
 

 
Figure 31 

 
Adjusted Series Display 
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When a series is adjusted, the original and adjusted returns will both be visible. Only the adjusted returns 
for a series will be used for analytics. To use unadjusted returns as well, you would bring in a second 
version of the series and keep the default returns for that second series in place. 
 
Identifying an Adjusted Series 
When a series is adjusted, the series’ name will become italicized in the Design Tree for easy 
identification. 
 
Using Adjusted and Unadjusted Returns for a Series 

In order to allow use of both an original and adjusted series in the same study, users may bring the same 
series into the Design Tree multiple times by holding down the ‘Ctrl’ button and dragging the series in 
question to the Design Tree. 

 
The available adjustment types are: 
 
Series Shift 
This function moves a series’ returns forwards or backwards in time by the number of periods specified in 
the control. For example, to use lagged returns as an explanatory variable, you would choose the index in 
the Style Outline and select Lag periods 1 for a single period, 2 for two periods, etc. 
 
 
 
Operation with Series 

This option allows basic operations to be applied to the original series. The first control allows you to 
select the operation (multiplication, addition, etc.) and the second control defines the value. Specifically, 
the second control allows you to: 

 

• Manually enter a value (i.e., 12). An example use of this could be to multiply by a value to 
simulate leverage. 

• Select another series in the study from the pull-down menu. An example use could be to add or 
subtract two return series from one another. 

• Enter a macro (i.e., @DBF{@MNG{0,DBID}, @MNG{0,FILEID}, Expense Ratio}). This example 
would help you bring in a Manager’s Expense Ratio to then subtract from the return stream. 

 

Convert to Change 

This option will convert either a Level or Return series to a first difference, or (tn-tn-1).  If the original series’ 
type is Level, the conversion is done directly.  If the original series’ type is Return, ‘Price’ and ‘Date’ must 
be entered.  

 

Convert to Level 

This option creates an Index Value for a series given a specified base date. The first control, “Price,” sets 
the initial index level. The second control is the date of the initial level. There are three options for data 
entry: manual input, selecting from a calendar control or entering as a macro. Please note that the values 
entered are for the end of period; for example, a level of 1,000 entered for Dec. 15, 2003 will be treated 
as 1,000 as of December 31, 2003 for monthly data.) 

 

Convert to Return 

This option will treat the original series as levels (for example, NAV or Index Values) and convert them to a 
return series, taking: (tn-tn-1)/tn-1A\ 
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Convert to Currency 

This option will convert and maintain a series’ currency. For example, assume you have an original series 
in USD and convert it by dividing the Manager’s return in USD by the return in JPY (1+rMngUSD)/(1+rJPY)-1. In 
the study, the converted series will remain in JPY rather than be converted back to the Study’s currency as 
defined in Advanced Parameters. This provides the opportunity to show local currency returns. If the 
original series is in a currency other than USD, using ‘Convert to Currency’ and selecting the same 
currency (i.e., for a series in JPY, set the converted currency to JPY as well) will maintain the series’ 
original currency. 
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Truncate 

This option will limit a return series to a specified date range, eliminating values before the ‘From’ date 
and after the ‘To’ date. There are three options for the date entry: it can be entered manually, selected 
from a calendar control or entered as a macro. 

 

User Macro 

This option permits the entry of a macro in order to perform an operation that hasn’t been pre-defined in 
the drop-down list.  

 
 
Adjust Portfolio 
 
Similarly to the ‘Adjust Series’ option, the ‘Adjust Portfolio’ feature allows you to make changes to 
Portfolio returns before using them in charts and tables. Once the feature has been clicked, the dropdown 
tool is enabled and you may select the type of change you wish to make. 
Convert to Currency 
Enables the user to convert the portfolio information into another currency. 
 
Operation with Series/Portfolio 

This option allows basic operations to be applied to the original portfolio. The first control allows you to 
select the operation (multiplication, addition, etc.) and the second control defines the value. Specifically, 
the second control allows you to: 

• Manually enter a value (i.e., 12). An example use of this could be to multiply by a value to 
simulate leverage. 

• Select another series in the study from the pull-down menu. An example use could be to add or 
subtract two return series from one another. 

• Enter a macro (i.e., @DBF{@MNG{0,DBID}, @MNG{0,FILEID}, Expense Ratio}). This example 
would help you bring in a Manager’s Expense Ratio to then subtract from the return stream. 
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New Map 
 
The New Map button allows you to create custom Style Maps.  MPI Stylus comes with a large range of 
Style Maps meant to cater to different asset classes and investment interests.  Before creating a new map, 
we recommend that you first check the list of style maps provided by MPI in order to make sure there is 
no current map that fits your needs.   
 

 
Figure 32 

 
Many of the fields in this map you may recognize from other menus and edit boxes in MPI Stylus Pro.  The 
new fields to learn about are: 
 

1. Title – You may enter the title for your Style Map in this field.  You may change this later by using 
the Attributes Editor for the chart. 

2. X Axis – You may enter the appropriate legend (i.e., Value-Growth) for the X-axis in this field.  
You may change this later by using the Attributes Editor for the chart. 

3. Y Axis - You may enter the appropriate legend (i.e., Large-Small) for the Y-axis in this field.  You 
may change this later by using the Attributes Editor for the chart. 

4. Label/Db/Name – This field will display the underlying indices of your Style Map once they have 
been selected.  The Edit and Delete buttons will be used to add or remove these indices (please 
see “Creating a New Style Map” below. 

5. Visual Style Map grid – The visual Style Map grid displays the actual appearance of your Style 
Map, and allows you to specify clearly where you would like your indices to be located.  The 
double-grid exists to allow for rounding issues in Style Maps.  Theoretically, no point in a Style 
Map would be further from the center in the same direaction as a given index; however, 
rounding issues can cause points to exist outside the boundaries created by the indices.  
Therefore, it is suggested that you locate all Style Map index points within the boundaries of the 
gray four-square grid. 
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Creating a New Style Map 
 
To create a new Style Map: 
 

1. Click on the “Style Outline” node of your Design Tree and select New->Map in the data pane.  
(Note: This function may also be reached through numerous other modes.)  The Map Edit box 
will appear. 

2. Insert a label for your Style Map.  This is the name the map will be given in the database, on the 
Design Tree, and as the name that will appear in the Style Map chart block when you are 
selecting a relevant Style Map for chart creation. 

3. Choose in which database your map will be stored.  The default database of “StyleMaps” is highly 
recommended. 

4. Enter an ID for your Style Map.  This needs to be a unique name or number of no more than 
fourteen characters. 

5. In the Description field, enter a brief description of the new map’s purposes or coverage.  For 
example, “U.S. Corporate Bond/Mortgage/Cash Style Map.” 

6. The memo field is optional and should only be used to store internal information about the Style 
Map, such as the reason for its creation, the clients for which it ought be applied, etc. 

7. Assign a title for the Style Map, and for the X- and Y-axis.  These may be changed later. 
8. Click the “Edit” button to open the browse tool.  You may now move between databases and 

select any index you would like represented in your Style Map.  Check each index you wish to 
include.  When you are done, press the green checkmark to return to the Map Edit box. 

9. If you wish to delete an index at any time, click on the index in the “Label/Db/Name” field and 
then press the “Delete” button. 

10. All of the indices you have selected will now appear on top of one another in the center of your 
Style Map.  Using your mouse, click the black square that represents the topmost index, and drag 
it to the appropriate area of the Style Map.  The square representing the index you are currently 
clicked on will turn red.  Please note that we do not recommend having more than six indices in 
one Style Map.   

11. Beneath each square will be a plot point in parentheses that tells you the current location of the 
dot on the Style Map.  You may use these to ensure that the points are evenly spaced or 
otherwise in the correct position. 

12. When you are finished, click the “Save” button to save your new map, or click “Cancel” to discard 
the map at any time. 

13. You may now go to the “Style Outline” node on your Design Tree and use the ellipse button to 
browse to the appropriate database and find your Style Map.  Once you select it, you may click 
on its name on the Design Tree to examine its setup, or click on the name of any of the 
underlying indices to see their specifics and returns. 

 

Refresh 
 
The Refresh button is useful when you are working with external databases in MPI Stylus.  Pressing the 
Refresh button updates all of the information in your data pane/design tree. 
 

Delete 
 
The Delete button allows you to delete managers, style maps, peer groups, indices, etc.  Deleted items are 
permanently erased – they do not go to your computer’s Recycle Bin. 
 
To delete something from a data pane: 
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1. Select the item you wish to delete with your mouse.  It will be highlighted. 
2. Press the “Delete” button. 
3. You will be asked if you are sure you would like to delete the file in question.  Click “Yes” to 

delete or “No” to cancel. 
 

Move 
 
The Move function allows you to move a file (for example, a manager) from any editable database to any 
other editable database (note that many 3rd party databases are not editable).  To move a portfolio, style 
map, etc., from one database to another: 
 

1. In the data pane, open the database that currently contains the item you wish to move. 
2. Locate the item and select it with your mouse.  The “Move” button will become enabled. 
3. Click the “Move” button and browse to the database to which you would like the selected file 

moved. 
4. If the move cannot be made, you will receive a pop-up window informing you it was unable to 

move the item between databases. 
5. If the move can be made, you will receive a request for confirmation for moving the file from one 

database to the next.  Carefully check that you are using the correct file and databases, and then 
press “Yes.” 

6. You may press the red “X” or answer “No” to the move pop-up to cancel the moving process. 
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Output Tabs in MPI Stylus Pro 

 

 
 
Output tabs in MPI Stylus may be found along the bottom of your screen in any of the modules, and are 
used to allow the user to see the relevant output for a given study.  The only output tab present in every 
study in all modules is the Designer Tab, which contains the Design Tree for the study/module. 
 
Output Tabs in Reporting Modules – Stylus, Integrator, Allocator 
The output tabs in the three reporting modules in MPI Stylus (Stylus, Integrator and Allocator) will always 
be correlated to the views and reports listed on the design tree in the study.  If a view or report is not 
checked on the study, then its corresponding tab will not appear.   
 
Output Tabs in Prospector 
MPI Prospector is not a reporting module and has no Views or Reports nodes; therefore, its output tabs 
will be focused on helping the user fulfill Prospector’s main functions – peer group editing and manager 
searches.   
 
Output tab 
Every Prospector study will have two tabs automatically – the Designer tab, where the design tree is kept, 
and the Output tab.  In a new Prospector study, the Output tab will automatically contain a “Table1” that 
is controlled under Output-> View in the design tree.  The contents of this table will be expandable 
depending on the source brought into the study, and any analytics the user chooses to create.   
 
Source Tab (i.e., Morningstar, Lipper, etc.) 
An additional tab will be added for each source brought into the study through the Source node.  A source 
tab will bear the “Dbname” of its corresponding source; for example, a Morningstar source would result 
in an “Mstar” tab, a HFR Hedge Fund database source would result in “HFR,” etc. 

 
Working with Output Tabs 
 
Output tabs are an important part of MPI Stylus, and are very simple to work with.   
 
Creating an Output Tab 
The only Output tab that cannot be created or destroyed is the Designer tab, which will be present in all 
studies.  Otherwise, the Output tab that you create will always be a function of the work you are doing in 
a given module – Output tabs do not exist for their own purposes, but are rather tied to a given task.  
Therefore, please consult the table below for the sections of each module that affect output tabs.  You 
may then consult that section of this manual. 
 

Module Output Tab Created By? 

All Designer -- 

Stylus View Tab Making a new View 

 Report Tab Making a new Report 

Prospector Source Tab Selecting a source in the Source Node 

 Output Tab Always present 

Integrator View Tab Making a new View 

 Report Tab Making a new Report 

Allocator View Tab Making a new View 

 Report Tab Making a new Report 

Figure 33 
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Renaming an Output tab 
View or Report output tabs may be renamed by renaming their corresponding view or report on the 
design tree or in the data pane.  Likewise, the Source tab in Prospector will always bear the name of the 
source as listed in the design tree; therefore, a change to the name in the design tree will also change the 
tab.  The Designer tab in all modules, and the Output tab in Prospector, may not be renamed. 
 
Hiding/Unhiding an Output tab 
View and Report output tabs may be hidden (without deleting their content) by deselecting their 
corresponding view or report on the design tree.  This allows you to control how many tabs are displayed 
at the bottom of your screen and makes for a more efficient workspace. The Designer tab in all modules, 
and output tabs in Prospector, may never be hidden. 
 
To hide/unhide an output tab: 
 

1. On the design tree in the Views or Reports nodes, locate the View or Report output tab you wish 
to hide. 

2. Click on the check box next to the output tab.  The box will become unchecked and the tab will 
disappear from the bottom of your screen.  The tab information will still be stored on your design 
tree. 

3. If you wish to see the tab again, simply recheck the box next to the View or Report on the design 
tree.  The tab will reappear. 

 
Scrolling through Multiple Output tabs 
When more output tabs have been created than may fit along the bottom of the screen, MPI Stylus will 
automatically enable a scrolling control that will allow the user to access tabs that may not be visible on 
your screen due to the high number of tabs.  The user may avoid this by hiding/unhiding tabs (see 
previous section) in order to only see tabs he or she is currently using.   
 
To scroll through output tabs: 
 

1. The output tab control arrows will only appear when there are too many output tabs on the 
bottom of your screen to be shown.   

2. To scroll through the tabs when these controls are visible, click one of the two arrows pointing in 
the direction you wish to move.  The simple arrow (the inside pair) will move you one tab to the 
right or left; the arrows pointing to lines (the outside pair) will move you to the last tab on either 
the right or the left. 

 

 
 

3. Please note that the design tree is located on the Designer tab; therefore, even if you click 
through numerous tabs (more than may be displayed on screen), the Designer tab will remain 
visible for ease of use.   
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Overview 
 

MPI Stylus is the module that 
allows users to create their own 
research and reporting solutions 
and applications.  Users can 
generate comprehensive 
performance-based statistics and 
publish professional-quality 
reports in multiple formats.   

 

Chapter 4 

MPI Stylus 
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Chapter 4 

MPI Stylus 

Introduction to MPI Stylus 

 
The MPI Stylus module is the most widely used element of the MPI Stylus Pro application, and represents 
much of the true power behind MPI’s powerful research and reporting solutions.   
 
MPI Stylus allows you to perform and report on analysis by: 
 

▪ Identifying and monitoring portfolio styles over periods of time 
▪ Understanding the factors responsible for a fund’s performance 
▪ Comparing fund or portfolio performance to benchmarks, peer groups, style indices and to 3rd 

party or user-provided return streams 
▪ Leveraging a comprehensive set of performance-based statistics 

 
Getting Started in MPI Stylus 
 
All modules in MPI Stylus Pro can essentially be divided into four parts: 
 

1. Main Menu. This appears across the top of your screen and is used to open, run and save studies. 
2. Design Tree. The Design Tree is found on the left side of your study and is used to navigate 

through the various major elements of your research and reporting. 
3. Data Pane. The Data Pane is found on the right side of your study and is used to interact with the 

application. 
4. Output tabs. These are found along the bottom of your study and are used to view output. 

 
For more information about these elements, please see Chapter 3. 
 

Working with Stylus Studies 

 
MPI Stylus studies may be created, edited, and deleted like all other files in the application.  For more 
information, please see Chapter 3.   
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Stylus Design Tree 

 
The MPI Stylus design tree is the backbone of the Stylus module and provides an easy and consistent 
method for users to quickly create or edit their analysis. 
 

 
Figure 34 

 
Design trees in MPI Stylus Pro are always made up of nodes.  Nodes represent specific concepts or types 
of information that are important for your analysis. The nodes in MPI Stylus are: 
 

Node  Symbol Description Function 

Input Nodes 

 Managers Regulates the funds/portfolios examined in the study. 

 Parameters This node contains a variety of date, analytical and 
other background information that controls the way 
the analytical engine for the module works.  

 Style Outline Regulates Style Outline/Style Map information. 

 Peer Groups This is where you will add peer groups for comparing 
managers to broader families of funds. 

 Benchmark This is where you will add one or more benchmarks to 
your study. 

 Hedge Groups This rarely used node is specifically for entering assets 
that are being hedged against. 

 Dictionaries This node is used for controlling Dictionaries in the 
application. 

Output Nodes 

 Views Your personal library of charts, tables and memos. 

 Reports Your publishable output. 

Figure 35 
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In addition, there is also the Study node at the top of the design tree.  This section governs a variety of 
study-wide settings, including automation, color and symbol conformity settings, etc.  For more 
information, please see Chapter 3. 
 
When designing your analysis, you will move down the list of design tree nodes to input the information 
necessary and then to create, view and organize output. 
 

Input Nodes 
 
The input nodes of your design tree will regulate the information you wish to add to your analysis, 
including funds/portfolios, benchmarks, peer groups, style maps, etc.  Although you do not need to 
populate all nodes in order to run analysis, Stylus will be unable to run any analysis without a certain 
amount of information available (such as return series) to populate output. 

 
Managers Node 
 
The Managers node of the design tree is typically the first node you will visit when constructing a new 
analysis or editing a study/template.  This node controls or allows you to view: 
 

▪ Funds or portfolios included in your study 
▪ The source database(s) from which funds will be selected (i.e., Morningstar) 
▪ Examination and editing (where allowable) of fund return series 
▪ All basic information about a particular fund (inception date, currency, frequency, etc.) 

 
In addition, the Managers node can be used to examine all the fields being imported from a given source.   
 
Selecting a Manager 
 
To select a new manager in Stylus: 
 

1. Click on the Managers node of the design tree.  In the data pane, you will see the list of available 
funds/portfolios in your database. 

2. To switch databases, click the (…) button at the end of the database line.  You can then browse to 
the appropriate database.   

3. To select a manager, you may click the check box to the left of the manager, double-click the 
manager’s name in the data pane, or drag the manager’s name to the Managers node with your 
mouse.  It will then appear on the design tree. 

 
Finding Managers 
 
Using the Search box (‘S’ box) 
The Search box is a convenient way to quickly find managers, benchmarks, etc., allowing you to search 
one or more columns simultaneously for text strings or numbers. For more information, please see 
“Searching Options in MPI Stylus Pro” in Chapter 3. 
 
 
 
Using QuickFilters 
You may use QuickFilters to help you quickly identify the Manager(s) you require.  For more information, 
please see “Using QuickFilters” in Chapter 3.  
 
Viewing Manager Information and Return Streams 
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By clicking on a manager’s name on the design tree, you may view the following information: 
 

▪ Fund name 
▪ The database where the fund’s return stream is located 
▪ Unique ID number 
▪ Basic memo information 
▪ Series adjustments if they’ve been applied 
▪ Date format 
▪ Return units (percent or fraction) 
▪ Frequency of returns (i.e., monthly, quarterly) 
▪ Database type 
▪ Series Type 
▪ Currency 
▪ Country of origin/currency 
▪ Return stream 
▪ Warnings (if any) about the returns data 
▪ Since Inception information, including: 

o Start date 
o End date 
o Fractional return 
o Total return 

 
List Selection  
Starting with version 11.3 Stylus provides an additional tab for selecting managers. In addition to 
Database Selection, there is now the List Selection tab. This allows user to select a manager from the 
fund list previously set up by the user. See Stylus Workspace section of the manual.  
 
Editing Manager Information 
 
In some cases, it may be possible to edit manager information through the Managers node.  This will not 
be possible for 3rd party databases of other data streams downloaded through MPI; it is rather meant for 
new funds/series created by the user within MPI Stylus Pro. 
 
To edit a manager: 
 

1. Click on the manager’s name in the design tree to bring up the manager information in the data 
pane. 

2. Click the “Edit” button (if it is not activated then the funds may not be edited.)   
3. The Series Edit or Portfolio Edit menu will open.  For more information on this item, please see 

Chapter 3. 
 
Manager Groups – Organizing Managers 
 
Users may add ‘groups’ to the Design Tree in order to allow for more structure and organization, 
especially for larger lists of Managers. These Manager Groups can then be to quickly check/uncheck all 
Managers in a group, and can serve other useful purposes as well. 
 
 
Creating a new Manager Group 
 

1. On the Design Tree node, right-click on the Managers node and select ‘Add Group’. A new Group 
will appear, with the name syntax ‘Group#’, where # is the lowest available integer not used by 
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another Group. For example, if you have created five groups and renamed them all, a new Group 
would be called Group1. 

2. You may now add, delete and reposition Managers within this Group as you would in the Design 
Tree.  

 
Checking/Unchecking Managers/Manager Groups 
 

3. You can individually check/uncheck specific Managers within the Group, or you can 
check/uncheck the entire Group, which would affect all underlying Managers. Please note that 
Stylus will ‘remember’ your selections; in other words, if a Group has four Managers and then 
you individually uncheck two, and then uncheck/recheck the entire Group, those two Managers 
will remain unchecked. 

a. In addition to checking/unchecking the Group, you can also right-click on the Group and 
select ‘Enable all’ or ‘Disable all’. While ‘Disable all’ works the same as unchecking the 
group, ‘Enable all’ does not. When this option is selected, all Group funds are checked, 
even if they were not formerly checked under the Group. 

 
Locking Groups 
 

4. Users may select to ‘Lock’ a Group, which would mean that it cannot be disabled/unchecked as a 
Group, nor can any underlying series in it be disabled/unchecked. This is helpful in preventing 
accidental deletion. 

5. Please note that when a Group has been locked, adding additional Managers to the Group will 
not lock those Managers within the Group. They will be available for checking/unchecking, 
addition and deletion. Managers that were in the Group at the time of the locking will remain 
locked. Users may select ‘Lock’ again when this happens to include any new series in the ‘Lock’. 

6. To unlock a Group, simply right-click and select ‘Unlock’. 
 
Group Properties 
Also available on the right-click menu is ‘Properties’, which brings you to Properties for the relevant 
Manager Group. 
 
Load underlying assets 
Currently, Properties relates entirely to Portfolios. When checked, the underlying assets of the Portfolio(s) 
in the Group will also be added as constituents.  
 
Use current (non-zero) assets only 
This option is enabled only when ‘Load underlying assets’ is checked. When this option is also checked, 
only current assets with weights for the most recent portfolio returns date will be introduced as 
standalone assets in the group. Older assets that are no longer portfolio constituents will not be added. 
 
Warnings 
 
The Warnings button at the bottom of the manager data pane will automatically be highlighted in cases 
where MPI Stylus detects problems or inconsistencies in the return data.  This may be because of missing 
or incorrect dates, improperly formatted returns, or other causes.  When there are no warnings, this 
button will appear inactive. 
 

 
 
 

When MPI Stylus does detect a problem, this button will become activated and may be clicked on. 
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When the Warnings button is clicked, the Returns Verification screen will open.  You will be able to view 
the entire return stream for the fund in question and there will be a pane explaining the problems 
detected, and any steps taken to correct this problem.  In the example below, the program has detected a 
return linked to the beginning of a month and adjusted it to the month end date.  It should be noted that 
missing returns can affect your analysis, whereas adjusted/extra returns generally will not. 
 

Parameters Node 
 

 
Figure 36 

 
The Parameters node contains a variety of important study-wide information, some of which will require 
attention with every study but most of which will seldom require any user changes.  Many of the detailed 
elements seldom requiring adjustment will be located under the “Advanced” section of the tab, and 
should not be changed unless there is a specific reason for doing so, as changes in this section can 
dramatically affect your analysis. 
 
Engine Type 
 
This option set will only be visible to users who subscribe to our Hedge advanced package (which contains 
Dynamic Style Analysis).  
 
Sharpe/LWR 
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This is the default setting in MPI Stylus Pro. Any user who does not subscribe to Hedge, and thus does not 
see the ‘Engine Type’ feature set, is automatically working in the Sharpe/LWR space. This essentially 
means that their Style Analysis will run under the Locally Weighted Regression model, using windows 
(unless Single Computation is checked) to inform their analysis. 
 
MPI/Dynamic 
This option set switches to the Dynamic Style Analysis (DSA) model. For more information, please see our 
DSA User Guide, available from MPI. 
 
 
Use Common Range for General and Style Analysis 
 
This option is useful in situations where your study timeline length needs to be longer than would be 
allowed by your Style Outline indices, which curtail the length of a study in their default setting. When this 
option is unchecked, a second study timeline is created that allows you to run simple statistics (unrelated 
to the Style Outline) over longer time periods, while continuing to run Style Outline-driven statistics for 
the shorter, relevant period. 
 
Date Range scrollbar 
 

 
 
The date range scrollbar allows you to specify the range of dates for which data points will be available in 
your analysis. This range may consist of: 
 

▪ Interval, in which both the start and end date must be specified, and all data points (inclusive) 
between the two dates will be available 

▪ Last, in which the last X number of periods may be used to regulate available data points.   
▪ First, in which the first X number of periods may be used to regulate available data points. 

 
In the case of Last and First, the timeline will not be separately controllable and will need no adjustment 
from the user.  However, in the case of Interval, the scrollbar will be used to specify the exact date range 
to be used. In addition, interval is one of the only two time configuration settings that allows for back 
testing (because it allows you to adjust the end date); the other is the First option. 
 
In addition to the Parameters node controls, MPI Stylus Pro allows you to specify the date range you 
would like to view on a chart-by-chart (or table-by-table) basis; therefore, it is recommended that you 
allow as much data as possible in the Parameters node and institute controls on particular charts or 
tables. 
 
Interval 
The interval option allows you to specify the date range to be used for your study.  You may do this 
manually by following the instructions below; however, some of this may be done automatically through 
Stylus itself, as well as through the use of the Limit function. 
 
When the beginning and end sliders on the date range scrollbar are at the leftmost and rightmost 
positions, all available manager data is being used in the analysis.  If there are style indices selected in the 
Style Outline, the date range will automatically default to the beginning of the most recent return series 
(which may be a manager or style index) for its beginning (from) date.  Otherwise, the date range may be 
limited by the Limit function. 
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It is possible for differences to exist in the time bar length between the dates at the top of the time bar 
and those at the bottom.  The top dates reflect the range available for reporting, while the bottom dates 
reflect the range available for analysis.  Note that the top and bottom date ranges will coincide with one 
another when “Use Single Computation” or “Style in first point” and “Style in last point” (advanced 
parameters) are selected in the Parameters node. 
 
Pushpin buttons 
The pushpin buttons give you control over date range updates and adjustments for your study.  When the 
pins are pushed in, the bottom dates on the date range scrollbar become gray and you may no longer 
adjust the date range. This locks the slider and lets your study adjust the “To” date to the most recent 
data point whenever you update your data.  When you update your database feeds and open the study, 
the date range will automatically include the most recent returns. 
 
If one or both pushpin buttons are not pushed down, the bottom dates on the scrollbar will have red and 
blue sliders which you may adjust with your mouse.  The data available in your analysis will change as the 
slider moves. 
 
 
First/Last 
The First and Last options for date range allow you to specify a period length (from the start or end of the 
total date range) for which data will be available.  The date range scrollbar becomes disabled and instead 
only shows the range specified by the period controls.  You can then enter the number and type of 
periods you wish to analyze. 
 
+fraction 
The +fraction option allows you to include any fractional parts of a selected date range.  This allows you to 
start with the beginning of a calendar period and to use the latest available dates past a period.  Without 
+fraction selected, the date range will coincide precisely with the specified periods you have requested. 
 
Limit 
 
The Limit feature allows you to specify how Stylus should interpret available date ranges from your return 
series.  The limit becomes especially important when you have multiple funds selected for analysis; 
however, even a single fund may be limited by style indices or the benchmark.  You have three options: 
 

▪ Use Managers’ Dates 
▪ Use Common Dates 
▪ None 
▪ Limit to Common End Dates 

 
Use Managers’ Dates 
The Use Managers’ Dates option will allow all the available data from your return series to be considered 
for analysis, even if you have multiple funds selected with different series length.  For example, if you are 
analyzing two funds – one from 1968 and one from 2001 – the Use Managers’ Dates option will allow you 
to show data from 1968 forwards in your charts and tables. 
 
The important exception to this is that the fund may still be limited by other return series, such as style 
indices.  Remember that Cash is always present on the design tree, and thus can always be limiting your 
analysis dates. 
 
Use Common Dates 
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The Use Common Dates option allows for an apples-to-apples comparison of return series by limiting the 
date range interval to time periods common to all selected return series.  For example, if you are 
analyzing two funds – one from 1968 and one from 2001 – the Use Common Dates option will allow you 
to show data from 2001 forwards in your charts and tables. 
 
None 
The None option will only constrain your analysis by the earliest date of the longest return series, 
regardless of the type of series or node in which it is located. 
 
Limit to Common End Dates 
This feature allows you to limit your study to the last available date for all series, which can be helpful if 
one or more managers have been updated ahead of schedule, or when managers with old data need to 
be displayed in a report. 
 
Computations 
 
The computations area is used to determine the average portfolio style during a specified period, to 
analyze the dynamic of the portfolio’s style and to monitor style changes. 
 

 
 
Use Single Computation 
Use Single Computation gives the user the average style for your date range.  When this option is 
selected, the window size is equal to the total length of the range, and the Window scrollbar does not 
appear. 
 
Multiple Computations 
When you uncheck “Use Single Computation” and use multiple computations instead, you can define the 
length of the moving window by sliding the circle along the line.  The length of the window and number of 
computations are shown to the right of the slider and the date changes accordingly. 
 
The length of the window controls the degree to which MPI Stylus is capable of suppressing noise in the 
data.  The longer the window, the larger the proportion of noise that is filtered out.  When the window is 
too long, though, the ability to detect changes in the portfolio’s asset allocation becomes very limited. 
 
The selection of the “right” window size is more an art than a science, and involves taking multiple factors 
into account, including: 
 

▪ Periodicity of returns 
▪ Style dynamic 
▪ Market conditions during the period being analyzed 
▪ Style outline 
▪ Purpose of the analysis 

 
Default settings are generally recommended for this tool because they tend to work well in most cases. 
 
Frequency 
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Use Common Frequency 
The Use Common Frequency option allows you to change the frequency of return data in cases where one 
or more return series use different data frequencies.  In most cases, higher frequency means higher 
accuracy of analysis; therefore, MPI Stylus tries to use the highest possible common frequency of returns 
by default. 
 
Nevertheless, there are several cases where a lower frequency may be called for.  An example might be 
the analysis of an international portfolio, when times for computing end-of-day returns will differ from 
those used in the computation of major style indices. 
 
Forced Data Frequency 
If you wish to force a particular data frequency, simply uncheck “Use Common Frequency” and select one 
of the available options.  In addition to four period options (weekly, monthly, quarterly, annual) there is 
also a None option, which preserves frequencies for each return series. 
 
Holdings 
 

 
 
Use Long Only Holdings 
The Use Long Only Holdings option disallows short positions in analysis of return series, and is the default 
setting for this area.  When this option is selected, all return series will be held to this standard. 
 
Holdings Options 
In most cases, the accuracy of style analysis can be improved by a priori information about the analyzed 
portfolio, particularly information regarding limitations and restrictions of the investment policy. The 
most common piece of information available to an analyst is the knowledge of the rules with respect to 
leveraging and short selling. This information can be mathematically expressed in terms of the constraints 
on the values of the asset loadings. The corresponding model is called the constrained regression model. 
 
Use Long Only Holdings is the default setting, which will be sufficient for an analysis in most cases. On the 
other hand, when you know or strongly suspect that leverage and/or hedging is being used, you should 
deselect the Use Long Only Holdings check box and make use of the other Holdings options. 
 
When you uncheck “Use Long Only Holdings,” you have the ability to select five different holdings 
interpretations: 
 

▪ Long only 
▪ Individual 
▪ No constraints 
▪ Leveraged 
▪ Short 
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These options allow you to specify relevant elements of the investment policies used by the portfolio 
manager. MPI Stylus uses this information to specify constraints for the optimization model.   
 
MPI Stylus supports several optimization models. Based on the information you supply, MPI Stylus selects 
the appropriate model for each specific analysis. Specifically: 
 
Multiple Linear Regression is used when the Use Long Only Holdings check box is unchecked and the No 
Constraints option is selected on the Data Pane of the Parameters node. See Constraints Specifications for 
more information. 
 
Constrained Regression is the default model and is used unless the No Constraints option is specified on 
the Data Pane of the Parameters node. 
 
Asset-based (CAPM) model is the default. The Effects Based (APT) model is used when the Effects-based 
(APT) check box on the Data Pane of the Advanced node is checked. 
 
Long Only 
Long only indicates that no leverage or short selling is allowed, so using this option is equivalent to having 
left the check box Use Long Only Holdings selected. 
 
Individual 
Individual is the most flexible option, permitting you to specify constraints on any element of the Style 
Outline. 
 
Leveraged 
Leveraged allows you to specify the maximum permissible leverage. 
 
No constraints 
No Constraints directs MPI Stylus not to use a priori information. The ability of the software to suppress 
noise in the data is limited when this option is set.  When the No Constraints option is checked, MPI Stylus 
uses the multiple linear regression model. This allows you to find asset loading that ensures the best fit to 
the historical returns data. In some cases, the results may be distorted by noise in the data. 
 
Short 
Short allows you to specify the maximum permissible short position. 
 
Index Selection Model 
 
The Index Selection model assists the user in adding indices to the Style Outline that provide the most 
meaningful result versus their selected manager(s). It seeks to do this by maximizing Predicted R-Squared, 
MPI’s proprietary measure of predictive power. The options are: 
 
All Indexes 
This option is the default, and will use all indexes selected by the user on the Style Outline for the 
regression. 
 
Full Search 
The Full Search option brings the power of running all iterations and combinations of style indices to your 
analysis. This is modified by a Forward/Backward toggle and a “Full Search Depth” feature. 
 

• Forward caps the maximum number of indices that can be included. For example, with 6 possible 
indices and a “Full Search Depth” of 4, the forward full search will return a combination of 1 to 4 
indices for input to the style analysis. 
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• Backward caps the maximum number of indices to be excluded. For example, with 6 possible 
indices and a “Full Search Depth” of 4, the backward search will return a combination of 2 to 6 
indices for input to the style analysis. 

 
Stepwise 
The Stepwise Functionality mirrors the old “Smart Front/Smart Back” functionality of versions 7.0 and 
earlier. Essentially, the model runs through the indices by either adding them (Front) or removing them 
(Back) and checking if each index’s addition/removal affects Predicted-R2 for the better or the worse. In 
both cases, the application runs through two iterations of the available indices before producing results. 
Please note that the old basic Front and Back features have been removed. 
 
 
Combined 
This option first performs the “Full Search” and then the “Stepwise” options both. For example, with a 
total of 6 indices and a Full Search depth of 4, the Forward Combined search would turn up four indices 
from the Full Search, and these results will then be compared with supersets with 5 and 6 indices in them 
in a stepwise search. 
 
Apply to Benchmark 
Apply to Peer Group 
These options apply the same index selection model to the style analysis for the benchmark and peer 
group members as for the managers. If unchecked, these style analyses employ the “Use All Indexes” 
model. 
 
Currency 
 
The currency menu allows you to specify the currency in which you want dollar amounts expressed in MPI 
Stylus Pro.  For a complete list of supported currencies, please see Chapter 3.  It should be noted that the 
currency option here is not the same as the currency in the Series Edit box. 
 
Cash 
 
The Cash feature allows you to specify the cash proxy for your study.  In MPI Stylus Pro, the default is 
normally the 3-month T-bill total return index; however, this may be changed in MPI Configurator.  
Therefore, always make sure to check which proxy is specified in your study.   
 
There are two fields in the cash area. The first field displays the name of the database (i.e,, US Fixed) 
where the cash proxy return series is located, and the second field displays the name of the file 
representing this series.  
 
To change cash proxy: 
 

1. Click the ellipsis (…) button at the end of the Cash line to open the browse utility. 
2. If you need to change databases to find your file, you may do so by clicking the (…) button at the 

end of the database line in the browse utility. 
3. Once you have located the correct database, double-click the name of the index you wish to use 

for your proxy.  Alternately, you may click the name once and then press the green checkmark. 
 
View Cash Series 
The ‘Series View’ button also appears here. This allows you to quickly open the ‘Series View’ window to 
see the series, including returns, dates, etc. 
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Advanced Parameters 
 
Advanced parameters in MPI Stylus Pro represent a variety of elements affecting your analysis, and 
should only be changed by experience users with explicit reasons for making changes.  Any changes made 
in this section can dramatically affect your analysis, and the defaults have been designed to work with 
most analyses. 

 

 
Figure 37 

 
Model Type 
 
Capital Asset Pricing Model (CAPM) differs from Arbitrage Pricing Theory (APT) in one respect.  In CAPM, 
asset loadings of style indices are forced to total 100% - this is not the case in APT.  In all other respects, 
these models are equivalent; use the information below as a general guide for selecting the appropriate 
model. 
 
CAPM (asset-based) 
CAPM is the default setting for model type and should be used when style indices are proxies of assets. 
 
APT (effects-based) 
APT should be used to perform fundamental analyses of portfolios when style indices are not assets, but 
rather values of fundamental factors that determine securities prices (such as earnings growth, dividend 
yield and capitalization) and/or economic factors (such as money supply, rate of inflation, economic 
growth, etc.) 
 
Intercept 
This checkbox option provides the opportunity to perform Style Analysis with or without an intercept. In 
earlier versions of MPI Stylus Pro, Style Analysis was calculated with an intercept – which remains the 
default setting. When this is used, the intercept is a component of Selection Return (Manager Return – 
Style Return), but it is equivalent to the Intercept (Alpha on the Performance block) plus the residual term 
(Error on the Performance block). When Intercept is unchecked, Selection Return is equal to the residual. 
 
 
 



MPI Stylus Pro  
 

Copyright 2005-2020, Markov Processes International, Inc.Page 98 

 

 
Window Position 
 
The window position determines which months will be included in the analysis.  For example, assume that 
you want to determine asset loadings of a portfolio as of the end of December 1995, using monthly return 
data and a twenty-four month window.  The obvious question becomes, which twenty four months of 
data should be used? 
 

 
Figure 38 

 
Trailing 
The trailing window option works well when asset allocation remains approximately constant during all 
time periods covered by a window but is subject to substantial error when allocations change frequently.  
(This problem can be alleviated somewhat by weighting returns in the window.) 
 
In the case above, the trailing window would cover a period from January 1993 to December 1995. 
 
Centered 
The centered window option (default) is more robust than the trailing window because it captures 
changes in a portfolio’s asset loadings more accurately. (When the portfolio style is stable, trailing and 
centered windows are equally accurate; in dynamic portfolios, centered is preferable.) 
 
In the case above, twelve monthly returns prior to the point of estimate (trailing) and twelve monthly 
returns following the point of estimate (leading) would be used for the window, giving a range of January 
1994 to December 1996. 
 
Custom 
This option allows you to specify exact window position on a percentage basis (50% would be the same as 
centered; 100% would be the same as trailing.)  To adjust window position, you will simply need to move 
the circle along the slider tool. 
 
Calculations 
 
Calculations options allow you to fine-tune your analysis.  The five available options are: 
 

▪ Style in first point 
▪ Style in last point 
▪ Use log returns 
▪ Use portfolio composites 
▪ Perform style analysis on Peer Groups 

 
Style in first point 
Style in last point 
 
When the moving window technique is used to estimate asset loadings, the number of full regression 
windows is smaller than the number of available portfolio returns. As a result, portfolio style in certain 
points cannot be directly calculated. 
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In the case of trailing window analysis, asset loadings in the first n-1 (n is the window size) data points are 
not defined. When a centered window is used, asset loadings in the first (n-1)/2 and the last (n-1)/2 data 
points are not defined (assuming that n is odd). 
 
By checking Style in First Point and Style in Last Point, you direct MPI Stylus to extrapolate the results of 
the analysis in order to compute estimates of asset loads in these points. 
 
Use log returns 
This option simply instructs MPI Stylus to use logarithms of all returns in calculating asset loadings. 
 
Use Portfolio Composites 
This option only affects analysis for funds’ returns (.fnd files). When checked, only the fund’s composite 
returns are used as inputs, even though the underlying portfolio returns and respective weights remain 
available. When this option is not checked, all of this information will be used for analysis. 
 
Perform Style Analysis on peer groups 
This option allows style analysis calculations to be performed on peer groups. Please note that, in the case 
of larger peer universes, this can significantly affect study run times. 
 
Return Weighting Scheme 
 

 
Figure 39 

 
Rapid changes in portfolio asset allocation may lead to substantial errors in determining an effective asset 
mix of the portfolio, especially when a trailing window is used.  Locally Weighted Regression (LWR) 
alleviates this problem by incorporating both weighted returns around the point of estimate and 
centering the point of estimates.  Weighing returns assign more importance to the more recent return 
data, and centering the point of estimate balances the return data. 
 
Use Weights 
The Use Weights check box allows you to instruct MPI Stylus to use weighted returns.  If you do not select 
this, the other options in this area (Half-life, etc.) will become unnecessary and disappear. 
 
If you do select the Use weights check box in the Return Weighting Scheme group, the weighting decay 
factors appear and the analysis uses exponential weighting of returns. 
 
HALF-LIFE SETTINGS 
It should be noted that only one of the three half-life settings may be adjusted at any time, as the 
remaining settings are a function of the setting you select.  Regardless, you are simply determining how 
heavily the returns closer to the point of estimate are weighted in comparison to returns that are further-
removed. 
 
Half-life (window size) 
The point at which the return weight has been reduced to 50%.  For a 24-month window, a 1.0 setting 
would mean that the 24th return from the point of estimate would be weighted at 50%.  The half-life in 
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months would be 24.  If the half-life in months were set to 12 for a 24-month window, the half-life in 
terms if window size would be .5 (12/24=.5). 
 
 
Half-life (frequency of returns) 
This option allows the user to specify half-life in terms of frequency (i.e., months) as opposed to window 
size.  Please see the above explanation for how half-life in window size relates to half-life in months. 
 
Decay factor 
This feature provides a third method for entering half-life.  Decay factor is the exponential factor that 
must be applied to arrive at the designated half-life.  It is the amount by which the returns are reduced in 
each period exp[(1-decay factor)*n]. 
 
Output 
 
Initial Investment Value 
This field may be used to specify (in dollars) the initial investment value to be considered in any 
cumulative growth/wealth charts or tables. 
 
Fiscal Year-end month 
The fiscal year-end month setting may be used to specify the correct ending month for a fiscal year.  The 
default setting is 12 (December), but this may be changed to any other month by specifying that month’s 
number in the calendar year (i.e., June would be 6.) 
 
Annual Minimum Acceptable Return (MAR) 
The Minimum Acceptable Return (MAR) allows you to specify the minimum annualized return rate to use 
as a threshold for all Excess (MAR) calculations. This affects the following blocks: Performance, Gain/Loss, 
Risk, Downside Risk, Performance Statistics and Downside Statistics. 
 
Output Asset Loadings in % 
This feature allows you to output asset loadings on a percentage basis, and is only used for the APT 
model. 
 
Number of trading days in a year 
This allows you to specify the number of trading days in a year. The default is 250, but users may select 
any number between 200 and 300. 
 
Peer group percentiles 
This allows users to specify the percentile breakdowns for peer group bands. The default is 5, 25, 50, 75 
and 95. 
 
Calendar 
 
The Calendar features allow you to specify how Market Holiday dates (and their data) are treated. Market 
holidays (days when markets are closed for trading) are automatically provided by MPI in the form of a 
text file linked into MPI Stylus Pro.  The field for these holidays will appear blank, but there is underlying 
data to inform the program of days when the market was or will be closed.   
 
Returns for these dates are automatically ignored; if you are an international client and use different 
market holidays than those recognized in the United States, a different holiday file may be called for. 
 
Use Market Holidays 
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When this box is checked, MPI’s holiday file is enabled; unchecking this box means that market holidays 
will no longer be ignored (for return purposes) and will appear as dates with missing data. 
 
Week ends on 
This control allows you to define the end date for weekly data. Previously, any weekly series would have 
its returns shifted to the Friday of each week, regardless of the day on which returns were reported. The 
resulting mismatch could invalidate the analysis based on these series. Setting the “Week ends on” 
control to the appropriate week day eliminates the possibility of this error. Friday remains the default. 
 
Missing Data Handling 
 
This section helps Stylus determine how you would like missing data to be handled. It may either receive 
no adjustment or be replaced/adjusted in another fashion. 
 
None 
In this case, no adjustments are made and data remains missing. 
 
Replace with Style 
This option will replace missing data with the Style Return estimated from the Style Analysis optimization. 
In this case the Style Window (under Parameters) must be wider than the missing date range. 
 
Replace with Benchmark 
This option replaces the missing data with the Benchmark Return. Note that this will always use your 
default benchmark. 
 
Remove and Compound 
This feature treats missing dates as holidays without having to use the holiday file itself. 
 
Confidence Intervals 
 
This section allows you to generate confidence intervals for asset loadings using Monte Carlo simulation 
methods.  
 
Level 
This tool allows you to adjust the confidence level. The default is 95 but values from 0 to 100 are 
supported. 
 
Use Monte Carlo 
This option turns on the ability to use Monte Carlo simulation, which is necessary to activate the 
remaining controls in this section. 
 
Iterations 
This tool allows you to adjust the number of iterations the simulation will run through. The default is 100 
but this may be raised or lowered.  
 
Normal Distribution 
 
This checkbox (default is unchecked) allows you to specify that a normal distribution should be used. 
 
Repeatable 
The random nature of Monte Carlo simulations means that variations will occur each time a simulation is 
run. By checking ‘Repeatable’, you are instructing MPI Stylus Pro to run the same iterations as the 
previous time the simulation was run.  
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Apply to benchmark 
Apply to peers 
These options allow you to run the benchmark and peer universe through the simulation as well. By 
default these are unchecked and only the Manager(s) are analyzed. 
 
CUSUM 
 
This tab provides the necessary background parameters for working with CUSUM in the application. For 
more details, please see the CUSUM User Guide and associated video, available via the MPI web site. 
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Proxy 
The Parameters section in the design tree contains a Proxy node. This node allows users to choose one of 
the seven options for proxy assignment within the study, after enabling the Use Proxy checkbox: 
Workspace Default, Series, Benchmark, Style, Peer, Library and None. 

 

 
Figure 40 

 

Workspace Default: This setting allows users to proxy the return series using the category association 
within Stylus Workspace and the specified proxy assigned on the category.  Stylus Pro has mappings for 
several databases, including the Morningstar US family of databases and HFR database. 

 
Figure 41 
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Figure 42 shows an example of the default assignments of Proxy Series within Stylus Workspace. Users 
with an Advanced Analytics license can modify these assignments and create their own classification 
mappings. 
 

 
Figure 42 
 
Series: This setting allows users to assign a single proxy series (S&P 500 Index in the example below) to all 
the return series in the Stylus study.  

 
Benchmark: This setting allows users to apply one of the benchmarks selected in the Stylus study as a 
proxy series for all the managers available in the study. It is possible to specify the benchmark by selecting 
either the name of it or the exact numeric position based on the list available under the Benchmark node 
of the design tree (from 1 to 9 and from -1 to -9). 
 

 
Figure 43 
 
Style: This setting allows users to assign a synthetic series built dynamically as a proxy series for all the 
managers selected in the Stylus study. The synthetic series construction process relies on the market 
factors listed under the Style Outline node of the study design tree; the market risk exposures are 
calculated by regressing the manager versus the market factors. It is possible to choose among three 
different types of exposures (as result of the multi-factor regression) to be used to build the synthetic 
series: earliest, average and recent exposure.  
 
Peer: This setting allows users to use either the average or the median of a peer group as a proxy series 
for all the managers selected in the Stylus study. The existing peer group must be loaded into the study 
under the Peer Groups node of the design tree in order to compute the proxy series. 
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Figure 44 
 
Library: This setting allows users to link the Stylus study to a library of generic proxy rules set in the Stylus 
Workspace. This feature allows users to build a Proxy Library and use it in multiple Stylus studies.   
 
 
Use Individual or Macro-based Proxy Assignments 
This option allows users to assign an individual proxy to each series within the study. The option enables 
the grid shown in Figure 9. This option is also applicable when using one of the Common assignments and 
allows users to override any such assignment for specific series.  
 
The grid can be updated manually by adding series to “Original Series” column. It can also be populated 
by clicking the arrow next to “Add” button and selecting one of the options: 

1. Add from databases 

2. Add managers 

3. Add indices 

4. Add benchmarks  

5. Add peer group series 

6. Add sources 

Notes:  

• When a user selects a portfolio (.fnd file) the constituents of the portfolio will be added to the 

grid.  

• Removing a series from the design tree does not automatically remove the series from this grid.  

 
The Forced Periods field can be used to override the returns of any period with the 
proxy returns.  This is often helpful when a manager starts and has a partial period 
return for the first month. 
 
Column Definitions 
 

Original Series Series for which the proxy is being defined 

Proxy Series Series which is being used to fill in the  returns of the Original Series 

Limit History Maximum length of track record to be used within the study. The length 
specified is equal to Original History + Proxy used. For example, if the original 
manager has five years of history and the Limit History is specified as 10Y (10 
years) then the combined series (original series + proxy) will be limited to no 
more than 10 years even if the Proxy series has a significantly longer history. 
 
The limit is specified as nP, where n is the number of periods and P is the 
period type (D: days, W: weeks, M: months, Q: quarters, Y: years). For 
example, 120M.  
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Forced Periods Time periods to be overridden from the proxy series, even if the original series 
has returns for those periods.  (A specified return value can also be specified 
instead of a proxy return). For example 20120501, 2013010120131231, 
20150515[0.1408], 20150101..20151231[0.00]. 

Series Range Shows the range of the original series (before proxy is applied) 

Proxy Range Shows the range of the proxy series 

Check box column 
(left) 

No proxy is applied to the series unless the checkbox is in checked.  Users can 
check individual check boxes and also use Check/Uncheck buttons on top of 
the grid. 

Figure 45 
 

Proxy Information 

Design Tree 

When a returns series has a proxy assigned, it will appear underlined in the Design Tree.  This is to help 
give a visual hint that a proxy is in use. 
 

 
 
A Review tab has also been added to give a summary view of all the proxy series being used and the time 
range for each. 
 

 
 
 
Other Options 
Apply To  
 
By default, proxies are applied to individual managers and managers within portfolios specified by the 
Manager node on the design tree. Users can also enable proxy use for series specified in other sections of 
the design tree as shown in Figure 46. 
 

 
Figure 46 
 
 
Limit Combined History 

 
Figure 47 

 



Chapter 4 
MPI Stylus 

www.markovprocesses.com  Page 107 

 

When checked, this option will limit the history of combined series (original + proxy) to the specified 
number of days, weeks, months, quarters or years.  
  
Fill Forward: This option turns on proxy returns for any time periods after a return series ends.   
 

Advanced Proxy Specification 

When using the Individual Proxy assignment option, it is possible to specify both the series to be proxied 
and the series being used as a proxy in Stylus expressions and macros. The following example shows how 
to specify a category average series from the Morningstar database to be used as a proxy. 

 
Figure 48 
 
The original series option specifies that any series where database ID is either “Mfi”, “Mce” or “Mfv” will 
use the series that has an ID matching the category code. The category field for each fund within the 
above-mentioned databases will be represented as a two-letter code. The code will also correspond to an 
ID for a category average series (named as Cat: <Category Name>). 

 
Figure 49 

Saving a Proxy  

Proxy set up in a study can be saved and placed in a Proxy Library within Stylus Workspace. This is 
accomplished by clicking on the “Save” button in the top right corner of the proxy definition screen. 
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Style Outline Node 
 
The proper selection of style indices is one of the most important steps in style analysis.  Portfolio returns 
are regressed against the returns of one or more style indices to determine market exposure.  MPI Stylus 
comes with a broad selection of databases from which users can choose style indices, including US Equity, 
US Fixed Income and other market indices.  In addition, new return series may be added by the user and 
serve as style indices. 
 

 
Figure 50 
 
Style Indices 
 
In general, any financial instrument that can be characterized by periodic historical returns can be a style 
index.  In MPI Stylus Pro, a style index can be either a real or hypothetical series of returns.  Normally, it is 
a market index; however, it can also be a managed portfolio or group of portfolios, a fund, stock, currency 
or commodity. 
 
Usually, the decision as to which style indices to select is partially based on a priori information about the 
portfolio(s) being analyzed.  Generally speaking, the fewer unnecessary style indices in your Style Outline, 
the higher the accuracy of your analysis.  Very seldom will similar indices need to be included in your style 
outline; in fact, this could be counter-productive.  For example, if you included both the Russell and 
Wilshire small value indices simultaneously, the accuracy of the estimate would usually deteriorate, and 
in some cases the results may simply be meaningless. 
 
Style Outline 
 
A style outline is a hierarchical structure that reflects logical relationships among style indices.  Each broad 
asset class can be represented by a combination of several more narrowly defined asset classes or styles.  
For example, a broad class such as US Equity can be defined with the S&P 500 serving as its proxy, but at 
the same time it may also be defined by a combination of value and growth styles represented by the 
Russell indices.  In most cases, this hierarchical structure will also include a proxy of risk-free rate, such as 
Cash. 
 
Style Maps 
 
Style maps combine the organizational qualities of a style outline with the visualization capabilities of 
charts.   
 
Selecting a style map in the Style Outline node will work just like selecting a manager in the Managers 
node, with one important difference.  When you select a style map, you will also add its underlying indices 
to the design tree. 
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The extension for style maps in MPI Stylus Pro is .smp.   
Style Maps Database 
MPI Stylus Pro comes with numerous pre-defined style maps representing various market segments that 
make style outline building easier, safer, and reduce the chance of error.  These maps are stored in the 
StyleMaps database (the description will say “Sample Style Maps”) which may be reached in the 
application like any other database. 
 
Alignment Arrows 
 
Alignment arrows appear twice in the MPI Stylus design tree, and allow you to move (align) the Min/Max 
settings to the left or right.  These arrows are discussed in full detail in the Basic Interface section of this 
manual. 
 
Creating a New Style Map 
 
For information on creating a new style map, please see Chapter 3. 
 
Selecting a Style Map or Style Index 
 
To select a style map or style index: 
 

1. Click on the Style Outline node on your design tree. 
2. In the data pane, browse to the database that contains your desired style map or indices.  For 

example purposes, we will browse to the StyleMaps database. 
3. Once you have located the correct Style Map or index, you may double-click its name in the data 

pane or click the check box next to it.  If it is a style index, it will appear on the design tree under 
Style Outline.  A Style Map will appear on the Style Outline as both the map itself and its 
underlying indices. 

 
 

Reviewing a Style Map 
 
When you click on a style map (as opposed to one of its underlying indices) on the design tree, you can 
get a quick sense of the visual composition of the style map as well as the indices comprising each plotted 
average.   
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Figure 51 

 
Reviewing Style Indices 
 
You may review any style index (whether it is linked to a style map or is stand-alone) by clicking on the 
name of the index in the Style Outline node of the design tree.  This will essentially show you the same 
screen as you would get by reviewing a manager in the Managers node – name, frequency, return series, 
etc. 
 
 
Saving a Style Outline as a Set 
 
Users may save a Style Outline as a set by right-clicking the Style Outline and selecting the ‘Save Outline as 
Set’ option. This allows you to use the group of indices in the set anywhere in MPI Stylus Pro where sets 
are supported, and can also be a convenient way of later retrieving this group of indices from the Sets 
database. 
 

 
Editing a Style Map 
 
To edit an existing Style Map: 
 

1. Click on the style map in the Style Outline node of the design tree. 
2. In the data pane, click the “Edit” button.  This will open the Map Edit tool. 
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Figure 52 

 
3. You may then adjust the name, proxy, map title, axis titles, underlying indices and plot positions 

of the map using this tool.  When you have finished, click the Save button.  You may also click the 
Cancel button at any time to close the map without saving your changes.   

4. If you want to edit the style map but save it under a different name to avoid overwriting the old 
map, you may do so by simply changing the map’s name in the ID field.  The application will 
automatically append the correct .smp extension for you. 

 
Deleting a Style Map or Index 
 
To delete a Style Map or Style Index from the design tree, simply click on it in the Style Outline node of 
the design tree and press the “Delete” button on your keyboard.  Alternately, you may right-click and 
select “Delete” with your mouse. 
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Peer Groups Node 

 
About Peer Groups 
 
It is often beneficial to look at a portfolio’s performance relative to a group of similar portfolios, or peers.  
This comparison provides valuable insight into a specific segment of the market and puts the results of 
analysis into the proper perspective. 
 
When peers are assembled they are said to be in a peer group or peer universe.  Peer universes are peer 
groups that have been created using filters applied to fund databases in MPI Prospector.  MPI Stylus Pro 
allows you to define peer groups of any size, and evaluate the performance of the analyzed portfolio in 
terms of its numerical and percentile rank within a group.  For more information on Prospector, please 
see Chapter 6. 
 
In addition to peer universes, there can also be sets.  A set is static and will not change from period to 
period – in other words, it will always contain the same given funds.  Peer universes, on the other hand, 
will update to include funds from the most recent period as part of their group. 
 
When working with peer groups in Stylus, you can: 
 

▪ Add a peer group to your study 
▪ View a peer group’s details and launch the group for editing in Prospector 
▪ Use statistics from a peer group in charts and tables, including distribution, median, average, 

min, max and size. 
▪ Beginning with version 11.0, analyze managers against different peer groups across charts and 

tables 
 
Creating a Set 
 
MPI Prospector should always be used to create new peer universes; however, sets may be created 
directly through the Stylus module.   
 
Adding a Peer Group 
 
Once a peer group has been created in MPI Prospector, the user may bring it into their study as they 
might a manager or style outline, but through the Peer Groups node. 
 
To bring a new peer group into Stylus: 
 

1. Click on the Peer Groups node of the design tree. 
2. In the data pane, browse to the appropriate database that contains your peer group.  You may 

use the (…) button to switch databases. 
3. Once you have located the correct database, double-click the name of the peer group you wish 

to use.  Alternately, you may click the check box next to it. 
4. The peer group should now appear in the Peer Groups node of the design tree and be ready for 

use in your analysis. 
 
Reviewing a Peer Group 
 
When you click on the name of a peer group in the Peer Groups node of the design tree, the data pane 
will display important information about the peer group, including its name and database, as well as a 
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complete list of funds that comprise it.  You may also launch the peer group from this screen into 
Prospector for editing by clicking the “Edit” button. 
 
 
 
 
Editing a Peer Group 
 
To edit a peer group, you will need to open the peer group in Prospector and work with it there.  Because 
all peer groups are Prospector studies (except sets), you may open the peer group directly in Prospector 
by going to File-> Open-> Prospector Study. 
 
However, if you already have the group selected in your design tree, there is an easier way to launch it 
into Prospector. 
 
To open a peer group for editing from the Peer Groups node: 
 

1. Click on the peer group’s name in the Peer Groups node of the design tree. 
2. In the data pane, click the “Edit” button. 
3. The peer group will open in MPI Prospector and be ready for editing.  Please make sure to save it 

when you are finished working with it. 
 
Deleting a Peer Group 
 
You may either delete a peer group from your design tree, or delete the actual file itself from MPI Stylus 
Pro.  To delete the entire file, please follow the instructions in Chapter 3. 
 
To remove a peer group from your design tree: 
 

1. Click on the peer group’s name in the Peer Groups node of the design tree. 
2. Press the “Delete” button on your keyboard.  Alternately, you may right-click and use the 

“Delete” option there. 
3. The peer group will be removed from your design tree. 

 
 
Multiple Peer Groups and Defaults 
 
Beginning with Stylus Pro 11.0, you may analyze managers against different peer groups within a single 
study. To accomplish this you must pay careful attention to the “default” settings of peer groups in the 
design tree. 
 
Each peer group added to the design tree is marked as a default (in bold font). Using Stylus with more 
than one group marked as default will lead to a single peer group that represents the union of each 
selected default peer group.  
 
Creating a Secondary Peer Group 
 

1. Add a peer group to the design tree as described above 
2. Right click on the new peer group and select Default. Note that the peer group is no longer 

shown in bold font. 
3. Select this new peer group in the designer of each chart or table you wish to compare your 

managers to. See the Parameters – Series Selection Settings in Chapter 5 for more information. 
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Benchmark Node 
 
MPI Stylus Pro supports several types of benchmarks and gives you the flexibility to select the most 
appropriate benchmarks based on the goals of your analysis.  Because benchmark selection seriously 
affects the validity of the interpretation of your analysis, including such important benchmark-dependent 
statistics as alpha and beta, great care must be taken to select the appropriate benchmark for your 
fund(s). 
 
Strictly speaking, you do not need a benchmark for all analyses.  Many performance statistics can be 
calculated without a benchmark selected; however, the ability to compare such statistics or any other 
characteristic of a portfolio to a benchmark is so valuable that they are generally included in all real-life 
analyses.   
 
MPI Stylus Pro supports four types of benchmarks: 
 

▪ Assigned – One or more specific benchmarks selected by the user 
▪ Manager-specific – Primary and secondary benchmarks that may differ by manager 
▪ Peer – One of several peer group statistics may serve as a benchmark 
▪ Style – Special customized benchmarks that are derived from your style outline. 

 
Assigned Benchmarks 
 
An assigned benchmark is a specific return series selected by the user.  Assigned benchmarks may be 
established benchmarks, like the S&P 500, indexes such as the Russell indices, or any other return series 
in the application. You may assign one or more benchmarks just as you might select a manager in the 
Managers node. 
 
Notes on Setting a Default Benchmark 
In any study containing multiple benchmarks, one will be considered the default benchmark for the 
purposes of calculating benchmark-dependent statistics. This is clearly visible on the design tree, as the 
default benchmark will have a blue icon with white lettering to its left. To change the default, please right-
click on the benchmark you wish to use and select “Default” from the right-click menu. Please note that 
studies created in previous versions of MPI Stylus Pro will automatically have their single benchmark 
selected as the default. 
 
Multiple Benchmark Ramifications on Automation 
The multiple benchmark feature affects macros and scripts both; for more information, please see the 
macroref and autoref documents in your Stylus\docs folder. 
 
Manager-specific Benchmarks 
 
In Stylus Pro 11.0, you have the flexibility to assign a benchmark individually to each manager that is most 
appropriate to the manager’s mandate. You define these benchmarks through new properties 
MPI_BMKPRIMARY and MPI_BMKSECONDARY, found under the Properties tab under Managers in the 
design tree.  Stylus provides the flexibility to define these properties in multiple ways: 

▪ Manually 
▪ Through a dictionary or external database lookup 
▪ By selection based on another manager property (e.g. manager’s asset class) 
▪ For some vendors, by referencing the benchmark specified by the manager 

 
Add Peer Benchmark 
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To select a Peer Group Benchmark, click on the “Add Peer Benchmark” button at the bottom for the 
Benchmark node data pane. When you select a peer group benchmark, a return series is automatically 
created based on all the portfolios in your peer group.  Peer group benchmarks are very effective when 
classifications are accurate.  You may specify one of four methods of calculation: 
 
Average Return 
Average return computes the benchmark return as the unweighted average of the returns of all portfolios 
in the group. 
 
Median Return 
Median return computes the benchmark return as the median of returns of all portfolios in the group.  
Compared to the average return, this method is less sensitive to the effect of outliers in small peer 
groups. 
 
Average Style 
Average style computes the benchmark return as the average style return of all portfolios in the peer 
group, after the style of each portfolio is calculated. 
 
Median Style 
Median style computes the benchmark return as the median style return of all portfolios in the peer 
group after the style of each portfolio is calculated. 
 
Add Style Benchmark 
 
To select a Style Benchmark, click on the “Add Style Benchmark” button at the bottom for the Benchmark 
node data pane. Style benchmarks are calculated benchmarks based on the results of style analysis for a 
portfolio.  They appear in charts/tables by default as FundName (Style Benchmark). 
 
There are two types of style benchmarks: Historic Average and Dynamic. 
 
Historic Average 
 
The calculation for Historic Average of a Style Benchmark will depend upon the engine being used in the 
Parameters section of your software. 
 

Common Scenario 
Subscribers to our core software who do not subscribe to our Dynamic Style Analysis 
(DSA)/Hedge Advanced Package 

 
For most users of the software, Historic Average will make use of the ‘Use Single Computation’ 
calculation option. While this is not averaging the results from window-based analysis, it may still 
be interpreted as average style because it is running one multivariate regression over the entire 
period of analysis. 

 
Dynamic Style Analysis (DSA) Scenario 

 
For users subscribing to our DSA/Hedge package, the behavior will be different as long as DSA is 
selected in Parameters. In this case, Stylus will average the exposures over the analysis time 
period and multiply these factors by factor returns to construct the average style return. 

 
When to Use Historic Average Benchmarks 
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These can be effective when there is reason to believe that changes in asset allocation during the entire 
period were caused by changes in market conditions (or by a perception of changes in market conditions 
by the portfolio manager). This type of benchmark should not be used if there are reasons to believe that 
the changes in asset allocation were caused by external factors and administrative decisions, such as 
changes in investment policies. 
 
Dynamic 
 
Dynamic benchmarks use the style analysis of historical returns in a portfolio.  As opposed to the Historic 
Average, the asset mix for this type of benchmark changes with time. 
 

▪ Cumulative – The cumulative option instructs MPI Stylus to calculate the dynamic benchmark 
point of estimate as an average style from the start of the analyzed period to the point of 
estimate.  Otherwise, MPI Stylus computes the benchmark based on the window size specified in 
the Parameters node of the design tree. 

▪ Lag – The lag parameter specifies the time horizon of asset allocation decisions.  It allows you to 
distinguish between and evaluate separately long-term and short-term decisions of the portfolio 
manager.  When the lag is set to zero, the Dynamic benchmark (without the Cumulative option) 
is equivalent to Style.  In this case the timing return, by definition, would equal zero. 

 
 
 
Automatically Apply Model 
Starting with version 11.3 users can click “Automatically apply model checkbox” before adding a manager 
to the study. For any manager that is part of one of the mapped databases Style Outline, Peer Group and 
Benchmarks node will be automatically populated. Please note that is will overwrite any previous values 
in these nodes. 
 

 
Figure 53 

 
Hedge Groups Node 
 
The Hedge Groups Node is used to apply hedging instruments to the assets under the Style Outline. This 
can have different applications – for example, in currency hedging.  
 
Consider the following case. A user selects Japanese Yen as the hedging instrument by bringing it into the 
Hedge Groups node. Now, all assets in the Style Outline will show up on the right-hand side (Min/Max) as 
‘hedged assets’. Users can select a specific asset (for example, MSCI Japan Large Growth USD) to be 
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hedged with Yen. When the analysis is run, Stylus will automatically consider this hedging implementation 
and calculate estimated asset loadings for MSCI Japan Large Growth and its Yen hedging positions 
correspondingly.  
 
 

Dictionaries Node 
 
Advanced Database package subscribers will have an additional node titled ‘Dictionaries Node’. 
Dictionaries serve as an intermediate storage facility in Stylus that can allow for the creation of more 
complex analytics or reports when combined with automation. For more information, please see the 
Dictionaries User Guide, available on our website.  
 

Views and Reports 

 
Views and Reports are the output of MPI Stylus Pro, and represent one of the most powerful areas of the 
application.  Due to the comprehensive set of features and options available to Stylus users, Views and 
Reports will both be covered in their entirety in Chapter 5 of this manual.  This chapter will also apply to 
creating Views and Reports in Allocator and Integrator; however, special features available for those two 
modules will be covered in their respective chapters. 
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Troubleshooting MPI Stylus 

 
For more Frequently Asked Questions (FAQ), please visit our web site at 
http://www.markovprocesses.com.  
 
Q: My Stylus study cannot be run.  The run button is red and says there is not enough data to run the 
analysis. 
A: This generally means that a major piece of information required for your analysis is missing.  In most 
cases, no manager has been selected or is checked in the design tree.  This is easily fixed by adding the 
missing series (manager, peer group, etc.) to your design tree. 
 
Q: My date range is constrained and is not going back to the inception date of my manager.  Why is this 
happening? 
A: Any time the date range listed in your Parameters node is not consistent with your requirements, it 
means that another return series is constraining your analysis.  This may be another manager, benchmark 
or style index.  You may wish to adjust the Limit function in Parameters to change Stylus’ date range 
requirements, or you can locate the constraining series through the Summary tab and then change it to a 
more acceptable series. 
 
Q: My views or reports are blank/not populating correctly. 
A: You may need to run or re-run your study.  Sometimes changes may only be reflected when the study is 
rerun to refresh calculations. 
 
 

  

http://www.markovprocesses.com/
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Overview 
 

MPI Stylus Pro’s reporting 
package has been designed to 
accommodate the full range of 
reporting needs for the financial 
services industry.  From one-page 
fact sheets to automated 
institutional books, MPI Stylus 
Pro’s Views and Reports features 
allow you to leverage the power 
of unlimited performance-based 
analytics and data visualization 
into your Reports. 

 

Views and Reports 

Chapter 5 
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Chapter 5 
 

Views and Reports 
 
MPI Stylus Pro’s Views and Reports features have been designed with the diverse reporting needs of the 
financial services industry in mind.  From templates designed with the independent advisor in mind to 
institutional-quality reporting solutions for investment banks, MPI Stylus Pro users will find a host of 
visual analysis and reporting solutions ready to enhance their productivity. 
 
Reporting in MPI Stylus Pro Modules 
 
MPI Stylus Pro consists of four main modules – Stylus, Allocator, Integrator and Prospector.  All four of 
these modules have Views functionality, but Prospector has no reporting functionality as it is an analysis-
specific application.  MPI Integrator may be used for creating Reports from Prospector studies. 
 
Understanding the Views/Reports Concept 
 
The differences between Views and Reports in MPI Stylus Pro are more significant than they might first 
appear, and understanding the rationale behind the system will help users make the most efficient use of 
MPI Stylus Pro’s output features.   
 
You should think of the Views node as your own personal chart, table and memo library.  You may create 
as many charts and tables as you feel necessary to conduct a thorough analysis, even if you do not intend 
to use all of the output in your final Report.  This allows you to quickly and efficiently create output for 
your analysis without having to worry too much about final aesthetic details or organization.  Because the 
organization of your Views will not affect the appearance of any Report you create, you may organize 
Views in whatever way you find most useful. 
 
Reports will be actual, final output – something you can feel comfortable sharing with clients, colleagues, 
partners and prospects.  These can be made up of any or all of the Views you have already reviewed – 
and, through the special “Link to View” feature discussed later in this chapter, users will be able to use the 
same chart or table in multiple Reports (or multiple times in the same Report), without having to create or 
change it multiple times. 
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Views 

 
Views are your own personal library of charts, tables and memos.  You may create as many Views as you 
like based on unlimited performance-based analytics and other data, such as database fields.  Unlike 
Reports, which will be actual publishable content, there is no disadvantage to creating extra Views in 
order to give oneself as complete a picture of a fund or portfolio as possible.  Once a View has been 
created, it can be used multiple times in multiple Reports – and if it needs to ever be changed, the change 
can be made in the View and automatically propagated to all Reports it links to. 
 
Modules Using Views 
 
All modules in MPI Stylus Pro, except Prospector, have a Views node that works according to the 
instructions in this chapter.  Prospector does have the ability to create select Views, and also adds 
powerful capabilities to Views that are not present elsewhere in the application; for more information, 
please see Chapter 5. 
 
View Components 
 
There are three possible components of Views in MPI Stylus Pro: 
 

• Charts, which show visual representations of data 
• Tables, which display actual data in columns and rows 
• Memos, which are used for text 

 
While Charts, Tables and Memos will have some shared features in the application, they will also have 
many unique features; therefore, each will be examined individually. 
 

Galleries 
 
It is highly recommended that anyone seeking to create or edit Views use the ‘Galleries’ approaches listed 
in this chapter under ‘Creating a New View with Galleries’ and ‘Populating Views with Chart/Table 
Galleries’. This is by far the fastest and most efficient method for output creation. 
 
Hiding Galleries 
You may hide the Galleries sidebar at any time by dragging the bar to the right side of your screen until it 
is completely hidden, or by double-clicking on the Galleries side bar. You then would need to save your 
study to capture the changes. 
 
Unhiding Galleries 
To unhide your Galleries sidebar, simply drag it from the right edge of your screen until it is visible, and 
then click ‘Save’ to capture the changes. 
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Working with Views 
 
All charts, tables and memos that you create in your Views node will be organized into one or more actual 
“Views.”  You may create as many Views as you like, each consisting of as many charts, tables and memos 
as you wish; however, MPI recommends that the user limit the number of charts, tables and memos in a 
View to ensure ease of use and optimal performance. 
 
Views Icons in Menu 
 

 
 
This series of icons allows you to perform a number of quick tasks related to views. Notice the section 
labeled ‘View’. The options are, left to right: 
 

• Add View (this adds a new View to the Design Tree) 

• Delete View (this deletes the currently active View) 

• Add blank chart (adds it to the currently active View) 

• Add blank table (adds it to the currently active View) 

• Add blank memo (adds it to the currently active View) 

 
Creating a New View with Galleries 
 
 
Galleries provide a simple and quick way to create a new view that is pre-organized and already has chart, 
table or memo blocks added. This allows you to then simply populate each block with the relevant 
content (i.e., drag in the Performance analytic block for a given chart). 
 
To create a new View using the Gallery feature: 
 

1. Scroll through the Gallery options to find the design that suits your needs. Remember that you 
can add or remove individual charts/tables/memos later on. 

2. Click your mouse on the view in question and drag it over into the data pane. 
3. When you release the mouse button, the new View will be added.  

 
Creating a New View from Scratch 
 
To create a new View from scratch: 
 

1. Go to the Views node on the Design Tree and click the + symbol to be found on the left.  
2. Your new view should appear. 

 
Alternately, you may do the following: 
 

1. In Stylus, Allocator or Integrator, click on the “Views” node on the design tree. 
2. In the data pane on the right-hand side, click the “New” button.  A new View will appear in the 

data pane, on the design tree under the Views node, and as a new output tab along the bottom 
of your screen.  The View will have an automatically generated name such as View1, View2, etc. 

3. To populate the View with charts, tables or memos, see “Editing Views” below. 
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Renaming Views 
 
If you wish to rename a View for organizational purposes (i.e., change View1 to Performance): 
 

1. Double-click on the name of the View on the design tree.  You will now be able to type in a new 
name for this View. 

2. When you have finished typing, hit the Enter key on your keyboard.  The View’s name will now 
be changed.   

   Note that the View tab will also reflect the name change.   
 
View names may also be renamed in the data pane when you click on the Views node.  Simply double-
click on the View name in the data pane, delete the existing name and type in new one.  This makes 
renaming multiple Views a quick process. 
 
Editing Views 
 
The ability to edit charts, tables and memos, as well as the layout of Views, is an important part of the 
Views concept.  There are two ways in which a user can edit a View. 
 

1. By editing the organizational structure of the View, such as adding, deleting or rearranging its 
component charts, tables and/or memos; or 

2. By editing the actual charts, tables and/or memos within the View (this will be discussed later in 
this chapter.) 

 
Once you have created a new View, you will wish to add one or more charts, tables or memos to the 
View. 
 
There will be two steps to creating a new chart, table or memo in MPI Stylus Pro. The first step will involve 
adding a chart, table or memo block to a View. This serves as a placeholder and tells the application what 
kind of View you wish to display.  The second step will be designating the analytic, data or text that will 
populate the View. 
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Figure 54 

 
The controls for creating new chart, table or memo blocks and designing your View pane are quite simple 
and consist of the blocks themselves and band quantity and orientation controls. 
 
Blocks 
 
Chart, table and memo blocks (visible in the picture above) serve as visual placeholders in both Views and 
Reports, and also tell MPI Stylus Pro what kind of information you need to show in a given View or Report. 
 
Bands 
 
Bands may be thought of as either rows or columns in a View that display one or more charts, tables or 
memos.  There are two controls governing bands in the application. 
 
Band Quantity 
 
The band quantity tool allows you to select how many rows or columns (depending on orientation) you 
have available for displaying Views.   
 
Band Orientation 
 
The band orientation controls allow you to specify whether you want your bands to appear in a vertical or 
horizontal format. 
 
Rearranging Views (or Reports) 
 
A variety of options exist for rearranging the order of Views (or Reports) on the Design Tree.  
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1. Up/Down. You may use the Up/Down buttons in the data pane (when clicked on the Views or 
Reports node) to rearrange specific Views by first selecting the relevant View/Report and then 
clicking on Up/Down as is necessary. 

2. You may click on a View or Report on the Design Tree and drag it while holding your left mouse 
button. You may then drop it in the relevant location. 

 
Review Links 
The Review Links button will be applicable once you have created Reports and have one or more 
charts/tables/memos in at least one View linked to at least one Report. Upon clicking the ‘Review Links’ 
button, you will see the ‘Linked to Reports’ interface, with the following information: 
 

• Report – The Report in which the chart/table/memo appears. 

• Page – The Page upon which the chart/table/memo appears. 

• Name – The Name of the placeholder chart/table/memo space in the Report into which the View 
chart/table/memo is linked. 

• Linked from/Not Linked: This lets you know for all charts/tables/memos if they are currently used 
in one or more Reports. 

• View – This is the name of the View in which the linked chart/table/memo resides. 

• Name – This is the name of the chart/table/memo itself. 

• Script – Any dynamic script statements that have been applied. 

• Force ungroup (PPT) – This ensures that all objects in the PPT document are not ‘grouped’ 
together as a larger image (for example, two charts on the same page) 

• Never ungroup (PPT) – This ensures that all objects in the PPT document are always grouped 
together as a larger image (for example, two charts on the same page) 

 
Close 
You may use this button to close this window when you are finished with the tool. 
 
 
 
Copy to Clipboard 
This tool allows you to copy your selections to the computer clipboard for pasting, i.e., into Excel. 

 
Deleting Views 
 
Before deleting a View, please consider whether you are interested in deleting the entire View or just one 
chart, table or memo within it.  If you delete an entire View, all charts, tables and memos within that View 
will be lost and they will no longer appear in any Report that links to them. 
 
You can delete via drag-and-drop at any time, or use the methods below. 
 
To delete only a chart, table or memo within a View: 
 

1. In the Views node of the design tree, click on the View that contains the chart, table or memo 
you wish to delete.   

2. You may now either delete the chart, table or memo by right-clicking on its name on the design 
tree and selecting “Delete”, or by simply grabbing the block corresponding to the chart, table or 
memo and dragging it off-screen.  It will automatically be deleted. 

 
To delete a View: 
 

1. Click on the View’s name under the Views node of the design tree. 
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2. You may now either right-click and select “Delete” or simply press the “Delete” button on your 
keyboard. 

3. The View has now been deleted. 
 
You may also delete Views from the data pane.   
 

1. Click on the Views node on the design tree. 
2. In the data pane, click on the name of the View you wish to delete. 
3. Click the “Remove” button.  The View will be deleted.  

 

Populating Views with Chart/Table Galleries 

 
Chart/Table galleries are the fastest and most elegant way to populate your Views with charts/tables, 
incorporating a sleek drag-n-drop interface as opposed to the more traditional bottom-up approach used 
in earlier versions of MPI Stylus Pro. 
 
Analytic Block Dropdown 
 
The first step to adding a chart/table via Galleries is to select the appropriate Analytic Block from which it 
is meant to come. This is done by using the dropdown menu at the top of the Gallery pane. 
 
Sample Charts 
For each listed Analytic Block category, there will be different sample charts or tables available. Please 
note that these charts or tables are truly ‘samples’ and do not reflect the current content of your output 
based on your manager, benchmark and other selections. These will only be applied once you drag the 
requested chart or table into your View. 
 
Previewing Sample Charts or Tables 
Sample charts or tables may be previewed by hovering over them with your mouse. This will show you a 
larger version of the image. Again, this is a sample image and does not contain data specific to your 
output. 
 
Adding a Chart/Table from the Gallery 
Once you have selected the correct chart/table you wish to add: 

1. Click it with your mouse and drag it into the View pane. 
2. Release the mouse button. Your chart or table will add and will contain a version of the 

requested output, specific to your current study (managers, benchmark, etc.) 
3. Please note that you may have to run the study to see the output. 

 
Daily 
 
Subscribers to our High Frequency (Daily) package will have an additional set of charts/tables from which 
to choose. These are specific to the requirements of daily data. 
 
Themes 
 
Themes allow you to drag-and-drop color schemes on to charts. This gives you a quick method for 
creating color-matched output that has a complimentary set of colors. 
 
Please note that it is not currently possible to create your own themes in the application. 
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Aggregation 
 
This option gives you a quick way to change the aggregation/frequency settings for a chart or table. You 
can choose from five options: 
 

• Single Outcome (one data point, such as 5Y return) 

• Rolling Statistics (i.e., 24 month rolling performance) 

• Cumulative Results (i.e., growth of $1000 chart) 

• Data Every X Periods (i.e., quarterly data for last ten years) 

• Multiple Period Data (i.e., 1Y, 3Y, 5Y performance) 
 
Applying an Aggregation Setting 
 
To apply a setting to an existing chart or table: 
 

1. Using your mouse, click on the setting you wish to apply and drag/drop it into the data pane. 
2. A Gallery Dialog window will open. This will explain the type of setting you are requesting, and 

provide you with the Aggregation settings controls to make your change. 
3. Once you have made your settings entries, click ‘OK’ to apply your changes. 
4. You may click ‘Cancel’ at any time to avoid making the changes. 

 
Filter/Sort/Group 
 
This option gives you a quick way to create/edit Filter/Sort/Group options for your output. In version 11.3 
an additional level of Filter/Sort/Group was added. This feature gives you a way to Filter/Sort/Group 
fields, rather than just Managers. More information on these options and their uses is available on our 
factsheets, demo studies, and the Dynamic Script User guide, available from MPI. 
 
For more information on these options and their uses, please see our Filter/Sort/Group User Guide, 
available from MPI. 
 
 
 
 
 
Chart Objects 
 
These options allow you to easily enrich your charts with objects such as labels and date range overlays 
that would otherwise require the use of macros to create. We recommend you experiment with these 
gallery items to explore their potential. 
  
Select Gallery Database 
 
This option allows you to select different gallery databases for review. This currently does not apply to 
most users.
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Working with Chart, Tables and Memos 
 
Charts, tables and memos are the three common types of output in MPI Stylus Pro, and may be created in 
either Views or Reports.  The same tools will be used in both cases; therefore, the instructions in this 
section will focus on performing tasks in Views, but will also be generally applicable to Reports. 
 
New Chart, Table or Memo 
 
The first step to adding a new chart, table or memo to your View will be to select the appropriate block 
(all three blocks are clearly labeled.) 
 
To create a new chart, table or memo: 
 

1. In the Views node of the design tree, click on the View in which you would like to create a new 
chart, table or memo.   

 

 
Figure 55 

 
2. In the data pane, use your mouse to select a block (chart, table or memo) and drag it up into the 

grid section of the data pane.  When you release the mouse button, the block will automatically 
expand to take up all available room in its band, ensuring that it can be viewed in the largest 
possible format. 

3. A default name (such as Chart1) will be generated.  You may rename the View by clicking in the 
name field of the block and typing in the name you wish to use.   
When you press enter, you will notice the new name is also reflected under the Views node on 
the design tree. 

4. You may add additional blocks if you like at this time.  Current blocks will resize automatically 
when you add additional blocks. 

 
Once you have specified the type of output you are looking for, it will be time to design the actual chart, 
table or memo you have created. 
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Chart and Table Design 

 
Chart and Table design in Views is quite similar, and therefore will be discussed simultaneously.  Memos 
are very different and will have their own section later in this chapter.  It should be noted that each 
module has its own variations on the Chart and Table designers; for example, MPI Allocator has statistics 
and charts available that are not available elsewhere in the application.  This chapter is meant to cover 
basic Views and Reporting features on an application-wide level wherever possible; however, it will be 
primarily be concerned with the MPI Stylus module.  Users should refer to module chapters for further 
information on statistics, charts or other output specific to those modules. 
 
Viewing Chart, Table and Memo Names 
 
You may choose to view your chart, table and/or memo names in Views at any time by toggling on or off 
the “Show design names as titles” button in each View tab.  This will allow you to view each chart, table or 
memo’s name above it in that View. You may also edit the name at that time simply by double-clicking the 
name and entering new text.  
 
Chart Designer and Table Designer 
 
The chart and table designer screens are the area in the application where charts will be designed.  They 
can be viewed at any time in one of three ways: 
 

1. Clicking on the name of the chart or table in the appropriate View in the Views node of the 
design tree. 

2. Right-clicking on the chart or table in a View tab and selecting “Chart/Table/Memo Designer”.  
This will also work in Reports if you have created the chart or table memo directly in the Report. 

3. Right-clicking on a linked chart or table in a Report and selecting Chart/Table/Memo designer.  
You will then be able to click the “Jump to View” button to be taken to the Chart Editor. 

 
The chart and table designers both consist of three similar sections: 
 

▪ Analytic blocks.  The analytic blocks control the type of statistics & data that will appear in your 
chart or table.  Each block represents either a particular chart type (i.e., Style Map, Scatter) or 
statistics that may be expressed in either chart or table form (i.e., Performance, Risk, 
Correlation.) 

▪ Parameters.  Chart or Table parameters control time periods, aggregation settings, and data 
point frequencies.  In addition, the table designer has additional controls for layout and date 
formats. 

▪ Series selection area.  This area allows the user to specify which managers, indices, peer groups 
and statistics (i.e., Distribution) and whether or not the benchmark should be included in the 
chart or table.  The user may specify all, none, or specific items for inclusion. 

▪ Pre-process. This feature allows the user to make additional adjustments to data being computed 
in the analytic blocks, so as to adjust the information displayed in a chart or table. In tables, 
Advanced Table Formatting is a more powerful and efficient tool for this purpose, but for Charts 
it is the only option currently for these additional adjustments. 
The Pre-process feature now also includes an option ‘Skip NA and 0’ to hide blank bar spaces in a 
chart in a report. Please note that this option is only present in the Chart Designer. This enables a 
user to hide resulting analytics which may appear blank in cases where data computes to 0 or 
NA. 
 

 
Table Layout 
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Tables in MPI Stylus Pro make use of a flexible table layout that allows the user to specify the location of 
data in both rows and columns, and provides a preview of the results.  
 
Edit 
The Edit button will open the Flexible Layout box, allowing you to make use of the layout options to best 
organize your table. This is described in detail below. 
 
Date matrix 
This option will be enabled for specific table types where the results may be viewed in a date matrix 
format. This option will be disabled in cases where data may not be shown in this form. 
 
Dates reversed 
This option allows you to reverse the order of dates in your table; for example, dates beginning with 1998 
and ending with 2005 may be reversed so that the 2005 column comes first. 
 
Flexible Layout box 
 

 
Figure 56 

 
The Flexible Layout box allows you to specify by data heading whether or not this data belongs in a row or 
a column, and what its relationship should be to other data headings in that row or column structure. The 
exact effects of each layout control on a given table will depend on its default layout, but generally the 
following settings apply: 
 
Date 
This will represent the time periods displayed in the table. This could either be a range (for an interval or 
rolling period) or specific periods (such as 2001). 
Manager 
This will determine the position of all series included in the table, including Managers, Benchmarks, Peer 
Medians, etc. 
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Section 
Section typically corresponds to the data elements in the drop-down menu of an analytic block. For 
example, a Performance table might have section options of Return, Annualized Return, etc. 
 
Field 
Field typically corresponds to the data elements available as checkboxes in an analytic block. For example, 
a Performance table might have field options of Excess, Alpha, Style, etc. 
 
Working with Flexible Layouts 
 
To use a flexible layout: 
 

1. First please review the table display shown in the “picture window” beneath the Row Headings 
and Column Headings controls. This is your table as it would appear if you accept the current 
settings for which elements are in rows and which are in columns – in the exact order in which 
they appear. Please remember that you will be able to remove headers and columns in the 
Attributes Editor, so the key here is to make sure the table logic is correct – even if you will want 
to remove some elements later. 

2. To move an option from Row Headings to Column Headings or vice-versa, click on the option 
with your mouse and then either drag it to the other Headings area or use the right/left arrows 
to guide it. 

3. You may also use up/down arrows to change the priority of options.  
4. Once the table looks correct, please click OK. 

 
Notes 
 
This option provides a report or template designer with a scratchpad to record notes about the design of 
the chart or table, possibly for use by others to later understand or modify the content. This is a good 
place to mention any macros used in the design or assumptions about the inputs. 
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Analytic Blocks 

 
Analytic blocks in MPI Stylus Pro represent groups of statistics or data organized by common type or 
theme.  For example, the MPT Statistics analytic block contains statistics related to modern portfolio 
theory, such as alpha, beta, and the Sharpe Ratio.  These groupings allow the user to quickly locate and 
implement the exact statistic(s) they require. 
 
Charts and Tables both have analytic blocks available to them, and many of the blocks are identical for 
both output types; however, the design of charts or tables makes certain types of output only useful for 
one type or the other.  For this reason, not all blocks will be the same for both charts and tables.  Please 
refer to the table below for a listing of available chart and table blocks.  Note that additional analytic 
blocks may be found in other MPI Stylus Pro modules, and that users should refer to module-specific 
chapters for this information. 
 

Stylus Module Analytic Blocks Available in Charts? Available in Tables? 

Asset Loadings Yes Yes 

Asset Map Yes Yes 

Asset Turnover Yes Yes 

Correlation Yes Yes 

Custom Yes Yes 

CUSUM Yes Yes 

Database Yes Yes 

Database Table Yes Yes 

Dictionaries Yes Yes 

Distribution Yes No 

Downside Risk Yes Yes 

Downside Statistics Yes Yes 

Gain/Loss Yes Yes 

Min/Max Yes Yes 

MPT Statistics Yes Yes 

Performance Yes Yes 

Performance Statistics Yes Yes 

Portfolio Analysis Yes Yes 

Properties Yes Yes 

Quantiles Yes No 

R-squared Yes Yes 

Risk Yes Yes 

Scatter Yes No 

Scenarios Yes Yes 

SQL Yes Yes 

Style Drift Yes Yes 

Style Map Yes No 

Style Metrics Yes Yes 

Summary Statistics Yes Yes 

VaR Yes Yes 

Figure 57 
 
Multi-section Charts (Combination Charts) 
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Users of Version 10.0 or greater may use the Multi-section option in the Chart Designer to create multi-
section (combination) charts. For more information, please see the ‘Multi-section’ (Combination) chart 
section of this chapter.  
 
 
Working with Analytic Blocks 
 
Most analytic blocks in Stylus come in the same form as the performance block below. 

 

 
Figure 58 

 
It contains the following sections: 
 

▪ The title, clearly identifying the block type 
▪ A drop-down menu.  Depending on block design, this may contain actual statistics or data, or it 

may contain features to organize data, such as ranks. 
▪ Select all and select none buttons.  These appear to the right of the dropdown menu and affect 

the check boxes in the block. 
▪ Check boxes.  Depending on block design, these may regulate the statistic, calculation type, map 

or other item to be included in the chart. 
 
There are eight blocks in Stylus where this is not the case.  The Scatter, Distribution, Database and 
Holdings blocks do not require check box functions and instead contain one or more dropdown menus as 
their only options.  The Asset Loadings, Correlation, Style Metrics and Asset Map (in the table version 
only) blocks work the same as the standard blocks above, but contain an additional feature.  Specific 
features of these blocks will be listed along with their entries below. 
 
Hide Zero Fields 
 
A ‘Hide Zero Fields’ checkbox exists for many blocks and is located in the upper-right corner of the block 
itself. When checked, the Chart/Table will not display ‘0’ or ‘NA’ values, allowing the user to focus on 
relevant data. For example, the Asset Loadings chart would show only those Assets in its legend that had 
non-zero data, as opposed to every index in the Design Tree. 
 
Asset Loadings 
 
The Asset Loadings block is used to demonstrate the likely allocation of a fund’s assets to different style 
classes or investment types.  The block retrieves any indices listed in the Style Outline node of the design 
tree, including underlying indices in Style Maps.  The user may then select which indices to include in the 
chart. 
 
Lock check box 
The Lock check box in asset loadings charts allows the user to lock all indices present in the block as 
checked.  This is helpful when the user expects to make periodic changes in the indices in the Style 
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Outline node.  When the Lock feature is selected, the block will capture such changes and ensure that all 
indices are included. 
 
 
Asset Map 
 
An Asset Map lets you study changes in the asset class exposure in terms of the values of the two 
coordinates of the corresponding style map. Visually, an asset map is similar to the Asset Loadings chart; 
however, in terms of specification, it is equivalent to the Style Map chart. 
In order to create an Asset Map, you must include at least one style map in the Style Outline. 
 
All style maps listed in the Style Outline display in the chart model. If more than one style map is present 
in the Style Outline, select the specific map you wish to analyze using the check boxes. 
The default Asset Map is a bar chart. Area and line charts are also available. 
 
After dragging the Asset Map icon from the center of Data Pane to the chart area, select the 
computational option: 
 
Weight  
Weight determines the position of any point on the map by portfolio assets allocated to each asset class 
presented on the map.  This is the standard form of the asset map. 
 
Rank  
This is a universe ranking of total statistics. 
 
Rescaled Weight  
This shows the allocation of assets to a style as a proportion of assets allocated to a specific asset class.  
Use rescaled weight when the proportion of total allocated assets to all assets on the style map is small, 
because a regular style map may not clearly show differences in exposure to asset classes. 
 
Rescaled Rank  
This is a universe ranking of rescaled weights. 
 
Asset Turnover 
 
Asset turnover measures the level of investment style change in a portfolio.  Investment style exposures 
in Stylus are estimated across style indices over rolling periods.  Unlike security-level turnover, where 
changes in specific holdings are measured, asset turnover deals with changes in exposure to segments of 
the investment market as represented by style indices. 
 
There are two different ways to look at asset turnover: 
 

▪ Total 
▪ By Asset 

 
If you select Total, you’ll see the total value associated with increases (buys) or decreases (sells) in style 
exposure.  No information about the specific styles to which exposure is being increased or decreased is 
provided at the Total level. 
 
If you select “By Asset”, you can then select the following information: 
 

▪ Turnover Buys shows increases in style exposure over the period specified 
▪ Turnover Sells shows decreases in style exposure over the period specified. 
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▪ Buys vs. Sells shows the net effect of style exposure increases and decreases over the period 
specified.  If the data is not aggregated, then Buys will match Turnover Buys and Sells will match 
Turnover Sells for each period; however, when the data is aggregated, increases and decreases in 
the same styles are shown at the net level, with some exposures canceling each other out, rather 
than accumulating. 

 
The Buys vs. Sells (By Asset) combination is quite useful because it measures the net effect of 
increases and decreases in style exposure and is therefore less likely to be affected by noise in 
style estimation results.  In other words, style movement due to noise is more likely to be 
canceled out with this measure, leading to more reasonable levels of turnover. 

 
Noise in style estimation should be minimized as much as possible when computing style 
turnover because much of turnover is attributable to noise.  You will find the style estimation 
results particularly noisy with daily data, and should make an effort to smooth the results as 
much as possible prior to computing turnover.  Jagged edges in the historical style exposure 
chart are an indication of noise; increasing the window size used to estimate style while 
decreasing the decay factor should lead to smoother results without compromising the accuracy 
of your style estimation. 

 
The Buys vs. Sells (By Asset) chart also allows you to see style changes together, as the chart 
shows increases and decreases simultaneously.  The best type of chart to use for demonstrating 
this turnover is the stacked bar chart (available through the Attributes Editor.)  It should be noted 
that this analysis becomes more meaningful when analyzed relative to peers than on a 
standalone basis. 

▪ Annual Turnover (Buys) is annualized Turnover Buys.  For periods greater than one year, turnover 
is divided by the total number of years.  For periods less than a year, turnover is multiplied by the 
number off periods in the year. 

▪ Annual Turnover (Sells) is annualized Turnover Sells.  For periods greater than one year, turnover 
is divided by the total number of years.  For periods less than a year, turnover is multiplied by the 
number off periods in the year. 

 
Correlation 
 
Correlation and covariance are some of the most commonly used statistics.  Accurate estimations of these 
statistics have become a centerpiece of modern finance and of risk measurement systems.  Covariance in 
particular measures the degree to which the returns on assets move together. 
 
If positive and negative deviations from the asset means occur at similar times, the covariance will be a 
large positive number; if the deviations occur at dissimilar times, the covariance will be a negative 
number.   
 
Correlation is defined as a standardized covariance, taking the values between positive and negative 1.  
You may compute correlation/covariance between selected managers, style indices, benchmarks and any 
other return series. 
 
You have the following options when working with covariance: 
 

▪ Correlation – measures the extent of a linear association between two variables 
▪ Excess Correlation – measures the correlation of excess returns. 
▪ Covariance – measures the degree to which returns on assets move together 
▪ Annual Covariance – measures the degree to which returns on assets move together annually 
▪ Correlation Rank – requires a peer group.  Displays the rank of the correlation value vs. the peer 

group 
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▪ Covariance Rank – requires a peer group.  Displays the rank of the covariance value vs. the peer 
group 

▪ Correlation Order Rank – Correlation order rank provides a true rank of correlations in a peer 
group; for example, for a peer group of 287 funds, the ranks would be from 1 to 287 with no 
repeated numbers. 

▪ Covariance Order Rank – Covariance order rank provides a true rank of covariances in a peer 
group; for example, for a peer group of 287 funds, the ranks would be from 1 to 287 with no 
repeated numbers. 

▪ Kendall’s Tau – This rank coefficient measures the similarity between ranks of values. As with the 
Pearson correlation coefficient, it is measured on a scale of -1 to 1, with -1 implying perfect 
disagreement between ranks and 1 implying perfect agreement. Kendall’s Tau is a non-
parametric measure and does not require a linear relationship between values – nor even that 
they even be measured in the same units. 

▪ Spearman Correlation – This rank coefficient assesses how well the relationship between two 
variables can be measured using a monotonic function. More robust than Pearson correlation 
but less computationally intensive than Kendall’s Tau. 

▪ Reflective Correlation – A variant of Pearson’s correlation that can be used when the mean 
estimates of your series are unreliable. Means are assumed to be zero. 

▪ Correlation of alphas 
▪ Correlation of selection returns 
▪ Correlation of Upside (positive) and Downside (negative) returns 

 
Once you have selected the statistic you wish to calculate, you may then select the columns for the 
correlation matrix you wish to see in the chart.  You may add managers, style indices, benchmarks and 
peer group indices.  You may select individual assets, asset groups, or all assets by using the checkmarks. 
 
Custom 
 
The Custom analytic block is only available for use/editing by Advanced Analytics package subscribers. It 
provides the user in the Stylus module with a powerful set of analytical features and capabilities related 
to custom creation and manipulation of statistics, ratios and models, and we recommend that anyone 
interested in using it contact the MPI Support team for assistance in planning out the best workflow 
solution for your needs.  
 
Note that the Custom block in the Stylus module is not identical to the one in Prospector, which has a 
separate syntax and use case. For more information on the Prospector version, please see our Advanced 
Analytics/Prospector User Guide, available on markovprocesses.com. 
 
CUSUM 
 

 
Figure 59 

 
CUSUM (cumulative sum of a series) is used to help monitor manager performance on an ongoing basis. 
Its primary purpose is not to be a hiring or firing decision-making tool, but rather to initiate investigations. 
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CUSUM, in and of itself, can be applied to a variety of statistics, but in MPI Stylus Pro, it is calculated off of 
the Instant Information Ratio statistic, which is the ratio of the log of excess returns to exponentially 
weighted tracking error. IIR is used because it is more stable than excess returns and directly related to 
manager skill.  
 
For detailed information on using the CUSUM analytic block and its features, please see the CUSUM User 
Guide and the associated video, available on the MPI web site. 
 
 
Database 
 
The database block gives you the ability to bring values from your database into Stylus as data in a chart 
(or table).  For example, if you are using Morningstar as your database, this block would allow you to 
return the appropriate fields from this database.   
 
When no manager (and thus no database) has been selected, this block will appear only with one 
dropdown field and will be unable to return information; however, when a database has been selected, a 
second dropdown field will appear, and this will allow the user to select from any and all fields in the 
database. 
 
In the picture below, the user has clicked on the second dropdown menu to reveal the available fields 
from Morningstar.  The user may then click on any field that should be included in the chart (this would 
also work for tables.) 
 

 
Figure 60 
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Once the selections have been made, the user can then click back on the dropdown field to have Stylus 
accept the selections for use in the chart (or table.) 
Database Block Parameters 
In general, it will not be necessary to fill out parameters for your database block chart or table because 
they retrieve information directly from the database.  Because this information is essentially “frozen,” the 
parameters settings in Stylus will not affect them. 
 
Rearranging Database Field Order for Tables 
Most 3rd party providers do not allow their database field orders to be rearranged in MPI Stylus Pro; 
however, there is a way to use database block functionality to achieve the same effect and to have fields 
appear in any order in a single table. (For charts, you would use Combination Charts to accomplish this) 
 
The secret lies in using multiple database blocks next to one another in the same table design.  For 
example, imagine that a user wishes to have a table with Sharpe Ratio and Mstar Rating - in that order - 
from the Morningstar database.  This would not be possible with one database block because Mstar 
Rating comes before Sharpe Ratio. 
 
However, the user could follow these steps to achieve this effect: 
 

1. In the table design area, create a database block and select the Sharpe Ratio as the field to be 
displayed. 
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Figure 61 

 
2. Now, use your mouse and select an additional database block, dragging it up to the area to the 

right of the first block. 
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Figure 62 

 
3. Drop the block there and select the Mstar Ratio as your field. 
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Figure 63 

 
This single table will now display (in its output stage) those two values in the specified order of Sharpe 
Ratio and Mstar Rating.   
 
Database Table 
 
This block enables one to import and manipulate data that could previously only be used through a 
combination of a database link and SQL code. In MPI Configurator, any of the existing databases already 
configured can be expanded by attaching additional data which exists outside of Stylus. Database tables 
are added in Configurator from the shortcut (right-click) menu and may be Excel, MPI or ODL databases. 
Examples of data that could be added include holdings information, historical assets under management 
or economic data (such as treasury yields.) 
 
Dictionaries 
 
This block allows the user to access and implement the Dictionaries settings made in the Design Tree. 
Note that Dictionaries features may also be accessed through other areas of the application, such as the 
Distribution analytic block, etc. 
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Distribution 
 
A distribution chart allows you to study a frequency of distribution values of any variable belonging to any 
of the major calculation groups in the application.  In each case, you will be presented with two dropdown 
menus. 
 
The first dropdown menu allows you to select the variable to be examined.  In the example above, the 
variable would be Asset Loadings: Cash, Weight. 
 
The second dropdown menu indicates the specific unit of measurement to be used in the output.   
 
Note that distribution charts must always be bar charts. 
 

 
Figure 64 
 
MPI Stylus offers a range of additional controls that allow the user to specify several facets of the 
distribution's appearance.  These Range and Bins controls greatly expand the flexibility of distribution 
charts in the application. 
 
Range 
 
Lower/Upper 
The Lower and Upper range settings allow the user to specify precisely at what point the Tails setting will 
be applied (at what point truncation or aggregation will occur.) 
 
Tails 
The Tails settings give the user three options for how to treat distribution data beyond the Lower and 
Upper ranges.   

• Truncate cuts off distribution tails at the Lower and Upper settings and discards the information 
beyond those points  

• Truncate & Rescale applies the Truncate setting to the distribution tails, but then rescales the 
distribution to total 100%  

• Aggregate applies the Truncate setting, takes the sum of the discarded values and puts the new 
value in as the last data point on each tail.  This may result in a distribution with unusual 
peakedness at the tails (in addition to the normal distribution peak)  

Bins 
 
Num 
This allows the user to specify the number of bins/bars to use in a distribution. 
 
Size 
This allows the user to specify the range of values to be placed in each bin - in essence, the width of each 
bar in the chart.  For example, a size of 10 would force the distribution chart to break its distribution data 
up into blocks with ranges of exactly 10 units per block. If the bin size were to encompass the entire range 
of values, a single bar would appear. 
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Anchor 
This setting allows the user to specify the numerical point all distribution bars are numbered from.  For 
example, if the Anchor were set at 0.5, then the distribution bins would all be adjusted to start their 
numbering on a data point divisible by 0.5. 
 
Quantile 
 
The Quantile block functions similarly to the Scatter block, but instead plots a single variable against 
another variable with distributions expressed in terms of decile, quartile or rank value.   
 
The top dropdown menu assigns the statistic to the Y axis, and the bottom dropdown menu assigns it to 
the X axis.  A third dropdown menu allows you to select additional parameters for the two axes: 
 
Quantile-Quantile 
The first option is for a Q-Q plot, which is a graphical method of comparing two distributions.  The 
statistics on each axis are ranked by quantile from lowest to highest and plotted among their respective 
axis, starting at the origin and moving outwards.   
 
The “hypothetical” distribution values are plotted along the x-axis, and the “observed” values on the y-
axis.  If the two data sets have the same distribution, they should fall approximately along a 45-degree 
reference line where y=x. 
 
Downside Risk 
 
Downside risk charts are very similar to risk charts.  The difference is that Downside Risk calculates risk 
value as the semi-standard deviation with a zero mean; therefore, it measures volatility of loss, or simply 
the risk of loss. 
 
Please see the statistical glossary at the end of this manual for specific information on your Downside Risk 
options. 
 
An alternative measure of risk, semi-variance calculates the expected squared shortfall, or the variance of 
returns below zero.  This differs from standard deviation -- the traditional measure of risk --in that 
volatility of positive returns is not penalized.  Negative volatility remains penalized.  Semi-standard 
deviation is simply the square root of the variance. 
 
Downside Statistics 
 
The Downside Statistics block provides another set of measures of risk-adjusted return, comparable to the 
Sharpe and Information ratios.  In this case, semi-standard deviation is used in the denominator as a risk 
factor.   
 
Also found here is the Omega Ratio, which uses calculus to assess the probability of returns falling above a 
given threshold rate, without making assumptions about return distribution. 
 
Gain/Loss 
 
Gain & Loss are simply options for analyzing positive and negative returns separately for a given return 
stream.  Gain Frequency, which can be found on this block, is essentially a batting average with a 
threshold of 0 instead of a benchmark series.  Average gain/loss and Weighted gain/loss give an indication 
of whether a fund behaves the same way on the right side of the distribution as on the left. 
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Portfolio Analysis 
 

Formerly known as the Holdings block, the Portfolio Analysis block is used to either demonstrate the 
breakdown in assets of a fund of funds/portfolio (the function of the original block), or to calculate a 
variety of analytics regarding these holdings. 

Note for Use in Tables 

Unlike conventional blocks, only one checkbox at a time may be used for this block. Therefore, to show 
more than one analytic in a Table, you must drag in the block multiple times. 

 
Transpose Portfolio Block Layout (portfolios as fields) 
 
Starting with 11.3 an option was added when a Portfolio Analysis block is added to the Chart/Table 
Designer. When this option is enabled, portfolios (.fnd files) become “Fields” while underlying holdings in 
the portfolio become “Managers”. This allows the Portfolio Analysis block to be combined with other 
analytic blocks (as long as the portfolio underlying assets are in the managers node), as well as apply 
Filter/Sort/Group to the Portfolio Analytics block. 

Names 

Please note that in MPI Stylus Pro versions 7.0 and earlier, the names of portfolio assets displayed 
through this block were taken from the Description field in the appropriate underlying database. As of 8.0 
or later, the default field has been changed to the Label field, and users moving from 7.0 to 8.0 may 
notice a change in names for this field. 

Performance (Return) Analytics 

All of the return analytics are intended to provide an estimate of each underlying asset's contribution to 
the total Portfolio's performance. For convenience, the analytics can also be displayed as “standalone” 
values, providing a reference point for the asset’s performance independently. The different options take 
into account several different methodologies used in the industry for this purpose. 

In all cases, the periodic (i.e., Quarterly, Monthly) return contribution is calculated each period by 
multiplying the Manager return by its weight in the Portfolio at the end of the prior period. 

 

Annual Return (a) 

The arithmetic option averages the periodic return contributions and annualizes the result arithmetically. 
The arithmetic annual return contributions on the Portfolio Analysis block will sum to the arithmetic 
annual return for the Portfolio on the Performance block. 

 

Annual Return (g) 

The geometric option is comparable to the Style Attribution on the Performance Block.  The periodic 
return contributions are compounded geometrically, and then annualized.  Please note that, as with Style 
Attribution, the individual contributions do not sum to the Annual return.   

 

Total Return 

The total return option scales the periodic return by the previous period’s cumulative return for the 
Portfolio.  The result is that these contributions will sum to the cumulative return for the Portfolio, which 
is aggregated geometrically.  
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Scaled Return (a) and Scaled Return (g) 

These options rescale the arithmetic (a) or geometric total (g) return contributions to percentages of the 
total Portfolio.  These will sum to 100%.  

 

Risk Analytics 

The Risk Analytics are intended to provide an estimate of each of the underlying Managers’ contribution 
to the total Portfolio’s risk, as measured by the standard deviation of the Portfolio’s returns.  Identical to 
the methodology used in estimating Component Risk on the VaR block, we take the product of the 
Portfolio’s standard deviation and the slope coefficient of the underlying series versus the Portfolio series.  
The two risk options differ in the series used to represent both the Portfolio and the underlying.   

 

Current Risk 

For the Portfolio series, this option takes the Portfolio weights as of the most recent period, and creates a 
synthetic history with the current weights applied in all periods.  This option is more representative of the 
Portfolio’s risk characteristics now (and therefore for the next period), especially if there has been a large 
change in the underlying assets.  The series used for the slope coefficients are the actual (un-weighted) 
returns of the Portfolio components. 

 

Average Risk 

For the Portfolio series this option uses the observed historical returns.  This option is more easily 
interpreted as how each of the underlying series contributed to the total Portfolio risk in the past.  The 
series used for the slope coefficients are the periodic weighted returns described under Performance.  
The Average Risk contributions on the Portfolio Analytics block will sum to the total Portfolio Standard 
Deviation on the Risk block.   

 

Scaled Current Risk 

This option rescales the current risk contributions to percentages of the total Portfolio.  These will sum to 
100%.  

 

Scaled Average Risk 

This option rescales the average risk contributions to percentages of the total Portfolio.  These will sum to 
100%.  

 

99% and 95% VaR 

These options show the component value-at-risk contribution of each asset to the total portfolio VaR, 
calculated with either 99% or 95% confidence. 

 

99% and 95% Marginal VaR 

These options show the effect of changes in weight of each asset to the overall value at risk of the 
portfolio with either 99% or 95% confidence. 
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99% and 95% CVaR 

These options show the component conditional value-at-risk contribution of each asset to the total 
portfolio conditional VaR, calculated with either 99% or 95% confidence. See our VaR reference guide for 
insight into these computations. 

 
Use Custom Labels 
A ‘Use Custom Labels’ checkbox (Versions 8.0 or higher) allows users to override the default setting of 
having portfolio asset names taken from the Description field in the underlying database. When this box is 
checked, portfolio asset names are taken from the Portfolio Editor (in cases where the underlying name 
has been overwritten.) 
 
Please see the MPI website for our Portfolio Investment Groups user guide, which discusses this analytic 
block in further detail and expands on the ability to group assets. 
 

 

Holdings 

This area allows you to view the contribution statistics for elements including Benchmark Correlation, 
Downside Risk, Sharpe Ratio, Tracking error and more. 

 
Min/Max 
 
 
The Min/Max block provides the user with access to statistics including best and worst periods and 
drawdown. Included here are so-called ‘Pain Statistics’ such as the Underwater Index (mean drawdown of 
a Manager for a given period) and the Underwater Ratio (risk-return measure for comparing Manager 
performance to the Manager’s Underwater Index).   
 
MPT Statistics 
 
MPT Statistics allows you to create charts of selected statistics associated with modern portfolio theory 
(MPT).  Included here are such important measures as alpha, beta, Sharpe Ratio, Modified Sharpe Ratio 
(incorporating Cornish-Fisher VaR) and Batting Average.  It should be noted that arithmetic and geometric 
(g) calculations are available for many of these statistics; for more information, please see the glossary to 
this manual. 
 
Performance 

 
The Performance block gives the user access to a variety of common performance statistics, including 
regular and annualized returns.  A complete review of statistics and their formulas may be found in the 
glossary to this manual. 
 
 
Performance Statistics 
 
The Performance Statistics block is the key to a variety of performance and distribution-related statistics, 
including Information Ratio, t-stats, Confidence Intervals, Skewness and Kurtosis.   
 
K-Ratio 
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The K-Ratio measures a manager’s magnitude of wealth against the consistency of wealth generation over 
time. For the formula, please review our Formula Reference guide in the Tools menu of your application. 
 
Tests 
 
Also found here are three additional tests: 
 

• Kolmogorov-Smirnov normality test (p-value), which is based on the comparison of a series of 
hypothetical normal distributions.  Stylus provides the p-value for the test where a small p-value 
indicates that the distribution is not normal. 

• Jarque-Berra normality test (p-value), which uses the skewness and kurtosis of a series to 
evaluate a distribution’s normality.  Stylus provides the p-value for the test where a small p-value 
indicates that the distribution is not normal. 

• Durbin-Watson autoregression test (statistic), which, aside from being a check for regression 
model specifications such as missing factors, is often used to check for index trends and 
smoothed fund returns. 

 
A complete review of statistics and their formulas may be found in our formula reference, accessible from 
the Help menu. 
 
R-squared 

 
The R-square block gives users access to a variety of R-squared calculations, including Predicted Style R-
squared.  Users are encouraged to review Predicted R-squared and the other R-squared options in detail 
in order to ensure that each different measure is understood properly.  A complete review of statistics 
and their formulas may be found in the glossary to this manual. 
 
Risk 
 
The Risk block gives the user access to a variety of risk measures for charts and tables, including Standard 
Deviation.  Note that additional Risk measures may be found in other analytic blocks as well.  A complete 
review of statistics and their formulas may be found in the glossary to this manual. 
 
Scatter 
 
The Scatter block gives the user the ability to plot a full range of statistical calculations on the X and Y axis 
of a standard scatter chart, giving the user a wide variety of charts to create.  The top drop-down menu 
will designate the Y-axis statistic, while the bottom drop-down menu will designate the X-axis statistic. 
Beginning in version 11.0, you can add an optional third dimension variable that defines the size of the 
data points, creating bubble charts. These charts are described later in the document. 
 
Beginning in version 11.3 you can color peer groups multiple colors when Distribution is selected in the 
Aggregation settings. The option for coloring them is located in the top left corner 
 
 
Style Contribution 
 
This analytic block extends factor attribution to Risk, Tracking Error and the Sharpe Ratio. Each statistic 
may be broken down into Marginal and Component varieties, assessing the effect of small modifications 
to factor exposure or of an entire removal. 
 
Style Drift 
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The Style Drift analytic block includes functionality that allows you to expand upon and address limitations 
associated with what is traditionally referred to in academic literature as "style drift". Style drift is 
essentially style dispersion, and only provides part of the decision support story, so it is critical to 
understand its components and limitations. 

In MPI Stylus Pro, style dispersion can be decomposed into two critical components: trend and noise. By 
partitioning dispersion into these component parts, users can evaluate not only the volatility of an 
investment product's exposure behavior, but also assess the trend rate (velocity) and direction of the 
drift. 

Detailed information about Style Drift is available in the Style Drift User Guide and associated video, both 
of which are available on the MPI web site. 
 
Style Map 

 
Style Maps are special scatter charts that are designed to capture the investment style of a financial 
instrument.  This makes them extremely useful visual tools for any user wishing to evaluate the 
investment style of a manager versus the stated style of their prospectus.  A complete review of statistics 
and their formulas may be found in the glossary to this manual. 
 
 
Style Metrics 
 
This block allows you to make use of MPI's proprietary, patent-pending Style Metrics measures, which 
present a style-based measure of fund similarity that is more accurate in many ways than correlation or 
holdings-based active share. For more information, please see our Style Metrics User Guide. 
 
Summary Statistics 
 
The Summary Statistics analytic block provides a powerful second layer of analysis to time series statistics 
calculated through other analytic blocks. For example, the block could be used to calculate the average of 
rolling standard deviations for a given manager. Given the flexibility and power this tool adds to the 
application, we recommend that users review the available sample study (available from MPI support) for 
some additional practical examples of this feature. 
 
VaR and VaR Testing 

 
These two analytic blocks allow you to report on top-down, returns-based value-at-risk measures of your 
managers and portfolios, and to test those models using various distributions. For much more 
information, please see our VaR User Guide. 

 
Scenarios 
This block allows you to perform analysis of exposures to hypothetical shocks/scenarios. The block allows 
you to pick scenarios to be evaluated from the library of scenarios defined within Stylus Workspace.  
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Figure 65 
 
For each scenario the block outputs a single number – theoretical performance due to the specified shock. 
For more information about scenario analysis, please see our Advanced Risk Analysis Guide. 
 
This block is available for users with Advanced Analytics license. 
  

 
Multi-section (Combination) Charts 
 
This feature was introduced in Version 10.0 to give users the ability to create powerful, flexible charts that 
combine multiple analytic blocks. For example, a single chart might display both Return and Standard 
Deviation, or might display rolling returns and 1,3,5 Y returns. To create these two types of charts, you will 
use two slightly different approaches. 
 
Creating a Multi-section Chart that uses the same Aggregation Settings 
 
This option is for creating a multi-section chart that uses the same aggregation settings for all statistics. As 
an example, you might want a chart that shows Total Annualized Return and Total Annualized Standard 
Deviation for 1, 3 and 5 years. 
 
To create a multi-section chart: 
 

1. In the Chart Designer, click the ‘Multi-section’ checkbox. 
2. You may now drag multiple analytic blocks into the chart, in effect the same way you can put 

multiple analytics in a table. You would then fill out aggregation settings as need be. 
 
 Creating a Multi-section Chart that uses different Aggregation Settings 
 
This option is for creating a multi-section chart that uses different aggregation settings for one or more 
analytic blocks/statistics. As an example, you might want a chart that shows Total Annualized Return for 
1,3,5 years, while providing rolling standard deviation. 
 
To create a multi-section chart: 
 

1. On the Design Tree, right-click on the Chart you would like to turn into a multi-section chart. 
2. Click ‘Add Section’. 
3. You will notice that a ‘child’ chart is now added to the original chart. In this manner, you can add 

the appropriate analytic blocks and aggregation settings to each particular chart. 
 

See our Combination Chart Design User Guide for more details, and Stylus’ report gallery for example 
combination charts. 
 
Use Secondary Y-axis 
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This option, found within Analytic blocks, is an additional way to create multi-section charts. When you 
click this box, a checked field in the Analytic Block is added to the Y-axis of the chart. 
 
Rearranging Section blocks 
When multiple analytic blocks are available, the user may change the order in which they appear (and 
thus, are displayed in output) by clicking on the small gray arrow next to the ‘X’ button in a given block in 
order to move it. 

 
Bubble Charts 
 
Beginning with MPI Stylus Pro 11.0, users have the ability to add a third dimension to scatter plots and 
other charts that defines the size of symbol of each series. You can use this option whenever a “Bubble-
section” checkbox appears at the top of your Chart Designer. 
 
To turn a regular chart into a bubble chart: 

1. In the Chart Designer, check the “Bubble-section” checkbox.  
2. Drag and drop an additional Analytic Block in the designer. This block will provide the analytic 

value that defines the symbol size. Note that only one analytic may be selected. 
3. Review the chart. You will notice that each bubble will be sized differently. 
4. If you wish to make the bubble size the inverse of the analytic you chose (larger values have 

smaller bubbles) 
a. Open the Attributes Editor for the chart 
b. In the “Style” tab, under Attributes for the chart, click the “Reverse” checkbox. 

 
You will find a number of sample bubble charts in the Stylus gallery. 
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Parameters – Series Selection Settings  

 

 
Figure 66 
 
Charts and tables can be designed to include many different combinations of the managers, benchmarks, 
peer groups and style indices that you have included in the design tree.  
 
Managers (Mng) 

 
The manager selector contains all the series that you added to the manager node of the design tree. Use 
the checkboxes next to each manager to include them in the chart or table. Checkboxes to the right of the 
dropdown selector can be used to quickly select or deselect all managers. 
 
Beneath all managers in the list are numeric entries (e.g. (2), (-1)). These are used when you wish to 
include managers in the chart based on their position in the design tree. For example, check “(2)” to 
include the second manager in the list, or “(-1)” to include the first from the bottom.   
 
Filter Expression Mode 
Clicking this button enables the filter/sort/group functionality, which you can use to create and apply 
dynamic rules for inclusion, ordering and grouping of the managers. With this option enabled, an ellipsis 
“…” button is presented. Clicking this button takes you to a dialog for defining the rules. Please reference 
the Filter-Sort-Group User Guide on our website for further details. 
 
Style Indices (Ind) 

 
You may include style indices in a chart or table for comparison with managers using this control. This 
selector behaves similarly to the Managers selector. By default, no indices are included.  
 
Note that your selection in this option does not affect which indices are used for style analysis.  
 
Peers 
 
Beginning with MPI Stylus Pro 11.0, each the peer group used in each chart or table can be selected 
independently; until this release all charts in a study used the same peer group. These selectors allow you 
to choose which, if any, peer statistics you wish to see and the peer universe that you wish to see them 
computed for. 
 
The following peer statistics can be displayed. By default, no peer group analysis is performed. Note that 
including peer statistics, particularly for large universes, can dramatically increase the time it takes your 
study to generate results. 
 
Distribution 
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Show the value for each percentile band over the peer universe. Peer bands are defined in the study 
parameters.  
 
Median 
Show the median value for all managers in the peer universe. 
 
Average 
Show the simple, equally-weighted average value for the peer universe. 
 
Min and Max 
Include the smallest or largest values across all managers in the peer universe. 
 
Size 
Display the number of managers in the universe for the period. 
 
Peer selection is achieved using a control similar to managers and style indices. One important difference 
is that the peer analysis for the chart or table is performed on the union of all selected peer groups.  
 
Default Peer Group 
Users of MPI Stylus Pro prior to version 11.0 traditionally control the selection of peer groups for the 
entire study through the design tree. In order to support this behavior and maintain backwards 
compatibility, charts and tables may opt to select as a peer group all those sets marked as default in the 
design tree. See chapter 3 for more detail on the design tree feature. 
 
Benchmarks (Bmk) 

 
You may use this selector to choose the benchmarks, if any, that is used in each chart or table. The 
selector works similarly to the manager selector described above, which a few notable differences. 
 
Like the peers selector, this control defines the benchmark that will be used in all calculations in this chart 
or table. This is relevant for statistics such as excess return and beta. If you choose no benchmarks, all 
calculations requiring one will be reported as “N/A”. Beginning with MPI Stylus Pro 11.0, you may select 
multiple benchmarks within the same chart for comparison. 
 
Default Benchmark 
You may highlight one benchmark in the design tree as the default benchmark. Choosing “Default” in this 
selector allows you to control the benchmark used in a chart or table from the design tree. 
 
Show Benchmark 
Checking this box allows you to display all selected benchmarks as series in the chart.  
 
MPI_BMKPRIMARY and MPI_BMKSECONDARY 
Introduced in version 11.0, these selections allow you to report against a different primary and secondary 
benchmark for each manager. The values in each benchmark-relative field will be, for each manager, 
calculated against the benchmark defined in that manager’s MPI_BMKPRIMARY or MPI_BMKSECONDARY 
property. Refer to our sample study available from the MPI website for examples of this feature in use. 
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Parameters – Chart and Table Aggregation Settings  

 
Aggregation Settings 
 

 
Figure 67 
 
 
The four aggregation setting controls affect the selection and appearance of data for your output.  They 
are: 
 

▪ Output Frequency, which controls the specific data points displayed in your chart or table 
▪ Aggregation, which defines how the results of style analysis and performance data are 

aggregated prior to appearing in output 
▪ Output Interval, which allows you to adjust the date range that appears in a given chart or table 

(when the required date range is inconsistent with the main range specified in the Parameters 
node) 

▪ Output Date Range, which allows the user to change the date range assessment made by MPI 
Stylus Pro about a return stream. 

 
Output Frequency 

 
The Output Frequency control allows you to select specific points to display and the number of points or 
bars to appear in a chart, the number of rows in a table, and so on. The possible options are: 
 
All 
Displays all available data points. 
 
Every 
This allows you to show a periodic subset of the available data points. The output is shown in equal 
increments and the size of the increments is determined by two additional parameters: the period 
frequency (daily, weekly, monthly, quarterly, and yearly) and the number of these calendar periods. You 
can also select the Non-overlap check box. 
 
Please note the effect of specifying the same output period using different calendar periods, for example, 
2 Quarters versus 6 Months. While the time between consecutive output points is the same in both cases, 
in the first case the output points are aligned with the end of each calendar quarter (March and June), 
while in the latter case such alignment does not necessarily occur. 
 
The calendar period on this control cannot be used to exclude the latest point. This point is always 
included in the output, even if it does not coincide with the selected calendar period. 
 



MPI Stylus Pro  
 

Copyright 2005-2020, Markov Processes International, Inc.Page 154 

 

When working with daily data, the principle of selecting calendar periods remains the same. For example, 
a calendar period of 5 Days means five business days and, in general, the output points are different from 
those obtained when the calendar period is 1 Week. 
 
Select the Non-overlap check box to automatically set the size of the window equal to the output period. 
 
 
 
Custom  
This option gives you complete control over the output. When you select this option and click the (…) 
button, the Edit Custom Frequency dialog box displays. Please note that in Versions 7.1 or later, selecting 
this option will automatically select the ‘To-date’ aggregation setting (Custom and To-Date should always 
be used together.) 
 
This tool allows you to specify periods of different length and assign custom labels to each period. The 
available periods are Beginning, Day(s), Week(s), Month(s), Quarter(s) and Year(s). 
 
Custom also allows you to create a chart that shows date periods of unequal length. An example is a chart 
that shows portfolio returns since the beginning of the year and for the last 1, 3, and 5 year periods. The 
Beginning option lets you guarantee that the point corresponding to the first available date in the output 
range is always included in a chart. You can use this feature to calculate the portfolio return since 
inception and include it in a chart or a table. 
 
Mixed (Tables only) 
The Mixed option allows users to format tables with mixed return periods, such as monthly returns 
followed by quarterly, etc. There are a total of five options from which to choose. In addition, the user 
may type in any combination of the below letters into the textbox instead of using one of the provided 
settings. 
 

• MY – Gives monthly returns followed by the annual return 

• MQ – Gives monthly returns followed by each quarter return for a 12-month period 

• QY – Gives quarterly returns followed by the annual return 

• MQY – Gives monthly returns followed by quarterly and then annual 

• YQM – Gives the annual return, followed by quarterly and then monthly 
 
Aggregation 

 
The Aggregation control defines how the results of style analysis and performance data are aggregated 
prior to appearing in the output.  
 
The available options are: 
 
None 
This means that no aggregation is performed on the data. 
 
Cumulative 
This means that the data are aggregated from the first point forward.  This is used in calculating data 
where wealth over time is being displayed, such as in growth of a dollar charts. 
 
To-date 
This means that the data are aggregated from the last point backward.  This setting will automatically be 
switched to when the ‘Custom’ Output Frequency is used in MPI Stylus Pro Versions 7.1 or later. 
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Window 
This is very effective in suppressing noise in the data. In the case of asset loadings, a rolling window is 
equivalent to applying a moving average to the output of the computational engine. This simple 
technique makes the results of some analyses much easier to understand. The rolling window technique is 
even more effective when applied to daily and weekly data, where the level of noise is somewhat higher. 
 
 
 
Total  
This is the single (entire) period measurement of the data. This can be accumulation or average, 
depending on the data 
 
Output Interval 

 
By default, charts and tables display data for all available dates specified in the Parameters node.  When 
the overall date range is inconsistent with the range you would like to show in a specific chart or table, 
you may change the interval using the Output Interval setting.  Please note that you may only further 
restrict date ranges from the main range in the Parameters node – you can not expand outside of that 
range in charts or tables. 
 
The Output Interval options are: 
 
All 
This captures the entire available timeline specified in the Parameters node. 
 
First/Last 
These options allow the user to specify that only the first or last X periods should be used for the 
chart/table. 
 
Interval 
This allows the user to select a different date range than that in the Parameters node (it may not be 
longer than the date range in Parameters.) 
 
Note that the pushpin button in this section may be used to ‘pin’ the interval to always adjust to the 
common end date period. 
 
+fraction 
The +fraction option starts the output with the beginning of a calendar period and continues through the 
latest available date; without such an option, the chart end date would coincide with the end of the most 
recent calendar period. 
 
Output Date Range 

 
The Output Date Range allows the user to change the date range assessment made by MPI Stylus Pro 
about a return stream.  The Default setting accepts the Limit specified in the Parameters node; however, 
you have additional options, including: 
 

▪ Manager Dates 
▪ Common Dates 
▪ Common beg, which stands for Common beginning and holds return streams to a common start 

date (but not end date.) 



MPI Stylus Pro  
 

Copyright 2005-2020, Markov Processes International, Inc.Page 156 

 

▪ Common end, which holds return streams to a common end date (but not start date.) 
▪ All dates 

 
Partial Data 
In addition, the user may select to use partial period data in these settings. 
 
 
Regime Analysis 
 

 
Figure 68 
 
Stylus Version 11.4 introduced new ways of grouping / filtering dates for charts and tables used in the 
views and reports. Regime Analysis option shown in Error! Reference source not found. allows user to s
elect Regime Models or Stress Tests.  Please see the Advanced Risk User Guide for more information on 
this functionality. 

 
Regime analysis option allows user to select one or more regimes within a single Regime 
Model.  
 

 
Figure 69 

 
The analysis performed using regime models will assume aggregation setting of “Total” 
and will produce a number of data points dependent on the number of regimes that 
exist in the model and are selected by the control. The data points will appear either in 
alphabetical order or the order specified by special sorting instruction specified in the 
regime name (e.g. {01}, {02}, etc.).  
 
Historical Stress Tests 

This option allows user to select one or more stress tests from multiple stress test 
groups. Similar to Regime Analysis option the number of output data points will equal to 
the number of specified stress tests. Total aggregation is assumed. The data points are 
sorted by the starting dates of each stress tests. 
 
See Advanced Risk Analysis document for more information about Regime Models and 
Stress Tests. 
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Memo Design 

 
Memo design in MPI Stylus Pro is significantly different from chart or table design.  You will have two 
options when designing memos – essentially, two modes in which to work.  The first mode will be a plain 
text mode, where you can enter simple text requiring no adjustments.  The second mode will be the rich 
text editing mode, which gives the user far more power to adjust memo content and formatting. 
 
Plain 
 
The plain text memo mode allows you to enter text in a simple format; essentially, what you see is what 
you get.  This allows for the quick creation of memos that have consistent format and easy-to-read 
content.  In addition to regular text, you may also use macros to enhance this section’s functionality. 
 
Rich 
 

 
Figure 70 
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The rich text memo mode is far more powerful than the plain text mode, and gives you word processing 
powers similar to those found in major word processing applications.  In addition to regular text, you may 
also use macros to enhance this section’s functionality. 
 
Most of the features available in the rich text editor should be familiar to users from other word 
processing applications; however, a few are either unique to MPI Stylus Pro or require additional 
explanation.  Please see below for details. 
 
Table Cell Formula & Formatting Controls 
 

 
 
Table cell formula & formatting controls present in the Rich text editor give the user additional control 
over table data and formatting and help replicate some abilities present in spreadsheet data programs. 
 
Cell Name 
The Cell Name field allows you to assign a name to a given cell in your table in order to be able to 
reference that cell.  The name may be a number, text string or combination of both; for example, the user 
may wish to mimic the popular A1, A2, A3, B1, B2, B3… format used in spreadsheet programs. 
 
To assign a name to a cell: 
 

1. In the appropriate table, click inside of the cell you wish to assign a name for. 
2. Click in the Cell Name field and type in the desired name of the cell. 
3. Once you have typed in the name, you may either press the “Enter” key or click elsewhere in the 

table to lock in the cell name.  You can change the name again at any time by repeating this 
process and overwriting the old name. 

 
Cell Formula 
The Cell Formula field allows you to input basic formulas to adjust the output content of a given cell.  This 
may include the use of basic mathematical signs, such as +, -, * and /.  Please note that this cell formula 
area does not necessarily support conventional Microsoft Excel formula entry parameters; however, you 
can leverage content from other cells by referring to the names assigned to those cells and using 
traditional mathematical operators.  The formula supports syntax and functions defined by the 
StylusExpress language (see Stylus Macro documentation.)  For example, if you have named two cells “A1” 
and “A2”, and they have values of 10 and 5, respectively, then you can produce the following formula in a 
third cell: A1+A2.  This will lead to the third cell displaying a result of 15. 
 
To enter a cell formula: 
 

1. In the appropriate table, click inside of the cell in which you wish to enter a formula. 
2. Click in the Cell Formula field and type in the desired formula.  Make sure to avoid common 

mistakes such as referencing the cell you are using for the output in the equation itself. 
3. Once you have typed in the formula, you may either press the “Enter” key or click elsewhere in 

the table to lock in the cell formula.  You can change the formula again at any time by repeating 
this process and overwriting the old name. 

 
Re-calculate 
The calculator button in this section re-calculates cell totals based on changes you made to cell name or 
formula values. 
 
Format 
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The format field allows the user to adjust the format of values returned in a given cell in a memo table.  
This field uses standard MPI Stylus Pro formatting codes.  (See “Format Specifiers” in Stylus Macro 
documentation.) 
 
Restore 
 
When used in memo design, the Restore button will revert the memo to its status when the user opened 
it for editing. 
 
Notes 
This option provides a report or template designer with a scratchpad to record notes about the design of 
the memo, possibly for use by others to later understand or modify the content. 
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Reports 

 
Reports in MPI Stylus Pro are the application’s actual publishable output.  They represent fact sheets, 
books and other investment documents that can be made ready to share with clients, colleagues and 
other investment professionals.  MPI Stylus Pro offers users a rich and powerful variety of reporting 
options, and MPI highly encourages users to carefully review this entire chapter in order to ensure that 
they are getting the most from reporting features in Stylus.   
 
Modules Using Reports 
 
Al modules in MPI Stylus Pro, except Prospector, have a Reports node that works according to the 
instructions in this chapter.  It is possible to use Prospector output through MPI Integrator; for more 
information, please see the chapter on Integrator. 
 

Working with Reports 
 
Report Icons in Menu Bar 
 

 
 
The Report ribbon contains a number of buttons that allow you to accomplish quick tasks. You can see it 
here in the central spot of the larger ribbon. Left to right, the relevant buttons in the Report section are: 
 

• Create new Report 

• Delete Report (affects the currently active Report) 

• Report Page (allows you to adjust page controls such as orientation, margins, etc.) 

• Add Page 

• Delete Page 

• Insert blank chart (this allows you to create a new chart or link to one in a View) 

• Insert blank table (this allows you to create a new table or link to one in a View) 

• Insert blank memo (this allows you to create a new memo or link to one in a View) 
 

Users who do not wish to use these shortcuts may use the traditional methods below. 
 

Creating a New Report 
 
There is no limit to the number of Reports you may create in MPI Stylus Pro; however, you may wish to 
organize your studies and their Reports in a way that makes them efficient to maintain. 
 
To create a new Report: 
 

1. In Stylus, Allocator or Integrator, click on the “Reports” node on the design tree. 
2. In the data pane on the right-hand side, click the “New” button.  A new Report will appear in the 

data pane, on the design tree under the Reports node, and as a new output tab along the bottom 
of your screen.  The Report will have an automatically generated name such as Report1, Report2, 
etc. 

3. To populate the Report with charts, tables or memos, see “Editing Reports” below. 
 
 
 
Renaming Reports 
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If you wish to rename a Report for organizational purposes (i.e., change Report1 to MyReport): 
 

1. Double-click on the name of the Report on the design tree.  You will now be able to type in a new 
name for this Report. 

2. When you have finished typing, hit the Enter key on your keyboard.  The Report’s name will now 
be changed.  Note that the Report tab will also reflect the name change. 

 
Reports may also be renamed in the Reports data pane: 
 

1. Click on the Reports node in the design tree. 
2. In the data pane, double-click on the name of the Report you wish to rename. 
3. Delete the old text and type in the new Report name. 

 
Editing Reports 
 
There are two ways in which a user can edit a Report. 
 

1. By editing the organizational structure of the Report, such as adding, deleting or rearranging its 
component charts, tables and/or memos; or 

2. By editing the actual charts, tables and/or memos within the Report (this will be discussed later 
in this chapter.)  In most cases, the user will go to the linked Views to edit these charts, tables 
and memos. 

 
Once you have created a new Report, you will wish to add one or more charts, tables or memos to the 
Report. 
 
There will be two steps to creating a new chart, table or memo in MPI Stylus Pro. The first step will involve 
adding a chart, table or memo block to a Report. This serves as a placeholder and tells the application 
what kind of Report you wish to display.  The second step will be designating the analytic, data or text 
that will populate the Report. 
 
The controls for creating new chart, table or memo blocks and designing your Report pane are quite 
simple and consist of the blocks themselves and band quantity and orientation controls. 
 
Blocks 
 
Chart, table and memo blocks (visible in the picture above) serve as visual placeholders in both Views and 
Reports, and also tell MPI Stylus Pro what kind of information you need to show in a given View or Report. 
 
Deleting Reports 
 
Before deleting a Report, please consider whether you are interested in deleting the entire Report or just 
one chart, table or memo within it.  If you delete an entire Report, you will permanently lose all 
formatting and links for the Report (it will have to be rebuilt from scratch.)  If you wish to remove a 
Report from View as a tab without deleting it, simply uncheck the Report on the design tree – you may 
then check it again at any time. 
 
To delete only a chart, table or memo within a Report: 
 

1. In the Views node of the design tree, click on the View that contains the chart, table or memo 
you wish to delete.   
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2. If the chart, table or memo is not in a View but in the Report itself (not linked), in the Reports 
node of the design tree, click on the Report page that contains the chart, table or memo you wish 
to delete. 

3. You may now either delete the chart, table or memo by right-clicking on its name on the design 
tree and selecting “Delete”, or by simply grabbing the block corresponding to the chart, table or 
memo and dragging it off-screen.  It will automatically be deleted. 

 
To delete a Report: 
 

1. Click on the Report’s name under the Reports node of the design tree. 
2. You may now either right-click and select “Delete” or simply press the “Delete” button on your 

keyboard. 
3. The Report has now been deleted. 

 
It is also possible to delete a Report in the data pane: 
 

1. Click on the Reports node on the design tree. 
2. In the data pane, click on the name of the Report you wish to delete. 
3. Click the “Remove” button.  The Report will be deleted. 

 
WYSIWYG export 
 
This checkbox allows the user to select WYSIWYG export (What You See is What You Get). This option 
allows text in exported charts to more accurately reflect the way the text looks in MPI Stylus Pro. Reports 
exported to PPT, PDF, RTF and image (metafiles) often include charts with font sizes that do not match the 
sizes used in the application itself. Checking this feature will result in a closer match. 
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Report Formatting Pane 

 

 
Figure 71 

 
When you create a new Report in MPI Stylus Pro, you will use the Report formatting page to tell Stylus 
how many pages you want, as well as to specify some basic Report-wide information. 
 
 
New Page 
To create one or more new pages for a Report: 
 

1. Click on the Report name in the design tree.  In the data pane you will see the Report Formatting 
pane. 

2. Click the New button once for each new page you wish to create. 
 
Deleting a Page 
There are multiple ways to delete a Report page in MPI Stylus Pro – you can either do it on the design 
tree, or in the Report Formatting Pane. 
 
To delete a Report page: 
 

1. In the Report node on the design tree, click on the Report that contains the page you wish to 
delete. 

2. You may either right-click on the page’s listing in the design tree and select “Delete”, or you may 
use the “Remove” button in the Report Formatting pane. 

 
Rearranging Pages in a Report 
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There are multiple ways to rearrange page order in a Report – you can either do it on the design tree, or 
in the Report Formatting Pane. 
 
To rearrange page order: 
 

1. In the Report node on the design tree, click on the Report that contains the pages you wish to 
rearrange. 

2. In the design tree, you may left-click on the icon for the page and drag it to a new position within 
the Report and drop it there.  Please note that page names (Page1, Page2) will not change to 
reflect new position. 

3. Alternately, you may go to the Report Formatting Pane and click on the page name there.  You 
may then use the Up and Down arrows to rearrange page order. 

 
Header 
 
The Header is a line of text that will appear near the top of every page in your Report (you may adjust at 
which page it begins to appear.)  This is useful when you wish to enforce consistency across all Report 
pages, and you may use macros in the header to help improve efficiency. 
 
The default header for a new Report is “Stylus Report|@Now{mmmm d, yyyy}”, which generates text that 
reads “Stylus Report” and gives the current date.  This may be changed or deleted in the Header field of 
the Report Formatting Pane. 
 
The margin settings for a header may be adjusted using the Margins Controls found elsewhere in the 
Report Formatting Pane. 
 
To add a new header: 
 

1. In the Report node on the design tree, click on the Report for which you wish to make a new 
header. 

2. In the Header field in the data pane, delete any text in the header field and enter the new text 
you wish to use. 

 
To delete a header: 
 

1. In the Report node on the design tree, click on the Report for which you wish to delete the 
header. 

2. In the Header field, select any text with your mouse and press the “Delete” button on your 
keyboard. 

3. When the Header field is blank, it means that no header will be shown. 
 
Header Fonts and Sizes 
You may adjust the font type, style and size for your header by clicking on the font size button at the end 
of the header line.  This will open the Font box and allow you to specify the Font type, the style (bold, 
italic, etc.) and the size. 
 
Header alignment 
You may align your header to the left, center or right of the Report by using one of the three header 
alignment buttons at the end of the Header field. 
 
Starting page to place header 
Users may choose to make their header start at a later page than page 1 of their Reports by adjusting the 
“Starting page to place header” box.   
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Footer 
 
The Footer is a line of text that will appear near the bottom of every page in your Report (you may adjust 
at which page it begins to appear.)  This is useful when you wish to enforce consistency across all Report 
pages, and you may use macros in the footer to help improve efficiency. 
 
The default footer for a new Report is “Page @Page”, which generates text that reads “Page” and gives 
the page number for each page.  This may be changed or deleted in the Footer field of the Report 
Formatting Pane. 
 
The margin settings for a footer may be adjusted using the Margins Controls found elsewhere in the 
Report Formatting Pane. 
 
To add a new Footer: 
 

1. In the Report node on the design tree, click on the Report for which you wish to make a new 
Footer. 

2. In the Footer field in the data pane, delete any text in the Footer field and enter the new text you 
wish to use. 

 
To delete a Footer: 
 

1. In the Report node on the design tree, click on the Report for which you wish to delete the 
Footer. 

2. In the Footer field, select any text with your mouse and press the “Delete” button on your 
keyboard. 

3. When the Footer field is blank, it means that no Footer will be shown. 
 
Footer Fonts and Sizes 
You may adjust the font type, style and size for your Footer by clicking on the font size button at the end 
of the footer line.  This will open the Font box and allow you to specify the Font type, the style (bold, 
italic, etc.) and the size. 
 
Footer alignment 
You may align your Footer to the left, center or right of the Report by using one of the three Footer 
alignment buttons at the end of the Footer field. 
 
 
Starting page to place Footer 
Users may choose to make their Footer start at a later page than page 1 of their Reports by adjusting the 
“Starting page to place Footer” box.   
 
Use chart/table names as their titles 
 
When this option is checked, MPI Stylus Pro will assign titles for each chart and table based on their 
names.   
 
Margins Controls 
 
MPI understands that many of our users require very specific margins for their Reports in order to be 
compliant with existing firm or industry standards; therefore, MPI Stylus Pro allows for extremely 
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powerful margin control measures.  The Margin Controls in the Report Formatting Pane are the only place 
where margins for a Report may be explicitly specified, and once they are specified, the user will be 
unable to accidentally or intentionally violate the margins in the Report design page without returning to 
this area to change their settings.  This ensures ease of mind when building Reports. 
 
Header and Footer Margins 
Margins may be set for headers and footers using the Header and Footer up/down menus in this area.  
The default settings are 0.5 inches for both the header and the footer.  This may be increased or 
decreased by clicking on the up/down arrows.  In addition, the user may manually enter a setting. 
 
Page Margins 
Margins may be set for a page using the four up/down menus in this area.  The default settings are 1.0 
inches for both the top and bottom margins, and 1.25 for the left and right margins.  This may be 
increased or decreased by clicking on the up/down arrows.  In addition, the user may manually enter a 
setting. 
 
Orientation 
 
There are three orientation options for Reports in MPI Stylus Pro: Portrait, Landscape and Screen.  It is 
important to choose the correct orientation because changing an orientation later may result in 
difficulties with your Report design (if you have already designed your Report at the time of the change.) 
 
Portrait 
The portrait orientation is for documents in a vertical layout.  It is one of the two recommended formats 
for hardcopy publishing, along with landscape. 
 
Landscape 
The landscape orientation is for documents in a horizontal layout.  It is one of the two recommended 
formats for hardcopy publishing, along with portrait. 
 
Screen 
The screen orientation is used specifically for presentations meant to be displayed on a computer screen 
(such as in a program like PowerPoint.)  Computer screens have different dimensions than the landscape 
format, which is intended for 8.5 x 11 inch paper.  Therefore, it is important to do computer presentations 
in the screen format to avoid adjustments when the document is exported from portrait or landscape to a 
computer-based program. 
 
 
 
Paper 
 
You can adjust your print output size to be consistent with two paper sizes. Please note that these sizes, 
while quite similar, are not identical. 
 
Letter 
This is conventionally sized paper (normal printing paper) for users in the United States or other countries 
that use the US paper standard. 
 
A4 
This is  conventionally sized paper for users in Europe or other countries that use the European standard.
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Link to View 

 
The Link to View feature represents a key part of MPI Stylus Pro’s powerful, flexible reporting capability.  
By allowing the user to link a chart, table or memo block in their Report to a chart, table or memo in a 
View, Stylus gives the investment professional the following capabilities: 
 

▪ The ability to use a single chart, table or memo multiple times in different capacities and in 
different Reports. 

▪ The ability to organize charts, tables and memos for quick analysis and review, and then to 
select the most appropriate output for use in a Report without having to recreate it. 

▪ The ability to change a chart, table or memo only one time and have the changes automatically 
propagate across all use in multiple Reports, avoiding possible errors while enforcing 
consistency. 

 

 
Figure 72 
 
The Link to View concept is simple.  Whenever you create a new chart, table or memo in your Reports, 
you will have the ability to adjust its size and position in the page designer; however, to specify its content 
you will have to the chart/table/memo’s name under the correct Report and page on the design tree. 
 
When you first click on a new chart, table or memo in a Report, you will see the Chart, Table or Memo 
designer fields just as you would in a View.  However, there will be one important addition – the “Link to 
View” button in the upper right-hand corner of the designer.  When you press this button, the Link to 
View screen will appear, and you will be able to simply link to a chart, table or memo in your Views 
without having to create a new one.  Once you have linked to this View, you will be able to go directly to 
your Report and view the output.  You will be able to make additional aesthetic changes within the Report 
through the various Report design tools available. 
 
To link to a View: 
 

1. Identify the View tab name for the chart, table or memo you want to link to, as well as the actual 
name of that chart, table or memo. 

2. In the Reports node, click on the page where you want to display this chart/table/memo.  If you 
have not already done so, insert an appropriate block on this page using the Page Designer. 
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3. Once you click on the appropriate block name in the design tree, you will see the chart, table or 
memo designer in the data pane.  This will allow you to create a new chart as if you were in a 
View; however, there will also be the Link to View button.  Press this button. 

4. You are now in the Link to View screen.  You will see a list of all available charts, tables or memos 
(depending on the block type) to which you may link.  The View column will tell you the name of 
the tab/location of each item, and the Table column will tell you the item’s name.  Click on the 
appropriate item with your mouse. 

5. Your View is now linked to your Report.  You may go to the Report output to view your chart, 
table or memo.  Should you need to make any changes to it, you may do so directly through the 
View. 
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Reporting Pane 
 
The Reporting Pane contains a few key areas that are very useful in report creation and navigation. 
 
Report Page Navigator 
 
This pane, visible on the left side of your Report output, will allow you to jump between different pages in 
the Report without having to use the left and right arrow buttons. You may also use drag-n-drop to 
rearrange Report pages via this pane. 
 
Report Alignment Tools 
 

 
Snap to grid 
This option ‘snaps’ charts, tables and memos to the grids that sit behind your Report design. This is a 
helpful way to be sure that your various objects line up well. 
 

 
Show grid 
This option can show/hide the grid behind your Report, allowing you to better design and arrange your 
Report layout. 
 

 
Restore 
This button undoes your last action. 
 

Report Gallery 
 
The Report Gallery provides many of the same features found in the View Gallery, along with a few that 
are specific to Reports. 
 
Views 
 
This section allows you to access View tab names via dropdown, in order to decide which underlying 
charts, tables or memos to bring in to your Report. Using this method will automatically create linked 
views, as opposed to new charts/tables/memos that exist only in the Report. Note that this applies only to 
charts/tables/memos you have created; the ‘Charts and Tables’ section below can be used for adding new 
charts/tables from our prepackaged set. 
 
Objects 
 
This area allows you to drag-n-drop object types directly into your Report. For example, you might pull in 
a horizontal and vertical line which you can then adjust using a combination of drag-n-drop and Object 
Editor features. 
 
Charts and Tables 
 
This section works identically to the Views Gallery, in which you may peruse analytic block types and 
select from sample charts/tables that may then be included in your Report. These charts/tables are pre-
existing and do not have to be manually created by you. 
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Daily Charts and Tables 
 
Visible to High Frequency (Daily) advanced package subscribers only, this adds an additional set of 
charts/tables that are useful with daily data analysis. 
 
Themes and Formats 
 
This section allows you to choose between Charts and Tables and to apply color themes or table formats 
to your Report. This is a quick and easy way to make table gridline formatting or other such elements 
consistent without using the Attributes Editor or other tools. 
 
Aggregation 
 
This option works identically to the same option in the Views Gallery. For more information, see the Views 
section of this chapter. 
 
Filter/Sort/Group 
 
This section, visible only to Advanced Database package subscribers, works identically to the same option 
set in the Views Gallery.  
 
In version 11.3 an additional level of Filter/Sort/Group was added. This feature gives you a way to 
Filter/Sort/Group fields, rather than just Managers. 
 
For more information on this functionality, please see the Filter/Sort/Group User Guide, available from 
MPI. 
 
 

Attributes Editor 
 
The Attributes Editor is one of the most powerful reporting tools in MPI Stylus Pro, and becoming familiar 
with its features and possibilities will dramatically improve your ability to produce high-quality Reports. 
 
The Attributes Editor is different for charts and tables; therefore each will be examined separately. 
 
The Attributes Editor for charts contains six tabs that govern different areas of a chart’s design: 
 

▪ Style 
▪ General 
▪ Axes 
▪ Zoom 
▪ Text 
▪ Layout 

 
General Features 
The Attributes Editor includes a few common features. These are available in the menu in the upper right 
corner of the dialog. 
 
Copy Attributes 
This feature allows you to copy all of the attributes that have been set for the given chart or table so that 
they can be pasted into another chart or table. 
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Paste Attributes 
This feature allows you to paste in attributes copied from another chart or table. 
 
Edit Notes 
You can click this to open the scratchpad editor for notes associated with this chart or table. This same 
scratchpad can be accessed through the chart or table designer. 
 
 
Style Tab 
 
 

 
Figure 73 

 
The style tab governs features related to the overall type of chart you wish to create and allows you to 
select how data on the chart is grouped. 
 
The first set of tools allows you to select the type of chart that is displayed.  Some options may not be 
available for certain calculations, and other options are available only given certain “Show by” criteria.  
The options available in MPI Stylus Pro are: 
 
Bar chart 
 
Bar charts in MPI Stylus Pro default to vertical in most cases. 
 
Labels 
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The Labels option will append data labels to the top (or side, for horizontal) of bars. 
 
Horizontal 
The horizontal option switches a bar chart from vertical (up-and-down) bars to horizontal (side-to-side 
bars.) 
 
Stacked 
This option allows for bars in a chart to stack one on top of the other, as opposed to side-to-side. 
 
Negative color 
Allows for charts to have different colors above and below the x-axis. To preserve compatibility with older 
versions of MPI Stylus Pro, the default is to have this option checked for area charts and unchecked for 
bar charts. It is not currently available for line charts. 
 
Offset and Angle 

 
 
The label offset tool allows you to specify incrementally how far from the top (or side, for horizontal) of 
the bar the label is.  This may be adjusted to positive numbers, which push the label further from the bar, 
or negative numbers, to place the label inside the bar. The angle of the data labels can be adjusted using 
the button on the right. 
 
Outline 
This check box places an outline around bars themselves to help distinguish their edges; without this 
option selected, each bar appears as a block of color with no distinguishing outline around it.  The outline 
color is determined by the text setting in the General tab. 
 
Label Format 
The format option adjusts the content and appearance of your data labels in your bar chart.  The options 
may be seen in the table below. 
 

Format Example 

%v 8.3 

%v%% 8.3% 

%n(%v) S&P 500 (8.3) 

%n(%v%%) S&P 500 (8.3%) 

 
Label Precision 
This setting controls the number of digits to the right of the decimal point in chart labels. 
 
Bar Width 
This setting controls the width of bars in bar charts.  The range is from 0 to 100.   
 
Size of a Group Mark 
This setting controls the height of the group mark (the color code assigned to managers at the bottom of 
a chart.) 
 
Area chart 
 
The “Area” option allows you to make a chart an area chart.  There are two additional options: 
 
100% 
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This feature allows you to rescale displayed data in a chart to 100%.  This may be useful when only certain 
asset classes or holdings of a fund are being displayed, and therefore the data only adds up to a certain 
percentage of total allocation.  Instead of having the data only add up to 65%, for example, it can be 
adjusted on a relative basis for 100%. 
 
Outline 
This check box places an outline around area colors to help distinguish their edges; without this option 
selected, each area color appears as a block of color with no distinguishing outline around it.  The outline 
color is determined by the text setting in the General tab. 
 
Negative color 
This setting allows you to define charts that have different colors above and below the x-axis. To preserve 
compatibility with older versions of MPI Stylus Pro, the default is to have this option checked for area 
charts and unchecked for bar charts. It is not currently available for line charts. 
 
 
Line Chart 
 
The “Line” option allows you to make a line chart.  There are three additional options: 
 
Symbols 
Symbols are graphical images, such as circles or squares, that display at each given data point on a line 
chart.  The symbol type may be controlled in the General tab.  When the Symbol option is not checked, 
only a line will appear on the chart. 
 
Connect 
The Connect option allows you to select whether to have the chart line visible in addition to the symbols.  
When this option is not selected, only the symbols themselves will appear. 
 
Spread 
The spread option is useful in situations where multiple points representing multiple indices on a line 
chart (using symbols) must be separated to differentiate them without adjusting chart values.  For 
example, in a 1Y, 3Y, 5Y chart, the spread option might visibly separate the points for the benchmark and 
a fund so they can both be clearly seen. 
 
Symbol Size 
This tool controls the size of symbols in charts.  The range is from 0 to 20 in 1/10th increments (the arrows 
adjust to 2/10th increments.) 
 
Line Width 
This setting controls the size of lines in line charts.  The range is from 0 to 100. 
 
Pie Chart 
 
The “Pie” option allows you to make a chart a pie chart.  Your additional options are: 
 
Outline 
This check box places an outline around the pie and its slices to help distinguish their edges; without this 
option selected, each slice appears as a block of color with no distinguishing outline around it.  The outline 
color is determined by the text setting in the General tab. 
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Format 
The format option adjusts the content and appearance of your data labels in your pie chart.  The options 
may be seen in the table below. 
 

Format Example 

%v 8.3 

%v%% 8.3% 

%n(%v) S&P 500 (8.3) 

%n(%v%%) S&P 500 (8.3%) 

 
Size 
The Size option adjusts on a percentile basis the overall size of your pie relative to the full size of the area 
it can occupy in a chart.  This gives you control for overall pie size. 
 
X-Shift and Y-Shift 
These two options allow you to move the pie chart around the chart area, away from the central location. 
 
Label From 
The Label From option allows you to determine the lowest acceptable slice size (label amount) for which a 
label may be shown in your chart.  This is useful when you have many small slices that you do not feel are 
large enough to merit independent labeling, and gives you extra control over chart appearance. 
 
Pie Start Angle 
This setting lets you control the start angle of a pie chart so that it does not interfere with other images on 
a chart.  The range is from 0 to 359 degrees.  This allows you to adjust any pie chart to any rotation. 
 
Group By 
 
This option allows you to choose between grouping by the manager or component. 
 
Peer Group – Attributes Controls 
 
The controls for peer groups in Attributes Editor give you quick access to several tools that can be used to 
adjust peer group bands (i.e., quartiles) in charts. 
 
Bar 
This option allows you to display peer bands as bars, as you might in a floating quartile chart. 
 
To adjust bar width, you may use the size control next to Bar in this section of the attributes editor.  The 
available sizes range from 0 to 100 and work on a percentile basis. 
 
3D 
This option allows you to make bars or other chart aspects appear as three-dimensional. 
 
Area 
This option allows you to display peer bands as areas, as you might in a rolling quartile chart. 
 
Outline 
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This check box places an outline around bars or area colors themselves to help distinguish their edges; 
without this option selected, each bar or area color appears as a block of color with no distinguishing 
outline around it.  The outline color is determined by the text setting in the General tab. 
 
Quartile Band Controls 
The quartile band controls give the user a quick, chart-specific tool for controlling the quartile band colors 
in a chart.  The user simply has to click on each color and adjust it using the drop-down menu.  These 
colors can be specified on a study-wide level in the Color & Symbol tab. 
 
Show By 
 
This option allows you to choose whether to show charts by the default one chart (None), by manager or 
by component, and to select the alignment of the charts in the cases of manager and component. 
 
 
Advanced Tab 
 

    
Figure 74 
  
 
Stylus Pro 11.0 introduced a new graphics engine that allows you to embellish chart elements with 
gradient colors, transparency and more. These graphics features are controlled through the optional 
advanced tab found in the common chart style and peer group style sections.  
 
The advanced graphics features are enabled in the General tab, described in the section following this 
one. 
 
The various advanced graphics settings are described below; the specific settings may differ by chart type. 
Many of these options are similar to those found in Microsoft Excel and elsewhere. 
 
Transparency 
This option allows one to see background objects through the graphics object. Specified as a percentage 
of transparency, 100% is fully transparent (invisible) and 0% completely opaque such that nothing shows 
through. 
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Label Transparency 
This option functions as above to control the transparency of the data labels. 
 
Anti-aliasing 
This option will smooth out jagged lines and visual distortions that are typical in older graphics. 
 
Smooth line 
This option is used in line charts to create a line through a set of database where the emphasis is on the 
smoothness of the line. Please note that “smooth lines” are not guaranteed to pass through each data 
point exactly; it is an interpolated line. The line smoothness can be controlled on a rolling scale. 
 
Hide contour 
This option allows the user to remove the contour line (similar to a border, but in the gradient color) 
drawn around gradient objects. 
 
Gradient 
Color gradients are a type of fill pattern for graphic objects that represent a progression of colors from 
some positional focal point. This option enables a color gradient fill and specifies the direction of the color 
progression. 
 

▪ Horizontal gradients transition color linearly from left to right 
▪ Vertical gradients transition color linearly from top to bottom 
▪ Diagonal forward gradients transition color linearly from upper left to bottom right 
▪ Diagonal backward gradients transition color linearly from upper right to bottom left 
▪ Path gradients transition color radially from a central point outward in all directions 

 
Position 
This option allows you to specify when to begin the gradient color transition. Using a horizontal gradient 
as an example, a position value of 50 would lead to a solid color half way across the object; the color 
transition would begin at the center and continue to the right edge. A zero value indicates an immediate 
transition, 100 is no transition. 
 
Luminance, Saturation, and Hue 
These three settings allow you to define the color that you wish to transition to. The base color is the 
default color of the object.  The left controls allow you to increase or decrease the hue, saturation and 
luminance as a base percentage of the base color to use as the starting color of the transition. The right 
controls allow you to adjust the ending color.  
 
By default, the starting color is the base color of the graphic object. The default ending color adjusts the 
luminance by 100% to transition into white. You are encouraged to experiment with these settings. In 
some organizations these gradient settings will be defined by a graphic artist. 
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General Tab 
 

  
Figure 75 

 
The General tab controls a wide variety of options for your chart’s appearance, including many options 
necessary to achieve detailed design control of Reports. 
 
Symbol 
 
This dropdown menu allows you to select the appropriate symbol for your managers; you can select 
different symbol variation options with the Cycle Symbol control.  The color will be controlled by the 
Managers dropdown menu, or through the Color & Symbol tab.   
 
 
Managers 
You may use this option to select the color for managers in your chart or table.  This may be done on a 
study-wide basis in the Color & Symbol tab, and those settings overrule Attributes Editor settings. 
 
Index 
You may use this option to select the color for indices in your chart or table.  This may be done on a study-
wide basis in the Color & Symbol tab, and those settings overrule Attributes Editor settings. 
 
Benchmark 
You may use this option to select the color for the benchmark in your chart or table.  This may be done on 
a study-wide basis in the Color & Symbol tab, and those settings overrule Attributes Editor settings. 
 
Universe 
You may use this option to select the color for the peer universe in your chart or table.  This may be done 
on a study-wide basis in the Color & Symbol tab, and those settings overrule Attributes Editor settings. 
 
Use Advanced Style 
You may use this option to enable the advanced graphics features described under the Style tab, including 
transparency and gradients. Checking this will expose an “Advanced” tab under “Style”. 
 
 
Component 
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You may use this option to select the color for the component in your chart or table.  This may be done on 
a study-wide basis in the Color & Symbol tab, and those settings overrule Attributes Editor settings. 
 
Text 
You may use this option to select the color for text in your chart or table. 
 
Cell 
The Cell option allows you to select a customized background for the active part of your chart (the area 
where data is displayed), either in the form of a color or as an image. 
 
To select a new cell background: 
 

1. Click on the dropdown menu next to cell. 
2. You may select another color by scrolling to it and clicking it.  In addition, you may also use the 

“Clear” function to have the cell default to a standard background, or the “Image” function to 
bring up an image. 

3. To use the image function, select “Image”.  Then, click the ellipsis button (…) next to it to bring up 
the Select Image tool. 

4. Browse to the image you wish to find and click it with your mouse.  Then, click the “OK” button. 
5. The image should now be imported as your cell background. 

 
Area 
The Area option allows you to select a customized background for your entire chart, either in the form of 
a color or as an image.  This may be done in the same manner as with cells (above.) 
 

Single Tile - Importing images of varying sizes without rescaling 
 

As of version 8.0, users may "assign" an image to a chart's 'area' in order to allow them to import 
multiple images into the application without having to rescale them. For example, if a user wants 
to bring an image in based on certain criteria, and a second image based on other criteria, they 
would no longer need to have the same size in order to avoid being distorted by sizing controls. 

To do this, use the Area function to select an image and then make sure to select 'Single Tile' in 
the control. This will bring the image in once at its correct size. 

 
Scale 
The Scale option controls the changes in the size of the symbols in style maps and scatter charts.  When 
this option is selected, symbols will vary in size dependent on the time period they represent (larger 
symbols represent more recent data). 
 
Credits 
When this option is checked, a credit line appears for compliance purposes in the form of “Created with 
MPI Stylus.”  With certain data providers, the data source may also be indicated. 
 
Border 
This option allows you to display a border around the chart.  This may also be controlled on an 
application-wide level from Configurator. 
 
 
Cycle Colors 
This feature allows you to control the colors of managers and components.  Cycling the colors lets MPI 
Stylus Pro determine which colors should be used for all managers and components other than the 
primary entry in both cases (which would be selected by the tools above.) 
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There are three settings for this check box: 
 

▪ Black checkmark on white background (checked).  This setting assigns all series a unique color, 
starting with the selected color(s) in the above tools. 

▪ Dark gray checkmark on light gray background (checked).  This setting allows color sharing by 
series in the same class; for example, all managers use one color, all indices the next color, and 
so on. 

▪ No checkmark.  All series use the same color. 
 
These options are overruled by the Color & Symbol tab. 
 
Cycle Symbols 
This feature is for Scatter charts only (it will be ignored by other chart types) and lets MPI Stylus Pro 
determine which symbols should be used for all managers other than the first one in the design tree, 
which would be controlled by the Symbols tool.   
 
There are three settings for this check box: 
 

▪ Black checkmark on white background (checked).  This setting assigns all series a unique symbol, 
starting with the selected symbol in the Symbols tool. 

▪ Dark gray checkmark on light gray background (checked).  This setting allows symbol sharing by 
series in the same class; for example, all managers use one symbol, all indices the next symbol, 
and so on. 

▪ No checkmark.  All series use the same symbol. 
 
Fill 
This feature is for Scatter charts only (it will be ignored by other chart types) and lets MPI Stylus Pro 
determine how to fill symbols. 
 
There are three settings for this check box: 
 

▪ Black checkmark on white background (checked).  This fills symbols with a color and establishes a 
border around them. 

▪ Dark gray checkmark on light gray background (checked).  This fills symbols with a color but does 
not establish a border around them. 

▪ No checkmark.  This puts an outline around a symbol’s shape but does not fill it with a color. 
 
The border settings are based on the Text color setting, but the Attributes Editor must be closed for 
changes to be reflected in certain cases. 
 
3D 
This changes a bar, line, area or pie chart to 3D; however, this setting cannot be used with scatter charts.  
Depending on the nature of your data, there may or may not be a substantial difference in appearance 
between 2D and 3D charts. 
 
Cell 
This option allows you to “turn off” the display of a chart, and is helpful when you only want to display a 
chart legend, and not the chart itself – for example, when you have several charts on a page with the 
same legend, you can use this option to display the legend for one chart and omit it for other charts 
through the Layout tab. 
 
Axes Tab 
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The Axes tab may be used to specify the characteristics of a chart’s axes, including gridlines, label 
orientation and tick marks, etc. 
 

  
Figure 76 

 
X-Axis and Y-Axis tabs 
 
Many of the controls for the X and Y axis tabs will be the same; however, a few slight differences will exist 
due to design and functional issues. 
 
Gridlines 
Gridlines appear by default in charts in MPI Stylus Pro.  To remove gridlines from a particular axis, simply 
uncheck this option. 
 
 
 
Gridline Type 
A dropdown menu linked to the Gridlines option allows the user to specify the type of line they would like 
for their gridlines.  The three options are a solid line, a dashed line (long dashes) and a dashed line (short 
dashes.) 
 
Gridline Color and Size 
Following the gridline type dropdown menu are two menus that regulate gridline color and size.  The 
color dropdown menu works as any other color menu in the application, and the size menu allows the 
user to scroll up (from a baseline of zero) to select larger gridline sizes.   
 
Frame 
Frames appear as lines along your X and Y axis, but may not always be visible because they often coincide 
with the chart origin.  This check box allows you to remove or add frames to your chart. 
 
Frame Color and Size 
Following the frame check box are two menus that regulate frame color and size.  The color dropdown 
menu works as any other color menu in the application, and the size menu allows the user to scroll up 
(from a baseline of zero) to select larger gridline sizes.  This will always be the same as the Origin color 
and size. 
 
Origin 
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This check box allows the user to choose whether or not to show the origin.  In some cases, the origin may 
not be apparent because the line coincides with a frame or another line; therefore, checking or 
unchecking this option can appear to do nothing in certain cases. 
 
Origin Color and Size 
Following the origin check box are two menus that regulate origin color and size.  The color dropdown 
menu works as any other color menu in the application, and the size menu allows the user to scroll up 
(from a baseline of zero) to select larger gridline sizes.  This will always be the same as the Frame color 
and size. 
 
Labels 
This option allows the user to control whether or not labels for axis ticks appear on their charts.  To hide 
labels, simply uncheck this box. 
 
Label Angle 
This option allows the user to adjust the angle of the labels that appear in the chart. A dropdown provides 
a number of predefined angles, or you may select a custom angle. 
 
Margin 
This option is used when a chart shows peer statistics or ranks in the form of floating bars.  It shifts the 
graph relative to the vertical access to give the quartiles a more traditional appearance. 
 
Log Scale 
This option allows the user to scale the axis, using the logs of term values. 
 
Control Date Labels 
This option is specific to the X-axis and allows the user to control the frequency of date labels on the axis.  
When this option is not selected, its sub-options will be grayed out and inactive. 
 
Tick 
The Tick option allows the user to specify (Y-axis only, except for Scatter charts) the frequency of ticks by 
setting the amount of points between them.  For example, a tick mark of 5 would place ticks at 0, 5, 10, 
15, etc.  
 
 % button 

 When this button is pressed, the tick-value entry applies on a percentage-basis, not as an 
absolute number. 

 
Edge 
This option is for Scatter charts only and allows you to guarantee the minimal distance between data 
points and the chart’s top and right edges.  This is often used when only one data point is shown on a 
chart.  In such cases, automatic axes scaling usually places the data point in the upper-right corner of the 
chart’s cell.  Using the edge control, the user may prevent this from happening and instead make sure the 
data point is reasonably positioned inside the chart.  This option has no effect if Zoom for the axis is not 
automatic (i.e., min/max are set to specific values.) 
 
 
 
Origin tab 
 
This tab allows the user to specify the return series or coordinates to use for the origin in a chart.   
 
Auto 



MPI Stylus Pro  
 

Copyright 2005-2020, Markov Processes International, Inc.Page 182 

 

This option uses the default origin for the chart, which may be any number of return series types, 
depending on the chart type. 
 
Peers Median 
This option uses the peer median for the statistic as the origin for the chart. 
 
Benchmark 
This option uses the benchmark values as the origin line for the chart. 
 
Custom 
This option allows the user to specify a custom origin line on both X and Y coordinate points.   
 
Zoom Tab 
 

  
Figure 77 
 
The Zoom tab allows you to change chart dates and axes ranges to any range you choose. 
 
By default, the Dates and Axes sliders will be set to the maximum range so all available information 
appears in the chart; however, you may change this by unlocking the ranges for editing.  To do this, simply 
click the pushpin buttons to make the ranges active. 
 
Dates 
As you move the date range, the chart default subtitle will also change to reflect your new range. 
Axes 
When you activate the Axes ranges to adjust zoom, arrows will appear at both ends of the range to allow 
you to control the amount of data displayed in the chart.   
 
Cells 
When “Show by Component” or “Show by Manager” has been selected in the Style tab of the Attributes 
Editor, a “Cells” option will also appear in the Zoom tab.  This allows you to control which components or 
managers appear in the chart. 
 
Text Tab 
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Figure 78 
 
The Text tab allows you to modify the text for the Title, Subtitle, Footer, X-Axis, Y-Axis and control 
information for the Legend, Label and CellTitle information. 
 
Each area can be modified using its own sub-tab in the Text tab.  You may scroll through the sub-tabs 
using the arrows provided in the application. 
 
When you first create a chart, MPI Stylus Pro assigns default values for all text options as follows: 
 
Title 
Title regulates the actual name of the chart in your View and Report.  The default will be the name of the 
chart (i.e., Asset Loadings) or the computational option (i.e., Total Annualized Return). 
 
Subtitle 
Subtitle allows you to include additional information about a chart below its main title.  The default is the 
range of return data as defined in the Parameters node. 
 
Footer 
Footer allows you to place additional information below a chart.  The default is the window (i.e., 24-
month centered window.) 
 
X-Axis 
This allows you to select the title for your X-axis.  The default is the value assigned to this axis in the 
program. 
 
Y-Axis 
This allows you to select the title for your Y-axis.  The default is the value assigned to this axis in the 
program. 
 
Legend 
This allows you to adjust the chart legend information and format. 
 
Tick Labels 
This feature gives you control over the size of your chart tick labels. 
 
Cell Title 
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This feature allows you to control whether Cell Titles for charts are on the top or bottom of the charts, 
and also to adjust the size of text and distance from the chart content. 
 
Modifying Text 
To modify text, you can simply input new text in the field for each text type.  The chart will update when 
you press the Enter button on your keyboard, or click elsewhere on the tab.  You may also use a vertical 
bar (|) to enter multiple lines within one text field.  When all text is deleted from a tab, defaults will 
automatically be restored.  To avoid this, please use the – sign described in “Deleting Text Tab 
Information.” 
 
Deleting Text Tab Information 
To delete text in a tab in the Attributes Editor, type in a dash sign (-) and press Enter.  This informs MPI 
Stylus Pro that you do not need any title and deletes it.  The chart size will adjust automatically. 
 
Date format 
This feature allows the user to choose from dropdown menus for both month and year, and to select from 
a wide variety of date formats. In addition, users may also entered “quoted text” to be displayed as-is in 
addition to the date string. For example, the input string: 
 
‘Fiscal: ‘YYYY’’ would return the display: Fiscal 2015 (or the current year). 
 
Additionally, it is possible to use conditional formatting as needed to achieve particular layouts. For more 
information, and a more complete summary of Date format specifiers, please see the Macro Reference 
Guide available in your software via Help-> Macro Reference. 
 
Font 
This option allows the user to specify the font type for the text in the chart (all chart text will share font 
type.) 
 
Min/Max 
The Min/Max font size options allow you to specify minimum and maximum acceptable font sizes.  This is 
a very useful feature because of the relative way in which Views in Stylus are sized.  By specifying 
minimum and maximum font sizes, the user may be certain that font sizes in charts remain in relatively 
acceptable sizes to one another, ensuring consistency throughout Report design. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Layout Tab 
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Figure 79 
 
The Layout tab lets you modify a variety of settings for a chart’s margins and legend. 
 
Layout Tab Dropdown controls 
 
There are a variety of settings controlled through the dropdown menu in the layout tab: 
 
Area Margin Settings 
The area margin settings allow you to adjust the amount of space taken up by the area (as opposed to the 
cell, which is the active part of a chart) – and thereby, to increase or decrease how much space in a given 
chart is populated versus white space.  This will include the title, subtitle, footer, legend, etc. (in contrast 
to the Cell Margin Settings, which change only the active part of the chart.) 

▪ Area Margin Left will adjust the left side of the area, using the increments available in the 
numerical dropdown menu. 

▪ Area Margin Right will adjust the right side of the area, using the increments available in the 
numerical dropdown menu. 

▪ Area Margin Top will adjust the top side of the area, using the increments available in the 
numerical dropdown menu. 

▪ Area Margin Bottom will adjust the bottom side of the area, using the increments available in the 
numerical dropdown menu. 

 
Cell Margin Settings 
The cell margin settings allow you to adjust the amount of space taken up by the cell (as opposed to the 
area, which covers the whole chart) – and thereby, to increase or decrease how much space in the active 
region of the chart (where data can appear) is populated versus white space.  This will not include the 
title, subtitle, footer, legend, etc. (in contrast to the Area Margin Settings, which do include those 
segments.) 
 

▪ Cell Margin Left will adjust the left side of the cell, using the increments available in the 
numerical dropdown menu. 

▪ Cell Margin Right will adjust the right side of the cell, using the increments available in the 
numerical dropdown menu. 

▪ Cell Margin Top will adjust the top side of the cell, using the increments available in the 
numerical dropdown menu. 

▪ Cell Margin Bottom will adjust the bottom side of the cell, using the increments available in the 
numerical dropdown menu. 
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Other Cell Settings 
These additional settings provide further control for chart cells. They become more useful when you use 
the “Show By” feature under the Style tab to present multiple chart cells within a single chart. 
 

▪ Cell Wrap Titles allows titles in Cells to wrap when a certain length is reached. 
▪ Cell Horizontal Gap Scale (%) allows you to control the horizontal space between cells.  
▪ Cell Vertical Gap Scale (%) allows you to control the vertical space between cells. 
▪ Cell Frame All Sides, when set, places a border around all four sides of a cell frame. By default, 

borders are drawn only the left and bottom sides of a cell. 
 
Legend Settings 
The legend settings will allow you to adjust various size and placement features of your chart legend.   
 

▪ Legend Maximum Width (%) allows you to specify in a percentage the maximum area width for 
the legend.  A fixed legend size may be specified by setting both Legend Maximum Width and 
Legend Minimum Width to the same percentage. 

▪ Legend Minimum Width (%) allows you to specify in a percentage the minimum area width for 
the legend.  A fixed legend size may be specified by setting both Legend Maximum Width and 
Legend Minimum Width to the same percentage. 

▪ Legend Maximum Height (%) allows you to specify in a percentage the maximum height for a 
legend.   

▪ Legend Minimum Height (%) allows you to specify in a percentage the minimum height for a 
legend. 

▪ Legend Indent Left shifts the legend along a virtual X-axis to the left or right.  The default will be 
at or near the 0 mark, and by shifting to lower/negative numbers, the legend may be moved 
incrementally to the left, whereas by shifting to higher/positive numbers, the legend may be 
moved incrementally to the right. 

▪ Legend Indent Top shifts the legend along a virtual Y-axis up or down.  The default will be at or 
near the 0 mark, and by shifting to higher/positive numbers, the legend may be moved 
incrementally towards the bottom of the chart, whereas by shifting to lower/negative numbers, 
the legend may be moved incrementally to the top of the chart. 

▪ Legend Symbol Scale (%) adjusts the size of the symbols in the legend as a percentage of their 
default size.  

▪ Legend Symbol Outline allows you to enable or disable the outline of the legend symbols. 
▪ Legend Wrap if Longer allows you to limit the width of the text in the legend, wrapping longer 

legend labels onto multiple lines. Words are not broken with this setting. 
 
Axis Margin Settings 
The margin settings allow you to control the amount of space surrounding the chart object. 
 

▪ X-Axis Extra Right Margin can be set to 1 to include extra margin space on the right-hand side of 
a chart. 

▪ X-Axis Margin allows you to control the margin size for the X-axis, and is only applicable when the 
Margin check box is selected in the X-axis section of the Axes tab. 

▪ Y-Axis Margin allows you to control the margin size for the Y-axis, and is only applicable when the 
Margin check box is selected in the Y-axis section of the Axes tab. 
 

 
Axis Label and Tick Settings 
The axis label settings allow you to control how axis labels and ticks are presented. 
 

▪ X-Axis Label Spacing (%) provides fine control for the distance between the ticks and the labels 
on the X-axis. The higher the distance, the fewer labels will appear. 



Chapter 5 
Views and Reports 

www.markovprocesses.com  Page 187 

 

▪ Y-Axis Label Spacing (%) controls the label spacing as above for the Y-axis. 
▪ Y2-Axis Label Spacing (%) controls the label spacing as above for the secondary Y-axis. 
▪ X-Axis Tick Size (%) can be adjusted as a percentage of the tick label font size. You may set a 

negative value here to shift the tick to the inside of the chart. 
▪ Y-Axis Tick Size (%) controls the tick size as above for the Y-axis. 
▪ Y2-Axis Tick Size (%) controls the tick size as above for the secondary Y-axis. 

X-Axis Tick Label Shift can be utilized to shift axis labels to the right or left of the tick. By default 
(value = 0), tick labels appear directly beneath the tick. Setting this value to -1 will shift the tick 
label to the left, +1 will shift the label to the right of the tick. 
  

Other Special Settings 
The settings below provide additional control for certain types of charts. 
 

▪ Pie Chart Label Distance 
▪ Pie Chart Leader-Label Distance 
▪ Map Corner Symbol Scale (%) 
▪ Map Corner Label Scale (%) 
▪ Symbol Scale Min Factor (%) 
▪ Symbol Scale Max Factor (%) 
▪ Negative color (palette index) 
▪ Spaces between Bars 

 
Legend Controls 
 
There are several specific controls (in addition to the Legend width and indent controls in the drop-down 
section above) that control legend location, appearance and content. 
 
Legend 
The Legend check box allows you to display or hide the entire chart legend.  It is useful to hide a chart’s 
legend when you wish to show several charts on one page that all have identical legends, and want to 
show the legend only one time. 
 
with title 
This check box allows you to display or hide the title for the chart legend.  Depending on the type of chart, 
this may be the name of the fund, or the type/degree of calculation (i.e., Total.) 
 
with map 
This check box allows you to display or hide the content of the style map in a chart legend.  Depending on 
the Style Outline for the chart, this may say the name of the map or be a content description, such as 
“Russell Indices.” 
 
with peers 
This check box allows you to display or hide the peer group name in a chart legend. 
 
Boxed 
This check box allows you to display or hide a box around the legend.  You may then also change the 
background color of the box by clicking the white color band next to box to reveal a color dropdown 
menu. 
 
Floating 
The Floating option allows you to make legend position independent of chart position, giving you 
maximum control over your chart’s appearance.  When the floating option has been selected, the chart 
will be able to take up the entire cell area and will not be constricted by legend position.  You may then 
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use the various legend dropdown menu tools (discussed previously) to precisely locate your legend in 
your chart. 
 
When Floating is checked, two additional tools appear in the Layout tab.  They are up/down menus that 
allow you to move the legend without using the dropdown options (such as Legend Indent Left.)  These 
two options are explained in further detail below as X-shift % and Y-shift %. 
 
Legend Position Diamond 
 

 
 
The Legend Position Diamond allows you to specify the general region of the chart where your legend 
should be located.  By clicking one of the four smaller diamonds, you may select whether your legend will 
be based at the top, bottom, left or right of your chart.  Your selection may adjust legend appearance 
(vertical vs. horizontal); therefore, you may wish to use the legend indent controls to adjust your legend 
location if you wish to preserve a vertical or horizontal legend appearance but are unable to do so with 
the diamond. 
 
Reversed 
This check box allows you to reverse the order in which items in the legend appear.  This is done by 
legend section – for example, if you were displaying a manager and a benchmark, these would reverse; 
however, if you were displaying peer quartiles, a manager and a benchmark, the peer quartiles would 
reverse – but still remain ahead of the manager/benchmark section.   
 
Max Legend Rows 

 
 
This allows the user to specify the maximum number of rows to display in the legend, and is most useful 
when a large number of indices are shown. 
 
Spacing 
The Spacing tool for legends can be used to incrementally change the spacing between legend 
rows/entries in your chart.  Note that increasing spacing will generally enlarge the overall size of your 
legend – in other words, the text will also grow larger. 
 
X-shift % 
This feature will only appear when the Floating option is selected.  This allows you to move your legend 
incrementally to the left or right using the up/down arrows, or entering a positive or negative number 
manually and pressing the Enter key. 
 
Y-shift % 
This feature will only appear when the Floating option is selected.  This allows you to move your legend 
incrementally up or down using the up/down arrows, or entering a positive or negative number manually 
and pressing the Enter key. 
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Objects – Object Editor & Stationary Objects 

 
There are two tools in MPI Stylus Pro that work with “objects” – the Object Editor and Stationary Objects 
controls.  These may seem quite similar at first, but there are important differences between them. 
 
Basically, you would use: 
 

▪ Object Editor when you want to add a chart-specific object to your Report.  This may be a line 
pointing to a data point, or a simple note, or some other kind of information. 

▪ Stationary Objects when you wish to add page-specific or Report-specific content to your Report.  
For example, this is the tool for bringing in a logo that you want to appear on every page, or a 
solid color line for design purposes, etc. 

 
Due to their similarities, most of the features will be covered under Object Editor. 
 

Object Editor 
 

  
Figure 80 
 
You will use the Object Editor to add chart-specific content to your Report.  To reach the Object Editor, 
you may either click on the icon above in your Report while selecting the correct chart, or right click on 
the chart and select “Object Editor.” 
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Adding a New Object 
 
To add a new Object: 
 

1. Right-click on the location/data point where you wish to create an object.  Select the “Object 
Editor.” 

 

 
Figure 81 
 

2. Click the “Add New Object” button in the Object Editor. 
3. You will now be able to define the various Object parameters (for more information, see below.) 

 
Renaming an Object 
 
Objects are automatically assigned numbers as names.  You may rename an Object by clicking on the 
General tab in the Objects Editor and typing in the new name in the Name field. 
 
Moving an Object 
 
To move an Object’s position on the Object tab list: 
 

1. Go to the Object Editor. 
2. Select the tab representing the Object you wish to move. 
3. Click the Up or Down arrows to move the Object’s position relative to other Objects in the tab 

list. 
 
Deleting an Object 
 
To delete an Object: 
 

1. Go to the Object Editor. 
2. Click on the tab representing the Object you wish to delete (there will only be multiple tabs if 

there are multiple Objects.) 
3. Press the “Delete Object” (X) button.  MPI Stylus will ask you if it should delete the Object.  Click 

OK. 
4. The Object is now deleted. 
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General Tab 
 

  
Figure 82 
 
The General Tab may be used to change the shape, background color and border color of any Object, as 
well as to assign the Object name. 
 
Visible 
This check box allows you to make an Object invisible.  This would be useful when you are trying to draw 
lines on charts (for more information, see Focus.) 
 
Name 
This field allows you to rename the Object by overwriting the default numerical name given an Object 
when it is created.  This name will be reflected on the tab identifying the Object in the Object Editor. 
 
Layer 
This selects the layer for the Object in the chart.  Objects in the Top layer cover the chart and legend.  
Objects in the Middle layer are above gridlines but below such elements as data points, bars and lines.  
Objects in the Bottom layer cover only the chart background.   
 
Use Shape 
This section controls the shape options available for an Object.  You may select Rectangle (default), Ellipse 
or Rounded Rectangle.  The ellipse option may be adjusted to a circle using the Size tab to modify the 
shape. 
 
Border 
The border option allows you to select the color of the shape border. 
 
Border Width 
You may adjust the border width by using the up/down control next to Border. 
 
Background 
The Background option allows you to select the color of the shape background (fill). 
 
Ellipse Angle 
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When the Shape is set to Ellipse, an up/down control will appear next to Background that will allow the 
user to adjust the angle of the ellipse’s line/curve. 
 
Use Picture 
Users may choose to insert a picture as an Object instead of using a shape.  When you click on the browse 
button (…), a navigation window will appear and allow you to locate graphic files on your system.  The 
default folder will be your Stylus installation folder (i.e., C:\Stylus).  You may select the Images folder to 
view graphics included with MPI Stylus Pro, or navigate to another folder to select your own images.  
 
Importing images of different sizes without rescaling 
As of version 8.0, it is possible to bring in images of different sizes to the same space/object without 
having to rescale them. This is useful for automated templates where the image you wish to import may 
vary based on other criteria. This will not be done through Stationary Objects, but rather through a chart’s 
Attributes Editor. For more information, please see “Single Tile” in the Attributes Editor section of this 
chapter. 
 
Position Tab 
 

  
Figure 83 
 
The Position tab is used to define the position of an Object. 
 
Horiz. Basis & Vert. Basis 
These two controls allow the user to specify the origin of the Object.  By default, the basis will be the 
bottom left of an Object.  These options allow the user to change the basis of an Object to other parts of 
the Object. 
 
Units 
 
Unit settings control the position of an Object when the size of the chart changes. 
 
Absolute 
This sets the position by using the specified number of pixels.  The position of the chart is relative to other 
elements of the chart and changes every time the size of the chart changes; this means that you should 
not use the Absolute option when you expect to print the chart, as the size of the chart on the screen and 
printout will be different. 
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Area Size, % 
This specifies the position of the Object relative to the horizontal and vertical dimensions of the total area 
of the chart.  This is the default setting, which ensures that the object is resized and repositioned correctly 
when the chart is resized. 
 
Cell Size, % 
This specifies the position of the Object relative to the chart cell. 
 
Axes 
This gives the user another way to control the position of the Object when the size of the chart changes.  
This option lets the user anchor to a point with specific coordinates along the X and Y axes of the chart. 
 
Cell Horizontal/Cell Vertical 
When you select Cell Size or Axes and the chart contains multiple cells, you must specify to which cell the 
Object will be linked.  To select the cell, use the appropriate up/down control.  The first cell will be 
assigned 0; the second cell will be assigned 1, and so on.  When a cell number is selected for a cell that 
does not exist, the Object disappears from the chart. 
 
X-axis & Y-axis 
These up/down controls specify the coordinates of an Object.  The interpretation of these two values 
depends on the selected method of determining the Object’s position and units of measurement. 
 
Zero-Origin 
This dropdown allows the user to change the position at which the origin is identified. By default, this is 
zero – the default measure for an origin. That said, the origin can be ‘pinned’ to certain series, locations, 
etc. For example, the ‘M’ in the dropdown would pin the origin to a Manager.  
 
Size Tab 
 

 
Figure 84 
  
 
The Size tab is used to modify the size of an Object.  By default, an Object uses the Width and Height fields 
to determine the Object size. 
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Size to Text 
This feature resizes the label to match the text entered on the Text tab.  When this setting is used, other 
settings on this tab disappear and the following message is displayed: “Object is sized automatically based 
on the current settings under the “Text” tab.  Uncheck to control the size manually. 
 
Units 
 
Unit settings control the position of an Object when the size of the chart changes. 
 
Absolute 
This sets the position by using the specified number of pixels.  The position of the chart is relative to other 
elements of the chart and changes every time the size of the chart changes; this means that you should 
not use the Absolute option when you expect to print the chart, as the size of the chart on the screen and 
printout will be different. 
 
Area Size, % 
This specifies the position of the Object relative to the horizontal and vertical dimensions of the total area 
of the chart.  This is the default setting, which ensures that the object is resized and repositioned correctly 
when the chart is resized. 
 
Cell Size, % 
This specifies the position of the Object relative to the chart cell. 
 
Axes 
This gives the user another way to control the position of the Object when the size of the chart changes.  
This option lets the user anchor to a point with specific coordinates along the X and Y axes of the chart. 
 
Cell Horizontal/Cell Vertical 
When you select Cell Size or Axes and the chart contains multiple cells, you must specify to which cell the 
Object will be linked.  To select the cell, use the appropriate up/down control.  The first cell will be 
assigned 0, the second cell will be assigned 1, and so on.  When a cell number is selected for a cell that 
does not exist, the Object disappears from the chart. 
 
Width/Height 
These specify the width and height of the Object.  The font is determined by the size of the Object, the 
length of the text and size of the margins.  (See the Text tab.) 
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Focus Tab 
 

  
Figure 85 
 
The Focus tab creates lines on the chart.  Each time a new Object is created, MPI Stylus Pro creates an 
invisible line connecting the basis (origin) of the Object with a point called the focus.  You may change the 
position of the line associated with an Object by modifying either the position or the coordinates of the 
focus. 
 
Display Pointer to Focus Point 
This check box allows you to display a line in the chart. When you enable this line feature in Stationary 
Objects only (not other Objects), controls on other tabs relating to shapes, including pictures and text, are 
disabled. 
 
Extend line 
This checkbox may be used to extend the line you have created past the default end point for ‘display 
pointer to focus point.’ 
 
Units 
 
Unit settings control the position of an Object when the size of the chart changes. 
 
Absolute 
This sets the position by using the specified number of pixels.  The position of the chart is relative to other 
elements of the chart and changes every time the size of the chart changes; this means that you should 
not use the Absolute option when you expect to print the chart, as the size of the chart on the screen and 
printout will be different. 
 
Area Size, % 
This specifies the position of the Object relative to the horizontal and vertical dimensions of the total area 
of the chart.  This is the default setting, which ensures that the object is resized and repositioned correctly 
when the chart is resized. 
 
Cell Size, % 
This specifies the position of the Object relative to the chart cell. 
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Axes 
This gives the user another way to control the position of the Object when the size of the chart changes.  
This option lets the user anchor to a point with specific coordinates along the X and Y axes of the chart. 
 
X-axis & Y-axis 
These up/down controls specify the coordinates of an Object.  The interpretation of these two values 
depends on the selected method of determining the Object’s position and units of measurement. 
 
Text Tab 
  
The Text tab is used to specify the text that appears in an Object.  The text settings on this tab are used 
when you select the Size to Text check box in the Size tab. 
 
Show Text 
This check box allows you to hide the text in the Object.  This setting lets you use the text as a tool to 
control the Object size, even though the text is not displayed. 
 
Proportional Font Size 
This control only works when the Size to Text option is selected in the Size tab.  The font size of the 
Object’s text will be based on the size control of the Text’s page.  When this check box is not selected, the 
control which defines font size defines it in points, whereas it defines it in relative points when the check 
box is selected.  Text defined in points never rescales; therefore, when the chart is resized, all fonts inside 
the chart scale to new dimensions, but the text stays the same size.  When relative points are used, the 
font will scale with other text objects in the chart. 
 
Font Settings 
This tab uses standard font controls found in most Word Processing applications.   
 
Horizontal Margin, % 
This determines the amount of space between the text and the Object’s edges on the sides. 
 
Vertical Margin, % 
This determines the amount of space between the text and the Object’s edges at the top and bottom. 
 

Stationary Objects 
 
Stationary Objects are used to add borders, backgrounds, logos or other design elements to your Reports.  
They may be used only in Report tabs, and, once defined, appear in all Report pages. 
 
For the most part, Stationary Objects controls are identical to Object Editor controls, and therefore they 
are covered in the Object Editor section; however, there are a few minor differences.  The Focus tab is 
available for use in Stationary Objects that are not using ‘shape’ features. When the ‘display focus line’ 
setting is checked, the ‘Use shape’ controls become disabled. In addition, there are the following 
additions: 
 
Credits 
The Credits check box (General tab) allows you to place the standard Stylus credit below a defined Object.  
The credit line displays when you set the Vertical basis on the Position tab to Bottom and adjust the Y-axis 
until the line displays. 
 
Page, % 
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This may be found in the Position and Size tabs.  This setting specifies that all dimensions are percentages 
of the page width of the whole page width or height. 
 
Margin, % 
This may be found in the Position and Size tabs.  This setting specifies that all dimensions are percentages 
of the page area inside the page margins. 
 

Page Designer 

 
The Page Designer is the area in Reports where users can “rough out” the actual design of their page – in 
other words, they can specify where charts, tables and memos will be shown, and tweak their position 
and size as necessary throughout the design process. 
 
This section looks similar to that used to create new charts, tables and memos in Views; however, there 
are important differences.  The Page Designer is a spatial tool only – it does not designate which charts, 
tables or memos will be in your Report.  It only regulates how many there will be, and where they will be 
placed.  In addition, when you drag and drop a new chart, table or memo to your Page Designer, it will not 
adjust to fill all available space.  Charts, tables and memos cannot overlap in Views, but may in Reports. 
 
To add a new chart, table or memo: 
 

1. In the Page Designer, click on a Chart, Table or Memo block with your mouse and drag the block 
up into the cross-hatched field. 

2. Drop the block in the approximate area where you would like a chart, table or memo to appear in 
your actual Report. 

3. You may use your mouse to resize the block and reposition it within the page.  Please note that if 
you drag any block more than 50% outside of the red lines around the Page Designer field and 
then release your mouse button, the block will be deleted automatically. 

 
You may rename any block in your Page Designer by clicking on the block name, deleting the text and 
entering new text.  Macros may be used in this field as well. 
 
Block coordinates and dimensions 
 

 
 
Each block in the Page Designer will have a series of coordinates at its bottom to specify its location within 
the page and dimensions to specify its size.  This helps users align multiple blocks perfectly as well as to 
ensure that multiple blocks are the same sizes (if needed.)  Coordinates and dimensions are divided by a 
single slash (/) 
 
The first number in each coordinate series represents the left and right sides of the block along the X-axis, 
respectively.  The second number in each coordinate series represents the top and the bottom of the 
block along the Y-axis, respectively.   
 
The first number in the dimension series represents width, and the second number represents height. 
 
Restore button in Page Designer 
When the Restore button is used in the page designer, the design will revert to its position when the page 
designer was first opened/clicked on.  Once the user navigates away from the page designer, the state of 
the page designer at that time will become the default for the next session. 
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Chart/Table/Memo Designer 
 
The Chart/Table/Memo designer in Reports may work in one of two ways, depending on whether or not 
the Reports node is being used to construct actual charts, tables and memos, or if they are being linked in 
to the Report from Views. 
 
If there are charts, tables or memos being constructed in the Report itself, this will work just like the Chart 
Designer or Table designer would in Views; however, MPI recommends using the Link to View feature 
instead. 
 

 
Figure 86 
 
Original 
The Original button allows the user to see the Chart or Table designer and design charts or tables in 
Reports. 
 
thin Link to View 
The Link to View button allows the user to select an existing chart, table or memo from their Views and 
display it in this area of the Report.  There will be two columns displayed here: 
 



Chapter 5 
Views and Reports 

www.markovprocesses.com  Page 199 

 

▪ View, which tells the user the name of the View where the chart, table or memo may be found.  
Note that this will be the same name as the tab along the bottom of your screen where this 
chart, table or memo may be viewed. 

▪ Chart (Table)(Memo), which will tell the user the name of the particular chart, table or memo 
within that View.  This allows for easy identification of the appropriate item for selection. 

 
Once the correct View has been identified, the user may select it with the mouse and then press the 
green checkmark to display the View in the Report. 
 
 
Jump to the Linked Chart Design 

 
 
This option allows the user to jump to the Chart Designer, Table Designer or Memo Designer in the Views 
node on the design tree in order to make adjustments to the View.  Because this is a linked View, any 
changes made will automatically be updated and reflected in the Report. 
 

Create Label 
 
The Create Label tool is a special feature that allows the user to quickly add an object to a chart without 
using the Object Editor (which will be used to edit the label if necessary.)  When you use Create Label, an 
object is automatically created for you in the place where you have clicked to create the label.   
 
The content of a label will depend upon the chart type as well as the location of data within a chart.  For 
example, an information ratio chart may have some data that is considered “Excess” whereas other data 
would not be; therefore, labels created for data above the base line would contain the word “Excess” in 
addition to the data point value, whereas labels for data below the base line would not. 
 
To create a label: 
 

1. A label will be created with its upper left-hand corner matching the area where you click (the 
data point).  This may be adjusted later with the Object Editor. 

2. To create a label, mouse over the data point you wish to feature in a label.  After a moment, you 
should see a floating box containing the value of the data point. 

 

 
 

3. Once the floating box is showing the info for the data point you wish to feature, right-click and 
select “Create Label.” 

4. An object will automatically be generated with that data point’s information.  You may adjust 
label appearance and position through the Object Editor. 

 
To delete a label: 
 

1. Because all labels are objects, you will always delete a label by right-clicking on it and selecting 
the Object Editor. 
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2. Each object in the object editor will have a tab with its name.  Click on the tab of the label you 
wish to delete. 

3. Once you have clicked the tab, press the “Delete object” button. 
4. Your label will now be deleted. 

 
Export 

 
MPI Stylus Pro gives users several export options from both Views and Reports in order to help make 
content from the application more useful in situations where final reporting will take place outside the 
program.  The following options exist when exporting out of Views and Reports. 
 

Output Node Option 

Views Bitmap to Clipboard 

Views Metafile to Clipboard 

Views Image to file 

Views Text to Clipboard (tables) 

Views Text to file (tables) 

Reports To PDF file 

Reports To PowerPoint 

Reports To RTF file 

Page Same three options as Views for images 

Area Same three options as Views for images 

Figure 87 
Please note that when a chart/area is exported to the clipboard as an image or saved as an image file, its 
elements will no longer become active; in other words, specific elements of the chart will not be editable 
through another data program, such as Excel. 
 
To export: 
 

1. Right-click on the chart, table or memo you wish to export (or that is on the page you wish to 
export). 

2. Select Export-> and then the option you would like to use.   
3. If you select to Export to a clipboard, the information will be automatically stored temporarily on 

your computer’s clipboard and may be copied into other applications. 
4. If you select to Export to an image to file, you will be given the option of where to save the 

image, and in what format. 
5. If you select to export to PDF, you will be given the option of where to save the PDF file. 
6. If you select to export to PowerPoint, the PowerPoint file will open automatically.  You may save 

it at this time.  
7. If you select to export to RTF, you will be given the option of where to save the RTF file. 
 

Print 

 
Print options are different for Views and Reports because of the nature of what you are trying to print.  In 
a Report, the Print feature will open your basic Windows print utility, allowing you to select the printer 
and other standard choices.  In Views, however, the user is given a certain level of control as to how a 
particular chart, table or memo should appear. 
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Page Setup 
 

 
Figure 88 
 
The page setup utility is opened whenever you press the Print button while in a View tab, or when you 
right-click on a chart, table or memo in the Views node and select “Print.” 
 
The page setup utility allows you to control the size of your chart, table or memo on the hard copy, as well 
as to adjust printer setup by clicking on the “Setup” button.  This will open the standard Windows print 
utility. 
 
The yellow rectangle visible in the page setup utility allows you to adjust the size of the chart, table or 
memo as you would in the Page Designer, with the block coordinates and dimensions also visible for 
comparison when the user wishes to make printouts of multiple charts, tables or memos in the same 
dimensions. 
 

Propagate Chart Style To… 

 
The Propagate Chart Style To… tool allows the user to quickly propagate one or more styles from a chart 
to every other chart of its kind in a Report.  This avoids the tedious process of formatting each chart 
separately and allows for a great deal more control, consistency and efficiency in chart design. 
 
In some cases, MPI Stylus Pro has features that have been developed that more explicitly allow for study-
wide control of these options – for example, the Color & Symbol tab.  It is recommended that the user be 
aware of all options for enforcing consistency on a study, in order to make use of the most efficient tool 
for any situation. 
 
There are five screens for the Propagate Chart Style To… feature, and the user is given a high degree of 
power and control in selecting precisely which features of a chart to propagate.  These screens each 
correspond to settings controlled through the Attributes Editor. 
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Peer Bands… 
 

 
Figure 89 
 
This screen allows you to propagate peer color bands and scatter chart colors, as well as chart types and 
styles, to other charts.  Peer color bands may also be specified in the Color & Symbol tab of a study, which 
would avoid the need to use the propagate feature in this case. 
 
Colors, Symbols… 
 

 
Figure 90 
 
This screen allows you to choose which series and other chart colors to propagate, as well as whether or 
not to propagate gridlines.  Path and symbol propagation may also be found in this screen.  Note that this 
screen takes color data from the Attributes Editor of a chart; if color data has been assigned in the Color & 
Symbol tab, it will have priority over any Attributes Editor assignments. 
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Font… 
 

 
Figure 91 
 
This screen allows you to propagate font sizes, types and alignments. 
 
Layout… 
 

 
Figure 92 
 
This screen allows you to propagate area and cell margins, and legend position, to other charts. 
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Apply To… 
 

 
Figure 93 
 
This screen allows the user to decide whether to propagate changes to all charts, or whether to propagate 
only to charts in Views, charts in Reports, and/or only checked charts.  This gives the user more control 
over how the propagation works throughout their Views and Reports. 
 

Troubleshooting Views and Reports 

 
Q: I have seen a chart in another study that I want to create in my study, but I don’t know how to design it.  
What should I do? 
A: One of MPI Stylus Pro’s reporting advantages is in its design system that allows any user to reverse-
engineer charts, tables or memos from other studies into their own study.  There are several ways to 
accomplish this.  You can use the right-click menu to copy an entire View or specific chart, table or memo 
from one study and paste it into another; or you may simply use the Chart/Table/Memo designer for any 
View to examine the precise elements of its design, which you may then recreate in your own study. 
 
Q: What is the advantage of creating my tables/charts in the Views Node as opposed to just creating them 
in a Report?  
 
A: There are several advantages to this, and this subject is discussed in detail earlier in this chapter; 
however, the main advantages are that it allows you to efficiently organize your output during the 
analysis phase without having to reorganize it later, and that you may reuse the same chart, table or 
memo multiple times in multiple Reports, as well as have any changes made to your Views propagate 
automatically to all Reports where they are used. 
 
Q: I would like to make a chart or table of a particular statistic but don’t know where to find it. 
A: Please see the Analytics Glossary at the end of this manual for descriptions of statistics. 
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Overview 
 

MPI Prospector allows you to 
create and edit peer groups, 
populate them with unlimited 
performance-based analytics, and 
use its powerful analytical and 
visualization capabilities to 
visually explore relationships in 
the data and conduct manager 
searches. 
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Chapter 6 
 

MPI Prospector 

 

Introduction to MPI Prospector 

 
The MPI Prospector module adds several important and powerful capabilities to MPI Stylus Pro, but it may 
be thought of first and foremost as serving three key purposes: 
 

▪ Creating and editing peer universes 
▪ Conducting manager searches 
▪ Leveraging visualization capabilities in data analysis 

 
Getting Started in MPI Prospector 
 
MPI Prospector makes use of the design tree and data pane setup, allowing new users to quickly and 
comfortably orient themselves within the module right from the start.  Though the nodes of MPI 
Prospector’s design tree are different from those of other modules, they may be navigated in the same 
manner and have most of the same tools available in them. 
 
An important feature of MPI Prospector will be the ability to filter data and examine it through the use of 
interactive scatter charts, distribution charts and data tables.  These dynamic views allow you to examine 
the relationships between data for the same fund(s) across a wide array of analytics, significantly 
increasing your analysis power. 
 
Reporting capabilities exist starting in Stylus 11.3. These reporting features will be similar to reporting in 
Stylus or Allocator, though the only charts/tables available in the reports will first need to be created in a 
View. This new feature will allow users to create a printable report explaining the filter process, and even 
show steps and where certain managers get removed along a process. 
 
Understanding Prospector Data 
 
It is important for users to understand that MPI Prospector output data behaves differently than data in 
other modules in MPI Stylus Pro.  Whereas with Stylus, Integrator and Allocator, data only “exists” when a 
particular study is open (and therefore studies must be run when opened to view data), Prospector data 
continues to exist even when a study is closed. This allows you to use peer groups (Prospector data) in 
other modules without requiring the actual underlying Prospector study to be open.  In addition, whereas 
a Stylus study (.sty) file is entirely self-contained, a “run” Prospector study creates additional files to store 
data.   
 
This is important to remember when using features such as the Dynamic Peer function in MPI Prospector, 
which changes the paradigm for MPI Prospector.  Whereas Prospector data is normally “stored” – that is 
to say, the most recently created data is maintained – the Dynamic Peer option causes the data to 
automatically update.  For more information, please see “Dynamic Peer” further in this chapter.



Chapter 6 
MPI Prospector 

www.markovprocesses.com  Page 207 

 

Working with Prospector Studies 
 
The same basic rules apply when working with MPI Prospector studies (signified by their .unv extension) 
as with all other studies in MPI Stylus.  For general information on creating, opening, saving or deleting 
MPI Prospector studies, please see Chapter 3 of this manual. 
 
It is important to note that Prospector studies, in addition to being the studies with which you will create 
or edit peer groups in MPI Stylus, will also serve as the peer groups themselves in the other modules.   
 
Dynamic Peers 
 
The Dynamic Peer check box option, located in the Properties tab of the Study Node, is a special feature 
for users who bring Prospector studies into other modules as peer groups.  This feature changes the 
fundamental appearance and functionality of the underlying Prospector study, and therefore should only 
be used when the sole purpose of the Prospector study is to supply data to another module.   
 
When the Dynamic Peer option is selected, MPI Stylus Pro will ignore all analytics and output filters, 
instead only applying Source filters present at the time when the data is requested. This is useful because 
it allows the .unv file to automatically receive new data when the user runs database updates. 
 
Prospector Study Changes for Dynamic Peer 
 
When the Dynamic Peer option is selected, the associated Prospector study will undergo extensive 
changes in order to support its new function as a pure data tool, and all nodes with the exception of the 
Source node will disappear from the Prospector study. 
 
To restore a Dynamic Peer study to its full version, you will have to uncheck the Dynamic Peer check box, 
save the study and reopen it. 
 
Note to Advanced Analytics/Advanced Prospector users 
 
Please note that you should not attempt to use the Dynamic Peer option if you are an 
Advanced/Enterprise Prospector user and are working with analytics in any form (i.e., in a ratings system.)  
Dynamic Peer only conducts source filtering and discards all other aspects of MPI Prospector. 
 
To make a Prospector study a Dynamic Peer: 
 

1. In the Prospector study, go to File-> Save As. 
2. In the Save as Study box, click on the Properties tab.   
3. Check the “Use as a dynamic peer group” check box. 
4. Save the study. 

 
Use as Prospector Database (formerly Prospector DB) 
 
The ‘Use as Prospector Database’ option (formerly called Prospector DB), is located in the Properties Tab 
of the Study Node and allows users to make a study available as a database/source in other modules in 
the application.  The Prospector study remains available for normal use as a peer universe, but it also 
appears as an available database (like Morningstar or US Equity) from which any of its funds/portfolios 
can be selected.  This provides users with a convenient way of organizing and accessing a specific group of 
funds.  For example, by specifying certain peer group filters, the user can be confident that any fund 
available in the Prospector DB passes required criteria.  
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MPI recommends that the Prospector DB option only be used when it is absolutely necessary to use a 
Prospector study as a database; too many databases linked to Stylus may affect performance, especially in 
database selection screens where information from all databases are retrieved. 
 
To make a Prospector study a Prospector DB: 
 

1. In the Prospector study, go to File-> Save As. 
2. In the Save as Study box, click on the Properties tab.   
3. Check the “Use as Prospector Database” check box. 
4. Save the study. 

 
Alternately, you can simply go to the Properties tab directly at any time, check this option and save the 
study. 

Show DBId in Output 

 
This option, also located in the Properties tab of the Study Node, allows you to include a column in your 
Output table showing the database ID for funds. This can be useful for a variety of reasons, especially 
when multiple databases are being used simultaneously in MPI Prospector.
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Prospector Design Tree 

 
The MPI Prospector Design Tree is similar in appearance to that of the Stylus module, but there are 
notable differences between the two. 
 
To quickly summarize these differences: 
 

▪ Instead of a Managers node, Prospector starts off with a Source node in which the user specifies 
one or more databases from which to work. 

▪ The remaining Input Nodes from the Stylus module design tree are found lumped together as 
subsections of the Analytics node in Prospector. 

▪ An additional Input Node, Composition, may be found in Prospector. 
▪ The Views for examining data in charts and reports are located inside the Source, Output and  

Views nodes, and may be used to review the appropriate data in both source databases and as 
the final screening and processing result.   

▪ Additional Views and Reports may be added for workflow purposes. Tables/Charts will need to 
first be created in Views, and can then also be displayed in Reports. Views are unique to each 
other and can each have their own set of filter criteria applied to them, based on the original 
filters set in the Source. 

 

  
 
Please take a moment to examine the Prospector design tree above.  Note that there are two populated 
elements here that are defaults for any new Prospector study: Cash in the Style Outline, and Table1 in the 
View.  When a source is selected, an additional (and different) Table1 will be generated in the Source 
node as well. 
 
As will be the case in all MPI Stylus modules, the Design Tree is made up of nodes.  Nodes represent 
specific concepts, input or output requirements, or groupings of information that will figure in the 
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character of your analysis, and are represented in MPI Stylus by black circles with a single yellow letter in 
them.  The nodes in the Prospector module may be categorized as input nodes and output nodes: 
 
 

Node  Symbol Description Function 

Input Nodes 

 Source Specifies one or more data sources that will be used in 
the study. 

 Analytics Controls the Parameters, Style Outline, and Benchmark 
nodes (Input Nodes from the Stylus module.) 

 Composition Allows the user to select which data from the Source 
should be copied to the Output, and to calculate 
additional performance-based statistics. 

Output Nodes 

 Output Controls the composition and appearance of your 
output. 

 Views Optional node for creating additional output screens 
for charts beyond the ones selected in the Output view. 
May also be used to create additional tables sourced 
from checked items in the Composition node.  

 Reports Optional node for creating a printable presentation 
that will include tables and charts coming from the 
various Views created. 

 
In addition to the four nodes listed in the table above, there is also the Study node at the top of the 
design tree.  The Study section governs a variety of study-wide settings, including automation.  For more 
information about the Study section, please see Chapter 3 (MPI Stylus Basic Interface Structure & 
Elements.) 
 
When designing your analysis, you will move down the list of Design Tree nodes to input the information 
necessary, and then to create, view and organize the output.  In the sections below, we will take a close 
look at how to get the most from each node. 
 

Input Nodes 
 
Input Nodes in Prospector represent information you will be providing the application in order to 
structure your analysis.  The Design Tree format allows you to quickly create your analysis in a familiar 
format. 
 

Source Node 
 
The Source node in Prospector is somewhat comparable to the Managers node in Stylus, in that it 
represents the area of the Design Tree where you select which data you will analyze.  In the case of 
Prospector, you may choose from any return series database in Stylus, and you may select multiple 
sources.   
 
The actual format of the Source node data pane should be familiar to Stylus users, as it is the same format 
as that of the Managers node in the Stylus module.  It may be operated in precisely the same way; for 
more information on using this data pane, please see Chapter 3. 
 
Once a source has been selected, there are several options available to filter the source and indicated the 
fields you are interested in studying further.  For more information, please see below. 
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ID/Records Column 
The ID/Records column is similar to many areas of the MPI Stylus application that tell you how many 
records are available for a given data source.  If a source’s entry in this column is blank, it generally means 
that you have not attempted to access this data yet, and therefore MPI Stylus has not loaded this 
information.  In addition, if you are using the “Delayed Open” option in MPI Configurator for a database, 
the number of records will not be available by default because MPI Stylus Pro will not have accessed this 
database yet.  You must select the database as a source to have Stylus retrieve, update and display the 
number of records. 
 
 
Considerations for Using Multiple Sources 
MPI Prospector will allow you to choose multiple sources for analysis in a single Prospector study; 
however, there are several considerations that users should keep in mind when using more than one 
source per study.   
 

▪ Not all sources have identical or even similar data fields.  For example, Morningstar provides 
quite a lot of quantitative fields that would be absent from many other data streams.  This will 
affect the ability of some funds to appear on given charts, or to have useful data (as opposed to 
N/A) available in given columns within a table.  If a chart in Prospector is not populating at all, it 
may be because its design is based on another source with different data headings and types. 

▪ Keeping this in mind, some templates in Prospector may have been built with a given source in 
mind, i.e. Morningstar, and therefore may display the names of fields and/or charts irrelevant to 
other data sources. 

▪ Sources may not agree on how to calculate a given statistic.  Please use care when determining 
which statistic you are using, and its parent source. 

 
Indicators 
 
Advanced Analytics package subscribers will see an additional option, ‘Indicators’, in the Source and the 
Output nodes. For more information on using this feature set, please see the Advanced Analytics user 
guide on our website, or contact us at support@markovprocesses.com. 
 
Working with a Source 
 
Once you have selected your source, it will appear on the Design Tree under the Source node.  By default, 
it will appear with a red plus sign next to it.  The sign next to a given source is important because it 
regulates how MPI Prospector populates the output list of funds.  These sign options give the user the 
power of applying extremely complex filtering rules to a database by selecting it multiple times, adding or 
removing funds for each instance and applying separate filters. 
 
 
 
 
 
 
 
 
This plus sign may be changed by clicking on it with the mouse to any one of the following options: 
 
All Funds Included 
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When a red plus sign appears next to the source, it means that all the underlying funds will be added to 
your output list. 
 
Exclude All Funds 

 
 
When a red minus sign appears next to the source, it means that any funds included in this source will be 
removed from the output list.  Therefore, if multiple databases are being used as sources, and there is a 
“minus” database before a “plus” database, the “minus” database will have no effect because there will 
be no list from which to remove funds. 
 
 
 
Ignore Source 

 
 
By clicking once more with your mouse, you can change the red minus sign to an empty box, which tells 
Prospector to ignore the source altogether.  This is the equivalent to deselecting something on the design 
tree, meaning that it will not be included in any analysis, but you will have the option to add it in again 
later. 
 
Once you have decided how to treat your source, you can click on the + symbol next to the source name 
to expand its design tree menus. 
 

 
Figure 94 
 
Source Sections 
 
Each source will be assigned two distinct sub-sections: Filters and View.  These will assist the user in 
preparing the source for further analysis for manager searches, or in adjusting the peer universe to 
necessary specifications. 
Filters 
Filters are an extremely powerful and important part of MPI Prospector because they allow you to 
customize data source streams to meet very specific needs.  The Source node will be one of two areas 
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within the module where filters may be applied.  Please see the “Working with Filters” section in this 
chapter for complete information on Prospector filters. 
 
Indicators 
Subscribers to our Advanced Analytics package will see an entry here for Indicators, similar to the one in 
the Output node. For more information on using this and associated features, please see the Advanced 
Analytics User Guide, available on the MPI website or from support@markovprocesses.com.  
 
View 
The View element of the source node is very similar to the Views node in the Stylus module, but in this 
case regulates the initial source view upon which filters may be applied.  By default, any time a new 
source is brought into Prospector it receives a View with one table (Table1) automatically populated to 
display the source’s data fields.  This table may be viewed by clicking on the name of the data source (for 
example, Morningstar.)   
 
You may create additional tables and/or charts in this view precisely the same way as you would in the 
Stylus application; however, the only two types of charts available in MPI Prospector are scatter and 
distribution charts.   
 

 
Analytics Node 
 
The Analytics node is composed of three of the input nodes from the Stylus module design tree – 
Parameters, Style Outline and Benchmarks.  Please note that the Peer Groups node is not necessary here 
because we are in the peer group file itself. 
 
When you click on the Analytics node itself, you will see a brief summary screen that will inform you of 
your basic parameters, including your selection of a benchmark (if any.)   
 

 
Figure 95 

 
These elements may all be changed within the Analytics node itself. 
 
These four nodes operate precisely as they do in the Stylus module, so we will not cover them again in 
this section.  For more information, please see Chapter 4 (MPI Stylus Module.) 
 

 
Composition Node 
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The Composition Node helps manage the various analytics that will be available for use in the output 
section of your Prospector study.  There are two different types of analytics to consider here: 
 

▪ Source: analytics/fields that are being brought in from the source database(s). 
▪ Analytics: analytics that are calculated by the user through the analytic blocks available in the 

Composition node. 
 
When you click on the Composition node itself, your data pane will be split into two “Summary” fields, 
displaying the various analytics available from each source.   
 

 
Figure 96 

 
Source Summary Field 
 
The Source field will list every data field selected for display in your output table.  If no data appears in 
this field, then no columns from your data source are currently selected. 
 
To add/change/remove data fields from the Source Summary field:  
 

1. Click on “Source” in the Composition node on the design tree. 
2. You will now see a check box list that is similar to that of Table1 in the Source node of your 

design tree.  This check box list may be operated in precisely the same manner, selecting or 
deselecting the fields that interest you. 

3. When you have finished making your selections, please press the run button to see them 
reflected in your Prospector study. 

 
Remove Duplicate Series 
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The “Remove Duplicate Series” options in the Source section of the Composition node are useful when 
multiple sources are being used.  The output list in MPI Prospector is created based only on fund ID, and 
normally if there is the same fund ID record in multiple sources, the output record will only be created 
once.  These options give the user the ability to remove duplicates. 
 
 
Analytics Summary Field 
 
The Analytics field will list every analytic (by type) that has been created in the analytics section of the 
Composition node.  The “ID” and “Description” fields are added automatically by the program and will be 
present regardless of whether or not any analytics have been created.  For more information on using 
Analytics in Prospector, please see the section “Working with Analytics” later in this chapter. 
 
Using Analytics 
 
The process of creating and using Analytics is quite similar to the chart/table design process in other 
modules. When you click on the Analytics node, you will be able to add table design blocks and then 
adjust them via the interface. 
 
It should be noted that you will be able to check/uncheck analytic blocks on the Design Tree (version 9.0 
or later). This allows users to ‘turn off’ a calculation without having to delete it from the Design Tree. 
Advanced Analytics package users who are using Custom blocks should take notice that turning off a 
calculation may affect other calculations built off of the calculation being disabled. 
 
Summary Statistics  
Stylus now has the ability to calculate universe statistics in Prospector. To access this feature, user will 
have to check/ click on the Enable option at the top of the Summary Statistic feature by going to 
Prospector Study-> Expand ‘Composition’ node and selecting ‘Summary Statistics’. Codes can be used to 
specify the analytic that the user would like to use on the universe group output. For instance, the code 
DISTR with Par 1 set to 0 will provide all percentiles specified for the study (which is defined under 
parameters). In order to use these computed statistics as ‘Filters’ in the prospector output, user needs to 
specify the ‘Use as Filter’ option. Users will also have the option to rename their Statistics as a Custom 
Field by selecting one of the 2 options Prepend and Replace. Using Replace will allow user to specify their 
own custom field title and using Prepend will allow the user to write their own Field followed by a Stylus 
specified ID.  

 
 

Output Node 

 
The Output node in Prospector has several important functions, some of which borrow from the output-
type nodes (i.e. Views) from other modules, and others of which are unique to Prospector.  The essential 
functions of the Output node in Prospector are: 
 

1. To allow for an additional level of filtering within a study and the use of calculated statistics 
(analytics) for filtering. 

2. To allow the user to make use of dynamic charts and tables to visually explore data relationships. 
3. To allow the user to export data to external applications or other modules in the application. 

 
When you click on the Output node itself, the table you are seeing is regulated by the View section of this 
node (by default, it will generally be called Table1.)  This is not the same table as appears in the Source 
node of the program, though it may look similar and operates in the same fashion; therefore, you may 
have some fields selected in the Source node that you choose not to select in the Output node, or vice-



MPI Stylus Pro  
 

Copyright 2005-2020, Markov Processes International, Inc.Page 216 

 

versa.  To edit the fields visible in this table for the Output node, please click on the table name on the 
design tree under the View section.  Because Prospector allows you to export to outside formats, such as 
Microsoft Excel, being able to control the Output table view columns allows you to configure your table so 
that only columns you require are exported. 
 
Filters 
The Filters section of the Output node works precisely the same as the Filters section of the Source node, 
thus adding an additional layer of filters to user capabilities.  For more information, see the “Working with 
Filters” section later in this chapter. 
 
Indicators 
Subscribers to our Advanced Analytics package will see an entry here for Indicators, similar to the one in 
the Source node. For more information on using this and associated features, please see the Advanced 
Analytics User Guide, available on the MPI website or from support@markovprocesses.com.  
 
View 
The View section allows you to add additional tables and/or charts to your Output view.  This is especially 
important for users wishing to use Prospector to conduct manager searches, as the dynamic view 
capabilities of the module make this easy and intuitive.  This View section works just like any View 
element in MPI Stylus, but as was the case with the Source node View section, you may only create 
scatter and distribution charts.   
 
Output Tab 
The relationship between the Output node and the Output view tab are slightly different than that of the 
Views/Reports nodes to their respective nodes in the Stylus module.  In the case of Prospector, the table 
that you see when you click on the actual Output node is the same table you will see when you click on 
the Output tab, and therefore if you are only using the one table in your Output view, you need not 
necessarily work from the tab to engage additional filters.  In fact, you can export the table data directly 
from the data pane itself. 
 
The Output tab becomes important when you wish to make use of additional tables and/or charts and 
capitalize on Prospector’s powerful dynamic views abilities.  For a complete guide to using Views in the 
Output tab, please see the “Working with Output Tab Views” section later in this chapter. 
 

Views Node 

 
The Views node in Prospector allows you to create additional View tabs with charts and tables, in order to 
give you more visualization power when doing research in Prospector. As with other modules in Stylus 
Pro, these Views are highly customizable. For information on using this section, please see the chapter in 
this manual dedicated to Views & Reports. 
 

 
 
 
Reports Node 

 
The Reports node in Prospector allows you to create a printable report including information about filters 
included in a run, and various charts/tables that were created in any of the Views mentioned above. As 
with other modules in Stylus Pro, these Reports are highly customizable. For information on using this 
section, please see the chapter in this manual dedicated to Views & Reports. 
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Working with Filters 

 
Filters in MPI Prospector give the user a great deal of power and flexibility in exercising both of the main 
functions of the module: to create/edit peer groups and to conduct manager searches.  Filters allow users 
to create very specific groups of funds based on criteria related to any quantitative or qualitative field in a 
source, and/or based on numerous performance-based statistics. 
 
In order to give our users the greatest degree of choice in how they went about performing these 
functions, the opportunity to place filters upon one or more data sources occurs at both the initial stage 
of source selection, and at the output stage as well. 
 
There are two main different types of filters that you can potentially put on a data source in Prospector.  
They include: 
 

1. Data Field Filters – A filter placed on a particular data field to restrict the group as a whole to 
funds fulfilling a given requirement, such as funds with r-squared values greater than 90, or funds 
with manager tenures longer than 5 years. 

2. Include/Exclude Filters – Source-specific filters that include or exclude one or more given funds, 
regardless of their level of acceptability given other filters.  These filters can be created by picking 
specific funds in both the Source and Output nodes.  In addition, the user can populate these 
filters directly through the View based on visual data exploration and the right-click menu. 

 
The picture below illustrates how the filters might be reflected in the Source node of the Design Tree.  For 
a given source, you can see that Include and Exclude filters are presented first, and then a list is made of 
each data field filter currently applied to the data source.  The user may choose to check or uncheck these 
at any time to temporarily remove them from the study or add them back again. 
 

 
Figure 97 

 
Data Field Filters 
 
Data Field filters are imposed by the user on a given data field to restrict the peer universe to only those 
funds fulfilling a given set of requirements.  This capability is given to the user at two points in MPI 
Prospector.  Firstly, the user may set filters on the source database in the Source node itself, allowing for 
the creation of a basic set.  Secondly, the user may impose further filters on the output table, allowing for 
more detailed analysis of a given set of funds. 
 
All data field filters are conveniently located out of a blank field just below the column heading for their 
respective data fields, as may be seen in the example below.   
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Figure 98 

 
Each yellow field represents a filter being applied to the given column.  In the first case, a drop-down 
menu accessed by clicking on the blank space underneath the “Morningstar Category” heading has 
allowed the user to select the “Large Growth” category.  In the second case, the user was able to type in 
“>4” in the Mstar rating to filter out any fund with a rating of four or lower. 
 
Numerical Filters 
MPI Prospector gives you several options for filtering numerical data.  These options work off of simple 
logical operators that may be familiar to most users.  These operators are: 
 

Logical Operator Function 

> Greater than 

< Less than 

= Equals 

<> Is Not Equal to 

>= Greater than or equal to 

<= Less than or equal to 

| or 

& And 

<na> Only “NA”s selected 

!<na> “NA”s excluded 

Figure 99 
 
 
 
 
 
 
These filters may often be used in conjunction with one another to produce desired results that may not 
be achievable through a single expression.  Some examples might include: 
 

Combination Function 

>2 & < 15 Would return numbers 
between 3 and 14 

>3 & <>10 Would return all 
numbers greater than 3, 

except for 10 

>5 | =1.7 Would return numbers 
greater than 5, or any 

field with a value of 1.7 
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Figure 100 
Please always make sure to check your field after filtering to ensure that you have achieved the correct 
effect.  You may click on the column heading to sort the field numerically, which should help you to 
quickly audit the data. 
 
Text-based Filters/Non-Numerical Filters 
 
It is also possible to filter based on non-numerical data (text strings). This generally requires a careful 
attention to detail, as (for example) a misspelling will cause the user to not find the results they require. 
 
The following filter codes may be used: 
 

Filter Function 

= Starts from 

== “exact match” 

~ Match any part of string 

!~ Do not match any part 
of string 

<, <=, >=, > String comparison 

<>, != Not equal to 

<blank> Empty string 

!<blank> Not empty string 

Figure 101 
Special Note on Usage of & 
 
When using the & symbol with text strings, it is important to remember that this may also occur naturally 
as a part of a string, and must be accounted for. To give a very obvious example, suppose that a user 
wished to search for an index beginning with the term S&P: 
 

• By simply typing S&P, the user will be telling Stylus to find text strings beginning with the letter S 
and beginning with the letter P also; and as no text string can separately begin with two 
characters, no results are returned; 

• By typing in S&&P, the user invokes a ‘mask’ that turns off this functionality, allowing for a search 
for this string properly. 

 
 
 
 
FILTERING OUT “N/A” OR “NA” 
 
The NA expression in a Prospector table stands for “Not Available.”  There are several factors that can 
influence whether or not data will be available for one or more funds in your source, including, but not 
limited to: 
 

▪ Study-level parameter settings that exclude certain funds.  For example, if your study is looking 
at a 10-year period of time, and your performance analytic default parameters are “All, Total, 
All”, then any fund with less than 10 years of return history will not have data available. 

▪ Missing data.  Some data sources contain certain fields that are optional, manager-reported, etc., 
and may have no data available. 

 
When NA appears in an output table, Prospector does not interpret it as a conventional text string and 
therefore a text string filter for “NA” will not work.  Instead, there are two ways of filtering on “NA” for 
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any column: either using special “NA” filters (described below), or by placing any regular filter on a 
column.  Prospector automatically removes NAs from any column that is using any filter. 
 
To filter on NA directly: 
 

1. The filter field for the column you wish to filter will either use the drop-down menu to allow you 
to select filters, or allow you to type a filter directly into the field. 

2. If it is a drop-down menu, the NA filters will be found at the bottom of the menu (the last two 
options.)  Use one of the two filers listed below. 

3. If it is a text entry field, type in one of the two filters below and press the “Enter” key on your 
keyboard. 

 
<na> = Select any fund with “NA” in its field for the column. 

!<na> = Filter out any fund with “NA” in its field for the column. 
 
Drop-down Menu Filters 
Some text-based fields in certain databases are programmed in Prospector to have drop-down menu 
options as opposed to filter fields.  This allows the user to simply click one or more check boxes, instead of 
going through the laborious process of entering each necessary filter expression.  To determine if a field 
utilizes a drop-down menu, simply click in the relevant filter field.  If the drop-down menu does not 
automatically appear, then the field requires text or number entry for filters. 
 

 
Figure 102 

 
To use a drop-down menu: 
 

1. Click on the filter field below the appropriate column heading.  The drop-down menu should 
automatically appear.   

2. You may use your mouse to select or deselect options as you see fit.  Selecting more than one 
option will be the same as using an “OR” operator. 

3. When you have made all of your selections, click again in the filter field.  The filters will be 
applied (this may take a few moments.)  When a filter is being applied to a column, the field will 
appear highlighted in yellow. 

 
Include/Exclude Filters 
 
The Include and Exclude filters give users the power to specify individual funds, indices, etc., that should 
either be included in or excluded from a given peer universe, regardless of any other filters and 
constraints placed upon the universe.  Include and Exclude filters always override any other filters in the 
Prospector module. 
 
As was the case with data field filters, users are given two opportunities to use include/exclude filters.  
Firstly, they may be entered directly on the source, and secondly, they may be used in the Output node as 
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an additional level of filtering.  In the case of Views in both the Source and the Output nodes, this may be 
accomplished either with the first set of instructions below, or with the right-click method described 
afterwards. 
 
Force Include Filter 
The “Force Include Filter” option allows the user to mandate that the Include filter be respected 
regardless of commands in the application that would normally contradict it – for example, an attempt to 
use the Exclude filter on any fund already listed in the Include filter option. 
 
To include/exclude one or more funds: 
 

1. In either the Source node or the Output node of your design tree, expand the Filters option (you 
must have a source selected for this option to appear in the Source node.) 

2. Click on either Include or Exclude. 
3. You will now see a list of funds in the source database.  Please double-click (or click the check box 

for) any fund you wish to select for this filter.  You may select as many funds as you wish. 
4. If you select a fund in error and wish to remove it, simply uncheck the fund in your data pane or 

click on it on your design tree and press the “delete” key on your keyboard.  Alternately, you 
could uncheck it on your design tree to temporarily remove it from your analysis without the 
fund disappearing from your design tree. 

 
To include/exclude one or more funds using the right-click option: 
 

1. In the Source or Output node Views, select one or more funds with your mouse from any chart or 
table. 

2. Right-click with your mouse and select the “Filter” option.  You may then use any one of the four 
options in the table below. 

 

Filter Option Result 

Exclude Selected Adds selected funds to the Exclude filter. 

Include Selected Adds selected funds to the Include filter. 

Clear Exclude Clears the Exclude filter. 

Clear Include Clears the Include filter. 

Figure 103 
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Working with Analytics 

 
In addition to making use of data fields brought in directly from a source database, MPI Prospector users 
have the ability to calculate numerous performance-based statistics from data return streams in order to 
give them additional analytical power in working with peer universes and conducting manager searches.  
These analytics are created and edited through the Composition node, and unlike the Stylus module, the 
Prospector module does not create unique tables or charts for each analytic, instead adding them as 
additional columns to your master table in your Output tab. 
 
Stylus module users will recognize many of the analytic blocks in Prospector from the Stylus module.  
These blocks contain a variety of analytics that will be available as: 
 

1. Columns in your output table, capable of being filtered by standard data filtering techniques. 
2. Data for inclusion in dynamic scatter or distribution charts in your output tab. 

 
Temporary (Do Not Store to Output) 
 
This checkbox allows an analytic block’s calculation to be performed without the output being displayed 
in the Output table or as an option for display in charts. This is primarily useful for multiple period output 
that is used as the basis for other calculations but whose underlying output is not necessary for 
viewing/filtering purposes. The same goal may also be achieved by adding the suffix “_temporary” to any 
Prospector analytic. These will be easily identified because they will become grayed out on the Design 
Tree. 
 
Creating a New Analytic 
 
Creating new analytics is quite simple, and will be very familiar to users of the Stylus module as well, as it 
will make use of drag-and-drop analytic blocks similar to those used to create charts and tables.   
 

 
Figure 104 

 
When you click on the Analytics section of the Composition node, you will see a blank data pane with all 
available analytics blocks to be found at the bottom.  As you create each analytic, they will be arranged 
automatically in a vertical row, with the newest analytic always on the bottom.  If you create more 
analytics than can be viewed on screen, a scroll bar will automatically appear and you will be able to scroll 
down to see the newer analytics.   
To create a new analytic: 
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1. Click on the Analytics section of the Composition node. 
2. Using your mouse, click on any of the green blocks at the bottom of the data pane and drag it to 

the top part of the data pane.  The block will automatically adjust to be the entire width of the 
data pane, and the newest analytic will always appear at the bottom of the screen. 

3. Using the drop-down menu, check boxes and parameter settings in the analytic block, design the 
analytic you require. 

4. The analytic will now also appear on the design tree in the Composition/Analytics section.  Click 
on the analytic’s name on the design tree to view its default parameter settings. 

5. The analytic also now appears as a column in your Output table, and will generally have been 
assigned a descriptive name (such as Total AnRtn for a “Total Annualized Return” Performance 
analytic.)  Like all columns in the output table, you will be able to filter based on analytic results. 
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Working with Views in Prospector 

 
Views in MPI Prospector may be found in the Source, Output and Views nodes, and constitute an area of 
the module that allows for very powerful filtering options and manager search capabilities.  Dynamic 
charts and tables give the user a visual appreciation for the data, and a variety of export options add to 
the experience by allowing users to take the results of their work and move them to the Stylus module, or 
export them to outside applications for further use. 
 
There are three basic steps to working with Views in MPI Prospector: 
 

1. Designing the Output 
2. Working with the Output to further your understanding of the data. 
3. (Optional) Exporting your results to the Stylus module or an outside application. 

 
Important Note – Running Your Prospector Study 
 
Because MPI Prospector works with large quantities of data, changes made in the “Input” part of the 
study (i.e., Source databases, filters, analytics, etc.) will not be reflected in the “Output” part until you run 
the study again – even if the “run” arrow appears green.  If you are unable to see the results of a change 
you have made, please try running the study by clicking on the green arrow.  In order to help your studies 
run faster, we suggest that you always start any new Prospector study by applying any filters you may 
have, in order to reduce the size of your working data set. 
 
Designing Your Output 
 
The first step to making full effective use of the output tab will be to understand the options you have 
available.  By default, an entirely unpopulated Prospector study still comes with an output tab partially 
built, including a View section with a table in it called Table1.  This table is meant to be your master table 
in the output stage, and the data that populates it is controlled in two areas of the application: 
 

1. The “Source” element of the Composition node regulates which fields from the source will be 
available for display within the table.  By clicking on Table1 on the Design Tree, you will then 
have the option of choosing whether or not to further pare down the fields for your table; 
however, to add any fields to Table1, you must first add them to the Source element. 

2. Any analytic created in the “Analytics” section of the Composition node will be available in your 
table. 

 
Output Tools 
 
It should be noted that many of the same output tools that are available in the Stylus module – such as 
the Attributes Editor, etc. – are available in MPI Prospector, and may be used precisely as they are in 
other modules. 
 
Create Linked Indicator 
Advanced Analytics package subscribers will see this feature in their usage of Prospector output. For more 
information on using this feature, please see our Advanced Analytics user guide, available on our website 
or from support@markovprocesses.com. 
 
 
 
Themes 
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Please note that users of Version 10.0 or later will have access to ‘Themes’ in this section. For detailed 
information on ‘Themes’, please see the ‘Views & Reports’ chapter of this manual. 
 
Charts 
 
In addition to table data, Prospector allows you to create two types of charts to add value to your 
analysis: scatter and distribution charts.  In each case, you will be able to use any chartable field available 
from your source database or from your analytics.  Scatter charts in Prospector are automatically dynamic 
and linked to all other scatter charts and to all tables, allowing each chart to reflect your interests more 
usefully.  Distribution charts in Stylus are not dynamic because they explore data relationships for the 
group as a whole, as opposed to for a given fund or funds. 
 
The Value of Multiple Dynamic Scatter Charts 
 
Scatter charts in MPI Prospector are dynamic, meaning that when you make a selection in an output table 
or another scatter chart, the same selection will appear highlighted in all other tables and scatter charts.  
This allows you to explore visual relationships between data. 
 
For example, consider the following screenshot.  The user has created an output tab with four scatter 
charts, one distribution chart, and a table underneath.   
 

 
Figure 105 

 
Through this process, the user is able to explore visual relationships between different segments of the 
data; however, suppose that this user notices that several of the charts contain outliers.  The user may 
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wish to find out more information about these outliers, and using their mouse, decides to select those 
outliers on one of the charts.  Their selections may be seen in the picture below. 
 

 
Figure 106 

 
This by itself would give them some limited information; for example, the user could right-click on this 
chart and choose to send these managers to a Stylus study (for more information, see the “Exporting from 
Prospector” section later in this chapter).  However, when used in conjunction with many other views, the 
value of having multiple dynamic view charts becomes readily apparent. 
 

 
Figure 107 

 
Note only is this data available for study in the table at the bottom of this view screen, but the other 
scatter charts have automatically highlighted the same funds selected in the first chart.  This lets the user 
learn more about these outliers and make a more informed decision on how to proceed with analysis.  It 
should be remembered that the table is dynamic too – clicking on one or more funds in the table will 
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automatically highlight those funds in all scatter charts.  Note that the distribution chart is not dynamic 
because it is displaying information describing the data as a group, as opposed to on a fund-by-fund basis. 
 
 
Using Dynamic Scatter Charts 
There are several important techniques that will help a user get the most out of dynamic scatter charts in 
Prospector.  Obviously, many of these tips may be combined for the most effective possible analysis. 
 
 
MANAGER IDENTIFICATION 
 

 
Figure 108 

 
When you place your mouse cursor over a given point in a scatter chart (without clicking), a floating box 
will appear telling you the name of the fund represented by the point, as well as its data values.  The 
inherent structure of scatter charts means that some data points can sometimes be partially or totally 
obscured by other points; therefore, it is suggested that you always double-check that you have the 
correct manager name for a given point.  One way to do this is to highlight the point by clicking on it, and 
then seeing if its dot appears more clearly in another chart where you can verify that it is the fund you are 
interested in. 
 
SELECTING ONE OR MORE MANAGERS 
 
Clicking on one or more managers on a given scatter chart will highlight them on all scatter charts and in 
any tables in your Output tab.  The techniques you use for selection will vary depending on how many 
managers you want to select, and where in the chart they appear. 
 
Shift and Ctrl (Control) Keys in Selection 
The “Shift” and “Ctrl” (Control) keys on your keyboard both have important functions in the scatter chart 
manager selection process, and learning the differences between these functions will help increase your 
power when working with Prospector. 
 
Holding down the “Shift” key while you make selections allows you to use all of the selection techniques 
below without losing any of your selections.  For example, if you would like to click on a few managers 
specifically, draw several boxes with your mouse, etc., you can do so.  Any manager you select will 
automatically stay selected as long as you hold the shift key down.  Once you release the shift key, do not 
left-click on the chart again or you will lose your selections (you may still right-click to access menus.)   
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Holding down the “Control” key also allows you to make multiple mouse choices without losing past 
selections, but adds an extra level of control.  When you hold down the Control key and make selections, 
each time you click on a particular data point, its status will change – this includes if it is part of a box 
drawing.  This allows you to quickly define specific areas of the data or somewhat unconventional shapes.   
 
This technique is only necessary when you need to select multiple managers on a chart that are not in the 
same geometric area of the chart. 
 
To select multiple managers in the same location in a chart: 
 

1. On the scatter chart in question, click and hold-down your left mouse button and use your 
mouse to draw a box around the area of managers that you wish to select.  This box can range in 
size from one manager to the whole screen, and if you wish to draw multiple boxes, you may do 
so by holding down the shift or control (ctrl) keys. 

 

 
Figure 109 

 
2. When you release the mouse button, your selection will now appear highlighted – both on the 

chart itself and in all other scatter charts and tables in your Output tab. 
 

 
Figure 110 

 
3. You may use other selection techniques to make further selections from the chart. 
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To select multiple managers in different locations in a chart: 
 

1. On the scatter chart in question, you may use any combination of the following techniques: 
a. Clicking on managers dot-by-dot, using the shift or control keys to allow multiple 

selections. 
b. Drawing one or more boxes with your mouse button.  If you wish to draw more than 

one box, use your shift key or control key to maintain your previous selections. 
c. You may make additional selections through tables. 

 

Exporting from Prospector 

 
There are two types of data you can export from Prospector: chart output and table data.  MPI has made 
every effort to make Prospector output available in a wide variety of useful ways.  Users should make 
themselves familiar with these basic options in order to ensure that the results of their Prospector 
analysis may be applied to further ongoing areas of analysis.  
 
Exporting Data 
 
Data available in any table in Prospector may be exported in several ways, including to Microsoft Excel 
spreadsheets.  This is an easy and fairly common way for getting the entire contents of a given data 
source into Excel for further analysis.  That said, data in Prospector tables may also be sent to Stylus, 
turned into sets, etc.  Therefore, it is reasonable to think of data exports in two ways in Prospector – data 
exported into other parts of the Stylus application, and data exported to external sources. 
 
 
 
 
 
 
 
Exporting Data 
 
You can export data in Prospector from tables onto your computer’s clipboard, or to any of the four 
following formats: 
 

Extension File Type 

.txt Text file 

.xls Excel file 

.dbf DBF file 

.sql SQL script 

 
This exporting may be done from the data pane of any of the following locations in Prospector: 
 

▪ The source database name in the Source node. 
▪ Any table in the Source node View. 
▪ The source database name tab. 
▪ Any table in the Output tab or Output View. 

 
These options should cover most uses of the data external to the application.  Please note that you may 
need updated versions of associated non-Stylus programs, such as Microsoft Excel, to read your export 
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files properly.  In addition, MPI does not support applications external to Stylus; please refer questions or 
problems with these applications to their vendors. 
 
To export data from a Prospector table to one of the file types above: 
 

1. Adjust the table to reflect all of the data you wish to export – use filters to weed out data you do 
not require. 

2. Right-click on the table and select “Export” and then either “Text to Clipboard” or “Text to File” 
with your mouse.  If you select “Text to Clipboard,” please continue to the next step.  If you 
select “Text to File,” please skip to step 4. 

 

 
Figure 111 

 
3. Once you select “Text to Clipboard,” the table contents will automatically be stored on your 

computer’s clipboard.  This will probably be a large set of data, so it is recommended that you 
paste it into a desired application quickly.  You are now finished with the Export process and may 
skip the remaining steps. 

4. Once you select “Text to File,” the “Save As” browse menu will open, allowing you to choose 
where on your computer to store the file, what to name it, and which file extension to use.  
When you have made these selections, press “Save.”  The file should now be available for use on 
your computer/network. 

 
Column Order 
 
It should be noted that it is not currently possible to change column order in Prospector. Therefore, users 
wishing to change column order should do so in external applications, such as Microsoft Excel, after 
exporting their data. 
 
Exporting Data for Use in Stylus 
 
There are several ways to make Prospector data available in some form for use in other modules of the 
MPI Stylus application.  First and foremost, a Prospector study file is the same thing as a peer universe file, 
and therefore any Prospector study may be brought into another module as a peer group.  In addition to 
this option, though, there are ways within the Prospector module to choose specific sections of data for 
export to other modules. 
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Create Set 
Sets in MPI Stylus are special grouping files that serve a very useful purpose.  Though they generally work 
like Prospector studies, and may be brought into another module as a peer universe, they allow the user 
to create small groupings of specific funds that might be otherwise impossible, or at least very tedious, 
with the Prospector filtering system. 
 
For example, suppose that a user is working within a particular database and is making use of dynamic 
views in Prospector to conduct their analysis.  As can be seen in the chart below, they have made 
numerous selections in their dynamic chart views in order to study a specific group of funds that fail to 
meet certain criteria the user had hoped to establish for the peer group or manager search.  In this case, 
the user has selected funds for further analysis based on two major criteria: 
 

1. Any fund with a Style R2 or Benchmark R2 of less than 80 (see the Diversification chart.) 
2. Any fund that the user considers an outlier on any of the four charts. 

 
As may be seen, these choices are also reflected in the table below the charts.  Now, the user wishes to 
take this information and bring it in to MPI Stylus to use like a peer group in order to judge various funds 
against this segment of the peer group to better understand its impact on their overall analysis.  To 
reproduce this list by applying Prospector filters would be a very difficult task, and take a lot of 
unnecessary time.  Instead, this user may take the data and create a set based on these live selections. 
 

 
Figure 112 

 
To create a set: 
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1. Once you have made the necessary selections, right-click on any dynamic chart, or on the table, 
and select “Create Set.” 

2. The “Peer Group Edit” menu box will now appear.  Basic information on filling out such a box 
may be found in Chapter 3 of this manual.  By default, the Description will indicate the name of 
the Prospector study from which a given set was created – it may be wise to keep this 
information for further reference, as you may not open a set later in Prospector the way you can 
a true Prospector study. 

3. It should be noted that this same box will be the only way to edit this particular set in the future; 
therefore, you may wish to make sure that the set you are creating is correct, and that you will 
not need to make major changes at a later time. 

4. Click “Save” once your set is prepared.  You may now access this file through “Peer Groups” 
nodes in other modules by browsing to the appropriate database.  You may make unlimited sets 
from a single Prospector study. 

 
Create Portfolio 
This option may be used to automatically open a new instance of the Portfolio Editor with all selected 
funds listed as assets.  This allows you to create your own weighted portfolio, fund of funds or blended 
benchmark directly from your Prospector research. 
 
Create Map 
This option may be used to automatically open a new instance of the Map Editor with all selected funds 
listed as points available for plotting on the map.  This allows you to use Prospector to identify factors for 
style analysis and then create maps immediately following your research. 
 
Send To 
This option allows you to take a given number of selected funds and send them to other modules for 
further use or analysis.  
 
There are four ‘locations’ to which selected funds may be sent: 
 

• New Stylus study (template) 

• New Allocator study (template) 

• Existing Stylus study (note: existing studies must be open in order to send funds to them) 

• Existing Allocator study (note: existing studies must be open in order to send funds to them) 
 
Please note that funds sent to the Stylus module can be sent to the Managers node or Style Outline, and 
funds sent to Allocator may be sent to the Assets node or Series node. 
 
To Send Funds to a study: 
 

1. Right-click on any chart or table and select the “Send To” option.  If you would like to send the 
managers to a new Stylus study, skip to step 3.  If you wish to send managers to a Stylus study 
you already have open, please continue to the next step. 

2. When you use the “Send To” option, any Stylus study you have open should appear in your list of 
studies to send to.  In this case, the user has a study open called “noname.sty” (in other words, 
they have used a template or blank study and not saved it yet.  By selecting that study name, the 
managers will automatically be added to the Managers node of the Stylus study in question – 
along with any managers already added by the user to the study’s Design Tree. 

3. When you use the “Send To” tool and select the “New Style Study” option, the “Select Template” 
menu from the Stylus module will open, and you will be able to select any of the templates 
available for this module. The template you select will open in the Stylus module with the 
managers populating the design tree Managers node. 
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Troubleshooting MPI Prospector 

 
For more Frequently Asked Questions (FAQ), please visit our web site at 
http://www.markovprocesses.com.  
 
Q: I can’t see data fields/columns for my table or my entire table comes up empty.  Why? 
A: The answer probably has to do with the selections made in one of two places in the design tree.  Please 
click on the tables in the View section of your Source node, and click on the “Source” section of the 
Composition node.  The selections in these areas determine what columns are shown in tables and what 
analytics are available for use in charts. 
 
Q: One or more of my Prospector charts is blank or incomplete.  Why? 
A: An entirely blank chart usually means that one or both analytics used to plot the chart are not present 
for the data you are using.  This is often because you are using one or more data sources that do not 
contain the fields that the chart is looking for.   
 
Q: I am using a large peer universe and should have lots of funds available, but very few funds show up on 
my charts.  Why? 
A: This is usually because many of your funds are being disqualified from appearing because they have no 
information available (NA) for a given statistic used in the chart.  This may be because the manager of a 
fund has provided no data to the data source company, but is more likely to be because of parameter 
restrictions on your statistics. 
 
 
 
 
 
 

 
  

http://www.markovprocesses.com/
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MPI Integrator 

Chapter 7 

Overview 
 

MPI Integrator is the perfect 
solution for professional, 
application-wide reporting in MPI 
Stylus Pro.  By allowing users to 
create one or more reports from 
Views in unlimited Stylus, 
Prospector and Integrator 
studies, MPI Integrator rounds 
out MPI Stylus Pro’s strength as a 
powerful, flexible reporting 
package.  Additionally, Integrator 
is the perfect solution for users 
looking to run and update 
multiple studies simultaneously. 
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Chapter 7 
 

MPI Integrator 

Introduction to MPI Integrator 

 
The MPI Integrator module gives users increased flexibility in their research and reporting solutions by 
allowing for easy integration of multiple studies from all Stylus Pro modules (except Configurator) into 
one or more reports.  Integrator’s primary function is to combine views from multiple Stylus, Prospector 
and/or Allocator studies into a single “library” in order to allow MPI Stylus Pro users to generate reports 
that are not possible in any other single module.  For example, a user could generate a report with a 
Stylus chart and a Prospector chart on the same page. 
 
MPI Integrator is also the perfect tool for users who wish to be able to run and update multiple studies 
simultaneously.  By linking all of those studies into a single Integrator study and pressing the “Run” button 
once, a user can save a lot of time compared with manually running the studies.  This does more than 
simply save time - MPI Integrator is a powerful production and publishing solution, capable of creating 
books that pull pages from multiple reports from throughout the MPI Stylus Pro application. 
 
Getting Started in MPI Integrator 
 
You may navigate Integrator’s main menu, design tree, data pane and view tabs exactly as you might in 
any other module in the application. 
 

Working with Integrator Studies 
 
Integrator studies function the same way as other studies in MPI Stylus Pro when it comes to opening, 
closing, saving or deleting them.  For more information on these basic steps, please see Chapter 3 of this 
manual. 
 
Why Aren’t Integrator Templates Available? 
 
Unlike other MPI Stylus Pro modules, Integrator is entirely dependent on the studies and ultimate 
reporting goals of the individual user.  An Integrator study’s content will be determined exclusively by the 
studies a user wishes to reference, which makes it impossible to anticipate on any meaningful level what a 
majority of users will want to create.  Therefore, MPI is unable to supply Integrator templates. 
 
MPI Integrator does allow users to create their own templates using the “Save As Template” feature in 
the module.  This is a standard feature available for all modules and is discussed in Chapter 3 of this 
manual. 
 
Understanding the Relationship Between Integrator Studies & Other Studies 
 
To use MPI Integrator effectively, it is essential to understand the relationship between Integrator studies 
and other studies in MPI Stylus Pro.  To use an Integrator study you must first have at least one study 
available in another module to bring into Integrator.  Because Integrator studies make use of actual 
studies from other modules, it may be necessary to run those studies in order to populate charts and 
tables.  Integrator allows the user to launch any and all studies in their respective applications and run 
them manually or automatically.  For instructions on launching a study from Integrator, please see 
“Editing a Study” later in this chapter. 
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When MPI Integrator is run it will copy the underlying data for precalculated charts, tables and memos.  
This allows users to share the Integrator study even with users who lack the underlying studies (though 
they will not be able to run or update it.) 
 
Binder Tab & Integrator 
 
The Binder Tab may have special applications for users who choose to utilize MPI Integrator. We highly 
encourage you to learn more about the Binder Tab (Chapter 3) in order to make the best use of this 
feature. 
 

Integrator Design Tree 

 
The MPI Integrator design tree is similar in appearance to that of other modules, though shorter, and 
contains only the elements necessary for efficient use of the application. 
 

 
 

There are a few important notes to consider about the Integrator design tree: 
 

▪ The Studies node.  Instead of brining in a manager, source or asset, you are bringing in one or 
more studies created in other MPI Stylus Pro modules. 

▪ No Parameters node.  Though some basic, study-level controls do exist in the Options node, 
parameters for charts, tables and memos will continue to be governed by the underlying studies 
in which they appear. 

▪ Views and Reports nodes.  Integrator is a reporting application, so these will be the key areas of 
the module.  Because Views and Reports in Integrator work somewhat differently from those in 
other modules, we recommend users familiarize themselves with these features specifically from 
this chapter if there is a need for Integrator. 

 
In addition, please note that the traditional input vs. output designations for nodes do not apply in 
Integrator – the whole module is built to facilitate output.  Users may therefore consider “Studies” the 
only real input node. 
 

Studies Node 
 
The Studies node allows you to bring one or more studies into Integrator.  It is the only true “input” node 
in Integrator because the only thing the module needs to know is which studies from other modules you 
wish to use as a basis for your new report(s). 
 
Study-level inputs, such as peer groups, benchmarks, assets, charts and tables should be designed in their 
respective Stylus, Prospector or Allocator studies.  Please note that Integrator will not automatically 
adjust all studies to a common benchmark, peer group, style outline, etc. – views from each study will 
continue to follow the parameters of that underlying study. 
Adding a Study 
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MPI Integrator allows you to add studies from different modules together into a single reporting solution.  
For example, imagine that a user has created a fact sheet template in the Stylus module, and then saved 
forty different versions of that template into forty studies, each one for a different fund they offer.  They 
would be able to use the Stylus module’s reporting solutions to examine a performance graph for any of 
these funds individually, but suppose that the user also had to put together a single report showing a 
performance graph for each fund.  They would be unable to do this without a great deal of copying, 
pasting and tedious exporting of images into a third-party application.  However, if they used Integrator, 
they could simply create a report with numerous charts per page, with each chart linking to a different 
study. 
 
To add a study to the Studies node: 
 

1. Click on the Studies node on the design tree. 
2. The data pane for study selection follows the same format used for manager selection in the 

Stylus module and Source selection in the Prospector module.  Simply click the check box next to 
each study you wish to add (you may also double-click the study name) and the study will be 
added to your design tree.  You may also use the ellipsis button (…) to browse to the correct 
database. 

 
Editing a Study 
 
When you click the name of any study on your design tree, you will see in your data pane an inactive 
version of the study’s main page from the appropriate module.  To edit a study, you will have to launch 
the study in its appropriate module and make changes there. 
 
To edit a study: 
 

1. In the “Studies” node on the design tree, click on the name of the study you wish to launch. 
 

 
 

2.  In the data pane, you will see a grayed-out version of the opening page of the study as it would 
appear in its module.  In the upper right-hand corner will be an “Open” button.  Click this button 
to launch the study. 

3. The study will launch in its module.  Depending on your Options node configuration and the 
study’s automation settings, any startup script associated with the study may run at this time. 

 

Options Node 
 
The Options node contains a few different features that may be used to help automate the Integrator 
process.  It should not be thought of as a replacement for the absent Parameters node, as it has extremely 
different functions.  Parameters for charts and tables must be adjusted through their underlying studies. 
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Figure 113 

 
There are four sections to the Options node, each based around steps the Integrator module must take 
whenever an Integrator study is run.  The four sections are: 
 

1. Open Studies 
2. Run Studies/Execute Startup Script 
3. Refresh Links 
4. Close Studies 

 
Open Studies 
 
The Open Studies section concerns any study that is present on the design tree in the Integrator study.  
When the user runs the Integrator study, one of the following three options can occur: 
 

▪ Open all studies.  This will automatically open all studies on the Integrator design tree, regardless 
of whether or not they are currently checked. 

▪ Open checked studies.  This will only open studies on the Integrator design tree that are currently 
checked. 

▪ Do not open studies – use already opened.  This option will not launch/run any studies on the 
Integrator design tree.  Only studies the user has already opened will be considered. 

 
Run Studies 
 
The Run Studies option allows you to adjust how studies on your design tree are run.  You have three 
options: 
 

▪ Run Stylus/Allocator studies.  When you run the Integrator study you are working in, all 
associated Stylus & Allocator studies will be run as well.  Any Prospector or Integrator studies 
associated with the master Integrator study you are running will not be run, because both 
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modules preserve data output and do not have to be re-run whenever charts need to be 
refreshed. 

▪ Run all opened studies.  When you run the Integrator study, any study that is also already open in 
any Stylus module will run as well. 

▪ Do not run any studies.  When you run an Integrator study, its underlying studies will be 
prevented from running. 

 
Only open studies can be run in MPI Stylus Pro; if a study is not open, the run function will not be 
performed. 
 
Execute Startup Script 
 
Some studies make use of automation options that automatically run a given script every time a study is 
opened.  Depending on the script design, the effects of this could range from the simple populating of a 
Stylus study’s design tree to the automatic printout of hundreds of reports.  Therefore, it is important to 
always know the specifics of any study you bring into Integrator, as several scripts running back-to-back 
may temporarily affect your computer’s performance. 
 
If you do have one or more studies on your Integrator design tree that have startup scripts, the Execute 
Startup Script functions will allow you to decide on what level to control these scripts in order to prevent 
scripts from running when you do not need them to.  Of course, scripts can only be executed in currently 
open studies; if a study is not opened, its script will not be run. 
 
The options are: 
 

▪ For all studies.  This runs any script in any study on the Studies node, regardless of whether or 
not the “Run on startup” box is checked in the underlying study. 

▪ For checked studies.  This runs any script in any study that is checked on the Studies node, 
regardless of whether or not the “Run on startup” box is checked in the underlying study.   

▪ Only if study is marked for auto-run.  This runs any script in any study in the Studies node that 
has the “Run on startup” option selected, regardless of whether or not the study is checked in 
the Studies node. 

 
Execute Binder 
 
Some studies make use of the Binder tab in order to accomplish quick, simple report combination options. 
This can result in the creation of PPT or PDF files of output in the relevant studies. 
 
If you have one or more studies on your Integrator design tree that use the Binder tab, this area will help 
you decide whether or not to run the Binder for those studies when the Integrator study is run.  
 
The options are: 
 

• For all studies. This runs the Binder in any study where it occurs. 

• For checked studies. This allows you to select for which underlying studies the Binder tab may be 
run, assuming it is populated in those studies. 

• Do not execute Binder. This allows you to prevent the Binder tab from being run in all underlying 
studies. 

 
 
Refresh Links 
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In Integrator, your views will be linked to views in given studies.  When these other studies are open, you 
have the option of changing views that are being linked into Integrator, such as a chart or table.  
Integrator will need to reflect these changes, and gives the user two options for how this is done: 
 

▪ Refresh charts linked to open studies.  This option allows Integrator to refresh itself whenever it 
detects that you have refreshed a chart in another study that its Integrator study links to. 

▪ Do not refresh linked charts. This option prevents Integrator from refreshing every time you 
change a linked view, unless you manually run the study. 

 
Close Studies 
 
When you run an Integrator study, it may open certain linked studies (depending on your specifications in 
the above options) to accomplish its necessary sequence of tasks.  The Close Studies tool allows you to 
specify whether or not Integrator needs to keep these studies open after running them, or may close 
them again when it is finished with them. 
 

▪ Do not close opened studies.  This option prevents Integrator from automatically closing a study 
that it has opened as part of its run process.  The advantage to this is that it allows you to know 
which studies Integrator has used. 

▪ Close opened studies.  This option allows Integrator to automatically close a study it has opened 
as part of its run cycle when it has finished running the study. 

 
Redirect warnings and errors to log file 
 
An Integrator study can rely on a great deal of information, including but not limited to data sources, 
specific funds, benchmarks, indices, peer groups, chart and table names and locations, and data source 
naming conventions and pathways.  Any change to one or more of these pieces of information could 
cause an error or warning to appear in Integrator if it is unable to perform a given task or access a 
necessary file.  Examples of common problems could include a fund that is no longer active and therefore 
has been removed from a database, a peer group that has been renamed or a chart that was deleted from 
its underlying study. 
 
In MPI Stylus Pro, it is generally the case that users receive error or warning messages via a pop-up box 
that informs the user of the problem at the time it occurs. 
 

 
 

This ensures that the user is aware there is a problem requiring further action; however, this can be 
problematic in the case of large studies, or with errors and warnings that the user may find acceptable.  
Therefore, to smooth automation, users have the option of specifying that errors and warnings be written 
directly into a log file, as opposed to onscreen. 
 
If you select this option, you may access this log file at any time through this process: 
 

1. Go to your computer’s file management system, such as My Computer.  This needs to be done 
outside of the MPI Stylus Pro application. 
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2. Browse to your Stylus root directory (for example, C:\Stylus). 
3. Locate the file called “Stylus.log” in this directory.  This is the log to which Stylus events, including 

errors and warnings, are written.  This is a text file, and may be opened through any basic text 
program such as Notepad, Wordpad, or Microsoft Word. 

4. Once the log file is open, you should be able to review all logged information. 
 
Changing the Log File Name and Location 
 
Users may change the name and/or location of the log file to meet their needs.  This will be unnecessary 
for all users except those who have a specific reason for the change.   

Views and Reports 

 
Most features of Integrator’s Views and Reports nodes work as they would in the Stylus or Allocator 
modules; however, there are some changes that are based on Integrator’s specific uses for reporting from 
multiple studies.  A quick summary of these may be found below, followed by more detailed explanations 
in the Views Node and Reports Node sections of this chapter. 
 

▪ There is no option to create new charts or tables (you may create new memos.)  Charts and 
tables must be linked to other studies. 

▪ Unlike with the link option in other modules, you can “lock” the link function for any view in 
Integrator.  This prevents accidental data refresh when you are trying to archive particular 
views/screens for certain dates or periods. 

▪ The Chart/Table/Memo designer screen has been expanded to include new information, such as 
the underlying study in which a given chart, table or memo may be found. 

 

 
 
Views Node 
 
Although it is not possible to create new charts or tables in Integrator (you may create memos), it is 
possible to create and organize new views.  This helps you to structure your Integrator study by creating a 
working library of charts, tables and memos from your underlying studies that you need for your reports.  
You may then link directly to charts, tables and memos in underlying studies from your report, or link to 
those studies in your new View tabs. 
 
 
 
 
 
 
 
 
 
 
 
 
 
View Link Screen 
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Figure 114 
 
The View data pane screen in Integrator is specially created to help users efficiently manage their links to 
charts, tables and memos in underlying studies.  Because of the number of underlying studies possible in 
Integrator, and the number of possible Views per study, it is obviously helpful to tell the user more than 
just the name of the particular chart, table or memo and its particular view; therefore, Integrator adds 
three additional columns to the traditional View link data pane screen: 
 

▪ Dbs – This “database” column will tell the user the database in which a given study is saved. 
▪ Studies – This column tells the user the file name of the study in which a given view is stored. 
▪ Report – This column tells the user the name of the report in which a given view may be found in 

a study.  It should be noted that views located in the Views node of a given study will have no 
entry for the Report column.  In addition, a view that has been added to a report in an underlying 
study will appear as both a View entry and a Report entry, but may have different 
titles/appearances based on the study design. 

▪ View/Page – This column tells you the name of the View, or the page in a Report, on which the 
chart, table or memo is located. 

▪ Chart/Table/Memo – This column will tell you the name of the charts, tables or memos in the 
underlying studies. Note that the column title will reflect the type of object you can link to (i.e., if 
you are using a Chart block, you will only see the title ‘Chart’, and only charts will be shown from 
underlying studies.) 

 

Reports Node 
 
The reports node will largely be the same as that of other modules in MPI Stylus Pro; for more 
information, please see Chapter 5 (Views and Reports.)   
 
Starting with version of Stylus 11.3, a user also has the option to share all the underlying studies in an 
integrator study to another recipient, rather than attaching each study one by one. A user can do so by 
going to MPI Stylus Pro-> Help-> Send Current Study to MPI Support. 
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Troubleshooting MPI Integrator 

 
For more Frequently Asked Questions (FAQ), please visit our web site at 
http://www.markovprocesses.com.  
 
Q: I am getting an error message saying that a manager, peer universe, benchmark, set, or other item 
cannot be found.  Why? 
A: This is a common error that can occur whenever Integrator looks to an underlying study for a file and is 
unable to find it.  This can happen because a manager ID is no longer found in a database, a file has been 
moved or deleted, or because a file is located on a network or drive to which the user no longer has read 
permissions. 

 
Q: Every time I run an Integrator study, my computer publishes or prints content or reports I was not 
expecting/don’t want.  Why? 
A: This usually means that one of the underlying studies you are using has a script in it that is designed to 
run whenever the study is opened.  Scripts of this kind will normally run when Integrator runs their 
studies, unless the user has designated in the Options node in Integrator that the script should not run 
automatically. 
 
Q: My Integrator study takes quite a long time to run. Is this normal? 
A: The chart refresh action in MPI Integrator is slow by nature, and this will especially be true when you 
link Integrator charts to charts/tables inside Stylus reports (as opposed to Views.)  To optimize your 
Integrator solution, try the following: 

 
▪ Remove all unused charts and tables from the underlying studies. 
▪ In your Integrator study, do not link to charts/tables/memos in reports in your underlying 

studies; instead, link to the charts/tables/memos in the views themselves. 
▪ Delete any unused reports from your underlying studies. 
▪ Redesign your Stylus views so that they have one chart or table per view. 

 
Q: What’s the fastest way to replicate a Report page in Integrator if I already have such a page in my 
Stylus or Allocator study? 
A: You can copy the page in your Stylus or Allocator study by right-clicking on the page’s listing on the 
design tree and selecting “Copy.”  Then, go to your Integrator study, right-click on the design tree where 
you wish to insert the page, and select “Paste.”  All appropriate information will be carried over to the 
Integrator report – from page design to chart/table/memo links.  If the study is not yet associated with 
the Integrator study, it will also be added automatically. 
 
Q: Do I always have to build reports in Integrator when I need to merge a few reports from my Stylus or 
Allocator studies into one? 
A: No!  This is actually a very inefficient way to achieve this.  Reports should only be built in Integrator 
when you need to mix charts, tables and memos from different Stylus, Prospector and Allocator studies 
(or report on Prospector.)  It is generally better to use automation to merge PDF reports from pages 
created in multiple studies or during several “runs” of the same study.  In Stylus, this would be done using 
the EXPORTREPORT statement with PDF output. 
  

http://www.markovprocesses.com/
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MPI Allocator 

Chapter 8 

Overview 
 

MPI Allocator is Stylus Pro’s asset 
allocation/optimization module, 
and provides Stylus users with a 
whole new level of research and 
reporting power, as well as access 
to Monte Carlo simulations. 
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Chapter 8 

MPI Allocator 

Introduction to MPI Allocator 

 
Allocator is MPI’s portfolio optimization tool. It allows users to create asset allocations using mean-
variance optimization and project future portfolio values using Monte Carlo simulation. For those wishing 
to optimize relative to a benchmark, or implement an allocation across funds, the Allocator module also 
includes benchmark tracking capabilities. 
 
Getting Started in MPI Allocator 
 
Allocator has its own design tree, data pane and view tabs, just like all other modules in MPI Stylus.  Some 
of the nodes on the Design Tree, such as Benchmark, Views and Reports, are familiar from other modules; 
others, such as Efficient Portfolios and Asset Blends, are unique to MPI Allocator. 
 

 

Working with Allocator Studies 

 
The same basic rules apply when working with MPI Allocator studies as with all other studies in MPI 
Stylus.  For specific information on opening, saving or deleting studies please see Chapter 3 – the 
instructions for any other Stylus module apply here.  It is helpful, however, to note the file extensions 
associated with MPI Allocator.  They are: 
 
 

File Extension File Type 

.ast Allocator study 

.att Allocator template 
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Allocator Design Tree 

 
Like all other MPI Stylus modules, Allocator has its own Design Tree, and while it does follow the basic 
Design Tree concept, its content is significantly different from that of other modules’ trees. 
 
Notable elements unique to the Allocator Design Tree include: 
 

▪ The Assets node.  This allows you to bring in any index or style map as an asset 
▪ Estimates, Groups and Simulations sections added to the Parameters node 
▪ Series, Efficient Portfolios and Asset Blends nodes 

 
Note that the Views and Reports nodes are present, which means that Allocator is both a research and a 
reporting tool.  Before jumping into the precise uses for each node, we can still summarize Allocator in 
terms of input and output nodes: 
 

Node  Symbol Description Function 

Input Nodes 

 Assets Controls assets added to the study. 

 Liabilities Used for asset liability modeling. 

 Parameters Governs date ranges, asset class forecasts, etc. 

 Benchmark Lets you assign a benchmark. 

 Series 
(formerly 
Portfolios) 

Allows the user to include previously created portfolios 
or other series in the study. 

 Efficient 
Portfolios 

Allows the user to add or delete efficient portfolios 
(points that reside on the efficient frontier.) 

 Asset Blends Allows the user to add or delete asset blends (non-
optimal, user-defined asset mixes.) 

Output Nodes 

 Views The same as the Views node in the Stylus module. 

 Reports The same as the Reports node in the Stylus module. 

Figure 115 
In addition to these nodes, there is also the Study node at the top of the design tree.  The Study section 
governs a variety of study-wide settings, including automation (for users subscribed to the optional 
Automation package.)  For more information about the Study section, please see Chapter 3. 
 
When designing your analysis, you will move down the list of Design Tree nodes to input the information 
necessary, and then to create, view and organize the output.  In the sections below, we will take a close 
look at how to get the most from each node. 
 

Input Nodes 
 
Input nodes in Allocator represent information you will be providing the application in order to structure 
your analysis.  The Design Tree allows you to quickly create your analysis in a familiar format. 
 
 
 

Assets Node 
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The Assets node allows the user to select the assets used in the optimization. Assets can come from any 
data source you have available in MPI Stylus Pro, and would be done the same way one selects a Style 
Outline in Stylus.   
 
Viewing Asset Details 
Click on the name of any asset on the design tree to view its specific information in the data pane.  This 
feature will be familiar to users of the Stylus module, as it is the same as viewing manager details in the 
Managers node. 
 
Assets Min & Max Feature (Individual Asset Class Constraints) 
In order to help users work more efficiently in Allocator, a Min & Max (short for Minimum & Maximum) 
feature has been made available for each asset on the Allocator design tree.  This assists the user by 
providing individual asset class constraints that specify how little or how much of a given asset must be 
present (in percentage terms) in any “optimal” portfolios on the efficient frontier.   
 
For example, if a user decided that any acceptable efficient portfolio would contain between 10% to 25% 
cash, he or she could then set the Min. to the lowest acceptable percentage (10%) and the Max. to the 
highest acceptable percentage (25%), with the assurance that all resulting portfolios would meet these 
specifications.  The default is a Minimum of 0% and a Maximum of 100% for all asset classes, which is 
considered an “unconstrained” optimization. 
 
To change the Min or Max setting for an asset: 
 

1. On the Assets node of the design tree, click on the blue number that you wish to change in the 
Min or Max column.  It should become activated as per the image below. 

 

 
 

2. Now type in the percentage amount that represents the minimum (for the Min column) or 
maximum (for the Max column) desired percentage for the asset in question, for any possible 
efficient portfolio.  For example, in this case the user has decided that 10% is the lowest 
acceptable cash allocation, and would therefore type in a “10” in this space.  They would then do 
the same for the Max column, with “25.”  No percentage sign is required in either case.  When 
the correct number has been entered, press the enter key to set the number. To enter +/- 
infinity, clear the corresponding edit box and hit Enter. 

3. The columns should now display the correct numbers for the Min & Max constraints. 
 

 
 
Grouping Assets 
As is the case in the Style Outline node throughout MPI Stylus Pro, it is possible to create ‘nested’ groups 
of Assets here in order to provide you with more control over totals of component representation. To do 
this, simply drag and drop new assets on to an existing asset name on the Design Tree. 

 
Liabilities Node 
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The Liabilities Node is used for those wishing to do asset liability modeling in MPI Stylus Pro. As with the 
Assets node, users may go in and select specific ‘liabilities’ to include here. 
 
Users should note that, if conducting a liability analysis, the ‘Mean-Surplus’ model type should be used in 
the Parameters node. 

 
Parameters Node 
 
The Parameters node in Allocator is significantly different from this same node in all other MPI Stylus 
modules, and deserves special attention.  While it still performs some of the same functions as in other 
modules, asset allocation-specific settings have been added to improve the user’s experience with the 
program. 
 
Model Type 
 
There are two basic model types available for users in MPI Allocator: Mean-Variance MVO (mean-variance 
optimization), and Mean-Benchmark Tracking MBO (mean-benchmark optimization.) Additional model 
types may be available to subscribers of our Advanced Analytics package. For more information, please 
see our Advanced Allocator documentation, available from MPI. 
 
Mean-Variance MVO 
The mean-variance optimization (MVO) model was pioneered by Nobel Laureate Harry Markowitz in the 
1950’s in his Modern Portfolio Theory, and is widely associated with asset allocation and portfolio 
diversification.  The MVO model is also the industry standard for performing asset allocation optimization 
and analysis. 
 
The foundation of Modern Portfolio Theory is that risk can be quantified, in this case as volatility or 
“standard deviation”, and that, all things being equal, investors will seek to avoid risk wherever possible.  
Working from this concept and using forecasts for each available asset class (expected return, standard 
deviation and correlation coefficients – the degree that each asset class moves in relation to every other 
asset class), the MVO model constructs an “efficient frontier” on which every possible “optimal” portfolio 
combination resides.  “Optimal” or “efficient” portfolios are theoretically expected to offer the maximum 
possible return for each given level of risk, or conversely, the minimum level of risk for each level of 
return. 
 
The general theory hinges on the concept that any correlation between asset classes that is less than one 
must reduce the overall risk characteristics of potential portfolios; therefore, MVO will always be looking 
for ways to diversify away risk by finding low correlation relationships between asset classes. 
 
Of course, everything in such a model is contingent on user forecasts or “inputs” for future asset class 
performance.  Inputs and constraints (optional) will entirely define the efficient frontier and its portfolios. 
 
Mean-Benchmark Tracking MBO 
The Mean-Benchmark Tracking (MBO) model runs a mean-variance optimization relative to a benchmark, 
deriving an efficient frontier that contains all “optimal” portfolio combinations from the minimal tracking 
error portfolio to the maximum excess return portfolio.  MBO is most often utilized for “fund 
optimization” or “fund implementation” where one has a target asset allocation or index and then wants 
to find optimal combinations of managers to fulfill the allocation.  In this case, the target allocation or 
index becomes the “benchmark” and one’s managers are included as the “Assets.” 
 
Mean-Surplus MSUR 
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The Mean-Surplus model is used when conducting asset liability modeling in Allocator and replaces 
standard deviation with surplus standard deviation in the optimization (versus Mean-Variance). 
 
Objective 
 
The Objective allows you to choose between four Objective types: 
 

• Return, which is the standard (default) for all Allocator studies 

• BL Implied Return, which uses the Black-Litterman model. Please note that more Black-Litterman 
options are available through our Advanced Allocator package. For more information, please 
contact us at support@markovprocesses.com. 

• BL Combined Return. Please see directly above for getting information on this feature. 

• Yield. While this is present by default in some of our templates, it is really meant to represent an 
objective that can be created via the Groups node. 
 

Date Range Settings 
 
The date range settings in MPI Allocator generally work the same as they would in the other MPI Stylus 
modules; however, an important change has been made that should be noted by users.  Whereas other 
modules have the date scrollbar, the date range, and a limit drop-down menu, MPI Allocator has replaced 
the limit menu with an Estimation Range tool. 
 
Estimation Range 
 
MPI Allocator generates asset class forecasts for the optimization from historical data. This section allows 
you to choose what historical time period will be used for those forecasts. 
 
Common 
A common time period will be used for calculating expected returns, standard deviations and correlations. 
This time period will be determined by the asset class with the shortest amount of historical data.  The 
“Pros” of this are that all asset classes will be exposed to the same time period, avoiding unintended 
biases that can occur when using asset classes that have experienced different economic conditions.  The 
“Cons” are that by utilizing a common time period, one may end up with a very short historical period that 
ignores very relevant and important periods for making long-term forecasts. 
 
Common for correlations 
A common time period will be used for calculating correlations. The time period will be determined by the 
asset class with the smallest amount of historical data. A separate time period will be used to calculate 
standard deviations and expected return, as specified by the date settings slider. 
 
All 
All available data will be used in estimating the expected return and standard deviation for each asset 
class, as well as the correlations between each asset class.  The advantage of this feature is that it will 
incorporate relevant historical data for longer-lived asset classes, and thus will be less sensitive to new 
data.  The disadvantage is that potential biases may exist that may favor or punish certain asset classes 
simply because some indices didn’t experience a bear or bear market (or vice-versa.) 
 
Use Common Estimation Frequency 
 
Allows you to choose the frequency of the historical data used to estimate the optimization inputs.  When 
you uncheck “Use Common Estimation Frequency,” you may then choose the frequency (or no frequency) 
to suit your needs. 

mailto:support@markovprocesses.com
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This setting works in tandem with the Allocation Frequency setting just below it. 
 
Use Default Allocation Frequency 
By default, optimization inputs (expected returns, standard deviations and correlations) are stated in the 
frequency of the historical data used to estimate them. This option allows lets you convert the historical 
estimates to a different frequency. 
 
If you’re using monthly historical data, for example, you could express the estimates on an annual basis by 
selecting Annual in this section. 
 
Use Individual Bounds 
Allows you to select the behavior of individual asset-level constraints from the following options: 
 
Long Only 
Minimum and maximum constraints on all asset weights will be 0% and 100%, respectively. The minimum 
and maximum holdings in the design tree are disabled. 
 
Individual 
Constraints may be set at the individual asset class level, by entering a minimum or maximum holding 
next to any asset in the design tree. 
 
No Constraints 
Constraints are set to +/- infinity. 
 
Initial Investment 
 
The initial investment tool allows you to specify a given initial investment value (in dollars, or any other 
currency) for your portfolios, as well as the specific date on which this investment was made.  Portfolio 
wealth forecasts and other “growth-of-a-dollar” charts will start on the date indicated, at the dollar 
amount entered. 
 

 
 

To change the initial investment value or date: 
 

1. Click on the push pin button (to raise it) located to the right of the item you wish to change.  
When the push pin is pushed down, study default settings will be used.   

2. In the Value box, the initial investment value of the portfolio. 
3. In the Date box, click the calendar icon to bring up MPI’s scrollable calendar feature.  Navigate to 

the correct date and then click on it once to activate it. 
4. If you push the push pins down again, values will return to study defaults; however, if you ever 

click the push pin buttons again to raise them, they will return to the last stored custom values. 
 
 
 
 
Return targets 
 
This tool allows you to specify Target Returns (for a given frequency) that you are interested in achieving 
over the course of time. These may then be viewed in specific charts and tables. The frequency will adjust 
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to the allocation frequency in order to clarify the units in which target returns should be entered. For 
example, if the title says 'Target Returns (annual)' then returns should be entered in terms of years. 
 
Wealth targets 
 
This allows you to specify Wealth Targets in dollar amounts for use in forecasting. 
 
Currency 
 
As in all MPI Stylus parameters nodes, this is where you may set the currency for the study. 
 
Cash 
 
As in all MPI Stylus parameters nodes, this is where you can set the cash proxy on a study-wide level. 
 
Inflation 
 
Allows you to pick the historical inflation rate series used in the study. This inflation series is used when 
adjusting future cash flows and/or simulating future inflation rates when running a Monte Carlo 
simulation. 
 
As of version 9.0, users also have the capability to do Inflation-Adjusted forecasts in real or nominal 
terms. 
 
Hist. risk free 
 
Allows you to specify a specific instrument to be used as the historical risk-free rate, as opposed to using 
the Currency as a stand-in. 
 

Estimates 
 
The Estimates section of the Parameters node controls the three required inputs to the optimization: 
 

▪ each asset's expected return 
▪ each asset’s expected standard deviation 
▪ expected correlation coefficients between each pair of assets 

 
Inputs will be based on historical data by default, over the time period selected in the Parameters node.  
Estimates based on historical data will be shown in gray.  Estimates entered manually will appear in black. 
 
To override a historical estimate, simply click on it and type in your new estimate. To remove a manually-
entered estimate, simply highlight and delete the value and the historical estimate will return. Estimates 
for the Benchmark (if one is selected) and for inflation are also shown and may also be replaced with 
manual values. 
 
The frequency of all estimates in this section is the same as the Estimation Frequency selected on the 
Parameters page. When entering a manual estimate, make sure the value entered reflects the Allocation 
frequency. When the Allocation frequency is changed, manually entered values are converted to the new 
frequency, just as historical estimates are. 
 
When entering values in the covariance matrix, you might see a warning message stating the covariance 
matrix is non-positive semi-definite. This means that the covariance matrix is internally inconsistent. For 
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example, three assets that are perfectly negatively correlated will cause the non-semi definite warning, 
since it is impossible for three assets to have returns that all move in opposite directions. 
 
Importing Estimates from External Sources 
 
Version 11.0 allows you to include capital market estimates defined in Microsoft Excel workbooks. This 
feature allows for easier sharing of estimates defined centrally by a research team throughout an 
organization. 
 
Allocator requires the estimate data for be formatted a specific way in the Excel. The simplest way to get 
started is to export the default estimates to Excel and modify that file with your own estimates. From the 
Estimates node, select a set of estimates to review. Click the icon in the upper right corner of the data 
overview table, select Export to File…, and provide a location to write the new Excel document.  
 
Groups 
 
In the Groups node you can create a constraint that involves more than one asset, such as the constraint 
that the holdings in one asset be greater than those of another. The Group selected as the allocation 
objective under Parameters will be highlighted on the Design Tree with a special blue icon (just like a 
default benchmark would be.)  
 
To add a Group to the optimization: 
 

1. Select the Groups node in the design tree. 
2. Click the Add button. A new group will appear in the Groups node in the design tree. 
3. Add in assets by clicking on a cell in the Assets or Group column, which opens a drop-down box 
4. Enter the coefficient for each asset in the Coefficient column 
5. Enter the minimum and maximum values for the constraint in the Design Tree. 
6. To set the minimum/maximum to infinity, delete the existing value, and with an empty edit box, 

hit Enter. 
 
Use all assets 
Use this option to add all assets to the group or constraint.   
 
 
Set all values to 
Use this option to give all assets the same coefficient. 
 
Advanced 
 
The Advanced section of the Parameters node allows you to choose between arithmetic and geometric 
average historical returns, as well as to customize the percentiles displayed in any wealth or return 
forecast. 
 
 
 
 
Expected Return Estimation Method 
 
Arithmetic Mean 
This option will use the arithmetic average for historical returns. 
 
Geometric Mean 
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This option will use the geometric average for historical returns. 
 
Covariance Matrix Exponential Weighting 
 
Beginning with MPI Stylus Pro 11.0, you may apply exponential decay to the covariance matrix to weight 
recent return periods more heavily. You control the weighting by specifying either the half-life in months 
or a decimal decay factor.  
 
Half-life (months) 
Use this option to specify the half-life of the exponential weighting. The decay factor will be derived from 
this value. 
 
Decay factor 
Use this option to provide the exponent value to the weighting function. 
 
CVaR 
Subscribers to our Advanced Analytics package will see a number of settings here for use in conjunction 
with CVaR (component value at risk). For more information, please contact MPI or visit our website for 
our CVaR User Guide. 
 
Projection Percentiles 
 
This allows you to enter the percentiles to be displayed in wealth and return forecasts.  The defaults will 
generally be “5 25 50 75 95” but these may be changed easily.  You may enter up to two decimal places 
for your projections. 
 
To enter your own projection percentiles: 
 

1. In the Projection Percentiles field, enter each percentage breakdown you would like. 
2. To separate two breakdowns simply put a space in between them.  Please do not use other 

characters (such as commas) to separate them. You will also note that percentage signs are not 
necessary in this field. 

 
Enable multiple frontiers 
 
Users with the Advanced Analytics package subscription have the option to show multiple frontiers on a 
single efficient frontier chart. For more information, contact MPI Support. 
 
Enable resampling 
 
Advanced Analytics users may contact MPI to learn more about our proprietary resampling methodology. 
You may also download our Resampling User Guide on the MPI website. 
 

Simulations 
 
This section sets the parameters for the Monte Carlo simulation; namely, the number of portfolios to 
simulate performance for, the number of future time periods to simulate, and future portfolio cash flows. 
 
To enable Monte Carlo simulation, select the check box at the top of the data pane in the Simulations 
node. Simulations are run every time the study is run. 
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Simulation options 
 
Use Monte-Carlo Simulations for Projections 
Checking this box enables Monte-Carlo Simulations, and will automatically activate the remaining options 
and fields in the Simulation section. 
 
Number of Paths 
This sets the number of portfolios to simulate performance for. 
 
Number of Periods 
Determines for how many future periods performance is simulated. The period length is determined by 
the Allocation frequency. 
 
Max Paths on Chart 
This limits the number of Monte Carlo-simulated portfolios displayed on a chart or table when the “Paths” 
option is selected. 
 
Run for Benchmark 
Check this box to simulate performance for the Benchmark. 
 
Run for Series 
Check this box to simulate performance for any portfolios you’ve added into the study from your Funds 
database. (These appear under the Series node of the design tree.)  
 
Repeatable 
The Repeatable option freezes the random numbers generated in a Monte-Carlo simulation, which is 
helpful for consistency and demonstration purposes. 
 
Distribution type 
By default, a LogNormal distribution is used in Allocator. However, users may switch to the Downside 
LogStable option if they want to instead use a distribution approach that can include so-called ‘fat tail’ 
events.  
 
For more information on Fat Tail distributions, please see the User Guide and associated video on the MPI 
web site. 
 
Cash Flows 
 
To enter a cash flow, click the Add button, and enter the following items in the table below.  Please note 
that for cash flow min/max values, automatic adjustments will occur if nonsensical values are entered.  
For example, a Min of 5% and a Max of 3% would automatically adjust to 3% for both. 
 
 
 
 
 
 
 
 
 

Field Description 

Name Description of cash flow 
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Type Specifies inflow or outflow 

Period Start Beginning of the cash flow.  The date may be specified as a calendar date, entered as 
mm/dd/yyyy or yyyymmdd, or as an offset from the Initial Investment date: 12M, 4Q 
or 1Y, for example. 

Period End The end of the cash flow, entered in the same format as the Period Start. This value is 
optional. If period end is entered as an offset, it is an offset from the period starts, or 
in other words, determines the period length. 

Installment 
Frequency 

The period between two cash flows, entered as 3M, 1Q, etc. 

Value Type ▪ Money Amount: A specific amount in the currently chosen currency 
▪ % of initial portfolio value: A percentage based on the Initial 

Investment defined in the Parameters node. 
▪ % of the most recent: A percent of portfolio value on the most recent 

allocation date. If the installment date coincides with the allocation 
date, portfolio value prior to all cash flow adjustments is used in the 
computations. If the installment date is later than the allocation 
date, the portfolio value after all cash flow adjustments (if any) is 
used in the computations. 

▪ % of current: A percent of the portfolio value on the installment 
date. Portfolio value prior to all cash flow adjustments is used in the 
computations. 

▪ % of Moving Avg: A percentage based on the Moving Average. 

Averaging 
Window 

Defines the trailing window size if the Value type is set to % of Moving Avg. 

Minimum Sets the minimum distribution amount. If a Maximum value is entered, a simulated 
valued is drawn from a uniform distribution 

Maximum Sets the maximum distribution amount. Works in tandem with the Minimum setting to 
simulate random distributions. 

Present or 
Future 

Indicates whether the first installment should be adjusted to inflation. If "Present" - 
adjusted, "Future" - not adjusted. Makes sense only when "Value Type" is set to 
"Amount" or "% of initial portfolio value". 

Inflation 
Adjust 

Indicates whether all subsequent installments should be adjusted to inflation.  Makes 
sense only when Value Type is set to Amount or % of initial portfolio value. 

Inflation Rate 
Type 

Indicates how the inflation rate should be computed. 
▪ Simulated Inflation Rate: A random inflation rate is drawn each 

period, based on the risk/return characteristics of the historical 
inflation series defined in the Parameters node. 

▪ Fixed Inflation Rate: The inflation rate is fixed each period at 
whatever value is entered in the Inflation Rate column. 

 

Inflation Rate 
or Premium 

Used as the inflation rate when Inflation Type is set to Fixed. If inflation is simulated, 
this value is added to the simulated inflation rate. This allows the user to specify cash 
flows that grow at some premium above the inflation rate. 

Figure 116 

 
 
 
Benchmark Node 
 



Chapter 8 
MPI Allocator 

www.markovprocesses.com  Page 257 

 

The Benchmark node in MPI Allocator should be familiar and easy-to-use for anybody familiar with MPI 
Stylus, but it should be noted that Allocator only allows the user to choose an existing index/fund as a 
benchmark – style and peer universe benchmarks are not an option. 
 
The benchmark is required when running a Mean-Benchmark Tracking optimization (MBO), but is optional 
in other cases. The benchmark is used when calculating a portfolio’s Excess Return or Tracking Error. 
 

Series Node (formerly Portfolios Node) 
 
Allows you use previously created series or portfolios in your Allocator study. Portfolios that you add here 
are not included as assets in the optimization, but can be added to risk/return charts, wealth forecasts, 
etc., using their historical average performance. 
 
Any portfolio in Allocator (a portfolio on the efficient frontier, for example) can be saved to a fund 
database. To do this, create a Portfolio Loadings table in a view, right-click on the table and choose Export 
– Loadings as Portfolio. 
 

 
Efficient Portfolios Node 
 
Here you can create a single portfolio or set of efficient portfolios. These efficient portfolios can then be 
used, for example, to show the different asset allocations along the frontier, or the estimated future 
wealth values across a set of investment options.  
 
For example, you can create: 
 

▪ A single portfolio, such as a proposed portfolio with a target expected return. 
▪ A set of portfolios evenly spaced across the frontier from least risky to most risky 
▪ A set of portfolios at specific intervals, such as a set with expected returns of 6%, 8%, 10% 

and 12% 
▪ Display the critical points along the efficient frontier. 

 
To create a new set: 
 

1. Click on the Efficient Portfolios node in the design tree 
2. Click on the Add button in the data pane. 
3. Select the newly-created area below. 

 
In the data pane, chose from the following statistics: 
 
Critical Points 
Critical points are the points on the efficient frontier where an asset is added to or dropped from the mix, 
or a point where a constraint becomes binding. 
 
Objective 
This varies, dependent on the currently-selected objective in the Parameters page. 
 
Risk 
Varies, depending on the currently-selected Model Type in the Parameters page. 
 
 
Return 
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Sharpe Ratio 
Risk Tolerance 
Excess Return 
StDev of Return 
Tracking Error 
Information Ratio 
Any objective/constraint appearing in the Group node, including Yield, Objective and Turnover 
Additional options may be available for Advanced Analytics subscribers. 
 
You can create a set of Efficient Portfolios using the following methods (note: you do not have these 
options if Critical Points are selected): 
 
Set 
A specific number of points evenly spaced across the frontier according to the statistic you've chosen. 
 
Value 
Finds one point on the frontier by a specific value. For example, the point with a standard deviation of 
10%. 
 
Range 
Finds a set of portfolios along a segment of the frontier. 
 
First/Last 
Defines the beginning and end of the range. If Auto is chosen, the range is defined by the number of 
values and the interval between them. 
 
Number of Values 
Determines the number of portfolios in the set. If Auto is chosen, the number is determined by the 
starting value and the interval between them 
 
Interval 
Defines the interval between each portfolio. If Auto is selected the interval is determined by the number 
of points chosen. 
 
Minimum 
Finds the portfolio that minimizes the portfolio statistic selected 
 
Maximum 
Finds the portfolio that maximizes the portfolio statistic selected.  
 

Asset Blends Node 

 
An Asset Blend is a fixed-weight portfolio made out of the assets in the optimization. An asset blend must 
be entered in percentages, and must have weights totaling 100%. Any Asset Blend can be plotted on the 
efficient frontier for example, or used to forecast future wealth or return values. 
 
To create an Asset Blend and use it in a table or chart:  
 

▪ Add a node under the Asset Blend section in the design tree 
▪ Select the blend, and enter the blend’s weights (totaling 100%) in the data pane 
▪ In the Chart/Table/Memo designer, select the blend from the Blends drop-down box 
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It’s important to note that one asset blend can be designated as Current. A Current blend is required if 
the optimization has portfolio turnover as a constraint or as an objective. To see the current blend, click 
on the Asset Blends node, and look for the checked box in the Current column in the data pane. 

 
Output Nodes 
 
The output nodes in MPI Allocator will be familiar to users of the Stylus module, and work precisely the 
same way.  It is recommended that users refer to both Chapter 4 (Stylus module) and Chapter 5 (Views 
and Reports) for complete information on using the Output nodes in MPI Allocator. 
 
This being the case, MPI Allocator gives the user access to numerous new charts and statistics unavailable 
elsewhere in MPI Stylus.  Therefore, this section will focus on understanding and making good use of 
these new options. 
 
Chart Designer 
 
The chart designer in MPI Allocator will be notably different from that of the Stylus or Prospector 
modules, highlighting the variety of new options available to MPI Stylus users.  The Allocator chart 
designer comes with 10 chart blocks; some of them, like “Scatter” and “Style Map,” will be familiar to 
Stylus module users; others are entirely new. 

 
A complete breakdown of chart blocks may be found in the appendices to this manual; however, a brief 
introduction to each block is in order here.   
 
In addition to analytic blocks, there are three other notable differences in Allocator's Chart/Table/Memo 
Designer. First there is a different method of selecting the items to be included in the Chart or Table. 
Below the set of analytic blocks are four drop-down menus: 
 

▪ Assets 
▪ Portfolios 
▪ Eff. Portf. 
▪ Blends 

 
These correspond to the four nodes in the design tree with the same names. To display an item on a chart 
or table, simply select it in the relevant drop-down. 
 
Groups of controls that appear on the left side of the bottom area of the chart designer are different for 
different types of analytic blocks. There are 3 types of analytic blocks in Allocator. They are: 
 

1. Blocks that display information about the efficient frontier, such as 
▪ Frontier 
▪ Frontier Assets 
▪ Frontier Statistics 
▪ Frontier Style Map 
▪ Frontier Asset Map 

2. Blocks that display information about portfolios and their underlying assets: 
▪ Estimates 
▪ Portfolio Assets 
▪ Portfolio Statistics 
▪ Portfolio Map 

3. Blocks that display future wealth or return forecasts (projection blocks): 
▪ Projections 
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▪ Simulations 
 
The chart designer displays a different set of controls depending on the type of analytic block chosen, as 
described below: 
 

1. For efficient frontier blocks you will see: 
a. A frontier check box beneath the four drop-down boxes. Selecting this box overlays an 

efficient frontier line on the chart, in addition to the individual portfolios. 
b. Base Axis - Switches the x-axis,, for example, from risk to return. 
c. Base Points - Changes the number of points  (displayed as bars) that the efficient 

frontier is broken into. 
2. For portfolio blocks, no additional controls are displayed 
3. For projection blocks you will see controls to: 

a. Select the dates 
b. Select the output frequency 
c. Select the output interval 
d. Change whether percentiles are displayed as lines or bands 

 
Frontier 
 
The Frontier block works the same as the Scatter block in both Stylus and Prospector – it can plot almost 
any fields on the X or the Y axis. The Scatter block is used, for example, to create an efficient frontier 
chart, by selecting Objective (Return) and Risk (StdDev Rtn) along the X and Y axes, respectively. Any 
Efficient Portfolios or Blends you've created can also be displayed on the scatter plot. 
 
The "Frontier" check box adds the efficient frontier to the scatter plot as a smooth line. 
 
Frontier Statistics/Portfolio Statistics 
 
These two blocks contains data items that apply to portfolios (efficient portfolios, non-efficient blends, or 
previously-created portfolios from a fund database). 
 
Available statistics include, but are not limited to: 
 

▪ Expected return 
▪ Standard deviation 
▪ Sharpe ratio 
▪ Information ratio 

 
Charts created using the Portfolio Statistics block appear as standard bar charts, showing only the 
portfolios you’ve selected. Charts created using the Frontier Statistics block appear slightly different: 
 

▪ the bars in the chart are spaced apart as they would be along the efficient frontier. 
▪ To include the rest of the points from the frontier in the background of the chart click the 

"Frontier" check box 
▪ To change the number of bars in the Efficient Statistics chart, de-select the "Use default base axis 

and number of points" check box and change number of base points. 
 
 
 
 
Frontier Loadings/Portfolio Loadings 
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These two blocks let you create a chart of the asset loading (portfolio allocation) for efficient points, any 
other portfolios, or for a fund. For any chart, you can choose which assets’ loadings you’d like to show in 
the check boxes. 
 
The Frontier Loadings chart separates the portfolios as they would be separated across the efficient 
frontier, and gives you the additional option to display the asset loadings for all the points across the 
frontier in the background, by checking the Frontier check box below the Blends drop-down box. 
 
To view an asset’s loadings as portion of the entire portfolio, select Weights from the drop-down. To view 
an asset’s loadings as a percentage of a subset of a portfolio, select Rescaled Weights. When Rescaled 
Weights is selected, each asset’s holdings is expressed as a percentage of the total holding of the assets 
selected in the chart. 
 
Estimates 
 
This block is unique to Allocator and contains the estimates used in the optimization, as well as the 
historical averages. In the drop-down box chose between the Optimization Input and the Historical value, 
and select which statistics (return, standard deviation) the chart should contain in the check boxes. 
 
Frontier Style Map 
 
This block displays a scatter plot of the holdings along the efficient frontier, as represented by the Style 
Map used in the study. The block works the same in Allocator as it does in Stylus module.  For more 
information, please see Chapter 4  of this manual. 
 
Frontier Asset Map 
 
This block displays a bar, line or area graph of the holdings along the efficient frontier, as represented by 
the Style Map used in the study. The block works the same in Allocator as it does in Stylus module.  For 
more information, please see Chapter 4 of this manual. 
 
Frontier Portfolio Map 
 
This block displays a bar, line or area graph of the holdings of specific portfolios, as represented by the 
Style Map used in the study. The block works the same in Allocator as it does in Stylus module.  For more 
information, please see Chapter 4 of this manual. 
 
Groups & Constraints 
 
This block (tables only) displays the constraints used in each frontier. With Allocator supporting multiple 
frontiers, each of which may contain multiple constraints, this table serves as a quick summary section for 
all constraints used across a study. 
 
Projections 
 
The Projections block (which also contains the content of the old Simulations block) may be used to view 
the distribution of future portfolio wealth or return values. You have two different options: Parameteric 
and Simulations. 
 
 
 
Parametric 
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Projections are parametric, based on a portfolio’s risk and return, and assume that return distributions 
are lognormal. Projections are not simulated and therefore do not include cash flows. 
 
Projections are based on the Initial Investment – Value and start as of the Initial Investment – Date 
entered in the Parameters node. 
 
Available data items include: 
 

▪ Return – shows the distribution of the portfolio’s geometric average return, expressed in the 
frequency of the underlying optimization inputs. 

▪ Total Return – shows the distribution of the portfolio’s cumulative return at any point in the 
future 

▪ Wealth – shows the distribution of the portfolio’s future wealth values, based on the Initial 
Investment entered on the Parameters node. 

▪ Annual Return – the portfolio’s geometric average return, but expressed on an annual basis. If 
the optimization inputs are annual, this will show the same data as the Return data item. 

▪ Quarterly Return – the portfolio’s geometric average return, but expressed on a quarterly basis. 
▪ Monthly Return – the portfolio’s geometric average return, but expressed on a monthly basis. 

 
The set of distribution percentiles can be modified Parameters – Advanced node, in the Projection 
Percentiles box. 
 
Simulations 
This displays a portfolio’s simulated future wealth and return values. Future portfolio values may be 
simulated with the option to include cash flows, as defined in the Parameters – Simulations node. The 
number of portfolios simulated is also defined in that node, which is described in more detail previously in 
this document. 
 
The following data items are available in the drop-down: 
 

• Total Return – the portfolio’s geometric average return, expressed in the frequency of the 
optimization inputs. 

• Excess Return – (real or nominal) 

• Total Excess Return – (real or nominal) 

• Wealth – the portfolio’s future wealth values, based on the Initial Investment entered in the 
Parameters node 

• Excess Wealth – (real or nominal) 

• Total Return (include cash flows) - the portfolio’s geometric average return, net of cash flows, 
expressed in the frequency of the optimization inputs 

• Wealth (include cash flows) – the portfolio’s future wealth values, net of cash flows, based on the 
Initial Investment entered in the Parameters node 

 
The check boxes enable you choose the following items in the distribution table or chart: 
 

1. The percentiles displayed 
2. The portfolio’s average value (this is not the same as the 50th percentile because the 

underlying lognormal distribution is skewed) 
3. The individual portfolio paths, i.e. their wealth or return values over time. 

 
Portfolio Risk 
Frontier Risk 
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These two blocks allow the user to verify not only which asset is the riskiest in and of itself, but also to 
analyze that risk within the context of a portfolio as a whole. For example, it could be that a given asset 
has the lowest marginal risk of all assets, but also has the highest contribution to the portfolio's risk 
and/or tracking error. These blocks make use of excess return, expected return, standard deviation, 
tracking error, the covariance matrix and efficient portfolio weights in order to calculate relevant 
statistics. Users may decide whether to use Standard Deviation or Tracking Error as the definition of risk 
by using the dropdown menu in the blocks. 
 
Table Designer 
 
As with the chart designer, the table designer in Allocator varies heavily from other modules and contains 
blocks specifically geared to Allocator’s special functions. A complete breakdown of table blocks may be 
found in the appendices to this manual; however, a brief introduction to each block is in order here.   
 
Some analytic blocks available in the Chart Designer are not available in the Table Designer. For example, 
the efficient frontier block is not present in the table designer. (For more details, there is a discussion of 
the types of analytic blocks available in Allocator in the Chart Designer section of this manual). 
 
Analytic blocks containing data about Portfolios and Wealth Projections are available as tables, but blocks 
of different types cannot be simultaneously selected into one table. If one of the portfolio blocks (say, 
Portfolio Assets) is selected into a table, Projection or Simulation blocks cannot be selected into this table, 
and vice versa. 
 
Estimates 
This block is unique to Allocator and contains the estimates used in the optimization, as well as the 
historical averages. In the drop-down box chose between the Optimization Input and the Historical value, 
and select which statistics (return, standard deviation) the table should contain in the check boxes. 
 
Frontier 
This block is used to create an efficient frontier. 
 
Portfolio Assets 
This block contains the holdings for efficient points, any other portfolios, or for a fund. For any chart, you 
can choose which assets’ loadings you’d like to show in the check boxes. 
 
Portfolio Statistics 
This block contains data items that apply to portfolios (efficient portfolios, non-efficient blends, or 
previously-created portfolios from a fund database). 
 
Available statistics include, but are not limited to: 
 

▪ Expected return 
▪ Standard deviation 
▪ Sharpe ratio 
▪ Information ratio 

 
 
 
Portfolio Map 
This block displays the holdings of specific portfolios, as represented by the Style Map used in the study. 
The block works the same in Allocator as it does in Stylus module.  For more information, please see 
Chapter 4 of this manual. 
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Projections 
Use this analytic block to view the distribution of future portfolio wealth or return values. Projections are 
parametric, based on a portfolio’s risk and return, and assume that return distributions are lognormal. 
Projections are not simulated and therefore do not include cash flows. 
 
Projections are based on the Initial Investment – Value and start as of the Initial Investment – Date 
entered in the Parameters node. 
 
Available data items include: 
 

▪ Return – shows the distribution of the portfolio’s geometric average return, expressed in the 
frequency of the underlying optimization inputs. 

▪ Total Return – shows the distribution of the portfolio’s cumulative return at any point in the 
future 

▪ Wealth – shows the distribution of the portfolio’s future wealth values, based on the Initial 
Investment entered on the Parameters node. 

▪ Annual Return – the portfolio’s geometric average return expressed on an annual basis. If the 
optimization inputs are annual, this will show the same data as the Return data item. 

▪ Quarterly Return – the portfolio’s geometric average return expressed on a quarterly basis. 
▪ Monthly Return – the portfolio’s geometric average return expressed on a monthly basis. 

 
The set of distribution percentiles can be modified Parameters – Advanced node, in the Projection 
Percentiles box. 

 
Simulations 
This block displays a portfolio’s simulated future wealth and return values. Future portfolio values may be 
simulated with the option to include cash flows, as defined in the Parameters – Simulations node. The 
number of portfolios simulated is also defined in that node, which is described in more detail previously in 
this document. 
 
The following data items are available in the drop-down: 
 

▪ Total Return – the portfolio’s geometric average return, expressed in the frequency of the 
optimization inputs. 

▪ Wealth – the portfolio’s future wealth values, based on the Initial Investment entered in the 
Parameters node 

▪ Total Return (include cash flows) - the portfolio’s geometric average return, net of cash flows, 
expressed in the frequency of the optimization inputs 

▪ Wealth (include cash flows) – the portfolio’s future wealth values, net of cash flows, based on the 
Initial Investment entered in the Parameters node 

 
 
 
 
 
 
The check boxes enable you choose the following items in the distribution table: 
 

▪ The percentiles displayed 
▪ The portfolio’s average value (this is not the same as the 50th percentile because the underlying 

lognormal distribution is skewed) 
▪ The individual portfolio paths, i.e. their wealth or return values over time. 

  



Target Probabilities 
The Target Probabilities block was discontinued as of version 9.0, having been replaced with 
functionalities via the Target Return and Target Wealth analytic blocks. More information is available 
under those respective headings. 
 
Target Return 
Formerly a part of the old Target Probabilities block, the Target Return block contains the following 
components of the old block: 
 

• Total Return (Parametric) 

• Total Return (Simulations) 

• Total Return (Simulations + Cash Flows) 

• Total Excess Return (Simulations) 

• Annual Return (Parametric) 

• Annual Return (Simulations) 

• Annual Return (Simulations + Cash Flow) 

• Annual Excess Return (Simulations) 

• Additionally, for each of the outputs above, the user will be able to: 
o Specify probabilities Above Target or Below Target 
o Consider returns in Real terms or Nominal terms 

 
Target Wealth 
This analytic block contains functionality split out from the old Target Probabilities block. It should be 
noted that the input Target Wealth may be found in the Parameters node. The block functionality 
includes: 
 

• Wealth (Parametric) 

• Wealth (Simulations) 

• Wealth (Simulations + Cash Flow) 

• Excess Wealth (Simulations) 

• Additionally, for the outputs above, the user will be able to: 
o Specify probabilities Above Target or Below Target 
o Consider returns in Real terms or Nominal terms 
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Chapter 9 
 

Stylus Workspace 
 

Introduction 
Stylus Workspace offers a place to organize various objects (Funds, Models, Templates, etc) and to 
provide different workflow for analysis of funds.  
 
At the very basic level Stylus Workspace provides user with ability to automatically select factor model, 
benchmark and peer groups for a manager specified in the Stylus study.  
 
Stylus Workspace also allows users to create custom lists of managers that can be used to quickly review 
various analytics. Each manager can use a model that is automatically assigned to it.  

Basic Usage.  
When selecting a manager for analysis within a Stylus study, users can now click on “Automatically apply 
model” checkbox. If the checkbox is checked before selecting the manager then when adding the 
manager to the study, it will populate Style Outline, Benchmark and Peer Group assignment for the 
manager. In order for the automatic assignment to work, the manager must be part one of the mapped 
databases.  

Fund Lists 
Stylus Workspace also provides users with the ability to set up custom fund lists that can be used to 
monitor and analyze different groups of funds. These lists can use multiple view templates also 
configurable by the user. Each fund in the list can have a model automatically assigned to it or it can be 
configured manually by the user.  

Models 
A model is a combination of Style Outline, Parameters, Benchmarks and Peer Groups. The basic use of the 
model is to provide a set of factors that can be used in Style Outline.  

Templates 
Templates provide a way to customize the views of the fund lists. Templates consist of columns from 
source databases, custom attributes and analytics. 

Mapped Databases  
Stylus Pro software (version 11.3 and above) is shipped with default category and model mapping for 
several fund databases. The list of databases is dependent on the user’s license. Stylus Workspace also 
includes a set of generic categories and models that can be mapped into custom user databases.  
 

Regime Models 
Stylus Pro software (version 11.4 and above) is shipped with a library of Regime Models defined by MPI’s 
research team. This section of Stylus Workspace allows user to review and modify existing models as well 
as define their own. 
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Stress Tests  
Stylus Pro software (version 11.4 and above) is shipped with a library of Historical Stress Tests defined by 
MPI’s research team. This section of Stylus Workspace allows user to review and modify existing stress 
tests as well as define their own. 

 

Scenario Analysis 
Stylus Pro software (version 11.4 and above) is shipped with a library of theoretical scenarios defined by 
MPI’s research team. This section of Stylus Workspace allows user to review and modify these scenarios 
as well as define their own. 

 

Proxy Library 
Stylus Pro software (version 11.4 and above) provides framework for creating proxies that can be used to 
extend the analysis of managers with short track records. See Proxy Handling document for more details. 

 

Advanced Features 
Advanced features provide a way to create custom attributes, categories and database classification 
mappings.  
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Automatically Applying Model 

 

 
Figure 117 
To automatically populate Style Outline, Benchmarks and Peer Groups, check the “Automatically apply 
model” checkbox before a manager is added to the study.  Please note that any factors that are already in 
the study’s Style Outline will be replaced.  

New Source for Manager Selection 
Stylus now provides an additional tab for selecting managers. In addition to Database Selection, there is 
now the List Selection tab. This allows user to select a manager from the fund list previously set up by the 
user (Figure 118).  

 
Figure 118 

 
 
 
 
 
 
 
 
The List Selection view provides the same flexible grid as the fund list view (see below).  



MPI Stylus Pro  
 

Copyright 2005-2020, Markov Processes International, Inc.Page 270 

 

Stylus Workspace 

 
Figure 119 

 
Stylus Workspace can be opened by clicking on Workspace icon in the main application toolbar. The 
workspace consists of the navigation tree on the left and the main panel on the right. By default, the 
navigation tree has three primary nodes: Lists, Model Libraries and Templates.  

Lists 
Lists node is a place to organize funds into logical groups that can be used to monitor, compare and 
analyze funds. Lists are grouped by List Types which represent the node level just below the Lists node.  

Adding List Type 
Right click on “Lists” in the try and select “Add List Type”. This would add a new List Type in the tree with 
the automatically generated name in the format of “ListTypeX”. The user can rename List Type by double 
clicking on the list type node and typing a new name.  

Deleting List Type 
Right click on List Type in the tree and chose Delete List Type. All Lists within the specified type will be 
deleted.  

Adding Lists to List Type 
There are two ways of adding a list to a List Type.  

1. Right click on List Type node in the navigation tree and click “Add List”.  

2. Click on List Type and then click “Add” button in the main panel (Figure 120) 

 
Figure 120 
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Clicking on the name of the list in the grid allows user to rename the list.   
 

Editing Lists 
Clicking on the name of the list in the navigation tree brings the user to the list view in the main panel 
(Figure 121).  

 
Figure 121 
 

Adding Funds 
Adding funds to the list is accomplished by clicking on the “Add” button.  This would invoke the fund 
selection interface familiar to Stylus users (Figure 122). 

 
Figure 122 

Deleting Funds 
To delete a fund or group of funds, highlight the funds in the grid, right click and then click “Delete 
Record”.  
 

Using Funds 
Using a fund or multiple funds in a Stylus study, select the funds, right click and chose “Use Funds” and 
select one of the four options: 

1. Add to Managers in Study (with model) – This will add managers to study in the same manner as 

adding manager from the study itself (as described in Automatically Applying Model)  
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2. Add to Managers in Study – This will just add managers to study without populating any of the 

model defaults.  

3. Add to Style Outline in Study – This will populate Style Outline only but will not add managers to 

the study.  

4. Add Benchmarks to Study – This will populate the Benchmarks in the study but will not add 

managers to the study.  

All four options will let the user select either an open existing study or a new study. Same options are 
available by clicking on “Use Funds” button on top of the main panel.  

Updating Results 
Clicking Update button at the top of the main panel will update information for all funds in the list. The 
update will pull necessary information from the databases as well as run any calculations specified in the 
Analytics section of the currently used template.  

Changing the View 
When a fund list is created, it is first assigned a template that is set as default in the Templates node (see 
Templates). The user, however, can change the template assigned to the fund list by selecting one from 
drop down on top of the main panel. It is sometimes necessary to also right click and select “Clear 
Formatting” to update the columns shown in the grid. 

Creating Additional Views 
While every list gets a default view, it is possible to create multiple views assigned to each list. For 
example: one view can be used to display basic statistical information and another view may contain 
fields regression to regression analysis.  
In order to create a new view for an existing list, the user needs to: 

1. Click on the appropriate list type in the navigation tree.  

2. Select the list for which the view is being created.  

3. In the main panel, select a template from the drop-down list 

4. Click on Create View button.  

The view will appear as a child node under the fund list name in the navigation tree.  

 
Figure 123 
There is one special type of a view that is available in the view drop down. It is called Model Comparison 
and is described in the Error! Reference source not found. section.  
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Overwriting Selected Model 
Stylus Workspace is designed to provide automatic model selection. The mechanism used for automatic 
model assignment is described in the Error! Reference source not found. section. In some cases, h
owever, users may want to overwrite the model that was automatically assigned or specify a model when 
no automatic assignment is possible due to mapping configuration. To assign a model manually, users can 
double click on the cell in Selected Model section and then select a model from the dropdown.    

Grouping  
Information in the grids can be grouped by dragging any of the column headers to the dark green section 
on top of the grid. Information can be grouped using multiple columns. 

 
Figure 124 

Changing Column Width 
The user can change column width manually by dragging column borders to the right or left.  The user can 
also elect to auto-adjust column widths by right-clicking anywhere in the grid and choosing “Best Fit (all 
columns)” option.  

Hiding Sections / Columns 
The user can hide columns by simply dragging the column headers outside of the main application 
window. The user can also click on the section icons on the left part of the column headers (Figure 125).  

 
Figure 125 
Clicking the bottom icon (column header level) will bring the dropdown of individual columns that can be 
hidden or be visible by tagging the checkmark next to column name. Clicking the top icon allows the user 
to do the same for the entire section of columns.  

Resetting the View 
Any changes in layout can be reset by right clicking anywhere in the grid and selecting Clear Formatting 
option. 
 

Copying List Contents 
To copy funds from one list to another: 
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1. Select funds in the source list 

2. From Tools dropdown on top of the grid, select “Copy” 

3. Select the target list.  

4. From Tools dropdown on top of the grid, select “Paste” 

Do not use regular Ctrl-C/Ctrl-V combination. 
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Model Comparison  

 
Model Comparison is a special type of view that allows the user to quickly review the fit of various models 
for a single manager. While general fund list contains many managers and results of calculations using 
single selected model, the Model Comparison shows results of calculations using many different models 
for one manager.  

 
Figure 126 
The most common application for this feature is finding the model that provides the best explanatory 
power for the manager. The typical template for model comparison would show R-squared statistics over 
one or multiple periods. Clicking on the analytics header allows the user to quickly sort data by R-square 
and to find the best fitting model. 
 

Templates 
Templates provide the user with the ability to customize the view for each fund list. Stylus Workspace 
ships with default summary and model comparison templates for each mapped database. Users are free 
to create their own templates.  

 
Figure 127 

Adding Templates 
To add a template, click “Add” button on top. Templates can be renamed by clicking on Name column in 
the grid and typing the new name.  

Deleting Templates 
Templates can be deleted by right clicking on the row and clicking on Delete Record.  

Template Attributes 

Name Template name 
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Type Attribute -based/Relation based. See Error! Reference s
ource not found. 

Relation Attribute -based/Relation based. See Error! Reference s
ource not found. 

Default Specifies how funds are matched.  

Memo Notes about the template 

Model Attributes List of fields from the selected model. 

Source DB Fields List of fields from source database 

Analytics List of Analytics to be calculated 
Figure 128 

Model Libraries 
A model is an object that describes how the fund analysis should be performed with respect to factor sets, 
regression parameters, and possibly peer groups and benchmarks. Models are grouped into Model 
Libraries for ease of use and maintenance.  

Creating Model Libraries 
In order to create a new Model Library, the user needs to right click on Model Libraries node in the 
navigation tree and then click Add Library. 

Renaming a Library.  
Libraries can be renamed by double clicking on Library name in the navigation tree and then typing new 
name.  

Deleting a Library 
Libraries can be deleted by right clicking on library name in the navigation tree and then clicking Delete 
Library.  

Adding New Model 
Adding a new model is accomplished by selecting a model library in the navigation tree and then clicking 
Add button on top of the main panel.  The user is then presented with the screen shown in Figure 127. 
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Figure 129 
The main feature of the model object is the Style Outline. Users can set up the Style outline section of the 
model in the manner similar to updating the Style Outline of the Stylus study. (Figure 130) 

 
Figure 130 
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Users can also populate Parameters, Peer Groups, Benchmarks and Hedge Group sections of the model. It 
is worth noting that while the Style Outline section of the model can be applied across different 
databases, Peer Group assignments may not. It is therefore recommended that Peer Group assignments 
are configured separately (see advanced features).  

Model Attributes 
Models can be assigned various attributes (such as Region, Asset Class etc.). These attributes are used 
primarily for model matching purposes using Attribute-based matching (see advanced features).  

Model Overwrites 
Models can inherit properties of another model and enrich the parent model with additional features. The 
most common use case for this is the ability to quickly change parameters such as use of Sharpe/LWR vs 
MPI / Dynamic model or the use of Long Only constraints. While it is possible to do it in every model 
within the specific library that process would be tedious. A better approach is to specify these parameters 
in Selective Save/Parameters section in the parent model and then have all (or group) of model within a 
library inherit from this model. This set up would make it easy to apply any parameter changes across all 
models easily. We recommend storing parent/parameter models in separate Parameter Library (see 
Figure 131 for example). 
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Figure 131 

 
Basic Parameters library shown above specifies only Parameter section: 

 
Figure 132 

 
Now models in My Models library can use Basic Parameters library as a parent. 

 
Figure 133 
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Copying Model 
Users can copy a model to a new model by selecting a model record from the grid in the main panel and 
then using Right-Click/Clone Record option. This will create a new model named in the format of [Original 
Model Name] – Copy.  

Deleting a Model 
Users can delete a model by selecting a model record from the grid in the main panel and then using 
Right-Click/Delete Record option. 

Model Assignment  
 
Usually funds obtained from vendor or custom user databases will have certain classification attributes 
assigned to them. These attributes can be mapped to internal category attributes set up by the user or 
shipped with software. These category attributes can be assigned to have a default model and 
benchmark. Model selection, in this case, is straightforward.  

1. Determine the value of the classification attribute based on the fund’s database. 

2. Map classification attribute to internal category attribute. 

3. Use the model assigned to that internal category. 

Example in Figure 134 shows default model assignment based on internal category attribute called MPI 
Category. 

 
Figure 134 
 
It is possible to create more granular mapping by assigning additional attributes to each category and 
specifying models based on each attribute. See Error! Reference source not found. sections. 
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Regime Models 
The node is only available to users with Advanced Analytics license. 
 
This node allows user to manage a list of regime models. Stylus version 11.5 ships with a list of regime 
models developed by MPI’s research team. Users can view the list of the models in the navigation tree 
and also review a quick summary of each model.  
 

 
Figure 135 
 
Users can add a new model by either clicking on “Add” button or right clicking on the “Regime Models” 
node.  Clicking on a model name in the navigation tree will enable user to review and edit the selected 
models.  
 

 
Figure 136 
 
Regime Models can be specified in two ways: 

• Rule Based – Under rule-based analysis, regimes are identified based on performance / level 

properties of various risk factors. Some examples may include: 

o Up Market / Down Markets – Regimes based on the performance of S&P 500 Index 

o Volatility Regimes – Regimes based on level of CBOE VIX index (e.g. <20, 20-35,>35) 

o Growth vs. Value regimes – Regimes based on difference of performance of Russell 3000 

Value and Russell 3000 Growth indexes 

• Custom – Regimes may be identified by a collection of user supplied dates. These dates don’t need to 

represent continuous time intervals. 
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Rule Based Models 

 
In order to set up a rule-based model, the user needs to select the “Rule-Based” mode 
and add one or more rules by clicking the “Add” button.  
A grid like the one in Figure 149 will appear on the screen. This grid is not shown when 
the “Custom” mode is selected.  
 

 
Figure 137 

 
Column Description 

Name Name of the regime. When viewing regimes in the tables and charts the name is 
used for alphabetical sort. Users can override the sort order by specifying an order 
prefix in the form {XX} before the name.  
 
Example shown Figure 149 demonstrates that Moderate 10-Year Treasury regime 
should appear in between High and Low regimes (ignoring alphabetical order). 
 
The prefix is not shown in charts and tables. 
 

Index Index used as a reference. Users can select by clicking on the cell and picking an 
index that either appears in a drop down or by clicking on the “add” item in the 
drop down and selecting any series from any of the databases available to the user.  

Relation Users need to specify a relation used for the particular rule. Possible choices are: 
1. < (X < v1) 
2. <= (X <= v1) 
3. > (X > v1) 
4. >= (X >= v1) 
5. Between (v1 < X < v2) 
6. Between+ (v1 < x <= v2) 
7. Outside (X < v1 or X > v2) 
8. Outside+ (X <= v1 or X >= v2) 
9. Percentile range (v1 < X <= v2%) 

 
In all of the above cases, v1 and v2 refer to Value 1 and Value 2 columns. 

Value 1 
Value 2 

These columns specify the values against which the condition is checked. Either 
column can be entered as a numeric value, or they can be used to specify an 
Index/Series. If the series is specified, then the rule checks the value of the Series 
specified in the Index column versus the value of the specified series at each data 
point.  
 

Figure 138 

 
The name of the regime specified in each row does not need to be unique. Combinations of multiple rows 
can be used to construct more complex rules. Multiple rows specifying conditions for the same regime 
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name can be combined using either “AND” or “OR” operators as specified in “Same name rules logic” 
section. Here are two examples of using these operators. 

 
Example 1: “AND” 
 

 
Figure 139 

 
In this example we are focused on four possible regimes: 

  High Inflation Low Inflation 

High Growth 1 2 

Low Growth  3 4 

 
For reach regime we specify two rows: 

1. Based on Industrial Production Index 

2. Based on CPI YoY index 

Example 2: “OR” 

 
Figure 140 

 
In this example we want to specify Extreme Volatility regime when: 

1. S&P 500 Index loses more than 8% (monthly) 

2. OR VIX level exceeds 30 

Please note that it is necessary to click “Calculate” button in order for the regime model to be useful.  
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Review Mode 
By default, when the regimes are recalculated using “Calculate” button, the bottom grid will display a 
concise view of regime history grouped by each regime. Users can click on the Review Mode checkbox to 
see a more detailed view 

 

 
Figure 141 
 
In this view, users can see all regime data points in chronological order (not grouped by regime) and check 
the actual value of the index versus values specified in Value 1 and Value 2 columns. Please note that 
when two or more conditions are specified for each regime (as described above), the Review mode will 
only show the Index Return column for the last index specified.  

Export Series 
While in Review Mode, it is possible to extract the history of the regimes as Stylus manager files by 
clicking on the export series button. Each series will be stored as “.mng” file in the database location 
specified by the user (Figure 142). Users can also modify Series ID and Series Description columns.  

 
Figure 142 
Each series will be extracted as level series showing 1 for each data point within regime and 0 for data 
points outside of the regime.  
 

Custom Models 
Sometimes it may be necessary to specify a regime model that cannot be calculated using the mechanism 
described above. For example, a user may have their own regime model based on some Bayesian analysis. 
Other users may want to look at aggregate index performance over certain time periods (e.g. Up /Down 
Market by Year). 
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Figure 143 
 
Using the custom mode, users can edit the grid shown in Figure 155 directly or paste values from the 
clipboard (e.g., excel). When pasting values please construct your spreadsheet to have three columns 
corresponding to Name, Start Date and End Date columns shown in Figure 155. 
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Stress Tests  
The node is only available to users with Advanced Analytics license. 
 
This node is used to maintain lists of historical stress tests. Stress Tests are grouped into logical Stress Test 
Groups.  

 

 
Figure 144 

 
Users can add a new group by right clicking on “Stress Tests” node and a new stress test by right clicking 
on individual group or clicking “Add” button. Clicking on individual stress test will prompt the definition 
screen. 

 

 
Figure 145 

Scenario Analysis 
The node is only available to users with Advanced Analytics license. Please see Advanced Risk Analysis 
document for detailed discussion of Scenario Analysis. 
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Introduction to Macros & Automation 

Chapter 10 

Overview 

 
MPI Stylus Pro’s macro and 
automation capabilities 
significantly enhance the 
application’s power and help 
position it as a premier research 
and reporting facility.  In this 
chapter, users will learn about 
the power of macros and be 
introduced to the concept of 
scripting. 
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Chapter 10 
 

Introduction to Stylus Automation 
 
Automation capabilities in MPI Stylus Pro represent one of the most powerful aspects of the program 
because they give the user the ability to create and publish complex reports with the push of a button. 
 
There are three major kinds of automation tools in MPI Stylus Pro: macros and scripts represent true 
automation and carry with them a great deal of power and flexibility, but a third option, the Binder Tab, 
provides an alternate option for users with simple automation needs or those who do not subscribe to the 
Automation advanced package. The Binder Tab is discussed in detail in the Basic Interface chapter of this 
manual.  
 
Macros are core components of the application available to all users, and most of this chapter will focus 
on them.  Scripts, on the other hand, are part of the Advanced Automation package and are extensively 
covered in additional documentation available from MPI.  We present a brief introduction to them in this 
chapter for the benefit of users who are not subscribed to the Advanced Automation package, but would 
like to get a sense for how scripts can help them reach their publishing goals. 
 
No matter which level of automation you are using, it is important to remember that automation can be 
extraordinarily convenient and time-saving, and though it may look intimidating, it is actually very easy to 
produce once a few key concepts have been mastered.  In addition to the information in this manual, you 
may also view our more complete macro and script reference guides in PDF form.  Simply browse to your 
Stylus directory in My Computer or Windows Explorer, and go to: 
 

Automation Type File Location 

Macros Stylus\docs\macroref.pdf 

Scripts Stylus\docs\autoref.pdf 

 
Macros vs. Scripts – What’s the Difference? 
 
There are many important differences between macros and scripts, and they are used to accomplish very 
different goals.  For the benefit of new users, however, the basic differences may be summarized as 
follows: 
 

▪ Macros are simple codes used to substitute a piece of information into a report 
▪ Macros are part of MPI Stylus Pro’s core product and are available to all users 
▪ Scripts are more complex codes used to populate studies and publish reports automatically 

based on preset criteria. 
▪ Scripts are part of the Advanced Automation package.  For more information, please contact 

your MPI sales associate. 
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Macros 

 
A macro is a specially formatted, simple code which will be substituted with another value when a report 
is populated.  By using a macro, you not only can avoid entering the same piece of information 
repeatedly, but you have a simple means for changing the information should the need ever arise.  It 
should be noted that macros are not limited to reports – they may also be used inside of StylusScript 
statements, for example. 
 
Example #1 – The Macro Concept 
 

To understand just how MPI Stylus Pro views a macro, consider the following example.  

Imagine that you need to produce a single fact sheet 500 times (once for each of 500 funds that your 
group analyzes). The fact sheet will have the name of the fund across the top, as well as its relevant ticker 
listed below. 

Normally, you would have two options. One would be to have 500 files - one for each fund - and update 
them each individually once per quarter with new risk and return information. The other option would be 
to have one file, and go in and change the information 500 times. Neither of these options is remotely 
scalable, and both open themselves up to frequent opportunities for data entry error. 

With a macro, you have only one copy of the fact sheet, and at the top - where the fund name is - you 
simply put in a code. That code - @MNG{} - is telling MPI Stylus Pro to check the Design Tree and put in 
the relevant information. If you have Mutual Fund A on the Design Tree, then that fund name will appear 
on your report. If you switch to Mutual Fund Z, your report will switch automatically. This means that you 
can run quick scripts or batch processes, and know the information will be correct each time. 
 
Why use a macro? 
 
There are many reasons why you might want to use a macro, including: 
 

▪ Saving time.  Macros may be defined quickly and then used again as often as you like.  You will 
also save time when it comes time to change the value of a macro, as you can avoid having to 
make the change numerous times after hunting through your report. 

▪ Reducing human error.  If you did not use a macro, you might have to make the same change ten 
times throughout a report – and missing one time could affect your report’s accuracy. 

▪ Enforcing consistency in your reports.  The text from a macro will appear the same no matter 
where it is used, avoiding slight variations that may be confusing to your report users. 

▪ Retrieving information from MPI Stylus Pro or external data sources automatically. 
 
 
 
 
 
 
 
 
 
 
 
 
Parts of a macro 
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Consider the following macro: 
 

@MacroName={Show This Text} 
 
This and all macros will consist of four basic parts: 

Macro Part Function 

@ The “@” symbol identifies this as a macro. 

MacroName This is where the name of your macro will go.  This must be unique; you may 
not use the names of macros that come predefined with MPI Stylus Pro.  For a 
complete list of these macros, please see the macroref.pdf document 
mentioned at the start of this chapter. 

= The equal sign separates the macro name from the output. 

{Show This Text} There will always be opening and closing brackets for macros {}, and you may 
often enter additional information inside these brackets, such as the output for 
the macro.  For more information, please see the macroref.pdf document. 

Figure 146 
 
The macroref.pdf document contains information on all available display options for existing MPI Stylus 
Pro macros, as well as how to program your own new macros. 
 
Please note that the Global Macros interface in Configurator allows you to simplify the design process by 
entering only the macro name and the value; for more information, please see below. 
 
Global Macros 
 
Global macros are macros that have been assigned on an application-wide basis and will work identically 
anywhere in MPI Stylus Pro.  There are two types of global macros: 
 

▪ MPI macros, which come pre-defined with MPI Stylus Pro and cannot be changed. 
▪ User-defined global macros, created in the Configurator module. 

 
For information on creating a new macro, please see “Creating a New Macro” later in this chapter. 
 
Common Global Macros 
 
There are numerous MPI macros defined for application-wide use, and the full list may be found in the 
macroref.pdf document discussed at the beginning of this chapter; however, for convenience we present 
a few of the most popular global macros in the table below.  Additional formatting options for the listed 
macros are available in the macroref.pdf document. 
 

Macro Function 

@NOW{} Current date 

@MNG{} Name(s) of manager(s) checked in your design tree. 

@UNV{} Name(s) of peer group(s) checked in your design tree. 

@BMK{} Name of the selected benchmark. 

 
 
 
 
Report Macros 
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Certain global macros have been defined for specific use in reports, and will not work in views.  These 
include various page-related macros to help the user change automatic page numbering.  For a complete 
list of these macros, please see the macroref.pdf document. 
 
User-defined Macros 
 
MPI Stylus Pro allows users to define their own macros on either a global level (through MPI Configurator) 
or directly in a single study.  This gives users a high level of flexibility in using macros to accomplish their 
diverse automation goals. 
 
The most important constraint on user-defined macros is that they may not use the name of an MPI-
defined macro; for example, a user may not create a new @MNG{} macro because this is a global MPI 
macro.  All macros must have unique names. 
 

Working with Macros 
 
Creating a New Macro 
 
Users have the option of creating new macros in Configurator (global macros) or in an individual study; 
the steps will be somewhat different, and therefore we will examine each method separately. 
 
To create a global macro: 
 

1. Go to File-> Configure in MPI Stylus Pro’s main menu.  The Configurator module will open. 
2. Click on the “Global Macros” section listed under the “Default” node on the design tree. 
3. In the Name field, enter the name of the macro you wish to create.  This may be any word(s) not 

currently used by another macro.  For example, if you wanted to create a macro for the name of 
your client, you could name the macro ClientName. 

4. In the Value field, enter the text string you want MPI Stylus Pro to display wherever the macro is 
used.   

5. Save Configurator.  Your macro should now be ready to use.  For information on using the macro, 
please see “Using a macro” below. 

 
To create a single-study macro: 
 

1. Open the study in which you wish to create your macro and click on the “Study” node at the top 
of the design tree. 

2. Click on the “Macro” tab in the data pane.  Please note that studies created in earlier versions of 
MPI Stylus Pro may have macros in the Memo tab; while this still works for macros, we 
recommend that the Macro tab be used for all new macros. 

3. Enter the new macro you wish to create in the following form:  
 

@MacroName={MacroValue} 
 

4. If you wish to enter an additional macro, please use the Enter key to place it on a new line. 
5. Your macro should now be ready for use.  For information on using the macro, please see “Using 

a macro” below. 
 
Using a Macro 
 
Once a macro has been defined, it is important to know how to use it in the study to get the results you 
want.  There are many places where defined macros may be used, including: 
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▪ Memos 
▪ Chart text (titles, subtitles, etc.) 
▪ Table text (Advanced Table Formatting) 
▪ Objects & Stationary Objects 

 
To use a macro, you need to know the macro name. While you had to define the macro when it was 
created (unless it was an MPI global macro), to use it you only need to reference it. 
 
To use a macro: 
 

1. Go to the field where you want to enter the macro.  This is the field in your view or report where 
you want the macro’s value to be displayed; for example, if you had a @ClientName{} macro, this 
field is where you would want the actual name of the client (the value) to be displayed. 

2. Enter the following parts of the macro: the @ symbol, the macro name and the brackets with 
nothing in between them.  Examples would include: @MNG{}, @ClientName{}, @MacroName{}, 
etc. 

3. Go to the actual view or report output.  Your macro should have been replaced in the output 
with its value.  For example, if you had typed @MNG{} in a memo’s design, you should see the 
actual manager name (i.e., Fidelity Contrafund) in the memo output. 

 
Changing a Macro 
 
Changing the value of a macro is easy: 
 

1. Go to the area where you defined the macro (Macro tab or Configurator). 
2. Change the macro value (between the {} brackets) from the old value to new value. 
3. If you are doing this in Configurator, save Configurator. 
4. Go to your output.  Your macro should now be changed to reflect the new value.  This will be the 

case wherever the macro is used. 
 
Deleting a Macro 
 
Great care should be exercise when deleting a macro – you must delete not only the macro’s definition (in 
the Macro tab or in Configurator), but also every instance where you used the macro in your view(s) and 
report(s).  Otherwise, once a macro is removed, any place where the macro is referenced will show as 
straight text. 
 
For example, imagine that you had a macro called @ClientName={Markov Processes Int’l}, and you used it 
in a report to produce the following sentence: 
 

We recommend to our client, Markov Processes Int’l, that they invest in… 
 

If you deleted the macro itself in the Macro tab or Configurator but did not remove it in the view or 
report, the following sentence would be generated: 
 

We recommend to our client, @ClientName{}, that they invest in… 
 

Obviously, this is problematic.  Therefore, it is always recommended that you review carefully your full 
report whenever you have deleted a macro. 
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Scripts 

 
Scripting is part of the Advanced Automation package for MPI Stylus Pro; however, we present here an 
introduction to scripting for the benefit of users who wish to get a better understanding of its functions 
and capabilities within the application. We recommend that those who do not subscribe to our Advanced 
Automation package review the Binder Tab functionality in the Basic Interface chapter of this manual. 
 
Scripting in MPI Stylus Pro is designed to help turn the application from an interactive desktop research 
tool to a powerful production system.  Essentially, it allows users to leverage MPI Stylus Pro as a massive 
report-generating system, for generating web site support material, as an engine for analytical database 
feeds, or other uses. 
 
StylusScript™ 
 
The StylusScript language is the core of scripting in MPI Stylus Pro.  It is a very simple language, and most 
statements represent actions which may be performed manually by users themselves, such as adding one 
or more managers to the design tree.  By combining these actions in sequence and executing them 
simultaneously, MPI Stylus Pro can act as a batch processing machine, performing complex and extensive 
tasks without human intervention. 
 
In simple cases, scripts may be written by the user and executed inside a study in very little time.  This is 
often used to simplify repetitive tasks in approved, proofed studies – for example, design tree population.  
In more complex cases, StylusScript can be generated by separate software modules.  For example, user 
input in proprietary databases could generate script that is then passed on to MPI Stylus Pro for 
execution. 
 
Script Tab 
 
Scripts in MPI Stylus Pro will be run out of the Script tab, which may be reached through the Study node 
on the design tree.  The script tab allows you to enter and edit your script, as well as to choose to run it 
manually by using the “Run script” button or to have it run when you open the study by using the “Run on 
startup” button.   
 
Integrator and Scripts 
 
MPI Integrator users should keep a few things in mind when working with studies that contain scripts.  
Integrator contains a variety of options to control whether or not scripts in underlying studies will be run 
on startup or will be suppressed and run only on instruction from the user.  For complete information, 
please see the chapter on MPI Integrator. 
 



MPI Stylus Pro  
 

Copyright 2005-2020, Markov Processes International, Inc.Page 294 

 

Troubleshooting Automation & Scripting 

 
The following frequently asked questions (FAQ) refer to basic macro situations and should not be 
considered comprehensive.  Users are encouraged to refer to MPI’s forum and the existing reference 
documentation on macros and scripts for more information on these features.  In addition, users may 
reference our FAQ on our web site at http://www.markovprocesses.com. 
 
Q: I am trying to use a macro, but instead of seeing my output I am seeing the macro text itself.  For 
example, instead of seeing “Fidelity Contrafund” I am seeing @MyStudy={}. 
A: The macro is either not properly defined or is entered incorrectly.  Please make sure that the format for 
the defined macro follows this pattern: @MacroName={MacroContent} and that the format for the macro 
used in your text is @MacroName{}. 
 
Q: I would like to find out if a macro already exists to perform a function.  Is there a way to find out what 
macros exist? 
A: Yes.  Please refer to the macroref.pdf file located in your Stylus/docs folder.  This file may also be 
downloaded from the Support-> Materials area of our web site. 
 
Q: I would like to find out more about scripts in MPI Stylus Pro.  Do I have the advanced automation 
package?  How can I determine if I have it?  How can I get it? 
A: Please go to Help-> About in your main MPI Stylus Pro menu.  If the word “Automation” appears in the 
Packages section, your firm subscribes to this package.  If you are unsure, please contact your key user to 
find out if you have the advanced automation package.  For users who do not currently subscribe to the 
advanced automation package, MPI will be able to refer you to your MPI sales associate. 
 
  

http://www.markovprocesses.com/
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Helpful Stylus Tools 

Chapter 11 

Overview 
 

This chapter covers additional 
utilities which may be helpful to 
MPI Stylus Pro users.  For 
more information, please 
contact MPI. 
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Chapter 11 

Helpful Stylus Tools 

 
MPI Stylus Pro has several additional utilities available to assist users in performing functions related to 
data acquisition and updating, and batch processing/publishing.  In some cases, these utilities may be 
available only as part of an advanced package, such as Automation.  The most important tools are 
presented here along with a brief description on their function.  More information may be found on our 
web site at http://www.markovprocesses.com, or directly through MPI. 
 

MPI Updater 

 
The MPI Updater is a utility that allows users to efficiently run their periodical updates to data streams 
(such as the MPI Basic Indices package, or 3rd-party databases.)  It may be accessed in MPI Stylus Pro 
through the Tools-> MPI Updater option. 
 
Detailed information is available in the Database Updates User Guide, available from MPI via our web site. 

MPI Publisher 

 
MPI Publisher is a part of the Advanced Automation package and allows for batch processing of studies 
using the MPI Stylus Pro reporting features.  This feature will be especially helpful to users with high 
volume publishing demands.  A reference guide for MPI Publisher is available on our web site in the 
Support -> Materials section. 
 
For more information about getting MPI Publisher, please contact us at support@markovprocesses.com. 
 

MPI PDF Merge Utility 

 
MPI PDF Merge Utility is a part of the Advanced Automation package and allows the user to quickly merge 
multiple PDF documents generated by MPI Stylus Pro (or from other sources) into a single, larger PDF 
document.  This allows for ease in creating institutional-wide books and combining reports for different 
purposes, while maintaining the flexibility to produce PDF documents for single studies, asset classes, etc.  
Reference guides for the MPI PDF merge utility are available on our web site in the Support -> Materials 
section. 
 
For more information about getting the MPI PDF merge utility, please contact us at 
support@markovprocesses.com. 
 

MPI Stylus Utilities 

 
From time to time, MPI may release additional utilities specific to a particular data vendor, study or report 
type, or formatting issue.  These utilities affect only a small percentage of MPI Stylus Pro users, and 
support for these utilities is available through reference documents issued at the time of their creation, or 
directly through MPI.  If you are a client using an additional utility and require assistance, please contact 
us at support@markovprocesses.com. 
 

http://www.markovprocesses.com/
mailto:support@markovprocesses.com
mailto:support@markovprocesses.com
mailto:support@markovprocesses.com


  

MPI Learning Program Resources 

Chapter 12 

Overview 
 

MPI has a variety of learning 
program resources available to 
assist users in getting the most 
from MPI Stylus Pro, including 
our Help Menu, web page and 
user training options. 
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Chapter 12 

MPI Learning Program Resources 

 
MPI has a variety of learning program resources available to assist users in getting the most from MPI 
Stylus Pro.  For more information on any of these resources, please see our web site at 
http://www.markovprocesses.com, or contact us at support@markovprocesses.com.  You will need your 
user name and password to access these materials. 
 

MPI Stylus Pro Help Menu 

 
MPI Stylus Pro’s Help Menu may be accessed directly through the application using Help-> Topics.  The 
Help Menu contains much of the information present in this manual, and provides users with a fast and 
convenient way of looking up information while using MPI Stylus Pro.  Please note that in many cases, 
additional information on Advanced packages, formula calculations, etc., may be available in the Support 
area of our web site.  For more information, please see the “MPI Support Materials” section below. 
 

Help Center 

 
The Help Center, accessible via the Home Module, contains quick access points to our various Support 
channel options, as well as direct links to some of our most commonly requested documents. In addition, 
MPI produces ongoing support materials for all MPI products and makes them available in the Help 
Center/Support/Training sections of our web page at http://www.markovprocesses.com.   
 
Highlights include: 
 

▪ MPI User Forums (more information below) 
▪ Database updates and release schedules 
▪ Back issues of MPI’s corporate newsletter, The Pilot 
▪ MPI Stylus Pro templates 
▪ Presentations and materials from MPI conferences and seminars 
▪ Advanced package documentation 
▪ Case studies 

 

MPI User Forums 

 
MPI’s forums provide users with an excellent reference for how other financial professionals use MPI 
Stylus Pro, as well as with opportunities to get quick answers from MPI support specialists.  There is a 
Wish List forum for sharing product suggestions directly with MPI developers, and all forums are fully 
searchable, which means that users can often find the answer to their question right away without having 
to submit their question. 
 
Please visit the MPI forums at: 
 

http://www.markovprocesses.com/phorum/index.php 
 

You will need your MPI user name and password to log in. 

http://www.markovprocesses.com/
mailto:support@markovprocesses.com
http://www.markovprocesses.com/
http://www.markovprocesses.com/phorum/index.php
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MPI Configurator – Configuring MPI Stylus Pro 

Chapter 13 

Overview 
 

In this section, you can find all the 
information you need to 
configure MPI Stylus using the 
Configurator module.  This will 
allow you to adjust global 
application settings and arrange 
to bring new database sources 
into Stylus. 
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Chapter 13 
 

MPI Configurator – Configuring MPI Stylus Pro 

 
MPI Configurator is a special module in MPI Stylus Pro that allows users to add, edit or remove elements 
that affect the application on a system-wide level, including databases.  Whereas other modules in the 
application are used for research, reporting and/or organization, MPI Configurator lets you: 
 

▪ Maintain or link to new databases containing portfolio returns, indices, style maps, peer groups, 
completed studies, etc. 

▪ Specify default values for new studies in other modules. 
▪ Define various settings and options that affect MPI Stylus Pro’s functionality, features and 

appearance. 
▪ Create global macros.  This will be covered more extensively in Chapter 9 (Introduction to 

Automation & Scripting.) 

Accessing MPI Configurator 

 
To access MPI Configurator, click on File-> Configure in your main MPI Stylus Pro menu. 

 

 
Figure 147 
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Despite the obvious differences between Configurator and other MPI Stylus Pro modules, the first thing 
you may notice when opening Configurator is that its basic setup is the same as all modules, including the 
presence of the design tree and data pane.  This helps Stylus users comfortably navigate Configurator as 
they would any other module. 

Configurator Design Tree 

 
MPI Configurator’s design tree contains nodes specific to its special functions within the application.  It 
contains only two nodes: Default and Databases. 
 

Default Node 
 
The Default node controls a variety of global settings that may be of interest to MPI Stylus Pro users, as 
well as specific sub-sections on palettes and global macros.  Most users will never have to change the 
default settings in this node. 
 
Home Directory 
 
The home directory allows you to generalize path descriptions in MPI Stylus Pro by defining the locations 
of databases and folders relative to a central (home) location.  This is typically the folder on your 
computer or network where MPI Stylus Pro is installed.  To use this relative reference, you would simply 
enter the <home> prefix when entering a new database location. 
 
If the home directory field is blank, Stylus is considering the <home> folder to be the folder from the 
application is being run. 
 
If you specify a different home directory folder, MPI Stylus Pro uses that folder to find all databases using 
the <home> designation in their location path.  This allows you to change the home directory folder and 
the location of all databases using this relative feature. 
 
It should be noted that the absolute path name must be used when referencing any database not located 
in the home directory. 
 
To specify a new home directory folder:  
 

1. In MPI Configurator, click on the Default node on the design tree. 
2. Click on the ellipsis button (…) at the end of the Home Directory field to open the “Browse for 

Folder” tool. 
3. Locate the folder you wish to specify as your new home directory. 
4. Click on the folder and then click “OK.” 
5. The specified path should appear in the “Home Directory” field and is now your <home> 

directory. 
 
Cash 
 
This section allows you to specify the default cash proxy for all MPI Stylus Pro studies you create.  You 
may change the label, database location, index and currency of your cash proxy in this section. 
 
The default cash proxy in MPI Stylus Pro is the 3-month T-bill Total Return Index; however, you may 
change this to any index or return stream available to you in MPI Stylus Pro.  Please note that Cash Proxy 
may also be changed manually in a given study, and that a study-level setting for cash will overrule the 
global setting; therefore, never assume your global cash proxy is the proxy used in a given study. 
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To change a cash label: 
 

1. Delete the text in the “Label” field.  The default text in this field is “Cash.” 
2. Type in the word(s) you would like to appear in all MPI Stylus Pro studies, wherever the cash 

proxy is used. 
3. Save your Configurator settings. 

 
To change the database and/or index set for cash: 
 

1. Click on the ellipsis button (…) at the end of the “Name” field for Cash to open the browse 
feature. 

2. The browse feature will open in the database where the currently specified cash proxy is located 
(the default will be the US Fixed database).  To select a different fund in this database, skip to 
step 4.  To switch to a different database, use the ellipsis button (…) located next to the database 
field in the upper-right hand section of the browse feature. 

3. Scroll to the appropriate database name and select it with your mouse.  Click the green 
checkmark in the upper right-hand corner of the browse feature.  To cancel without changing 
databases, click the red “X” button. 

4. Once you are in the appropriate database, use your mouse to select the index you wish to use as 
your cash proxy.  You may use the standard MPI Stylus Pro search and sort features to assist you 
with finding the correct index. 

5. Select the index with your mouse and click the green checkmark in the upper right-hand corner 
of your browse menu. 

6. The new index/database should now appear in the Cash fields. 

 
Currency 
 
The default currency in MPI Stylus Pro is the United States Dollar.  To change a currency, please use the 
drop-down menu under “Currency” to scroll to the appropriate world currency.  Please note that currency 
may also be specified in a specific study in the Parameters node, and that study-specific currencies 
overrule global currency settings. 
 
All major global currencies are available in MPI Stylus Pro. 
 
Inflation 
 
This section allows you to specify the default inflation tracking index for all MPI Allocator studies.  You 
may change the label, database location, and name of this index in this section.  This may also be done on 
a study-level setting in MPI Allocator. 
 
To change the Inflation index: 
 

1. Click on the ellipsis button (…) at the end of the “Name” field for Inflation to open the browse 
feature. 

2. The browse feature will open in whichever database holds the currently specified inflation index 
(the default may be no index, in which case this section would appear blank).  To select a 
different fund in this database, skip to step 4.  To switch to a different database, use the ellipsis 
button (…) located next to the database field in the upper-right hand section of the browse 
feature. 

3. Scroll to the appropriate database name and select it with your mouse.  Click the green 
checkmark in the upper right-hand corner of the browse feature.  To cancel without changing 
databases, click the red “X” button. 
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4. Once you are in the appropriate database, use your mouse to select the index you wish to use as 
your inflation index.  You may use the standard MPI Stylus Pro search and sort features to assist 
you with finding the correct index. 

5. Select the index with your mouse and click the green checkmark in the upper right-hand corner 
of your browse menu. 

6. The new index/database should now appear in the Inflation fields. 
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OPTIONS TABS 
 
The Options tabs contain a variety of default settings that you may adjust as necessary to fit specific 
global needs.  In general, you will not need to change these settings from their preset defaults.  In 
addition, note that changes in settings will not go into effect until you have saved your Configurator 
settings. 
 
Reset Button 
 

 
 
You may use the Reset button at any time to restore the settings in any Options tab to their defaults.  This 
will only affect the active Options tab and will not affect settings in other tabs. Not all tabs will have the 
Reset button available. 
 

GENERAL TAB 
 
 
Disable study scripts 
 
This feature automatically disables all start-up scripts in your installation of MPI Stylus Pro.  This overrules 
the “Run on Startup” feature that may be assigned in a particular study. 
 
Default to multiple selection of studies on Open 
 
This feature allows you to specify that the “Select Study” menu that is used to open studies in any module 
(File -> Open…) defaults to the “Allow multiple selection” mode.  This allows you to specify more than one 
study to be opened at the same time. 
 
Use Excel 2007 Library for both .xls and .xlsx files 
This option allows the user to specify that the Excel 2007 library is to be used when these file types are 
referenced (including the .xls file type, which is pre-2007). 
 
Show Navigator on Top 
This option allows the user to move the Navigator pane from its default position (left side) to the top, 
giving the program more of a ‘tabbed’ feeling that is familiar to users of some web browsers. 
 
Use A4 report page size by default 
This option allows the A4 paper size to be the default option for report-making. This is helpful to 
European clients and others who use an A4 paper standard. 
 
Disable “restore” in views and reports preview 
This option disables the recording of report design changes needed to support the undo functionality. This 
may lead to performance improvements for some users with networked installations or mirrored local 
disks. 
 
Learn and Remember Preferences 
 
This control allows you to specify persistence for certain preferences throughout the application.  This 
includes many small details such as the size and position of popup windows, column widths in the 
Portfolio Editor, Database Selection field, etc. 
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There are three options for Learn and Remember: 
 
Session 
This option will learn and remember your preferences for your current session of MPI Stylus Pro only.  All 
preferences will be lost when you close the application and defaults will be in place the next time MPI 
Stylus Pro is opened. 
 
Always 
This option allows you to keep your preferences in place even when MPI Stylus Pro is closed and 
reopened at a later time. 
 
Never 
This option always reverts to defaults and does not “remember” your preferences. 
 
Recently used studies list 
 
This feature allows you to control the number of recently used studies that appear in the main MPI Stylus 
Pro file menu below “Exit.”  This feature allows you to access studies you use often without having to 
locate them repeatedly in the Open menu.  The maximum number of studies is 20.   

 
SAVE TAB 
 
The Save tab contains a number of useful controls that allow user control over auto-save and work 
recovery options. It is important that users understand the scope of each control in order to ensure no 
issues arise from lost work. 
 
Automatically save open studies every X minutes 
This feature authorizes MPI Stylus Pro to automatically save all open studies at a user-defined time 
interval. You may specify any increment between 1 and 600 minutes. The auto save option creates a 
backup version of the study with a modified extension that is saved at a given period, with the file deleted 
when the study is explicitly saved by the user. 
 
Automatically save Recovery file every X minutes 
This feature authorizes MPI Stylus Pro to automatically save the recovery file every X minutes. 
 
On save, maintain study revisions for recovery  
When this option is checked, MPI Stylus Pro will save recovery versions of a study on any study save. 
Checking this option will enable the two sub-options listed below, detailing how many revisions to keep 
and for how many days a revision should be kept. It should be noted that when both of the features 
below are checked/activated, they will both be observed; in effect, this keeps the most possible number 
of revisions so long as they meet one or the two criteria. 
 
 Keep only the last X revisions 

This option allows the user to decide how many revision copies of a study should be maintained. 
The user may specify a number between 1 and 600. When a revision is no longer one of the X 
newest, it will be deleted automatically. 
 
Keep only revisions for the last X days 
This option allows the user to decide for how many days of revisions may be kept. For example, if 
the user specifies 10 days, then revisions that become 11 days old will be deleted. 

Recovery storage  
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Allows the user to specify the location where recovery files are stored. Useful when the default location is 
a network location that incurs speed penalties. 
 
Temporary file location 
Similar to above, but for temporary files. 

 
GRAPHICS TAB 
 
 Avoid using hatched brush when printing 
This setting allows you to avoid having elements such as benchmarks print in hatched-line form.  These 
may continue to appear in this form in MPI Stylus Pro, but will not be hatched upon printing.  This may be 
important for users who wish to print to PDF, as that format does not support hatched printing well. 
 
Avoid using hatched brush in metafiles 
This setting removed the hatched lines from bar charts when a report is exported to a metafile format, 
including .wmf, .emf or .ppt. These lines will continue to appear in MPI Stylus Pro, but will not be hatched 
upon export. 
 
Avoid using dashed line 
This setting changes the line used for benchmarks on line charts from a dashed line to a solid line. 
 
Force frame in charts when exporting from views 
This setting forces a border to appear on all charts when they are exported from views. 
 
Do not use advanced styles defined in charts and objects 
This setting allows the user to disable the use of gradients, transparency and other advanced graphics 
introduced in version 11.0 that may be incompatible with the printing or exporting environment. This 
overrides settings used in studies. 
 
Monitor image in cache via time-stamp 
This setting is enabled by default to improve performance of image caching and should be disabled only in 
rare circumstances. 
 
Axis Margin % 
This setting allows you to specify the default margin percentage that will be enacted in charts when 
“Margin” is selected in the Axis tab of the Attributes Editor for the given chart. 

 
COLORS TAB 
 
  
Several settings in this editor may be set on a chart-by-chart basis in the Attributes Editor and/or Color & 
Symbol tab of a given study; however, making these changes in Configurator allows you to set global 
appearance settings without having to indicate them every time you create a new study. 
 
Peer Group 
 
This section allows you to set several peer-group specific settings, including chart type, bar width and 
quartile settings.  All of these settings may be done in a given study on the specific chart level through the 
Attributes Editor. 
 
Bar vs. Area 
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This setting allows you to specify whether your charts using peer group statistics, such as distribution, 
appear in the default as a Bar or an Area chart. 
 
Bar Width Setting 
This feature allows you to specify the relative default width of bar charts.  The default setting of 100% 
means that all bars in a chart will be touching one another edge-to-edge. 
 
Outline 
This setting controls whether or not the bars/boxes for peer groups in a chart will have outlines around 
them. 
 
Scatter 
This allows you to set a default color and symbol for peer groups in scatter charts. 
 
To change a default color or symbol: 
 

1. Click on the current color or symbol selection.  This will bring up a scroll menu with all available 
colors or symbols. 

2. Use your mouse to scroll through the available colors or symbols.  When you find the color or 
symbol you would like to use as your default, click it with your mouse. 

3. The new color or symbol should now appear as the current color selection. 
 
Quartile Color Picker 
This feature allows you to specify on a global level the four default colors in which you would like quartile 
peer bands to appear.  The default settings are two green and two pink colors.  You may also choose to 
overrule your default color settings on a chart-by-chart or a study-by-study basis. 
 
Color Pickers – Manager through Asset Blends 
This feature allows you to specify particular colors to be associated by default with specific indices or 
various other chart elements.  Colors may be assigned on a more detailed level in a given study through 
the Color & Symbol tab.  The default setting for most colors will be “Automatic”, which bases a color on its 
relationship to the MPI Stylus Pro color palette and to other color elements.  When certain colors are 
changed (i.e., default Manager color), all automatic color settings will adjust as well.  To override this, 
simply choose a default color for all options. 
 
To assign a particular color to a given item: 
 

1. Click on the appropriate dropdown menu.  This will bring up the scrolling menu of available 
colors. 

2. Using your mouse, scroll to the desired color and click it once. 
3. This color should now be your default color setting. 
4. You must save Configurator before your changes will be reflected. 

 
Cell & Area Options 
 
These tools allow you to specify the default background color for a chart cell or area.  The “cell” is the 
region that may be occupied by data points on a chart (i.e., the area inside the axes in a bar chart.)  The 
area is the entire area of the chart including the region outside the cell.   
 
Please note the following images illustrating the difference between cell and area.  In the Cell image, the 
cell has been colored green – notice that only the active area of the chart is affected (the part where data 
points may be seen.) 
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In the second image, the cell has been changed back to clear and the area has been colored green.  Notice 
how the entire chart is affected, including the cell region (unless it is set to a different color, in which case 
it would appear distinctly.) 
 

Cell 
 

 
Figure 148 

 
Area 

 

 
Figure 149 

 
The default for both cell and area colors is “clr” for clear, which defaults to the Stylus background color of 
gray for views and white for reports.   
 
To change cell or area color: 
 

1. Click on the appropriate dropdown menu.  This will bring up the scrolling menu of available 
colors. 

2. Using your mouse, scroll to the desired color and click it once. 
3. This color should now be your default setting. 
4. You must save Configurator before your changes will be reflected. 

 
 
You may also choose to bring in a particular image to be the background of your cell or area.  The 
following image types are supported in MPI Stylus Pro: 
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File Extension Image Type 

.bmp Bitmap file 

.gif GIF file 

.wmf Metafile 

.emf Metafile 

.jpg JPEG 

.png PNG 

.xls Picture in Microsoft Excel 

 
To import an image as a cell or area background, please see “Stationary Objects” in Chapter 5 (Views and 
Reports) for information on using the “Select Image” tool. 
 
Path 
This feature controls lines on Monte Carlo simulations and affects only MPI Allocator studies.   
 
Prospector 
This special set of tools allows for specific color selection for certain traits related only to Prospector 
studies.  
 
Background 
Sets the background color for charts in Output. 
 
Text 
Sets the default text color for chart labels, axes, etc. 
 
Symbol 
Sets the default symbol color and shape for charts. Note that shape only applies to scatter charts. 
 

FONTS TAB 
  
The fonts tab allows you to specify the default font type and size for charts and tables throughout MPI 
Stylus Pro, as well as set the option to embed fonts when exporting PDFs from within MPI Stylus Pro. 
 
Use in Charts/Use in Tables 
You may specify the default font for a chart or a table in MPI Stylus Pro by selecting a font from the 
dropdown list.  MPI strongly recommends that users select clear, traditional and well-established fonts 
such as the Arial class of fonts in order to ensure clear reports that can easily be shared with other users. 
 
Min/Max 
The Min/Max controls allow the user to set a font size range for text in charts and tables.  This allows the 
program to automatically adjust text size within a given range whenever other changes are made to a 
chart or table.  MPI Stylus Pro’s reporting features are designed around a relative scaling system that 
allows the user to change the size of one item in a chart and have the remaining elements of the chart 
adjust to be in harmonic sizes with the changing element.  This helps to improve general consistency 
throughout reports. 
 
Use the “Min” setting to indicate the minimum acceptable font size, and use the “Max” setting to indicate 
the maximum acceptable font size. 
Use in script editors 
This control allows you to specify the default font to use in macro and script editors in the application. 
 
Embed fonts when using MPI PDF engine 
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This option allows you to automatically embed all fonts in a report into a PDF file whenever you export it 
from MPI Stylus.  This ensures that other users can view a report in the fonts you intend, even if the other 
users do not have that font installed on their computers.  Please note that embedding one or more fonts 
in a PDF file may result in a dramatic increase in overall file size because the files associated with that font 
on your computer are included in the PDF file size. 
 
It is important to note that this option only works for MPI’s PDF writer within MPI Stylus Pro; for Adobe or 
other PDF drivers, their own settings should be used. 
 

FORMATS TAB 
 
The formats tab regulates global settings for how dates are displayed for data periods in return streams. 
 
Dates for daily and weekly data 
The same control governs the default date setting for both daily and weekly data.   
 
Dates for monthly data 
This control governs the default date setting for monthly data.   
 
Dates for quarterly data 
This control governs the default date setting for quarterly data.   
 
 

ANALYTICS TAB 
  
 
This tab governs several important factors for global analysis controls.  Most of these settings may also be 
changed in individual studies, and generally these defaults in Configurator do not need to be changed. 
 
Min Observations for Standard Deviation 
This function allows the user to set the minimum number of data points required to calculate standard 
deviation.  The default setting (and minimum) is 3 observations and the maximum is 50 observations (as a 
minimum for calculation.)  The user may either manually type in the minimum number of observations, or 
may use the scroll feature to select a number. 
 
Initial investment value for accumulation 
This setting allows the user to specify the initial investment value for a portfolio or fund and is used in 
cumulative growth/wealth-related charts.  MPI Stylus Pro automatically appends the dollar sign to any 
number entered into this field.  Positive or negative dollar amounts may be used in this function. 
 
Number of trading days in a year 
This option allows the user to specify how many days in a year should be considered ‘trading days’. Users 
may specify a number between 200 and 300. 
 
 
Default location for computation logs 
This allows you to set the appropriate folder destination for computation logs generated by the software. 
 
Confidence Level 
This setting allows the user to set the confidence interval for Performance Statistics.  The default is 90%. 
 
Min Rank Value 
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This setting affects all ranking options in MPI Stylus Pro and allows the user to specify if a ranking system 
begins at “0” or “1”. 
 
Peer group percentiles 
This allows you to set the peer group percentile thresholds used in the software. By default, they are 5 25 
50 75 95, but users may change these values as they see fit. 
 
 
CFA Institute compliant Sharpe Ratio 
The CFA Institute compliant Sharpe Ratio uses the manager’s standard deviation in the denominator; the 
MPI Sharpe Ratio uses manager-cash standard deviation in the denominator. 
 
Population Standard Deviation and Covariance 
Standard Deviation is the square root of variance. Population variance takes the arithmetic average of the 
sum of the squared differences. Sample variance divides by (n-1) instead of N to produce an unbiased 
estimate of population variance. 
 
Exclude the beginning partial period in aggregations with non-overlapping window 
This option allows users to decide whether or not to exclude the beginning partial period data for 
aggregated calculations that use the non-overlapping window. 
 

DATABASE TAB 
  
The Database tab allows control over several database-related features.  
 
Performance Optimization 
 
Use Cache for: 
This feature specifically affects the Database analytic block, improving the speed with which 
Views/Reports featuring this block are loaded and populated. You must specify the number of records to 
cache and the expiration time (for how long they should remain cached.) 
 
ASCII databases (studies, templates, maps…) 
 
Use Cache: 
This feature likewise allows for the use of caching, which can improve speed. 
 
Preload on startup for up to X seconds 
Allows you to control preloading time on program startup, which can likewise reduce loading times during 
use of areas of the application.  
 
 
 
 
Do not maintain sort order for more than X studies/templates 
For those who anticipate using very large numbers of studies/templates, this allows you to control how 
many are subject to using sort order. This can assist with performance in these cases. 
 
Show returns in Portfolio View/Edit 
This option allows the user to decide whether or not they wish to see underlying returns in the Portfolio 
Editor tool. Users may decide to do this Always (default), Never or only when editing an existing Portfolio. 
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Force “Delayed Open” for all databases 
This option allows the user to specify that all databases used in an MPI Stylus Pro installation use the 
‘delayed open’ feature. When this is checked, no database will be ‘opened’ unless a user explicitly 
attempts to access it.  
 
Use default database views when available 
This option specifies that when a default database view is available for a database, it should always be 
used. Users may switch explicitly to another view, if available. 
 
Disable dynamic series adjustments 
This feature allows administrators to disable user privileges in adjusting dynamic series. This is helpful in 
cases where it is crucial to ensure that individual users are not making changes to return series. 
 
Close all databases daily at 
This feature allows administrators of network installations to schedule automatic updates without them 
being blocked by open instances of MPI Stylus Pro. The specific action performed by this tool is to put all 
databases in the same state as they would be in if ‘Delated open’ were checked and the database had not 
yet been accessed by the user in the current session. Thus, users are not denied access to their databases 
per se; instead, a database would need to be explicitly opened to be active. This action takes place on a 
daily basis and is governed by the time specified in Configurator. All installations sharing a given 
configuration file will be affected, and the time specified will be based on the time of the PC clock on 
which MPI Stylus Pro’s .exe file is running. Please note that a user trying to access a database during an 
update would experience an error.  
 
Fixed (non-scrollable) columns in selection pane 
This allows you to decide how many columns (beginning with the left-most) remain fixed in place when 
you scroll through columns in a selection pane (such as in the Data Pane of the Managers node 
 

USER INTERFACE 
 
This tab was formerly known as the “Level” tab and is an organizational tab used by MPI Stylus Pro and 
certain power users supporting large user groups. 
 
Level 
This may be used to specify the user level for an instance of MPI Stylus Pro. The four levels are 
“Experimental,” “Power User,” “Lite” and “Template designer/Stylus.WEB.”  Each level may have certain 
features enabled/disabled as a result of its nature. Virtually all MPI Stylus Pro users will have no reason to 
ever use or change these settings.  Please note that level changes will not be reflected until after MPI 
Stylus Pro has been closed and restarted. 
 
 
Gallery database location 
Through this setting the user can locate an alternative gallery database. Not commonly used. 
 
Chart/Table Designer: use dropdown when more than X fields in a section 
This option allows the user to decide at what point a given number of fields in a Chart/Table analytic block 
should be expressed as a dropdown list. The available range is from 2-999. 
 
Mouse-activated drag-drop, move and resize in report preview 
This option allows the user to enable mouse-based adjustments in the Report preview space. 
 
Use extra columns for assets in Portfolio Editor 
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This allows the user to decide whether extra columns will appear for assets in the Portfolio Editor. The 
‘Edit’ button supplied allows the user to add or review columns. 
 
Use timestamp in log messages 
This allows the user to decide whether log messages will carry timestamps.  
 

HOME TAB 
  
Show Home module on startup 
This option allows the user to turn on/off the Home module for when they initially open an instance of 
MPI Stylus Pro. The module may separately be opened or closed while using the application, via the main 
menu. 
 
Show “Online Resources” page 
This feature allows the user to view some information from the MPI website directly in the module. While 
this may be useful to some, we generally recommend to instead visit the website directly in order to avail 
yourself of the full suite of resources there. When visiting the website, your user name and password will 
be your case-sensitive Stylus Pro serial number, viewable through Help-> About in the software menu. 
 
Do not use the Database Update Monitor 
This allows you to opt out of using the Home screen monitor of database update information. This might 
be useful if updates are pushed to you automatically by your firm, meaning that you do not need to 
monitor them yourself. 
 
Do not use MPI Portal connection and panel 
This allows you to opt out of viewing the MPI Portal panel, and its connection to news feed updates. 
 
Default startup Home page: 
This allows user-level control of which page of the Home module is shown on startup. For example, a user 
may decide that it is more useful for the ‘Recent’ studies pane to show, than for the Welcome screen. 
 
Thumbnail size 
This allows the user to control thumbnail sizes for reports, and to thus have more or less information on 
their screen as fits their preferences. 

 
 
 
 
 
EXPORT TAB (Formerly the PDF Tab) 
 
Automatically select Standard or Alternative (XPS) PDF engine 
In Stylus Pro 11.0, a second PDF creation mechanism was created to support the advanced graphics 
capabilities, while leaving the legacy engine in place for full backwards compatibility. Through this setting, 
the user can instruct Stylus to choose the appropriate engine based on attributes of the study, such that 
older studies will use the legacy export mechanism.  
 
When this feature is checked, the ‘Use the following PDF engine on export’ option is grayed out. 

 
Automatically delete intermediary XPS file when Alternative (XPS) PDF engine is used 
Should the user not choose to let Stylus choose the appropriate engine, one can use this setting 
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Use the following PDF engine on export 
Should the user not choose to let Stylus choose the appropriate engine, one can use this setting to choose 
the method for creating PDF files. This feature is disabled when the ‘Automatically select Standard or 
Alternative (XPS) PDF engine’ feature is enabled. 
Auto launch PDF preview after export 
This feature has been added for the convenience of users who wish to see their final PDF output 
automatically once it has been created.  
 
Show individual ungroup options for PowerPoint 
This feature allows the user to view individual ungrouping options for exporting to PowerPoint. 
 

ULI Tab 

 
This tab controls features relevant to the User Level Interface (ULI) tool. 

 
Default location for jobs, queues, reports 
These folder settings provide users with the ability to customize the locations of their User Level Interface 
inputs and outputs. 

 
Prevent running reports with warnings 
This option allows the user to specify that ULI reports that generate warnings cannot be run; thus, the 
user’s attention is brought to the matter. 
 

LINKED DATABASE LIST 

 
The linked database list allows you to build and maintain a common set of Stylus databases for all of your 
Stylus users.  Without such an option, one user would have to enter identical database entries on all local 
(desktop) user configuration files (Stylus.ini.) Though this is possible to do, it is an inefficient solution 
because any change to these settings would have to be manually propagated to all users.  The linked 
database list saves you this trouble. 
 
Before you can create a set of databases for all Stylus users, you must create a new .ini file that contains 
the individual database information. 
 
 
 
 
To create a new .ini file for selection in the Linked Database List field: 
 

1. Print this topic so that you have the instructions available when you create the .ini file. 
2. If MPI Stylus Pro is running, please close it. 
3. Using Windows Explorer, go to your Stylus folder. 
4. Make a copy of the existing stylus.ini file and name it something else, such as “common.ini.”   
5. In Stylus Shortcut Properties, temporarily point to this new .ini file. 
6. Launch MPI Stylus Pro and go to Configurator. 
7. In Configurator, create access to the databases that you would like users to have in common.  

Make sure all linked paths are available to all users on the network. 
8. Once these links are built, save Configurator and exit MPI Stylus Pro.  You have now created a 

common .ini file. 
9. In Stylus Shortcut Properties, replace the common.ini file with your original .ini file (Stylus.ini.) 
10. All users should now select the common.ini file in the Linked Database List field.   
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To view the list of linked databases, highlight the Linked Databases node on the Configurator design tree. 
 
Please note that database IDs for linked databases must be unique; if some databases in the linked list 
have conflicting IDs, they will be shown in gray and ignored by MPI Stylus Pro.  For example, in the event 
of a conflict such as the same database ID used in the linked .INI file and in the user’s .INI file, the user’s 
file will take precedence. 
 
MPI Stylus extracts only database information from the linked .ini file and ignores all other configuration 
information. 
 

MARKET HOLIDAYS 
 
MPI provides a file (holidays.MPI in your Stylus root directory) with market holidays automatically 
programmed in.  If you have a need to change these for any reason, please use the following instructions; 
however, MPI strongly recommends not making adjustments to this file, as it is updated automatically 
through our program downloads. 
 
The .MPI file is a text file with a different extension, and may be opened in any basic text editing software, 
such as Notepad.   
 
The file begins with the following lines: 
 
ADD 
200 
 
These should not be changed for any reason. 
 
To add a new market closure date: 
 

1. Open the file in a text editor. 
2. Enter the new date for the holiday, and the holiday name, in the following format: 

 
YYYYMMDD // Event 

 
3. Save the file, preserving the .MPI extension. 

 
 

Palettes 
 
The Palettes section regulates the global color and symbol palettes in MPI Stylus Pro and allows you to 
import new colors (using RGB codes) and new shapes (using metafiles).  You may also reorder the MPI 
Stylus Pro color and symbol palettes as you see fit, returning to default settings at any time. 
 
 
Standard Color and Symbol Palettes 
 
MPI Stylus Pro comes with standard (default) color and symbol palettes that cannot be changed by users.  
Any changes to these palettes will be in the form of a separate “custom” palette, and the standard palette 
may be used again at any time by switching back to the standard settings. 
 
Custom Color and Symbol Palettes 
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Any palette changes made in MPI Configurator will result in the use of a custom palette.  This will include 
any case where a user enters a new color using the RGB code function. 
 
To create a custom palette: 
 

1. Select the Custom circle above the palette. 
2. You can now add, delete, or move the order of colors or symbols in the palette.  You may also 

switch back to the Standard palette at any time, and if you switch to Custom palette again 
thereafter, you will find your Custom palette will represent its last saved configuration. 

 
COLORS in MPI STYLUS PRO 
 
In order to provide meaningful, customizable reporting solutions to our clients, MPI Stylus Pro has been 
outfitted with a powerful color palette system that enables users to locate and use colors based on 
recognized systems, such as RGB codes. That said, in versions 8.1 and later, we also implemented a color 
order recognition system that is of great assistance in making correct color selections on the fly. This is 
done by giving each color in your color palette a unique number based on its order in the palette. In other 
words, the first color (black in our default palette) will have a unique number of zero, and each successive 
color will have a higher number based on its relative order. This allows you to quickly make use of these 
reference points in design; for example, knowing that you always wish to use color 54 for table headings. 
In cases where a Custom Palette is added, color numbers may change but used colors will not. For 
example, if a color is #10 in the Default palette, and you switch to a Custom Palette in which this color 
occurs in position #50, the same color will be used and the new number shown (as opposed to switching 
to whatever color is #10 in the new palette). 
 
 
 
 
 
 
 
 
 
 
 
 
ADDING COLORS 
 
There are two ways to add colors to MPI Stylus Pro’s custom palette.  You may either use the “Add” 
function, which opens a color browse utility, or you may use the RGB code entry function. 
 
Add 
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The “Add” button for colors opens a color picker utility that allows the user to browse through a whole 
range of colors based on tint or shade.  There are several components to this tool, including a range of 
standard colors that may be selected immediately, a custom color setting that reflects the color selected 
in the color honeycomb, and the honeycomb tool itself. 
 
To select a Custom color from the honeycomb tool: 
 

1. Using your mouse, adjust the black arrow to the right of the vertical shade bar.  This will cause all 
of the colors in the honeycomb tool to become darker or lighter, depending on how much black 
or white has been included. 

2. Once the honeycomb reflects the appropriate tints and shades of the color you wish to select, 
you may click directly on that color in the honeycomb to select it.  It will automatically be added 
to your custom palette. 

3. You may also choose to select either pure white or black at the bottom of the screen, or select 
from various shades of gray between them. 

4. In addition, you may also select from forty standard color squares across the top of the add 
utility. 

 
RGB 
 
In addition to using the color add function, users may also manually specify the RGB color code for a color 
they wish to use in MPI Stylus Pro.  This is especially helpful when colors must exactly match corporate 
color schemes or other approved colors. 
 
RGB (Red Green Blue) is an internationally recognized setting system combining incremental elements of 
the three primary colors to form any necessary new color.  Values for each of the three colors may range 
from 0 (black) to 255 (white).  Users may either adjust the RGB settings for colors already in their palette, 
or create new colors for adjustment. 
To create a new color using RGB codes: 
 

1. Locate the position on the color palette where you wish to create the new color.  You may then 
add to that location either any new color (using the color add tool) or choose to adjust the color 
currently present at that location.  For instructions on using the color add tool, please see above. 

2. Once you have added or selected the color to change, click on it on your palette.  Its current RGB 
color codes will be reflected in the RGB tool. 



MPI Stylus Pro  
 

Copyright 2005-2020, Markov Processes International, Inc.Page 318 

 

3. You may now either manually enter codes for red, green and blue, or you may scroll through 
each color to find the perfect shade.  As you scroll, you will notice your selected color block on 
the palette incrementally adjust to the selected colors. 

4. Once you have the correct color in your color block, save Configurator. 
 
ADDING SYMBOLS 
 
Add 
 
Users have three options for adding symbols to their custom symbol palette.  The user can: 
 

▪ Add an image (metafile) as a symbol 
▪ Add an empty space between symbols 
▪ Add an existing symbol in a new location (as opposed to moving the existing symbol from its old 

location.) 
 
To add an image as a symbol: 
 

1. Click the Add button in the Symbols section and select “Custom…” 
2. Use the Select Image browse tool to navigate to the appropriate metafile image and select it. 
3. Click “OK” to import the symbol. 

 
To add an empty space between symbols: 
 

1. Click the Add button in the Symbols section and select <empty> 
2. This will insert a blank space to the right of whichever symbol you have clicked on in the Custom 

palette. 
 
To add an existing symbol one or more times: 
 

1. Click the Add button in the Symbols section and select one of the available symbols.  It will be 
added to the Custom palette. 

 
Moving Colors & Symbols 
 
Users may move color or symbol positions on their Custom palettes through the following steps: 
 

1. Click on the color block or symbol you wish to move. 
2. With your mouse button still held down, move your mouse to drag the color or symbol to a new 

location in the palette. 
3. When you reach the desired location, release the mouse button and your color or symbol will 

appear in its correct spot. 
 
 
 
Reset 
 
The Reset button will restore your Custom palette to being an exact duplicate of the Standard palette, 
and you will lose any new colors or symbols you have created/imported, as well as any position changes 
you have made.  Please do not hit the Reset button unless you are certain you wish to reset the colors or 
symbols, as MPI Stylus Pro will not ask for confirmation before resetting the palette to the default 
settings. 
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For this reason, it is recommended that the user temporarily switch back to the Standard palette when 
they require it, instead of resetting their Custom palette. 
 
Monitor symbol image in cache via time-stamp 
This control simply relates to enabling the time stamp monitoring for symbols defined as images in the 
Symbols palette. This relates to our internal image caching/storage, and is not applicable to most users; it 
is recommended to keep it off unless needed. 
 

Global Macros 
 
The global macros feature allows you to add custom macros that you would like to make automatically 
available to all MPI Stylus Pro studies.  Please note that any standard pre-defined MPI Stylus Pro macros 
(such as @MNG{}) are already global macros by default and do not need to be specifically entered as 
global macros. 
 
For complete information on creating and using global macros, please see Chapter 9 of this manual. 
 

Databases Node 
 
The databases node in the Configurator module is where all of your data sources for MPI Stylus Pro will be 
added, modified or deleted – except for any portfolio or return series you create yourself in a specific MPI 
Stylus Pro module.  Those portfolios and series will be stored in MPI Stylus Pro folders/databases that 
come automatically configured with the application. 
 
Simply creating a folder in your Stylus directory through Windows file management systems is not 
sufficient for brining information into MPI Stylus Pro; it must be configured correctly in order for the 
application to be able to accurately read the information. 
 
Most of the database headings under the Databases nodes are defaults that come automatically 
configured with MPI Stylus Pro and should not be changed without reason.  This includes all of the 
databases that are study or template-based.  Please see the table below for recommendations on 
Database modifications. 
 

Database Node  
Section 

Modifications Recommended? Description 

Style Studies No Stylus folder 

Style Templates No Stylus folder 

Prospector Studies No Stylus folder 

Prospector Templates No Stylus folder 

Integrator Studies No Stylus folder 

Integrator Templates No Stylus folder 

Allocator Studies No Stylus folder 

Allocator Templates No Stylus folder 

Publisher Studies No Stylus folder 

Manager Series Yes 3rd Party Databases 

Index Series Yes Stylus-included series 

Portfolios No Stylus folder 

Style Maps No Stylus folder 

Peer Group Sets No Stylus folder 

Currencies No Stylus folder 
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Adding, Changing and Deleting Databases 
 
For the most part, making additions, changes and deletions to this section is done through the same 
manner.  Therefore, this will be covered first and then each particular sub-section will be examined with 
any specific instructions on using unique features. 
 
 
Adding a New Database/Database Folder 
 
To add a new database or database folder in MPI Stylus: 
 

1. Click on the relevant Sub-directory (i.e., Integrator Templates or Manager Series) on the 
Configurator Design Tree under the “Databases” node.  If you do not see any sub-directories 
under Configurator, you may need to expand that section by clicking the plus sign next to the 
word “Databases.” 

2. In the data pane, click the “Add” button.  This will bring up a numerically named new database 
heading in both the data pane, and on the Configurator design tree under the appropriate sub-
directory heading (you may have to expand the sub-directory to see it.) 

3. Click on the new numeric database name under the sub-directory on the design tree.  The data 
pane will change to show you the available design and configuration elements for this 
database/database folder. 

4. The ID code should be a unique case-sensitive letter/number combination of 3 characters that 
uniquely identifies the database.  Most users do not need to remember these IDs, but in some 
cases they might be required (for example, to refer to a database in a macro or the SQL block of a 
table designer.)  The name and description you may fill out as needed in order to clarify the 
content of this database/database folder.  Please note that the name will appear on the 
Configurator design tree and be used by MPI Stylus to identify the database/folder in all MPI 
Stylus modules. 

5. To map your database file/folder into MPI Stylus, click the ellipse button at the end of the 
“Location” line to bring up a file browse tool.  Locate the appropriate file or folder on your 
computer or network, and then click “OK.” 

6. You do not need to make changes to the default mask setting. 
7. Save Configurator. 

 
Editing an Existing Database/Folder 
 
MPI does not recommend making changes of any kind to folders that have a “No” value for “Changes 
Recommended?” in the table above.  However, to edit the basic information for any of the folders or 
databases associated with MPI Stylus: 
 

1. Click on the database name under the appropriate Sub-section on the Configurator design tree. 
2. Simply delete the content of any field and change it accordingly. 
3. To change the location of a folder/database, use the “Location” ellipse button to map to the new 

location on your hard drive or network. 
4. Save Configurator. 

 
Deleting an Existing Database/Folder 
 
Deleting any database/database folder that came with MPI Stylus is highly discouraged, and may result in 
loss of data & software malfunction.  In addition, please note that deleting said folder in Configurator 
does NOT delete this folder or any of its files on your hard drive or network.  This deletion should be done 
separately outside of MPI Stylus using Windows Explorer or another file management program. 
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1. Click on the appropriate Sub-section that contains the database/folder you wish to delete from 
MPI Stylus Configurator. 

2. In the data pane, click on the name of the database/folder to select it. 
3. Press the “Delete button” at the top of the data pane. 
4. Configurator will ask you to verify that you wish to make this deletion.  Click “Yes.” 

 
 
Database Node Subsections 
 
Style Studies 
The Style Studies sub-section links MPI Stylus to three specific folders in your Stylus directory where you 
are likely to store studies you create or work with in MPI Stylus.  The sub-section names and their 
corresponding folders in your Stylus director in Windows are as follows: 

 

Sub-section in Configurator Links to Folder in Stylus directory 

StyleAccounts Study\sample 

Daily Studies Study\daily 

My Studies Personal\mystudy 

 
Style Templates 
The Style Templates sub-section links MPI Stylus to two specific folders in your Stylus directory where MPI 
Stylus templates are stored.  The sub-section names and their corresponding folders in your Stylus 
director in Windows are as follows: 

 

Sub-section in Configurator Links to Folder in Stylus directory 

Sample Templates template\sample 

Daily Templates template\daily 

 
Prospector Studies 
The Prospector Studies sub-section links MPI Stylus to three specific folders in your Stylus directory where 
MPI Prospector studies are stored.  The sub-section names and their corresponding folders in your Stylus 
director in Windows are as follows: 

 

Sub-section in Configurator Links to Folder in Stylus directory 

Prosp Study Pstudy 

My Prosp Studies Personal\mypstudy 

EPS Pstudy\e_pstudy 

 
Prospector Templates 
The Prospector Templates sub-section links MPI Stylus to one specific folder in your Stylus directory 
where MPI Prospector templates are stored.  The sub-section names and their corresponding folders in 
your Stylus director in Windows are as follows: 

 

Sub-section in Configurator Links to Folder in Stylus directory 

Prosp Templates ptemplat 

Integrator Studies 
The Integrator Studies sub-section links MPI Stylus to two specific folders in your Stylus directory where 
MPI Integrator studies are stored.  The sub-section names and their corresponding folders in your Stylus 
director in Windows are as follows: 

 

Sub-section in Configurator Links to Folder in Stylus directory 

Integrator Integrat\sample 
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My Integr Studies Personal\myintegr 

 
Integrator Templates 
The Integrator Templates sub-section links MPI Stylus to one specific folder in your Stylus directory where 
MPI Integrator templates are stored.  The sub-section names and their corresponding folders in your 
Stylus director in Windows are as follows: 

 
 

Sub-section in Configurator Links to Folder in Stylus directory 

Integrator Templates itemplat 

 
Allocator Studies 
The Allocator Studies sub-section links MPI Stylus to one specific folder in your Stylus directory where MPI 
Allocator Studies are stored.  The sub-section names and their corresponding folders in your Stylus 
director in Windows are as follows: 

 

Sub-section in Configurator Links to Folder in Stylus directory 

Allocator Studies Allocate\sample 

 
Allocator Templates 
The Allocator Templates sub-section links MPI Stylus to one specific folder in your Stylus directory where 
MPI Allocator templates are stored.  The sub-section names and their corresponding folders in your Stylus 
director in Windows are as follows: 

 

Sub-section in Configurator Links to Folder in Stylus directory 

Allocator Templates Atemplat\sample 

 
Publisher Studies 
The Publisher Studies sub-section does not come automatically setup in MPI Stylus, and is affiliated 
entirely with the MPI Publisher add-on available at additional cost to MPI Stylus users.  Please refer to 
MPI’s Publisher documentation for more information on this item.  Users who do not have MPI Publisher 
do not need to worry about this sub-section, and it will have no effect on any of your MPI Stylus usage, 
studies, templates or exporting. 
 
Manager Series 
The Manager Series sub-section contains the configurations for any 3rd party databases to which you may 
subscribe, as well as configurations for the SampleMNG & MyManagers folders.  MPI strongly discourages 
changing any settings for these databases, as they may cause the particular data stream to become 
unusable in MPI Stylus. 
 
Configuring a New Manager Database in MPI Stylus 
 
There are several steps to adding and configuring a new manager series for use in MPI Stylus, and they 
may depend on what kind of information you would like to bring in.  Options may change for each kind of 
manager series; therefore, instructions are provided by type of series you wish to add.  However, in all 
cases, the first three steps are the same: 
 
FOR ALL MANAGER SERIES TO BE ADDED: 
 

1. Click on the Manager Series sub-section under the Databases node on the design tree. 
2. In the data pane at right, click on the “Add” button. 
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3. Select the new Manager Series name on your Design Tree (located under the Manager Series 
sub-section) to bring up the edit options in the data pane. 

4. Decide what type of database you are trying to add/configure. 
 
Choosing a Database Type 
There are ten database types available for configuration in MPI Configurator.  Many of them have very 
specific functions and specialized options available; therefore, each will be addressed in turn in this 
section. 
 
Native Databases 
A Native database is a set of specially formatted ASCII files located in one folder (usually within your Stylus 
folder on your hard drive or network.)  It can contain files of the following types: 
 
MPI ASCII Files – MPI ASCII keeps a series of returns and descriptive information in a special ASCII format.  
It contains a block in the beginning of the file that contains descriptive information that improves 
performance of the software.  This information allows you to extend functional capabilities, improve 
performance and provides compatibility with future versions of MPI Stylus Pro. 
 
MPI Link – A link to a spreadsheet file.  This link allows you to keep (and update) all managers’ 
performance data in separate spreadsheets, independent of MPI Stylus.   
 
MPI Stylus allows you to work with its own single-series (native) databases and any number of external 
databases (i.e., 3rd party) within the same study.   
 
Import Databases 
An Import database is one in which a file in ASCII format has been placed with return series data.  When a 
database is defined as Import in Configurator, MPI Stylus can read the information and use them in any 
analysis, but certain parameters such as country, currency, frequency, etc., can not be specified.   
 
Formatting an ASCII file as an Import database: 
 
The correct format for an Import database is shown below: 
 

<date><separator><return> 
 
The <date> field may be in one of the following formats: MM/DD/YY, MM/YY, YY/MM, YYMM, or 
YYMMDD, where YY is the last 2 digits of year (for example, 99 for year 1999), MM is the month number 
from 01 to 12, and DD is the day number. 
 
The <separator> field can be one or several spaces or tabs. 
 
The <return> field can be specified as percentages (5 for 5%) or as fractions (.05 for 5%). 
 
Metastock Database 
 
This setting is used to import data from the Metastock databases. 
 
MPI DB 
MPI DB is a good general format used for brining databases into Stylus, and many standard and 
subscription-based databases come into Configurator through this tool.  When adding an MPI database, 
you don’t enter the mask, but you do need to specify the names of both the Header file and the Returns 
file. 
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An MPI DB usually (but not always) contains two files in the DBF format.  The first file, the header, 
contains descriptive information about all returns series in the database.  The second file contains the 
actual returns data.   
 
The MPI DB format can be used to store daily, weekly, monthly and quarterly return series. 
 
Spreadsheet 
This special database type lets you link to all manager (or custom index) series, including attributes, from 
a spreadsheet, so that you don’t have to link to each series individually. 
 
Wiesenberger 
This setting is used to import data from the Wiesenberger databases. 
 
Lipper 
This setting is used to import data from the Lipper databases. 
 
OLE DB 
This setting may be used for linking to relational database systems through an OLE DB driver, which must 
be installed on the user’s machine. 
 
Excel DB 
This setting allows users to import return series from Excel spreadsheets.  This allows for the easy import 
of proprietary database data, manager series, etc. 
 
Creating an Excel Database to be used in Stylus 
 
Creating an Excel database for use in MPI Stylus is fairly straightforward, and is a skill that MPI Stylus users 
would greatly benefit from learning, as it opens the door for you to bring in a great deal of data in 
addition to that already available in Stylus. 
 
To import data from an Excel spreadsheet: 
 

1. As the first step in creating an Excel Database, three rows/columns need to be created in the 
spreadsheet – an ID row/column, a Name row/column, and the first of your Date and Return 
rows/columns. Either row or column format can be used in this excel spreadsheet – all of the 
information applied to columns in this section may be similarly applied to rows. 

2. The ID column represents the unique identifier which will be used within stylus to identify this 
fund. The Name column is the name of the fund as it will appear within stylus on the Manager’s 
list and anywhere where the fund needs to be labeled (for example, within the legend of a chart.) 
The last column or set of columns will consist of dates and their relative returns. The date format 
for these columns is most commonly seen as such – MM/DD/YYYY. 

3. Any columns after the ID and Name columns will be considered qualitative (“static”, i.e., not 
time-series) information and will be detected in Stylus as such.  These columns may include 
additional information such as ratings, manager names, etc. 

4. Two additional columns may be used within the qualitative information section (however they 
are not required): 

 
▪ Currency -  to define the currency in which this fund’s returns are represented in. 
▪ Fraction - to determine whether the returns are represented as decimals or fractions.  

 
Your working version of the excel spreadsheet should look something like this: 
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Figure 150 

 
Now, you will need to label the information in your spreadsheet for Stylus to properly understand it.  In 
Excel, this is done using the “Name” feature. 

 
5. Select the area you wish to name, using the pictures below for reference. 
6. Click on the text box in the upper left hand corner. 

 

 
Figure 151 

 
7. Type in the name that you want to associate with this selection. 

 

 
Figure 152 

 
8. Hit Enter.  You have now named the selection. 

 
There are five required and two optional selections which must be named for Stylus to properly read from 
this spreadsheet: 
 

▪ MPIID will be used to name the ID column. 
▪ MPINAME will be used to label the Name column. 
▪ MPIHEADER will be used to label the entire qualitative information section including both ID 

and Name. 
▪ MPIDATE will be used to label each of the date column headings. 
▪ MPIRETURN will be used to label the entire set of cells which contain in them returns. 

 
Optional selections are as follows: 
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- MPICURRENCY will be used to label the currency column. 
- MPIPERC will be used to explicitly specify the use of percents. While this is the default, it 

removes the need for Stylus to ‘guess’ this information. 
- MPIFRAC will be used to specify returns as fractions.  Unless this setting is used, Stylus will 

automatically assume percentages. 
- In addition, you may use one of the five options to force the interpreted frequency of returns: 

o MPIANNUALLY 
o MPIQUARTERLY 
o MPIMONTHLY 
o MPIWEEKLY 
o MPIDAILY 

 
By carefully following these steps, you can ensure that your Excel files will be easily and correctly read by 
MPI Stylus.  For convenience, we include below examples of how column selections for each of the labels 
might be made using our example working spreadsheet from the images above.  Obviously, MPI Stylus 
can handle much larger and more complex spreadsheets, but this should give the user a good idea about 
how to go about creating their sheet correctly. 
 
MPIID 
The entire ID column is selected and will be named MPIID. 
 

 
Figure 153 

 
MPIDATE 
The entire range of dates will be selected. 
 

 
Figure 154 

 
MPIHEADER 
All header fields will be selected, including the ID column.  Note that dates are NOT header fields. 
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Figure 155 

 
MPIRETURN 
All returns information in date columns, but not the dates themselves, are selected. 
 

 
Figure 156 

 
Your Excel database should now be ready to be linked into Stylus. 
 
Linking Your Excel Database into MPI Stylus Pro 
 
Once the Excel database has been correctly configured, it is ready to be linked into MPI Stylus Pro. To do 
this: 
 

1. In Configurator, expand the ‘Databases’ node in the tree and select ‘Manager Series’. 
2. Click ‘Add’ on the right side of the screen. A new entry will be added to the bottom of your 

Manager Series list on the Design Tree. You may need to expand the list to see the new entry. 
3. Please ensure that ‘Type’ is switched to ‘Excel DB’. 
4. For ID, enter any unique three-character designation. This may not already exist as a designation 

for another database in Configurator. You may use any combination of letters and numbers. 
5. For ‘Name’, enter the name of the database as you wish for it to appear in your database lists in 

the software (for example, Morningstar US). 
6. The ‘Description’ field may be used for entering further information if you wish.  
7. For ‘Location’, use the browse button to navigate to the Excel sheet in question. 
8. Once you have completed these steps, please save Configurator before attempting to access the 

sheet via a study. 
 
 
 
 
 
 
Database Options 
 
Allow Direct Returns Editing (MPI DB only) 
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This feature is database-specific and allows you to enable the direct editing of returns in database 
streams. It is not recommended that you enable this feature unless for a specific purpose as it may allow 
other users to adjust data and affect the integrity of information feeding into your analysis. Please note 
that this option is only supported for the MPI DB database type. 
 
Delayed Open (on first access) 
 
When you open the MPI Stylus Pro application, the default setting is for all databases in MPI Configurator 
to be opened and read at that time as well. This allows for them to be accessed quickly as you move 
throughout the application. For users with large numbers of databases, or exceptionally big databases, 
this can lead to slow opening time for the application and other possible performance issues. By clicking 
the ‘Delayed Open’ checkbox, you instruct MPI Stylus Pro not to open a database until the first time you 
attempt to access it in the application. This is a recommended setting for most databases. Please note 
that this option does not support the Native, Import, Spreadsheet or Wiesenberger database types. 
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Portfolio Database Linking 

 
This section references only the Excel-based version of this feature; for information on using this with 
Access, SQL or other databases supported by the Advanced Database package, please contact MPI 
Support. 
 
While MPI allows users to manually create, edit and delete portfolios, this can be an inefficient process 
(and allow extensive opportunities for human error) when scaled to the level of tracking even a few 
portfolios. In the case of users who have thousands of portfolios to manage, a more efficient solution is 
called for. 
 
The Portfolio Database linking tool allows the user to use Excel DB functionality to create and update 
portfolios in an Excel database environment and have MPI Stylus Pro “read” the data. Specific formatting 
controls will be enacted depending on whether the portfolio is ‘Simple’ (has static weights) or ‘Advanced’ 
(weights change). 
 
Basic Setup 
All information MPI Stylus Pro needs to link a portfolio must be located in the first two rows of a 
worksheet; otherwise, MPI will assume the sheet does not contain relevant information for Excel 
portfolios and will be ignored. Each header field corresponds to an option which can be defined manually 
in the Portfolio Editor in MPI Stylus Pro. 
 
The lines of information will be: 
 

• Names of header fields. These can be of two types: a string, or a range of cells.  

• Beneath the header filed names will be a line of cells containing the field values. Range 
fields must be in the format A1:A10 (two cell addresses separated by a colon.) All ranges 
in the header should have either a width or height of 1, meaning that the range is a 
single column or row. 

 
Simple Portfolios 
Simple Portfolios (portfolios with no change in their weights) have four mandatory fields and four optional 
fields. If several simple portfolios are found on a single Excel tab, optional fields will apply to all portfolios. 
Additional Excel tab may be added to the spreadsheet to allow for different options. 
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Required Fields 
The required fields for Simple Portfolios are: 
 

Name Type Description 

MPI_PORTFOLIOTYPE String For simple portfolios, the value should be 
“Simple” 

MPI_ASSETIDRANGE Range Range of asset or fund IDs. This will either 
be one column wide or one row wide. 
Empty cells will be ignored. 

MPI_PORTFOLIOIDRANGE Range Range of portfolio IDs. Each portfolio must 
have a unique ID. Empty cells will be 
ignored. 

MPI_SOURCEDATABASE 
or 
MPI_ASSETDBIDRANGE 

String 
 
Range 

One of these two fields is required. If all 
Assets in the portfolio come from a single 
database, the Database ID under 
MPI_SOURCEDATABASE is sufficient. If the 
Assets come from multiple databases, each 
one must be defined in a column or row 
parallel to MPI_ASSETIDRANGE. 
 
MPI_ASSETDBIDRANGE defines this cell 
range. Please note that both options can 
be used in the same sheet; in this case, the 
Source Database will be used as the source 
in blank cells of MPI_ASSETDBIDRANGE. 

Figure 157 

 
Optional Fields 
The following fields for Simple Portfolios are optional: 
 

Name Type Description 

MPI_PORTFOLIONAMERANGE Range Portfolios are to be assigned names with 
this range. If not used, portfolio names will 
default to the unique IDs. 

MPI_LABELRANGE Range Use this range to assign labels to the 
portfolio assets.  

MPI_ORDERRANGE Range Use this range to fix the order of the assets 
in the portfolio. If all values are numerical, 
Stylus will use the numerical order; 
otherwise, alphabetical will be used (not 
case-sensitive.) 

MPI_DESCRIPTIONRANGE Range Use this field to set the portfolio 
description range. 

MPI_REBALANCE String Use this field to set the portfolio 
rebalancing option. Supported values are: 
 

• None (default setting) 

• Daily 

• Weekly 

• Monthly 

• QuarterlyAnnually 

Figure 158 
 
 
 
Advanced Portfolios 
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Advanced Portfolios use options which are featured in the Advanced Portfolio editor in Stylus. Unlike 
Simple Portfolios, there can only be one Advanced Portfolio per Excel Tab. Advanced Portfolios have four 
required fields and six optional fields. 
 
Two fields which are necessary for Simple Portfolios must be removed in Advanced Portfolios: 
 
MPI_PORTFOLIOIDRANGE (the ID will be taken from the Excel sheet name) 
MPI_PORTFOLIONAMERANGE (replaced with MPI_PORTFOLIONAME) 
 
Required Fields 
The following fields are required for Advanced Portfolios: 
 

Name Type Description 

MPI_PORTFOLIOTYPE String For advanced portfolios, the value should 
be “Advanced” 

MPI_ASSETIDRANGE Range Range of asset or fund IDs. This will either 
be one column wide or one row wide. 
Empty cells will be ignored. 

MPI_PORTFOLIODATERANGE Range  

MPI_SOURCEDATABASE 
or 
MPI_ASSETDBIDRANGE 

String 
 
Range 

One of these two fields is required. If all 
Assets in the portfolio come from a single 
database, the Database ID under 
MPI_SOURCEDATABASE is sufficient. If the 
Assets come from multiple databases, each 
one must be defined in a column or row 
parallel to MPI_ASSETIDRANGE. 
 
MPI_ASSETDBIDRANGE defines this cell 
range. Please note that both options can 
be used in the same sheet; in this case, the 
Source Database will be used as the source 
in blank cells of MPI_ASSETDBIDRANGE. 

Figure 159 
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Optional Fields 
The following fields for Simple Portfolios are optional: 
 

Name Type Description 

MPI_PORTFOLIONAME Range Use this field to name the Advanced 
Portfolio. If not used, the portfolio name 
will be the sheet name. 

MPI_LABELRANGE Range Use this range to assign labels to the 
portfolio assets.  

MPI_ORDERRANGE Range Use this range to fix the order of the assets 
in the portfolio. If all values are numerical, 
Stylus will use the numerical order; 
otherwise, alphabetical will be used (not 
case-sensitive.) 

MPI_EXTENDBEGDATE String “Yes” enables the Extend begin date 
control. “No” disables it (though this is also 
the default setting.) 

MPI_EXTENDENDDATE String “Yes” enables the Extend end date control. 
“No” disables it (though this is also the 
default setting.) 

MPI_REBALANCE String Use this field to set the portfolio 
rebalancing option. Supported values are: 
 

• None (default setting) 

• Daily 

• Weekly 

• Monthly 

• Quarterly 

• Semi-annually 

• Annually 
 

Note that the semi-annually option is 
based on the Calendar year, and balances 
after the June and December returns. 

MPI_DESCRIPTION String Use this field to set the portfolio 
description. 

Figure 160 
 
Configuration 
Excel portfolios are linked into MPI Stylus Pro through the Portfolios Database node in Configurator. The 
options are the same as those used for Excel databases (for more information, see earlier in this chapter.) 
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Add Table - Database Tables (for Table Blocks) 
 
The “Add Table” option in the right-click menu is used to create database tables that feed information to 
the Database Table blocks in MPI Stylus Pro. Extensive information on using this feature is available in a 
separate technical reference from MPI; however, basic instructions have been provided below in order to 
give you a good idea of how this feature may be used. To get the full technical reference, please contact 
us at support@markovprocesses.com. 
 
Purpose 
 
The idea behind the Add Table option was to bring to MPI Stylus Pro a level of functionality that allows 
the user to bring in table data with more flexibility and less configuration than might be required in other 
circumstances. Specifically, it gives the user the ability to put into a single table data that may come from 
different databases or even different database types. In doing so, it accomplishes the result of using SQL 
in Stylus without the user actually having to make use of a SQL statement. 
 
“Owner” Databases 
 
To create an additional table in Configurator, the corresponding “owner database” must be selected on 
the Design Tree. The owner database is the database that contains the funds/IDs that you will be using to 
match your other tables to. For example, if you create a table under Morningstar, then Morningstar will 
become the owner database. We call this database the “owner database” because it is essentially 
‘borrowing’ tables from other databases, even if they are databases of different types. 
 
It is important to know your owner database because you will need some ID column to ensure that the 
tables you bring in (and their underlying data) have a way of linking to the correct return series in the 
owner database. 
 
Adding a Table 
 
To add a Table: 
 

1. In Configurator, browse to the Design Tree setting corresponding to the owner database you 
wish to use. For example, in the screen shot below, the owner database will be Morningstar. 

 

 
Figure 161 

 



MPI Stylus Pro  
 

Copyright 2005-2020, Markov Processes International, Inc.Page 334 

 

2. Right-click on the database name on the Design Tree and select “Add Table.” A new table will 
appear under the database name with an automatic default name consisting of the database ID, 
“Table” and a number. For example, the first table created in Morningstar would read MfiTable0. 

3. Click on the table name on the Design Tree. You will now fill in the appropriate fields in order to 
properly format your table setup. The columns below describe the parameters necessary. 

 
Required/Optional Parameter 

Name 
Description 

Required Settings Type Table type (based on the outside database you will be referencing.) This will either be 
Excel DB, MPI DB or OLE DB. 

Location The location of the table. Depending on the table type, this may mean different things. 
Pressing the browse (…) button opens a help dialogue to specify a particular location, but 
the key thing to remember is: 
 

• Excel DB – Table location is a full path to a particular worksheet file. 

• MPI DB – Directory name where data (*.DBF) and index (*.IDX) files are 
located. 

• OLE DB – Data source connection string to access the table. 

Table The name of the table to be accessed. Pressing the browse (…) button opens a help 
dialogue allowing the name of a table to be selected from a list, but the key thing to 
remember is: 
 

• Excel DB – Spreadsheet name or a predefined named range. The first row in a 
named range is recognized as a row of labels used as column names. No blank 
row is allowed between the labels and the data. As an alternative to a named 
range, a spreadsheet name may be used. This causes the whole spreadsheet to 
be recognized as a table, and the first nonempty row in the spreadsheet must 
be a row of labels.  

• MPI DB – This is the name of a DBF table located in the directory specified in 
the Location parameter. 

• OLE DB – This is the name of a table or view available from the data source 
specified in the Location parameter. 

Optional Settings Description A text description for the table. 

 Title table The name of the table used to store column titles. This must be a table with a minimum 
of two columns – one for column names, the other for associated titles. Depending on 
the table type, particular column names may be different: 
 

• MPI DB – First column must be named ‘field’ and the second column must be 
named ‘title’. 

• OLE DB – First column must be named ‘FName’ and the second column must 
be named ‘FTitle’.  

 
For both types of database there may be an optional additional column (‘tabname’) that 
allows you to filter title table contents for a particular table name. If the title tab is not 
specified, the program tries to use the title table from an owner database to associate 
columns with titles. If no associated title is found, a column name is used.  
 

• Excel DB – For Excel DB, a title table does not need to be specified because the 
program uses text from the first row cells as column titles. 

Figure 162 
 
Using the Table Columns Grid 
 
When you add a table, the table columns grid will need to be filled out appropriately. A review of the 
options may be found below. 
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Column 
Name 

Control/Entry 
Type 

Description Input Options 
(if specific) 

(blank) Checkbox The checkbox setting determines whether the column is configured 
for later usage in the chart/table designer. 

- 

Name Read-only text The column name. - 

Title Read-only text The column title. This may be associated with a column name in an 
optionally provided title, or be in the owner database’s title table. If 
no associations are found then a column name is used as a title. 

- 

Type Read-only text The column type. This may be one of three options: 
 

• C – character or string column; 

• N – numeric column; 

• D – date column 

- 

ID Checkbox The checkbox setting here determines whether or not the column is 
a manager ID column. It is used to establish the relationship 
between the configured table and the owner database header table. 
This relationship allows the configured table to filter according to 
the current selection of the managers in the Stylus Chart/Table 
Designer window. Of all options selected in the Design Tree 
(managers, indices, etc.), only those matching the manager ID 
column type will be considered. 
 
For instance, if the ID column is numeric then the only managers 
considered would be those whose IDs can be converted to numbers. 
All others would be ignored even if they are selected in the 
corresponding section of the Design Tree. There may be one ID 
column only set for a table; this setting is optional. If this is not 
specified, the Design Tree selections have no effect on the table 
query output shown in the table and chart views. Therefore, 
omitting this setting makes it possible to show data unrelated to the 
header table. 

- 

Key Dropdown 
box. 

The Key column (or columns) is used in addition to the ID column in 
order to combine data for different managers into a common table.  
 
According to the Stylus reporting technology, the number of rows 
for every selected manager in the resulting chart/table must be the 
same. This means that the statement output rows for several 
managers must be aligned somehow relative to one another. In 
cases where the row corresponding to some key column value is 
absent, the manager’s output has a row inserted with a special N/A 
value.  
 
It is desirable for the key column value (or combination of column 
values) to be unique for any selected manager; if duplication does 
occur and the system gets several rows for a key column value, a 
simple row comparison algorithm is used in order to avoid duplicate 
rows in the final table view. Obviously, the ID column may not be 
used as a Key column because there is no way to combine manager 
rows by a manager ID column value that is unique for every 
manager.  
 
The key column may also be used to generate labels for charts. If 
the key column is a text column then text labels are generated. It 
may also be used to combine several Table blocks if no blocks of 
other types are present in the table or chart design. In some cases it 
is possible to combine columns to make a composite key. If this 
setting is omitted, but the ID column is present, then the system still 
needs some way to combine different manager rows for the final 

No (default;  
hidden) 
 
Yes (for 
generic 
columns) 
 
Day 
Week 
Month 
Quarter 
Year 
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output. In this case, rows are joined by row number. This means for 
all managers that the number of rows is equal to the maximum row 
number and the additional bottom rows are filled with N/A values. 
The row comparison is also used for this case in order to avoid 
duplicate rows; however, a comparison may be done only with the 
previous manager’s row as there is no key column available. For this 
reason, the final output may depend on the order of actual rows in 
the table output. 

Order Dropdown 
box 

One or more columns determining a default sorting order. Every 
column may have ascending/descending order attributes assigned 
(this setting is optional.) If it has been omitted, the default will be 
that the table query output is sorted by the specified Key column in 
ascending order. A default sorting order may be overridden by 
table/chart design settings. 

None 
(default, 
hidden) 
 
Asc 
(ascending) 
 
Desc 
(descending) 

Figure 163 

Linked Databases 

 
This sub-node on the Design Tree lets users view their current list of Linked Databases, and includes the 
following fields: 
 

• ID – The unique database ID 

• Name – The name assigned to the given database 

• Description – The DB description 

• Class – Displays the database class 
 

Database Views 

 
Database Views allow the user to define customized database field browse/selection screens, in order to 
eliminate scrolling or selection from unwanted/unnecessary fields. A Database View tells MPI Stylus Pro 
how you want to see a specific database – which columns are of interest, and in what order they should 
appear. Database Views are always created in Configurator and may be used throughout the application 
in the following  nodes/areas: Managers, Series, Manager Groups, Style Outline, Assets, Peer Groups, 
Benchmarks, Hedge Groups, Include/Exclude filters, Prospector Indicators and the Studies node. 
 
 
Default View 
Users may mark a specific view as ‘Default’ in order to specify in what manner the database should 
normally appear. 
 
Database View limits 
You may create multiple Database Views for a single database, and then use a dropdown to decide which 
view is appropriate in any specific database interaction. This allows you to tailor views to different 
tasks/jobs. 
 
Applying Database Views across Multiple Databases 
You may decide to apply a specific Database View across multiple databases in order to provide a 
consistent user experience, Please note that not all databases will necessarily have the same 
column/header names or data. 
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Filters for Database Views 
You may add filters to Database Views to ensure that some basic logic/criteria are applied before the 
database output is applied. This is useful for ensuring that you are selecting only from series of interest to 
your Database View task. 
 
Use automatic database view in selection pane 
This control was added to the Database tab in Configurator to specify the use of Default databases. 

 

 

 

 

 

 

 

 

 

 

 

 
 
 
 
Global Dictionaries 

Subscribers to our Advanced Database package will see a ‘Global Dictionaries’ option here. For more 
information, please see our Dictionaries User Guide, available on the MPI website. 

Troubleshooting the Configurator Module 
 
Q. Why do two of my configured Database Folders contain the same files? 
A. This happens when two Database Folders are pointing at the same location. Simply change the location 
of one to a different folder. 
 
Q. Why do I see files other than the type of files which this Database Folder should contain? (Ex: 
Executable files in a Stylus Study Database Folder) 
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A. This is corrected using the Mask field in the properties section for that Database Folder. The following 
masks should be used for the following files: 
  - Style Study: *.sty 
  - Prospector Study: *.unv 
  - Integrator Study: *.itg 
  - Allocator Study: *.ast 
 
Q. Why do the fields in the property window not correspond with the ones listed in the documentation as 
the ones that need to be filled out? 
A. Make sure that Type field is set to the correct type of database that you are trying to create. For 
example if you want to create an Excel Database your Type dropdown box should be set to “Excel DB” 
 
Q. What does <home> mean? 
A. <home> is defined by default as your Stylus directory as it was installed, but this can be changed in the 
Default node of Configurator. 
 
 



Glossary 

MPI Stylus Pro Analytics 

www.markovprocesses.com  Page 339 

 

Appendix A 

MPI Stylus Pro Analytics 

 
 
MPI Stylus Pro provides users with access to an extraordinary selection of analytics, including the 
flexibility to select your own dates/time periods, specify calculation parameters, etc. As such, there is a 
large volume of information available on the specific calculations behind each analytic block, model, etc.  
 
In prior versions of this manual, a summary of relevant calculations was provided in this space in order to 
give users a quick idea of some of the analytics and how they operate. As of version 9.0, this information 
has been moved to a new standalone reference document in order to provide a great deal more clarity 
and detail on how our powerful set of analytics functions. 
 
This document may be accessed directly in your application by going to: 
 
Help-> About-> Formula Reference 
 
Alternately, you may contact MPI Support for the standalone PDF. 
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